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6.5 Opcje linii poleceń . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
6.6 Projekty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
6.7 Zapisywanie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

7 Interfejs graficzny użytkownika QGIS (GUI) 21
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7.2 Pasek narzędzi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
7.3 Legenda mapy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
7.4 Widok mapy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
7.5 Pasek statusu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

i



8 Podstawowe narzędzia 33
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ROZDZIAŁ 1

Preambuła

Ten dokument to oryginalny podręcznik użytkownika programu QGIS. Większość oprogramowania i sprzętu
opisanego w tym dokumencie to zarejestrowane znaki towarowe, które podlegają prawnym regulacjom.
QGIS wydany jest na Powszechnej Licencji GNU. Więcej informacji znajdziesz na stronie domowej QGIS
http://www.qgis.org.

Informacje, dane, wyniki itp. zawarte w tym dokumencie zostały podane i sprawdzone zgodnie z najlepszą wiedzą
i odpowiedzialnością autorów i edytorów. Mimo tego, istnieje możliwość, że zawierają one pomyłki.

Zatem żadne dane nie mogą być przedmiotem żądań lub gwarancji. Autorzy, edytorzy i wydawcy nie biorą żadnej
odpowiedzialności za niepowodzenie i jego konsekwencje. Zgłoszenia potencjalnych pomyłek są zawsze chętnie
przyjmowane.

Ten dokument został złożony za pomocą reStructuredText. Jest dostępny w postaci kodu źródłowego reST
na github i online jako HTML i PDF pod adresem http://www.qgis.org/en/docs/. Z sekcji Dokumentacja pro-
jektu QGIS można również pobrać tłumaczenia tego dokumentu w kilku formatach. Więcej informacji na
temat możliwości wniesienia własnego wkładu do dokumentacji i jej tłumaczenia znajdziesz pod adresem:
http://www.qgis.org/wiki/.

Odnośniki w tym dokumencie

Dokument niniejszy zawiera odnośniki wewnętrzne i zewnętrzne. Kliknięcie odnośnika wewnętrznego przenosi
do inne części tego dokumentu, natomiast zewnętrzne odnośniki prowadzą pod inne adresy internetowe. W PDFie
oba rodzaje linków mają kolor niebieski i obsługiwane są przez przeglądarkę systemową. W przypadku HTML
przeglądarka wyświetla i obsługuje oba rodzaje linków tak samo.

Autorzy i edytorzy podręczników użytkownika, instalacji i programowania:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet: http://www.qgis.org

Licencja niniejszego dokumentu

Dopuszcza się kopiowanie, rozpowszechnianie oraz/lub modyfikację tego dokumentu pod warunkami licencji
GNU Free Documentation w wersji 1.3 lub dowolnej późniejszej opublikowanej przez Free Software Founda-
tion, bez niezmiennego tekstu oraz tekstów okładek. Kopia licencji została zamieszczona w Dodatku GNU Free
Documentation License.

.
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ROZDZIAŁ 2

Przyjęte oznaczenia

W tym rozdziale opisany jest jednolity styl oznaczeń przyjętych w tym podręczniku.

2.1 Oznaczenia GUI

Oznaczenia GUI są tak pomyślane, aby przypominały właściwy wygląd interfejsu użytkownika. Ogólna za-
sada jest taka, że używa się wyglądu elementów tak, jak wyglądają one bez fokusa, aby użytkownik mógł łatwo
odnaleźć w interfejsie to, co opisane jest w podręczniku.

• Pozycje menu: Warstwa → Dodaj warstwę rastrową lub Widok→ Paski narzędzi → Digitalizacja

• Narzędzia: Dodaj warstwę rastrową

• Przycisk: [Zapisz jako domyślne]

• Tytuł okna Właściwości warstwy

• Zakładka: Ogólne

• Pole wyboru: Renderuj

• Przycisk radio: SRID Postgis EPSG ID

• Podaj liczbę:

• Wybierz tekst:

• Przeglądaj w poszukiwaniu pliku:

• Wybierz kolor:

• Suwak:

• Wprowadź tekst:

Jeśli element posiada tło (cień) oznacza, że można go kliknąć.

2.2 Oznaczenia tekstu i klawiszy

Podręcznik zawiera również oznaczenia odnoszące się do tekstu, poleceń i kodu, aby można było odróżnić różnego
rodzaju obiekty, jak metody i klasy. Nie mają one żadnych odpowiedników w interfejsie użytkownika QGIS.

• Hiperlinki: http://qgis.org

• Kombinacje klawiszy: naciśnij Ctrl+B, oznacza przytrzymaj klawisz Ctrl i naciśnij klawisz B.

• Nazwa pliku: lakes.shp

5
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• Nazwa klasy: NewLayer

• Metoda: classFactory

• Serwer: myhost.de

• Tekst wprowadzany przez użytkownika: qgis --help

Linie kodu wyróżnione są czcionką o stałej szerokości:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Uwagi szczegółowe dla platform

Ciągi poleceń i niewielkie ilości tekstu mogą być sformatowane w w linii: Kliknij Plik QGIS → Zakończ
QGIS. Na systemach uniksowych i Windows oznacza to, że najpierw powinno się kliknąć polecenie menu Plik, a
następnie Zakończ QGIS. Natomiast na platformie Macintosh OS X, powinno się najpierw kliknąć menu QGIS a
następnie Zakończ QGIS.

Dłuższe fragmenty tekstu mogą być sformatowane jako lista:

• zrób to;

• zrób to;

• zrób tamto.

lub jako akapity:

Zrób to, to i to. Potem zrób to, to i to, a następnie zrób tamto i to, a potem jeszcze to.

Zrób to, a potem tamto. Potem zrób to i to. Następnie zrób tamto i to, a potem jeszcze to. Na koniec zrób to,
to, to, to i tamto.

Zrzuty ekranowe zamieszczone w podręczniku zostały utworzone na różnych platformach, której znacznik
umieszczony jest na końcu opisu obrazka.

.
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ROZDZIAŁ 3

Wstęp

Witaj we wspaniałym świecie Systemów Informacji Przestrzennej (GIS)!

QGIS jest systemem informacji przestrzennej o otwartym źródle. Projekt rozpoczął się w maju 2002 roku, a
w czerwcu utworzono projekt w serwisie SourceForge. Staramy się bardzo udostępnić oprogramowanie GIS
(które tradycyjnie jest kosztownym oprogramowaniem prawnie zastrzeżonym) wszystkim, którzy mają dostęp do
komputera. Obecnie QGIS działa na większości platform uniksowych, na Windows i OS X. QGIS jest rozwijany
przy użyciu C++ i narzędzi Qt (http://qt.digia.com). Oznacza to, że QGIS ma przyjemny, łatwy w użyciu interfejs
(GUI) i chętnie się go używa.

W naszych zamierzeniach QGIS ma być prostym w użyciu systemem informacji przestrzennej, posiadającym
popularne funkcjonalności i polecenia. Początkowo miał być przeglądarką GISową. QGIS osiągnął taki stopień
rozwoju, że przez wielu użytkowników jest na co dzień używany do przeglądania danych GIS. QGIS obsługuje
wiele formatów danych rastrowych i wektorowych, a dodanie kolejnych jest bardzo proste dzięki mechanizmowi
wtyczek.

QGIS udostępniany jest na Powszechnej Licencji GNU (GPL). Dzięki temu, że QGIS rozwijany jest pod tą
licencją możesz mieć wgląd w jego kod źródłowy, możesz go modyfikować i masz gwarancję, że jako nasz
szczęśliwy użytkownik, zawsze będziesz mieć dostęp do programu GISowego wolnego od opłat i którego możesz
dowolnie modyfikować. Razem z QGIS powinieneś otrzymać pełny tekst licencji GPL, którą znajdziesz też w
dodatku GNU General Public License.

Wskazówka: Aktualna wersja dokumentacji
Aktualna wersja tego dokumentu zawsze dostępna jest w sekcji dokumentacji na stronie QGIS pod adresem
http://www.qgis.org/en/docs/

.
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ROZDZIAŁ 4

Cechy

QGIS oferuje wiele funkcjonalności GIS dostępnych jako wbudowane części programu lub jako wtyczki. Poniżej
zaprezentowano sześć ogólnych kategorii narzędzi i wtyczek, a następnie dokonano krótkiego wprowadzenia do
wbudowanej konsoli Pythona.

4.1 Przeglądanie danych

Można przeglądać i nakładać na siebie dane wektorowe i rastrowe zapisane w różnych formatach i w różnych
układach odniesienia bez ich konwersji do jakiegoś wspólnego formatu. Obsługiwane formaty obejmują:

• Tabele i widoki z informacją przestrzenną w PostGIS, SpatiaLite, MSSQL Spatial, Oracle Spatial, format-
ach obsługiwanych przez zainstalowaną bibliotekę OGR, w tym ESRI shapefiles, MapInfo, SDTS, GML i
wiele innych, zobacz rozdział Working with Vector Data.

• Rastry i zobrazowania obsługiwane przez zainstalowaną bibliotekę GDAL (Geospatial Data Abstraction
Library) takie jak GeoTiff, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG i wiele innych, zobacz rozdział
Working with Raster Data.

• Rastry i dane wektorowe GRASS zapisane w bazach GRASS (location/mapset), zobacz rozdział GRASS
GIS Integration.

• Dane przestrzenne udostępnione online jako OGC Web Services, w tym WMS, WMTS, WCS, WFS, WFS-
T. Zobacz rozdział Working with OGC Data.

4.2 Przeglądanie danych i tworzenie map

Możesz tworzyć mapy i interaktywnie przeglądać dane przestrzenne za pomocą przyjaznego interfejsu użytkown-
ika. Interfejs zawiera wiele przydatnych narzędzi:

• Przeglądarka QGIS

• Przeliczanie współrzędnych w locie

• Zarządzanie bazami danych

• Wydruki map

• Panel podglądu

• Zakładki

• Narzędzia opisu

• Zaznaczanie i uzyskiwanie informacji o obiektach

• Edycja/przeglądanie/przeszukiwanie atrybutów

• Etykietowanie obiektów oparte na danych

9
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• Style wyświetlania warstw wektorowych i rastrów oparte na danych

• Tworzenie atlasowych kompozycji mapowych z siatkami

• Umieszczanie na mapie strzałki północy, skali i informacji o prawach autorskich

• Wsparcie dla zapisywania i przywracania projektów

4.3 Tworzenie, edycja, zarządzanie i eksport danych

Można tworzyć, edytować, zarządzać i eksportować dane rastrowe i wektorowe w różnych formatach. QGIS daje
następujące możliwości.:

• Narzędzia digitalizacji dla formatów obsługiwanych przez OGR i warstw wektorowych GRASS

• Możliwość tworzenia oraz edycji plików ESRI Shapefile i warstw wektorowych GRASS

• Wtyczka Georeferencer do geokodowania obrazów

• Narzędzia GPS do importu i eksportu formatu GPX oraz konwersji innych formatów GPS do GPX i
bezpośredniego ściągania/ładowania danych na urządzenia GPS (na GNU/Linuksie dodano usb: do listy
urządzeń GPS)

• Wsparcie dla przeglądania i edycji danych OpenStreetMap

• Możliwość tworzenia tabel przestrzennych w bazach na podstawie plików Shapefile za pomocą wtyczki
Zarządzanie bazami danych

• Poprawiona obsługa tabel w przestrzennych bazach danych

• Narzędzia do zarządzania tabelami atrybutów warstw wektorowych

• Możliwość zapisywania zrzutów ekranowych jako obrazów z georeferencją

4.4 Analiza danych

Można wykonywać przestrzenne analizy danych umieszczonych w bazach danych z rozszerzeniem przestrzennym
i innych formatach obsługiwanych przez OGR. Obecnie QGIS oferuje analizę danych wektorowych, próbkowanie,
geoprocesing, narzędzia zarządzania geometrią i bazami danych. Można też wykorzystać wbudowane narzędzia
GRASS, dające pełną funkcjonalność GRASS, tj. ponad 400 modułów (zobacz rozdział GRASS GIS Integration).
Można też wykorzystać wtyczkę Geoprocesing, która daje dostęp do własnych i zewnętrznych narzędzi z poziomu
QGIS, obejmujących algorytmy GDAL, SAGA, GRASS, fTools i innych (zobacz rozdział Introduction).

4.5 Publikowanie map w Internecie

QGIS może służyć jako klient WMS, WMTS, WMS-C, WFS i WFS-T oraz jako serwer WMS, WCS lub WFS
(zobacz rozdział Working with OGC Data). Dodatkowo można wyeksportować dane i opublikować je w Internecie
przy użyciu zainstalowanych serwerów UMN MapServer lub Geoserver.

4.6 Rozszerzanie możliwości QGIS za pomocą wtyczek

QGIS można dostosować do swoich indywidualnych potrzeb za pomocą elastycznej architektury wtyczek i bib-
liotek, których można użyć do tworzenia wtyczek. Można nawet tworzyć własne aplikacje w C++ lub Pythonie!

10 Rozdział 4. Cechy
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4.6.1 Wtyczki instalowane razem z programem

Wtyczki instalowane razem z programem:

1. Przechwytywanie współrzędnych (Informacja o współrzędnych kursora myszy w różnych układach
współrzędnych)

2. Zarządzanie bazami danych (wymiana, edycja i przeglądanie warstw i tabel, uruchamianie zapytań SQL)

3. Tworzenie diagramów (nakładanie diagramów na warstwy wektorowe)

4. Konwerter Dxf2Shp (konwertuje pliki DXF do Shapefile)

5. eVIS (wizualizacja zdarzeń)

6. fTools (analiza i zarządzanie danymi wektorowymi)

7. Narzędzia GDAL (zintegrowane z QGIS)

8. Georeferencer GDAL (dodawanie informacji przestrzennej do rastrów przy użyciu GDAL)

9. Narzędzia GPS (Ładowanie i import danych GPS)

10. GRASS (integracja GRASS)

11. Mapa termiczna (tworzenie rastrowych map termicznych na podstawie danych punktowych)

12. Wtyczka interpolacji (interpolacja rastrów na podstawie wierzchołków warstwy wektorowej)

13. Edycja offline (pozwala na edycję offline i synchronizację z bazą danych)

14. GeoRaster Oracle Spatial

15. Geoprocessing (dawniej SEXTANTE)

16. Rastrowa analiza terenu (analiza ukształtowania terenu na podstawie rastrów)

17. Wtyczka Road graph (znajdowanie najkrótszej trasy za pomocą analizy sieci)

18. Wtyczka zapytań przestrzennych

19. SPIT (importowanie plików Shapefile do bazy PostgreSQL/PostGIS)

20. Wtyczka SQL Anywhere (przechowywanie danych w bazach SQL Anywhere)

21. Kontrola topologii (znajdowanie błędów topologicznych w warstwach wektorowych)

22. Wtyczka statystyk strefowych (oblicza ilość wystąpień, sumę, średnią z rastra dla wieloboków warstwy
wektorowej)

4.6.2 Wtyczki Pythona

QGIS zawiera rosnącą liczbę zewnętrznych wtyczek pythonowych, tworzonych przez społeczność. Wtyczki te
można znaleźć w oficjalnym repozytorium wtyczek i łatwo zainstalować za pomocą menedżera wtyczek (zobacz
rozdział load_external_plugin).

4.7 Konsola Pythona

Do uruchamiania skryptów można wykorzystać wbudowaną konsolę Pythona. Można ją otworzyć za pomocą
menu: Wtyczki → Konsola Pythona. Konsola otwiera się jako okno niemodalne. Do interakcji ze środowiskiem
QGIS służy zmienna qgis.utils.iface, będąca instancją QgsInterface. Ten interfejs pozwala na
dostęp do okna mapy, menu, pasków narzędzi i innych części aplikacji QGIS.

Więcej informacji o pracy z konsolą Pythona i programowaniu wtyczek QGIS i aplikacji można znaleźć na stronie
http://www.qgis.org/html/en/docs/pyqgis_developer_cookbook/index.html.

4.7. Konsola Pythona 11
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4.8 Znane błędy

4.8.1 Ograniczenie ilości otwartych plików

Gdy otwiera się duży projekt QGIS i ma się pewność, że wszystkie warstwy są prawidłowe, a niektóre z nich za-
znaczane są jako błędne, dotyczy to prawdopodobnie tego błędu. GNU/Linux (również inne systemy operacyjne)
ma ograniczenie ilości plików otwartych przez pojedynczy proces. Ograniczenie danych źródłowych określane
jest dla procesu i jest dziedziczone. Wbudowane polecenie powłoki ulimit zmienia to ograniczenie jedynie dla
procesów bieżącej powłoki, natomiast będzie dziedziczone przez każdy proces potomny.

Można podejrzeć informacje o bieżącym ulimit przez wpisanie

user@host:~$ ulimit -aS

Możesz zobaczyć bieżącą dopuszczalną liczbę plików otwartych przez pojedynczy proces wydając następujące
polecenie w konsoli

user@host:~$ ulimit -Sn

Aby zmienić to ograniczenie dla istniejącej sesji można użyć

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Aby naprawić to na stałe

Na większości systemów linuksowych ograniczenie źródeł ustawiane jest w czasie logowania przez
moduł pam_limits zgodnie z ustawieniami zawartymi w /etc/security/limits.conf lub
/etc/security/limits.d/*.conf. Jeśli masz uprawnienia roota (można użyć sudo) można edytować
te pliki, ale zmiana dokona się dopiero po powtórnym zalogowaniu.

Więcej informacji:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

.
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What’s new in QGIS 2.6

This release contains new features and extends the programmatic interface over previous versions. We recommend
that you use this version over previous releases.

This release includes hundreds of bug fixes and many new features and enhancements that will be described in
this manual. You may also review the visual changelog at http://changelog.linfiniti.com/qgis/version/2.6.0/.

5.1 Application and Project Options

• Project filename in properties: You can now see the full path for the QGIS project file in the project
properties dialog.

5.2 Data Providers

• DXF Export tool improvements:

– Tree view and attribute selection for layer assigment in dialog

– support fill polygons/HATCH

– represent texts as MTEXT instead of TEXT (including font, slant and weight)

– support for RGB colors when there’s no exact color match

– use AutoCAD 2000 DXF (R15) instead of R12

5.3 Map Composer

• Update map canvas extent from map composer extent: On the Item properties of a Map element there
are now two extra buttons which allow you to (1) set the Map canvas extent according with the extent
of your Map element and (2) view in Map canvas the extent currently set on your Map element.

• Multiple grid support: It is now possible to have more than one grid in your Map element. Each grid is
fully customizable and can be assigned to a different CRS. This means, for example, you can now have a
map layout with both geographic and projected grids.

• Selective export: To every item of your map composer layout, under Rendering options, you may exclude
that object from map exports.

13
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5.4 QGIS Server

5.5 Symbology

5.6 User Interface

.
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Pierwsze kroki

Ten rozdział zawiera ogólne informacje o instalacji QGIS, przykładowych danych zawartych na stronie interne-
towej QGIS i uruchomieniu pierwszej sesji z wizualizacją warstw rastrowych i wektorowych.

6.1 Instalacja

Instalacja QGIS jest bardzo prosta. Standardowe pakiety instalacyjne są dostępne dla MS Windows i dla Mac OS
X. Dla wielu dystrybucji GNU/Linuksa dostępne są pakiety binarne (rpm i deb) lub repozytoria oprogramowania,
które można dodać do swoich menedżerów instalacji. Najświeższe informacje o pakietach binarnych można
uzyskać na stronie internetowej QGIS pod adresem http://download.qgis.org.

6.1.1 Instalacja z kodu źródłowego

Jeśli chcesz skompilować kod źródłowy QGIS, sięgnij do instrukcji instalacji. Instrukcje te dołączane są
do kodu źródłowego QGIS w pliku o nazwie INSTALL. Można je również znaleźć online pod adresem
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Instalacja na nośnikach zewnętrznych

QGIS umożliwia zdefiniowanie opcji --configpath, która nadpisuje domyślną ścieżkę dla konfiguracji
użytkownika (np. ~/.qgis2 w GNU/Linuksie) i nakazuje, aby również QSettings korzystały z tej ścieżki. Umożli-
wia to użytkownikom przenoszenie instalacji QGIS na pamięci zewnętrznej razem ze wszystkimi ich ustawieniami
i pluginami. Więcej informacji znajduje się w rozdziale Zakładka System.

6.2 Przykładowe dane

Przewodnik zawiera przykłady wykorzystujące próbny zestaw danych QGIS.

|win|Instalator windowsowy posiada opcję ściągnięcia próbnego zestawu danych |qg|. Jeśli zostanie ona
zaznaczona, wówczas dane zostaną ściągnięte do twojego folderu Moje Dokumenty‘i umieszczone w
folderze :file:‘GIS Database. Możesz przenieść ten folder w inne, dogodne położenie za pomocą
Exploratora Windows. Jeśli nie zaznaczysz opcji instalacji próbnego zestawu danych podczas pierwszej instalacji
QGIS, możesz wybrać jedno z poniższych rozwiązań:

• użyć danych GIS, które już masz

• pobrać dane przykładowe z http://download.osgeo.org/qgis/data/qgis_sample_data.zip

• odinstalować QGIS i zainstalować go od nowa zaznaczając tym razem opcję pobierania danych (to
rozwiązanie polecane jest w wypadku, gdy nie zadziała żadne z powyższych).
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Dla GNU/Linuksa i Mac OS X nie są jeszcze dostępne pakiety instalacyjne rpm, deb czy dmg z przykład-
owymi danymi. Aby skorzystać ze zbioru danych przykładowych pobierz plik ZIP qgis_sample_data z
http://download.osgeo.org/qgis/data/qgis_sample_data.zip a następnie odpakuj archiwum na swoim komputerze.

Zbiór danych z Alaski zawiera wszystkie dane GIS wykorzystywane jako przykłady w tym podręczniku oraz mały
zestaw danych dla GRASS. Odwzorowanie zbioru danych przykładowych to Alaska Albers Equal Area z miarą
długości w stopach (ang. feet). Kod EPSG tego układu to 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Jeśli chcesz wykorzystać QGIS jako nakładkę wizualną dla GRASS, możesz pobrać zbiory danych
przykładowych (np. Spearfish lub South Dakota) z oficjalnej strony GRASS GIS pod adresem
http://grass.osgeo.org/download/sample-data/.

6.3 Przykładowa sesja

Teraz, gdy zainstalowałeś już QGIS i masz dostęp do próbnego zestawu danych, chcielibyśmy pokazać
Ci prostą i krótką sesję QGIS. Wyświetlimy warstwy rastrowe i wektorowe. Wykorzystamy rastrową
warstwę pokrycia terenu qgis_sample_data/raster/landcover.img oraz wektorową warstwę
qgis_sample_data/gml/lakes.gml.

6.3.1 Uruchomienie QGIS

• Uruchom QGIS wpisując w linii poleceń: “QGIS” lub korzystając z prekompilowanego pakietu bina-
rnego z menu aplikacji.

• Uruchom QGIS z menu Start, za pomocą skrótu na pulpicie lub dwukrotnie klikając na dowolnym pliku
projektu QGIS.

• Kliknij dwukrotnie ikonkę w twoim folderze Aplikacji.

6.3.2 Załaduj warstwę rastrową i wektorową z próbnego zestawu danych.

1. Kliknij na ikonce Dodaj warstwę rastrową.

2. Przejdź do folderu qgis_sample_data/raster/, wybierz plik w formacie ERDAS
IMG:file:landcover.img i kliknij [Otwórz].
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3. Jeśli nie widzisz tego pliku, sprawdź na listewce typu pliku u dołu okna dialogowego zaznaczony jest
właściwy typ, w tym przypadku “Erdas Imagine Images (*.img, *.IMG)”.

4. A teraz kliknij ikonkę Dodaj warstwę wektorową.

5. Jako typ źródła danych w nowym oknie dialogowym Dodaj warstwę wektorową powinien być zaznaczony
Plik. Kliknij [Przeglądaj], aby wybrać warstwę wektorową.

6. Przejdź do folderu qgis_sample_data/gml/, na listewce typów plików wybierz ‘Geography Markup
Language [GML] [OGR] (.gml,.GML)’ i potem wybierz plik GML lakes.gml i kliknij [Open], a następ-
nie w oknie dialogowym Dodaj warstwę wektorową kliknij [OK]. Gdy pojawi się okno Wybór układu
współrzędnych z zaznaczonym układem NAD27 / Alaska Alberts, naciśnij [OK].

7. Powiększ nieco widok do wybranego obszaru z jakimiś jeziorami.

8. Kliknij dwukrotnie warstwę lakesw legendzie mapy aby otworzyć okno dialogowe Właściwości warstwy.

9. Kliknij zakładkę Styl i ustaw niebieski jako kolor wypełnienia.

10. Kliknij zakładkę Etykiety i aby włączyć etykietowanie zaznacz pole wyboru|checkbox| Etykietuj tę warstwę
z. Wybierz “NAMES” jako pole zawierające etykiety.

11. Można poprawić widoczność etykiet dodając do nich białą obwódkę klikając “Otoczka” w liście po lewej,

zaznaczając Rysuj otoczkę i wybierając jako rozmiar otoczki 3.

12. Kliknij [Zastosuj], sprawdź czy rezultat zmian wygląda dobrze i potem naciśnij [OK].

Przekonałeś się właśnie, jak łatwo można wyświetlić raster i warstwę wektorową w QGIS. Teraz przejdziemy do
kolejnego rozdziału, w którym dowiemy się więcej o dostępnych funkcjonalnościach, obiektach i ich ustawieni-
ach.

6.4 Uruchamianie i zamykanie QGIS

W rozdziale Przykładowa sesja dowiedziałeś się jak uruchomić QGIS. Wracamy do tego tematu, aby pokazać, że
QGIS ma więcej opcji uruchamiania w linii poleceń.

• Zakładając, że QGIS jest zainstalowany w lokalizacji zarejestrowanej w zmiennej PATH, możesz uru-
chomić QGIS wpisując: qgis w linii poleceń lub klikając dwukrotnie na ikonce aplikacji QGIS (lub skró-
cie) na pulpicie lub w menu aplikacji.

• Uruchom QGIS z menu Start, za pomocą skrótu na pulpicie lub dwukrotnie klikając na dowolnym pliku
projektu QGIS.

• Kliknij dwukrotnie ikonkę w folderze aplikacji. Jeśli musisz uruchomić QGIS w powłoce, uruchom
/path-to-installation-executable/Contents/MacOS/Qgis.

Żeby zamknąć QGIS kliknij w menu Projekt polecenie Wyjdź z QGIS lub użyj skrótu klawiaturowego
Ctrl+Q.

6.5 Opcje linii poleceń

QGIS można uruchomić z linii poleceń z szeregiem opcji. Listę dostępnych opcji można uzyskać wpisując w
linii poleceń qgis --help. Instrukcja użycia dla QGIS jest następująca:

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
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[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--help] this text

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Wskazówka: Przykłady wykorzystania opcji linii poleceń
Możesz uruchomić QGIS podając w linii poleceń jeden lub więcej plików z danymi. Zakładając, że jesteś w kata-
logu qgis_sample_data, mógłbyś uruchomić QGIS z ładowaniem zbioru danych składającym się z warstwy
wektorowej i rastrowej używając polecenia: qgis ./raster/landcover.img ./gml/lakes.gml

Opcja linii poleceń --snapshot

T opcja pozwala na utworzenie zrzutu bieżącego widoku do formatu PNG. Może się to okazać przydatne, gdy
masz wiele projektów i chciałbyś utworzyć zrzutki swoich danych.

Obecnie tworzone są pliki PNG w rozdzielczości 800x600 pikseli. Można to zmienić używając w opcji linii
poleceń argumentów --width i --height. Po argumencie --snapshot można podać nazwę pliku.

Opcja linii poleceń --lang

QGIS określa twoje ustawienia językowe na podstawie twojej lokalizacji. Gdybyś chciał uruchomić go w
swoim języku, możesz podać kod tego języka. Na przykład --lang=pl uruchomi QGIS w języku pol-
skim. Lista obsługiwanych obecnie języków, ich kodów i postępu tłumaczenia opublikowana jest pod adresem
http://hub.qgis.org/wiki/quantum-gis/GUI_Translation_Progress.

Opcja linii poleceń --project

Można też uruchomić QGIS z istniejącym projektem. Należy wtedy dodać opcję --project i nazwę projektu,
a QGIS otworzy wszystkie warstwy zawarte w tym pliku.

Opcja linii poleceń --extent

Używając tej opcji można uruchomić QGIS z określonym zakresem widoczności. Trzeba wtedy podać rozdzielane
przecinkami współrzędne prostokąta opisującego żądany zakres w następującym porządku:

--extent xmin,ymin,xmax,ymax

Opcja linii poleceń --nologo

Ta opcja ukrywa ekran powitalny w czasie uruchamiania QGIS.

Opcja linii poleceń --noplugins

Gdybyś miał kłopoty z wtyczkami w czasie uruchamiania QGIS, możesz wyłączyć ich ładowanie przy starcie.
Będą one nadal dostępne w Menedżerze Wtyczek.
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Opcja linii poleceń --customizationfile

Użycie tej opcji spowoduje, że w czasie uruchamiania zostanie zastosowana zapisana w pliku personalizacja
interfejsu użytkownika.

Opcja linii poleceń --nocustomization

Użycie tej opcji spowoduje, że w czasie uruchamiania nie zostanie zastosowana istniejąca personalizacja interfejsu
użytkownika.

Opcja linii poleceń --optionspath

Możesz mieć zapisanych wiele konfiguracji i za pomocą tej opcji wybrać, którą z nich użyć w czasie uruchamiania
QGIS. Sprawdź Opcje żeby zobaczyć, gdzie twój system operacyjny zapisuje pliki ustawień. Obecnie nie ma
możliwości określania w jakim pliku i gdzie zapisać ustawienia, więc możesz utworzyć kopię wyjściowego pliku
ustawień i zmienić jego nazwę. Tu określa się ścieżkę do katalogu z ustawieniami. Na przykład, aby użyć ustawień
z pliku ustawień /path/to/config/QGIS/QGIS2.ini wykonaj:

--optionspath /path/to/config/

Opcja linii poleceń --configpath

Ta opcja jest podobna do poprzedniej ale dodatkowo nadpisuje domyślną ścieżkę (~/.qgis2) dla konfiguracji
użytkownika i nakazuje, aby również QSettings korzystały z tej ścieżki. Umożliwia to użytkownikom np.
przenoszenie instalacji QGIS na pamięci zewnętrznej razem ze wszystkimi ich ustawieniami i pluginami.

Opcja linii poleceń --code

Może być wykorzystana do uruchomienia danego kodu Pythona zaraz po starcie QGIS.

Na przykład, jeśli masz plik z kodem Pythona :file:‘load_alaska.py‘o następującej zawartości:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Zakładając, że jesteś w katalogu, w którym znajduje się plik load_alaska.py, możesz uruchomić
QGIS ładując raster landcover.img i nadając mu nazwę ‘Alaska’ za pomocą polecenia: qgis --code
load_alaska.py

6.6 Projekty

Projekt jest zapisem stanu twojej sesji QGIS. QGIS pracuje na raz z jednym projektem. Ustawienia można
zmieniać na poziomie projektu bądź uczynić je domyślnymi dla nowych projektów (zobacz rozdział Opcje). QGIS

zapisze stan twojej przestrzeni roboczej w pliku Projektu, gdy użyjesz polecenia menu Projekt → Zapisz lub

Projekt → Zapisz jako.

Ładowanie zapisanych Projektów do QGIS następuje za pomocą poleceń Projekt → Otwórz ..., Projekt →
Nowy z szablonu lub Projekt → Otwórz ostatnie →.

Wyczyszczenie sesji i rozpoczęcie nowej następuje za wybraniu polecenia Projekt → Nowy. Każde z
wymienionych poleceń zapyta Cię, czy zapisać bieżący projekt, jeśli nastąpiły w nim jakieś zmiany od czasu
otwarcia lub ostatniego zapisu.

Informacje zapisywane w pliku projektu obejmują:

• Dodane warstwy

• Właściwości warstw, włącznie ze stylem

• Odwzorowanie widoku mapy

• Ostatni zakres widoczności

6.6. Projekty 19



QGIS User Guide, Wydanie 2.6

Plik projektu zapisywany jest w formacie XML, więc jeśli się na tym znasz, możesz go zmienić poza QGIS.
Format pliku zmieniał się kilkakrotnie razem z kolejnymi wersjami QGIS. Pliki projektów z wcześniejszych wersji
mogą nie działać teraz prawidłowo. Możesz uaktywnić ostrzeżenia o tym w zakładce Ogólne w Ustawienia →
Opcje zaznaczając:

• Informuj o konieczności zapisu, gdy projekt i źródło ulegną zmianie

• Ostrzegaj przy otwieraniu projektów zapisanych w starszych wersjach QGIS

Za każdym razem, gdy zapiszesz projekt w QGIS 2.2 zapisywany będzie również plik zapasowy projektu.

6.7 Zapisywanie

Jest kilka możliwości zapisu danych z sesji QGIS. Jedną z nich, zapisywanie jako plik projektu, omówiliśmy już
w rozdziale Projekty. Teraz podamy inne sposoby zapisu plików:

• Polecenie menu Projekt → Zapisz jako obraz otwiera okno dialogowe, gdzie określasz nazwę, ścieżkę i typ
obrazu (format PNG lub JPG). Plik światowy z rozszerzeniem PNGW lub JPGW zapisany w tym samym
katalogu zawiera informację o georeferencji obrazu.

• Polecenie menu Projekt → Export DXF ... otwiera okno, w którym można zdefiniować ‘Tryb stylów’,
‘Skalę stylów’ oraz warstwę wektorową, którą chcesz wyeksportować do DXF.

• Polecenie menu Projekt → Nowy wydruk otwiera okno dialogowe, w którym możesz ułożyć i
wydrukować bieżący widok mapy (zobacz rozdział Print Composer).

.
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ROZDZIAŁ 7

Interfejs graficzny użytkownika QGIS (GUI)

Po starcie QGIS zobaczysz pokazany na rysunku interfejs użytkownika (wyjaśnienie cyfr od 1 do 5 jest przed-
stawione poniżej).

Rysunek 7.1: QGIS Interfejs użytkownika z przykładowym zestawem danych Alaska

Informacja: Wygląd twojego okna (paska tytułu itd.) może być nieco inny w zależności od tego, jakiego systemu
operacyjnego i menadżera okien używasz.

GUI QGIS składa się z pięciu części:

1. Pasek menu

2. Pasek narzędzi

3. Legenda mapy

4. Widok mapy

5. Pasek statusu

Wymienione części interfejsu użytkownika QGIS opisane są bardziej szczegółowo poniżej w kolejnych rozdzi-
ałach. Dwa następne rozdziały opisują skróty klawiaturowe i pomoc kontekstową.
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7.1 Pasek menu

Pasek menu umożliwia dostęp do różnych poleceń QGIS przy użyciu standardowego menu hiererchicznego.
Poniżej znajdują się elementy najwyższego poziomu menu i podsumowanie niektórych jego opcji wraz z ikonkami
narzędzi i skrótami klawiaturowymi. Skróty klawiaturowe mogą być ustawione ręcznie za pomocą polecenia
[Konfiguracja skrótów] z menu Ustawienia.

Mimo, że wiele poleceń menu ma odpowiadające im przyciski na paskach narzędzi i na odwrót, porządek menu
jest inny od układu pasków narzędziowych. Jeśli polecenie menu znajduje się również na jakimś pasku narzędzi,
to obok polecenia podana jest nazwa tego paska. Niektóre z poleceń menu pojawiają się na paskach jedynie
wówczas, gdy załadowana jest odpowiednia wtyczka. Więcej informacji o paskach i przyciskach narzędzi zna-
jdziesz w rozdziale Pasek narzędzi.

7.1.1 Projekt

Polecenie menu Skrót Odnośnik Pasek narzędzi

Nowy Ctrl+N see Projekty Projekt

Otwórz Ctrl+O see Projekty Projekt
Nowy z szablonu → see Projekty Projekt
Otwórz ostatnie → see Projekty

Zapisz Ctrl+S see Projekty Projekt

Zapisz jako... Ctrl+Shift+S see Projekty Projekt

Zapisz jako obraz... see Zapisywanie
Eksport DXF ... see Zapisywanie

Nowy wydruk Ctrl+P zobacz Print Composer Projekt

Zarządzanie wydrukami ... zobacz Print Composer Projekt
Wydruki → zobacz Print Composer

Wyjdź z QGIS Ctrl+Q
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7.1.2 Edycja

Polecenie menu Skrót Odnośnik Pasek narzędzi

Cofnij Ctrl+Z zobacz Advanced digitizing Zaawansowana
digitalizacja

Ponów Ctrl+Shift+Zzobacz Advanced digitizing Zaawansowana
digitalizacja

Wytnij obiekty Ctrl+X zobacz Digitizing an existing
layer

Digitalizacja

Kopiuj obiekty Ctrl+C zobacz Digitizing an existing
layer

Digitalizacja

Wklej obiekty Ctrl+V zobacz Digitizing an existing
layer

Digitalizacja

Wklej obiekty jako → zob. Working with the
Attribute Table

Dodaj obiekt Ctrl+. zobacz Digitizing an existing
layer

Digitalizacja

Przesuń obiekt(y) zobacz Digitizing an existing
layer

Digitalizacja

Usuń zaznaczone zobacz Digitizing an existing
layer

Digitalizacja

Obróć obiekt(y) zobacz Advanced digitizing Zaawansowana
digitalizacja

Uprość geometrię zobacz Advanced digitizing Zaawansowana
digitalizacja

Dodaj pierścień zobacz Advanced digitizing Zaawansowana
digitalizacja

Dodaj część zobacz Advanced digitizing Zaawansowana
digitalizacja

Wypełnij pierścień zobacz Advanced digitizing Zaawansowana
digitalizacja

Usuń pierścień zobacz Advanced digitizing Zaawansowana
digitalizacja

Usuń część zobacz Advanced digitizing Zaawansowana
digitalizacja

Zmień kształt obiektu zobacz Advanced digitizing Zaawansowana
digitalizacja

Przesuń krzywą zobacz Advanced digitizing Zaawansowana
digitalizacja

Rozdziel obiekty zobacz Advanced digitizing Zaawansowana
digitalizacja

Wyodrębnij części zobacz Advanced digitizing Zaawansowana
digitalizacja

Połącz zaznaczone obiekty zobacz Advanced digitizing Zaawansowana
digitalizacja

Połącz atrybuty wybranych
obiektów

zobacz Advanced digitizing Zaawansowana
digitalizacja

Edycja wierzchołków zobacz Digitizing an existing
layer

Digitalizacja

Obróć symbol punktowy zobacz Advanced digitizing Zaawansowana
digitalizacja
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Po włączeniu Trybu edycji dla jakiejś warstwy ikonka Dodaj obiekt w menu Edycja będzie zależała od typu
tej warstwy (punktowa, liniowa czy poligonowa).

7.1.3 Edycja (extra)

Polecenie menu Skrót Odnośnik Pasek narzędzi

Dodaj obiekt zobacz Digitizing an existing layer Digitalizacja

Dodaj obiekt zobacz Digitizing an existing layer Digitalizacja

Dodaj obiekt zobacz Digitizing an existing layer Digitalizacja

7.1.4 Widok

Polecenie menu Skrót Odnośnik Pasek
narzędzi

Przesuń widok Nawigacja
mapy

Przesuń widok do
zaznaczonych

Nawigacja
mapy

Powiększ Ctrl++ Nawigacja
mapy

Pomniejsz Ctrl+- Nawigacja
mapy

Wybierz → zobacz Zaznaczanie i odznaczanie
obiektów

Atrybuty

Informacja o obiekcie Ctrl+Shift+I Atrybuty
Pomiar → zobacz Mierzenie Atrybuty

Cały zasięg Ctrl+Shift+F Nawigacja
mapy

Powiększ do warstwy Nawigacja
mapy

Powiększ do zaznaczonych Ctrl+J Nawigacja
mapy

Poprzedni widok Nawigacja
mapy

Następny widok Nawigacja
mapy

Powiększ do właściwego
rozmiaru

Nawigacja
mapy

Dekoracje → zobacz Dekoracje

Podpowiedzi na mapie Atrybuty

Nowa zakładka Ctrl+B zobacz Zakładki przestrzenne Atrybuty

Pokaż zakładki Ctrl+Shift+B zobacz Zakładki przestrzenne Atrybuty

Odśwież Ctrl+R Nawigacja
mapy
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7.1.5 Warstwa

Polecenie menu Skrót Odnośnik Pasek narzędzi
Utwórz nową warstwę → zob. Creating new Vector layers Zarządzaj warstwami
Osadź inny projekt ... zobacz Zagnieżdżanie projektów

Dodaj warstwę wektorową Ctrl+Shift+V zobacz Working with Vector Data Zarządzaj warstwami

Dodaj warstwę rastrową Ctrl+Shift+R zob. Loading raster data in QGIS Zarządzaj warstwami

Dodaj warstwę PostGIS Ctrl+Shift+D zob. Warstwy PostGIS Zarządzaj warstwami

Dodaj warstwę Spatialite Ctrl+Shift+L zob. Warstwy SpatiaLite Zarządzaj warstwami

Dodaj warstwę MSSQL Ctrl+Shift+M zob. Warstwy MSSQL Spatial Zarządzaj warstwami

Ddoaj warstwę rastrową Oracle zob. Oracle Spatial GeoRaster Plugin Zarządzaj warstwami

Dodaj warstwę SQL Anywhere zob. SQL Anywhere Plugin Zarządzaj warstwami

Dodaj warswtę WMS/WMTS Ctrl+Shift+W zob. WMS/WMTS Client Zarządzaj warstwami

Dodaj warstwę WCS zob. WCS Client Zarządzaj warstwami

Dodaj warstwę WFS zob. WFS and WFS-T Client Zarządzaj warstwami

Dodaj warstwę tekstową CSV zob. Pliki tekstowe z danymi rozdzielanymi separatorami Zarządzaj warstwami

Kopiuj styl zob. Style Menu

Wklej styl zob. Style Menu

Otwórz tabelę atrybutów zob. Working with the Attribute Table Atrybuty

Tryb edycji zobacz Digitizing an existing layer Digitalizacja

Zapisz edycję zobacz Digitizing an existing layer Digitalizacja

Bieżaca edycja → zobacz Digitizing an existing layer Digitalizacja
Zapisz jako...
Zapisz wybrane jako plik wektorowy... Zob. Working with the Attribute Table

Usuń warstwę(y) Ctrl+D

Duplikuj warstwę(y)
Ustaw układ współrzędnych warstw(y) Ctrl+Shift+C
:menuselection:‘Układ współrzędnych projektu z warstwy ‘
Właściwości
Zapytanie...

Etykietowanie

Dodaj do podglądu Ctrl+Shift+O Zarządzaj warstwami

Dodaj wszystkie do podglądu

Usuń wszystkie z podglądu

Pokaż wszystkie Ctrl+Shift+U Zarządzaj warstwami

Ukryj wszystkie Ctrl+Shift+H Zarządzaj warstwami
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7.1.6 Ustawienia

Polecenie menu Skrót Odnośnik Pasek
narzędzi

Panele → zob. Panele i paski narzędziowe
Paski narzędzi → zob. Panele i paski narzędziowe
Przełącz tryb pełnoekranowy F 11

Właściwości projektu ... Ctrl+Shift+P see Projekty

Układ współrzędnych
użytkownika ...

zob. Układ współrzędnych
użytkownika

Zarządzanie stylem... zob. Presentation
Konfiguracja skrótów ...
Personalizacja ... zob. Personalizacja
Opcje ... zob. Opcje

Opcje przyciągania ...

7.1.7 Wtyczki

Polecenie menu Skrót Odnośnik Pasek narzędzi

Zarządzaj wtyczkami zob. The Plugins Dialog
Konsola Pythona

Gdy uruchamiasz QGIS po raz pierwszy nie wszystkie wtyczki rdzenne wtyczki są załadowane.

7.1.8 Wektor

Polecenie menu Skrót Odnośnik Pasek
narzędzi

Open Street Map → zob. Ładowanie warstw wektorowych
OpenStreetMap

Narzędzia analizy → zob. fTools Plugin

Narzędzia badawcze → zob. fTools Plugin

Narzędzia geoprocesingu → zob. fTools Plugin

Narzędzia geometrii → zob. fTools Plugin

Narzędzia zarządzania
danymi →

zob. fTools Plugin

Gdy uruchamiasz QGIS po raz pierwszy nie wszystkie wtyczki rdzenne wtyczki są załadowane.

7.1.9 Raster

Polecenie menu Skrót Odnośnik Pasek narzędzi
Kalkulator rastra ... zob. Raster Calculator

Gdy uruchamiasz QGIS po raz pierwszy nie wszystkie wtyczki rdzenne wtyczki są załadowane.
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7.1.10 Geoprocesing

Polecenie menu Skrót Odnośnik Pasek narzędzi

Narzędzia zob. The toolbox

Modelarz graficzny zob. The graphical modeler

Historia i logi zob. The history manager

Opcje zob. Configuring the processing framework

Podgląd wyników zob. Configuring external applications

Wiersz polceń Ctrl+Alt+M zob. The QGIS Commander

Gdy uruchamiasz QGIS po raz pierwszy nie wszystkie wtyczki rdzenne wtyczki są załadowane.

7.1.11 Pomoc

Polecenie menu Skrót Odnośnik Pasek narzędzi

Informacje i podręczniki F1 Pomoc

Co to jest? Shift+F1 Pomoc
API dla programistów
Potrzebujesz wsparcia komercyjnego?

Strona projektu QGIS Ctrl+H

Sprawdź wersję QGIS

O QGIS

Sponsorzy QGIS

Proszę zwrócić uwagę, że w GNU/Linuksie pozycje paska menu pokazane powyżej są domyślne dla menadżera
okien KDE. W GNOME menu Ustawienia ma nieco inną zawartość i pewnych pozycji trzeba szukać gdzie indziej:

Właściwości projektu Projekt
Opcje Edycja
Konfiguracja skrótów Edycja

Zarządzanie stylem Edycja

Układ współrzędnych użytkownika Edycja
Panele → Widok
Paski narzędzi → Widok
Przełącz tryb pełnoekranowy Widok
Skala kafla Widok
Śledzenie GPS Widok

7.2 Pasek narzędzi

Ten pasek narzędziowy umożliwia dostęp do większości funkcji obecnych w menu, a dodatkowo do narzędzi
interakcji z mapą. Każda pozycja paska posiada wyskakujący opis pomocy. Gdy przytrzymasz przez chwilę
kursor myszy nad przyciskiem, wyświetli się jego krótki opis jego działania.

Każdy z pasków może być przesunięty w dowolne miejsce, odpowiadające ci miejsce. Ponadto każdy z pasków
może zostać wyłączony w menu kontekstowym otwieranym prawym przyciskiem myszy w obszarze pasków
(zobacz również Panele i paski narzędziowe).
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Wskazówka: Przywracanie pasków
Jeśli przez przypadek schowasz wszystkie paski narzędziowe, możesz je przywrócić korzystając z polecenia menu
Widok → Paski narzędzi →. Jeśli paski znikną w Windows, co się czasem przydarza, musisz usunąć klucz rejestru
\HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state. W czasie restartu QGIS klucz ten zostanie
utworzony na nowo z domyślną wartością i wszystkie paski będą znów widoczne.

7.3 Legenda mapy

W legendzie widoczne są wszystkie warstwy projektu. Pole wyboru obok każdej warstwy służy do jej chowania
i pokazywania. Za pomocą narzędzi z paska narzędziowego legendy można dodać grupę, zarządzać widocznoś-
cią warstw — wszystkich naraz lub zestawów warstw, pokazywać klasy obiektów widocznych w widoku

mapy, zwijać i rozwijać wszystkie warstwy oraz usuwać warstwę/grupę. Przycisk pozwala zmieniać
widoczność warstw legendy. Oznacza to, że można wybrać pewne warstwy i dodać je do zestawu. Robi się to

klikając ikonę , a następnie polecenie Dodaj zestaw... i określenie nazwy zestawu. Zapisany zestaw warstw

można wyświetlić naciskając przycisk i wybierając jego nazwę.

Wszystkie zapisane zestawy warstw są dostępne również w menadżerze wydruku tak, aby można było tworzyć
wydruki na ich podstawie (zob. Main properties).

Warstwy można wybierać i przeciągać w dół lub górę legendy, żeby zmienić ich porządek nakładania. Warstwy
umieszczone wyżej w legendzie będą rysowane ponad warstwami umieszczonymi u dołu legendy.

Informacja: Można zmienić ten układ w panelu ‘Kolejność warstw’.

Warstwy w legendzie mogą być grupowane. Można to zrobić na dwa sposoby:

1. Przyciskiem dodaje się nową grupę warstw. Należy wpisać nazwę grupy i przycisnąć Enter. Następ-
nie, aby dodać warstwę do grupy, przeciąga się ją myszą na tę grupę.

2. Wybierz jakieś warstwy, następnie kliknij prawym przyciskiem myszy w polu legendy i wybierz Grupuj
wybrane. Wybrane warstwy zostaną automatycznie umieszczone w nowej grupie.

Żeby wyciągnąć warstwę z grupy możesz przeciągnąć ją poza jej obszar lub kliknąć ją prawym przyciskiem i
wybrać Przenieś na główny poziom. Grupy mogą być zagnieżdżane w innych grupach.

Pole wyboru przy grupie służy do ukrywania i pokazywania wszystkich warstw grupy za pomocą jednego kliknię-
cia.

Zawartość menu kontekstowego wywoływanego prawym przyciskiem myszy zależy od tego, czy wybrana jest

warstwa rastrowa czy wektorowa. Dla warstw wektorowych GRASS Tryb edycji jest niedostępny. O edycji
warstw GRASS przeczytasz w Digitizing and editing a GRASS vector layer.

Menu kontekstowe dla warstw rastrowych

• Powiększ do zasięgu warstwy

• Pokaż w podglądzie

• Powiększ do najlepszej skali (100%)

• Wzmocnij kontrast do zasięgu widoku

• Usuń

• Duplikuj

• Zakres skalowy widoczności warstwy

• Ustaw układ współrzędnych warstwy

• Układ wsp. projekty z warstwy
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• Zapisz jako ...

• Zapisz definicję warstwy

• Właściwości

• Zmień nazwę

• Kopiuj styl

Dodatkowo, w zależności od pozycji warstwy i jej wyboru

• Przenieś na główny poziom

• Grupuj zaznaczone

Menu kontekstowe dla warstw wektorowych

• Powiększ do zasięgu warstwy

• Pokaż w podglądzie

• Usuń

• Duplikuj

• Zakres skalowy widoczności warstwy

• Ustaw układ współrzędnych warstwy

• Układ wsp. projekty z warstwy

• Otwórz tabelę atrybutów

• Tryb edycji (niedostępne dla warstw GRASS)

• Zapisz jako ...

• Zapisz definicję warstwy

• Filtr

• Wyświetl liczbę obiektów

• Właściwości

• Zmień nazwę

• Kopiuj styl

Dodatkowo, w zależności od pozycji warstwy i jej wyboru

• Przenieś na główny poziom

• Grupuj zaznaczone

Menu kontekstowe dla grup warstw

• Powiększ do grupy

• Usuń

• Ustaw układ współrzędnych grupy

• Zmień nazwę

• Dodaj grupę

Można wybrać naraz większą liczbę warstw lub grup przytrzymując klawisz Ctrl w czasie wybierania warstw
lewym przyciskiem myszy. Wówczas można przesunąć wybrane warstwy do nowej grupy za jednym zamachem.

Możesz również usunąć naraz więcej warstw lub grup wybierając je z wciśniętym klawiszem Ctrl, a następnie
przyciskając Ctrl+D. Wówczas wszystkie wybrane warstwy i grupy zostaną usunięte z listy warstw.
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7.3.1 Określanie kolejności wyświetlania warstw niezależnej od legendy

Istnieje panel do określania porządku wyświetlania warstw niezależnie od legendy. Można go aktywować przez
polecenie menu Widok → Panele → Kolejność warstw. Umożliwia to, na przykład, określenie kolejności
warstw mapy wg ich istotności przy zachowaniu ich właściwego porządku wyświetlania (zob figure_layer_order).

Kliknięcie pola Kolejność warstw pod listą spowoduje powrót do domyślnej kolejności.

Rysunek 7.2: Określ niezależny od legendy porządek wyświetlania warstw

7.4 Widok mapy

To jest właściwe stanowisko robocze QGIS — to tu wyświetlane są mapy. Widok mapy zależeć będzie od
tego, jakie warstwy wektorowe i rastrowe załadujesz (zob. kolejne rozdziały, w których omówione jest ład-
owanie warstw). Widok mapy można przesuwać (przesunąć zakres widoczności w inne położenie), pomniejszać i
powiększać. Z widokiem mapy można wykonać wiele różnych operacji, zgodnie z powyższym opisem paska
narzędziowego. Widok mapy i legenda są ze sobą ściśle związane — mapa odzwierciedla zmiany, których
dokonuje się w legendzie.

Wskazówka: Zmiana przybliżenia mapy za pomocą kółka myszy
Do powiększania i pomniejszania widoku można użyć kółka myszy. Należy umieścić kursor myszy w widoku
mapy i przekręcić do przodu (od siebie), aby powiększyć widok lub przekręcić w tył (do siebie), aby widok
pomniejszyć. Punktem centralnym przybliżenia widoku jest kursor myszy. Można dostosować zachowanie się
kółka myszy w zakładce Narzędzia mapy menu Ustawienia → Opcje.

Wskazówka: Przesuwanie mapy za pomocą klawiszy strzałek i spacji
Można używać klawiszy strzałek do przesuwania mapy. Umieść wskaźnik myszy wewnątrz pola mapy i kliknij.
Użyj strzałki w prawo, aby przesunąć się na wschód, lewej, aby przesunąć się na zachód. Strzałka w górę przesunie
widok na północ, a strzałka w dół przesunie widok na południe. Mapę można również przesuwać poruszając
wskaźnikiem myszy przy wciśniętym klawiszu spacji lub wciśniętym kółku myszy.
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7.5 Pasek statusu

Gdy wskaźnik myszy znajduje się w polu widoku mapy, na pasku statusu widoczna jest jego bieżąca pozycja we
współrzędnych mapy (tj. w metrach lub stopniach). Z lewej strony pola współrzędnych znajduje się mały przycisk
przełączający widok współrzędnych wskaźnika myszy na współrzędne zakresu widoku mapy, które zmieniają się,
gdy przybliżasz, oddalasz lub przesuwasz widok.

Obok pola współrzędnych znajduje się pole skali. Pokazuje ono skalę widoku mapy. Gdy powiększasz lub
zmniejszasz widok QGIS podaje Ci bieżącą skalę. Możesz też wybrać zdefiniowane wcześniej skale z zakresu od
1:500 do 1:1000000.

Wskaźnik postępu na pasku statusu ilustruje postęp renderowania każdej z warstw w widoku mapy. W niektórych
przypadkach, np. gdy określane są statystyki warstw rastrowych, wskaźnik postępu używany jest do pokazania
statusu dłuższych operacji.

Gdy pojawi się nowa wtyczka lub aktualizacja wtyczki, po lewej stronie paska statusu pojawi się wiadomość. Po
prawej stronie paska statusu znajduje się małe pole wyboru, za pomocą którego można chwilowo wstrzymać ren-

derowanie map w widoku mapy. (zob. rozdział Renderowanie). Ikonka natychmiast przerywa renderowanie
mapy.

Z prawej strony funkcji renderowania znajduje się kod EPSG bieżącego projektu i ikonka odwzorowania. Jej
kliknięcie powoduje otwarcie właściwości układu współrzędnych dla bieżącego projektu.

Wskazówka: Określanie poprawnej skali dla twojej mapy
Gdy uruchamiasz QGIS domyślną jednostką miary są stopnie i powoduje to, że QGIS traktuje współrzędne twoich
warstw jako stopnie. Aby otrzymać właściwe wartości, możesz ręcznie zmienić jednostkimiary na metry w za-
kładce Ogólne w menu Plik→ Właściwości projektu lub określić odwzorowanie dla swojego projektu za pomocą

przycisku z ikoną Stan CRS W prawym końcu paska ststusu u dołu okna. W tym drugim przypadku jednostki
miary są określone w definicji odwzorowania (np. ‘+units=m’).

.
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Podstawowe narzędzia

8.1 Skróty klawiaturowe

QGIS ma zdefiniowane domyślne skróty klawiaturowe dla wielu poleceń. Znajdziesz je w rozdziale Pasek menu.
Dodatkowo, polecenie menu Ustawienia → Konfiguracja skrótów pozwala na zmianę tych domyślnych skrótów i
dodanie do poleceń QGIS nowych skrótów.

Rysunek 8.1: Określanie opcji skrótów (Gnome)

Konfiguracja jest bardzo prosta. Zaznacz na liście polecenie i kliknij [Zmień], [Usuń] lub [Dodaj domyślny].
Gdy określisz już swoją konfigurację, możesz ją zapisać w formacie XML i załadować do innej instalacji QGIS.

8.2 Pomoc kontekstowa

Gdy potrzebna ci pomoc w pewnym temacie, możesz skorzystać z pomocy kontekstowej, dostępnej w większości
okien dialogowych pod przyciskiem [Pomoc] — proszę zwrócić uwagę, że wtyczki mogą wskazywać na poświę-
cone im strony internetowe.

8.3 Renderowanie

Domyślnie QGIS renderuje wszystkie widoczne warstwy za każdym razem, gdy obszar mapy ma być odświeżony.
Zdarzenia, które wyzwalają odświeżanie, obejmują:

• Dodawanie warstwy
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• Przesuwanie widoku i przybliżanie

• Zmiana wielkości okna QGIS

• Zmiana widoczności warstwy lub warstw

QGIS pozwala na kontrolę renderowania na różne sposoby.

8.3.1 Renderowanie zależne od skali

Renderowanie zależne od skali pozwala na określenie minimalnej i maksymalnej skali, pomiędzy którymi
warstwa jest widoczna. Aby wybrać renderowanie zależne od skali otwórz okno dialogowe Właściwości poprzez

dwukrotne kliknięcie na warstwie w legendzie. W zakładce Ogólne zaznacz pole wyboru Widoczność zależna
od skali, a następnie podaj minimalną i maksymalną skalę.

Możesz najpierw, poprzez przybliżenie widoku i sprawdzenie skali na pasku statusu QGIS, określić skalę, której
chcesz użyć.

8.3.2 Sterowanie renderowaniem mapy

Sterowanie renderowaniem mapy może odbywać się na różne sposoby, opisane poniżej.

Zawieszanie renderowania

Aby zawiesić renderowanie kliknij pole wyboru Renderuj po prawej stronie paska statusu. Gdy pole wyboru

Renderuj nie jest zaznaczone, QGIS nie przerysowuje obszaru mapy po żadnym ze zdarzeń opisanych w
rozdziale Renderowanie. Przykłady sytuacji, kiedy można zawiesić renderowanie obejmują:

• Dodanie wielu warstw i nadanie im stylu przed ich wyświetleniem

• Dodanie jednej lub więcej dużych warstw i ustawienie wyświetlania zależnego od skali przed ich wyświ-
etleniem

• Dodanie jednej lub więcej większych warstw i przybliżenie się do pewnego widoku przed ich wyświetle-
niem

• Dowolna kombinacja powyższych

Zaznacznie pola wyboru Renderuj włącza renderowanie i powoduje natychmiastowe odświeżenie kanwy
mapy.

Ustawienia dodawania warstw

Można ustawić opcję ładowania warstw bez ich renderowania. Oznacza to, że warstwa zostanie załadowana do
mapy, ale jej pole wyboru widoczności bedzie domyślnie odznaczone. Aby ustawić tę opcję wybierz polece-

nie menu Ustawienia → Opcje i kliknij zakładkę Renderowanie. Odznacz pole wyboru Domyślnie nowo
dodawane warstwy są wyświetlane. Teraz każda nowo dodana do mapy warstwa będzie domyślnie wyłączona
(niewidoczna).

Zatrzymywanie renderowania

Do zatrzymania rysowania mapy używaj klawisza ESC . Zatrzymuje on odświeżanie kanwy mapy i pozostawia
ją częściowo przerysowaną. Zatrzymanie renderowania mapy może nastąpić po jakimś czasie od naciśnięcia
klawisza ESC.

Informacja: W chwili obecnej nie można zatrzymać renderowania — ze względu na problemy interfejsu
użytkownika (UI) zostało to zablokowane w porcie Qt4.
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Aktualizacja obrazu mapy podczas renderowania

Można wybrać opcję odświeżania mapy w miarę rysowania obiektów. Domyślnie QGIS nie wyświetla żadnych
obiektów aż cała warstwa zostanie zrenderowana. W celu odświeżania ekranu w czasie czytania danych ze źródła
wybierz polecenie menu Ustawienia → Opcje, kliknij zakładkę Renderowanie. Ustaw wybraną ilość obiektów,
po narysowaniu których ma nastąpić odświeżenie ekranu. Ustawienie wartości 0 wyłącza odświeżanie w czasie
rysowania (to jest domyślne zachowanie). Ustawienie zbyt małej ilości spowoduje spadek wydajności, ponieważ
obszar mapy będzie ciągle odświeżany w czasie czytania danych obiektów. Proponuje się, aby wartość ta nie była
mniejsza niż 500.

Zmiana jakości renderowania

Aby zmienić jakość renderowania mapy mamy dwie opcje. Wybierz polecenie menu Ustawienia → Opcje, kliknij
na zakładkę Renderowanie, a następnie zaznacz lub odznacz następujące pola wyboru.

• Wyświetlaj linie mniej poszarpane, ale licz się ze spadkiem wydajności rysowania

• Napraw problemy z niewłaściwie wypełnionymi poligonami

Przyspieszenie renderowania

Dwa ustawienia pozwalają poprawić szybkość renderowania. Otwórz okno opcji QGIS używając menu Ustaw-
ienia → Opcje, przejdź do zakładki Renderowanie i zaznacz lub odznacz następujące pola wyboru:

• Szybsze wyświetlanie. Powoduje ona szybsze wyświetlanie grafiki kosztem braku możliwości zatrzyma-
nia renderowania i stopniowego rysowania obiektów. Jeśli ta opcja jest odznaczona, można podać w polu
‘Liczbę obiektów koniecznych do narysowania przed odświeżeniem widoku’, w przeciwnym wypadku pole
liczby obiektów jest nieaktywne.

• Użyj pamięci podręcznej aby przyspieszyć odświeżanie.

8.4 Mierzenie

Mierzenie działa zarówno w odwzorowanych układach współrzędnych (np. UTM) jak i dla danych nieodw-
zorowanych. Jeśli mierzenie odbywa się w układzie współrzędnych geograficznych (długość/szerokość), wówczas
wyniki pomiaru długości i powierzchni będą nieprawidłowe. aby temu zaradzić, należy zdefiniować odpowiedni
układ współrzędnych mapy (zob. rozdział Praca z układami współrzędnych). Wszystkie narzędzia pomiarowe
korzystają z ustawień przyciągania modułu digitalizacji. Jest to przydatne, gdy chcemy mierzyć wzdłuż linii lub
powierzchni warstwy wektorowej.

Aby wybrać narzędzie pomiaru kliknij na ikonce i wskaż narzędzie, którego chcesz użyć.

8.4.1 Pomiar długości, powierzchni i kątów

Pomiar odległości: QGIS potrafi zmierzyć rzeczywistą odległość pomiędzy danymi punktami wykorzystując dane
elipsoidy bieżącego układu odniesienia. Aby ją zdefiniować, wybierz polecenie Ustawienia → Opcje, Kliknij
na zakładkę Narzędzia mapy. tutaj możesz zdefiniować kolor linijki oraz jednostki pomiaru odległości (metry
lub stopy) i kątów (stopnie, radiany lub grady). Narzędzie pozwala na klikanie kolejnych punktów na mapie.
W okienku pomiaru zobaczysz długości kolejnych segmentów i całkowitą długość linii. aby zakończyć pomiary
kliknij na prawym przycisku myszy.
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Rysunek 8.2: Pomiar odległości (Gnome)

Pomiar powierzchni: można mierzyć także powierzchnie. W okienku pomiaru pokazana jest zmierzona w danej
chwili powierzchnia. Dodatkowo, jeśli bieżąca warstwa ma ustawioną tolerancję przyciągania, narzędzie pomiaru
będzie przyciągane do tej warstwy. (Zobacz rozdział Setting the Snapping Tolerance and Search Radius). Zatem
jeśli chciałbyś mierzyć wzdłuż obiektu liniowego lub wokół jakiegoś poligonu, najpierw ustaw jego tolerancję
przyciągania, a następnie zaznacz odpowiednią warstwę. Wówczas podczas pomiaru każde kliknięcie będzie
przyciągane do tej warstwy w granicach tolerancji przyciągania.

Rysunek 8.3: Pomiar pola powierzchni (Gnome)

Pomiar kąta: Można mierzyć równierz kąty. Kursor przechodzi w krzyż. Kliknij wskazując pierwsze ramię kąta,
który chcesz zmierzyć, a następnie przesuń kursor tak, aby narysować mierzony kąt. Wynik pomiaru wyświetlany
jest w osobnym okienku.

Rysunek 8.4: Pomiar kąta (Gnome)

8.4.2 Zaznaczanie i odznaczanie obiektów

Pasek narzędziowy QGIS zawiera kilka narzędzi do zaznaczania obiektów na mapie. Aby wybrać jeden lub kilka

obiektów kliknij na i wybierz odpowiednie narzędzie:

• Wybierz jeden obiekt

• Wybierz obiekty prostokątem

• Wybierz obiekty wielobokiem

• Wybierz obiekty zaznaczeniem

• Wybierz obiekty promieniem
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Odznaczenie wszystkich obiektów uzyskuje się po naciśnięciu ikonki Odznacz obiekty ze wszystkich warstw.

Zaznacz obiekt za pomocą wyrażenia umożliwia zaznaczenie obiektów za pomocą wyrażenia. Zob. przykład w Expres-
sions.

Użytkownicy mogą zapisać zaznaczone obiekty do Nowej tymczasowej warstwy wektorowej lub do Nowej
warstwy wektorowej korzystając z manu Edycja → Wklej obiekty jako ... i wybierając odpowiednią opcję.

8.5 Informacje o obiekcie

Narzędzie informacji o obiekcie umożliwia interakcję z obszarem mapy i otrzymanie wartości atrybutów w oknie.
Aby wyświetlić informację o obiektach skorzystaj z polecenia Widok → Informacje o obiekcie, wciśnij kombinację

klawiszy Ctrl+Shift+I, lub kliknij ikonkę Informacje o obiekcie, znajdującą się na pasku narzędziowym.

Jeśli klikniesz na kilku obiektach, w oknie Wynik identyfikacji pokazane zostaną dane atrybutów wszystkich
klikniętych obiektów. Pierwsza pozycja to numer obiektu na liście z nazwą warstwy. Następnym elementem
potomnym będzie nazwa i wartość jego pierwszego atrybutu. W dalszej kolejności wyświetlone są wszystkie
informacje o obiekcie.

Zawartość tego okna można dostosować tak, aby wyświetlały się wybrane pola, ale domyślnie pokazuje ono trzy
typy informacji:

• Akcje: do okna informacji o obiekcie mogą zostać dodane akcje. Kliknięcie nazwy akcji powoduje jej
uruchomienie. Domyślnie dodana jest tylko jedna akcja wyświetlająca formularz edycji obiektu.

• Pochodne: te informacje obliczane są lub określane na bazie innych informacji. Znajdziesz tu współrzędne
kliknięcia, współrzędne X i Y, pole powierzchni i obwód w jednostkach mapy dla poligonów, długość w
jednostkach mapy dla obiektów liniowych oraz id obiektów.

• Dane atrybutów: lista atrybutów danych.

Rysunek 8.5: Okno dialogowe informacji o obiekcie (Gnome)

U dołu okna znajduje się 5 ikonek:

• Rozwiń strukturę

• Zwiń strukturę

• Nowe wyniki będą domyślnie rozwijane

• Kopiuj zaznaczony obiekt do schowka

• Drukuj wybraną odpowiedź HTML
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Inne funkcje można znaleźć w menu kontekstowym rozpoznawanego obiektu. Można, na przykład, wykonać
następujące zadania:

• Wyświetl formularz obiektu

• Zbliż do obiektu

• Kopiuj obiekt: skopiuj cały obiekt, tj. jego geometrię i atrybuty;

• Przełącz zaznaczenie obiektu: dodaje bieżący obiekt do zaznaczenia

• Kopiuj wartość atrybutu: kopiuje wartość klikniętego atrybutu

• Kopiuj atrybuty obiektu: kopiuje tylko atrybuty

• Wyczyść wyniki: usuwa wyniki z okna

• Wyczyść zaznaczenie: usuwane jest zaznaczenie obiektów na mapie

• Zaznacz wszystkie

• Zaznacz warstwę

• Aktywuj warstwę: warstwa obiektu jest aktywowana

• Właściwości warstwy: otwiera okno właściwości warstwy

• Rozwiń wszystkie

• Zwiń wszystkie

8.6 Dekoracje

Dekoracje QGIS stanowią siatki, informacje o prawach autorskich, strzałka północy i podziałka. Służą one do
uzupełnienia mapy poprzez dodanie elementów kartograficznych.

8.6.1 Siatka

Siatka pozwala na dodanie do obszaru mapy siatki współrzędnych i jej opisu.

Rysunek 8.6: Okno siatki

1. Z menu Widok → Dekoracje → Siatka. Wyświetli się okno (zob. figure_decorations_1).
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2. Zaznacz pole wyboru Siatka i ustaw parametry siatki odpowiednie dla załadowanych do obszaru mapy
warstw.

3. Zaznacz pole wyboru Opisy współrzędnych i ustaw parametry opisu odpowiednie dla załadowanych do
obszaru mapy warstw.

4. Kliknij [Zastosuj] żeby sprawdzić, czy efekt będzie zadowalający.

5. Kliknij [OK] żeby zamknąć okno.

8.6.2 Informacja o prawach autorskich

Informacja o prawach autorskich dodaje do mapy etykietę z podanym tekstem.

Rysunek 8.7: Okno dialogowe praw autorskich

1. Wybierz polecenie Wisok → Dekoracje → Informacje o prawach autorskich. Pokaże się okno (zob. fig-
ure_decorations_2).

2. Wprowadź tekst, który chcesz zamieścić na mapie. Możesz wykorzystać HTML, jak to pokazano w
przykładzie.

3. Określ położenie etykiety z listy rozwijalnej Położenie .

4. Upewnij się, czy pole wyboru Włącz etykietę jest zaznaczone.

5. Kliknij [OK].

W powyższym przykładzie, QGIS umieści symbol copyright z datą w dolnym prawym rogu obszaru mapy, co jest
domyślnym położeniem informacji o prawach autorskich.

8.6.3 Strzałka północy

Strzałka północy dodaje do obszaru mapy prostą strzałkę północy. Obecnie dostępny jest tylko jeden styl strzałki.
Można dopasować kąt strzałki samodzielnie lub pozostawić to QGIS do automatycznego określenia. Jeśli po-
zostawisz wybór QGIS spróbuje on znaleźć właściwy kierunek strzałki. Strzałkę możesz umieścić w dowolnym
rogu mapy.

8.6.4 Podziałka

Podziałka dodaje do obszaru mapy prostą podziałkę. Położenie, styl i etykiety podziałki zależą od Ciebie.
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Rysunek 8.8: Okno dialogowe strzałki północy

Rysunek 8.9: Okno dialogowe podziałki

QGIS można wyświetlić skalę jedynie w jednostkach ramki mapy. Zatem jeśli twoje warstwy są w metrach,
nie możesz stworzyć podziałki w stopach. Podobnie, jeśli używasz stopni dziesiętnych, nie możesz stworzyć
podziałki w metrach.

W celu dodania podziałki:

1. Wybierz polecenie Widok → Dekoracje → Podziałka. Pokaże się okno (zob. figure_decorations_4).

2. Określ położenie z listy rozwijalnej Położenie .

3. Z listy rozwijalnej Styl podziałki wybierz styl.

4. Wybierz kolor podziałki z Kolor lub pozostaw domyślny czarny.

5. Ustaw rozmiar podziałki i jej etykietę Długość .

6. Upewnij się, czy zaznaczone jest pole wyboru Włącz

7. Opcjonalnie, zaznaczając pole wyboru Automatycznie dostosuj rozmiar, sprawisz, że rozmiar skali au-
tomatycznie się zmieniał przy przybliżaniu widoku.

8. Kliknij [OK].

Wskazówka: Ustawienia dekoracji
W czasie zapisu projektu .qgs zapisywane są wszystkie zmiany, jakich dokonałeś w siatce, strzałce północy,
podziałce i prawach autorskich i będą one użyte, gdy otworzysz ten projekt następnym razem.
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8.7 Narzędzia opisu

Narzędzie Opis tekstowy z paska narzędziowego atrybutów umożliwia umieszczenie w obszarze mapy chmurki
ze sformatowanym tekstem. Wybierz narzędzie Opis tekstowy i kliknij w obszarze mapy.

Rysunek 8.10: Okno dialogowe opisu tekstowego

Dwuklik na wybranym opisie spowoduje otwarcie okna dialogowego z różnymi opcjami. Mamy tu pole edytora
tekstowego do wprowadzenia sformatowanego tekstu i inne ustawienia. Jest np. możliwość umiejscowienia opisu
w określonej pozycji mapy (wyświetlany jako znacznik) lub utrzymania pozycji opisu na ekranie (niezależnie od
mapy). Opis może być przesuwany przez zmianę jego pozycji na mapie (przeciągnij znacznik) lub poprzez prze-
sunięcie samej chmurki. Ikonki są częścią szablonu GIS i są domyślnie używane również w innych szablonach.

Narzędzie Przesuń opis umożliwia przesuwanie opisu po obszarze mapy.

8.7.1 Opis HTML

Narzędzie Opis HTML z paska narzędziowego atrybutów umożliwia umieszczenie w obszarze mapy QGIS
chmurki z zawartością opisaną kodem HTML. Wybierz narzędzie Opis HTML, kliknij na obszarze mapy i wskaż
w oknie ścieżkę do pliku HTML.

8.7.2 Opis SVG

Narzędzie Opisy SVG z paska narzędziowego atrybutów umożliwia umieszczenie w obszarze mapy QGIS sym-
bolu SVG. Wybierz narzędzie Opisy SVG, kliknij w obszarze mapy i wskaż w oknie ścieżkę do pliku SVG.

8.7.3 Opisy w formularzu

Możesz również stworzyć własne formularze opisu. Narzędzie Opis w formularzu przydaje się, gdy
chcemy wyświetlić atrybuty warstwy wektorowej w dostosowanym formularzu Qt Designera (zob. fig-
ure_custom_annotation). Jest to podobne do formularzy Designera dla narzędzia Informacje o obiek-
cie, ale wyświetlane jest w postaci opisu. Aby dowiedzieć sie więcej, obejrzyj to wideo Tima Suttona
https://www.youtube.com/watch?v=0pDBuSbQ02o
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Rysunek 8.11: Dostosowany formularz opisu Qt Designera

Informacja: Naciśnięcie kombinacji klawiszy Ctrl+T gdy aktywne jest którekolwiek narzędzie Opisu (przesuń
opis, opis tekstowy, opis w formularzu) spowoduje zmianę stanu widoczności opisów.

8.8 Zakładki przestrzenne

Zakładki pozwalają na zapisanie pozycji geograficznej i poźniejszy powrót do tego widoku.

8.8.1 Tworzenie zakładki

Żeby utworzyć zakładkę:

1. Zbliż się lub przesuń widok do interesującego Cię obszaru.

2. Z menu górnego wybierz polecenie Widok → Nowa zakładka lub wciśnij klawisze Ctrl-B.

3. Wprowadź nazwę zakładki opisującą bieżącą pozycję (może zawierać do 255 znaków).

4. Naciśnij Enter, aby dodać zakładkę lub [Delete], aby ją usunąć.

Zwróć uwagę na to, że możesz mieć wiele zakładek o takiej samej nazwie.

8.8.2 Praca z zakładkami

Aby użyć lub zmienić zakładki wybierz polecenie menu Widok → Pokaż zakładki. Okno dialogowe Zakładki
umożliwia przejście do widoku zakładki lub jej usunięcie. Nie ma możliwości zmiany nazwy zakładki ani jej
współrzędnych.

8.8.3 Przejście do widoku zakładki

W oknie dialogowym Zakładki zaznacz pożądaną zakładkę kliknięciem, a następnie wybierz [Powiększ do].
Można również wyświetlić widok zapisany w zakładce poprzez dwukrotne kliknięcie na niej.
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8.8.4 Usuwanie zakładki

W celu usunięcia zakładki w oknie dialogowym :guilabel:‘Zakładki‘kliknij na niej i naciśnij przycisk [Usuń].
Potwierdź swój wybór naciskając następnie [Tak] lub zrezygnuj z usuwanie przyciskiem [Nie].

8.9 Zagnieżdżanie projektów

Jeśli w bieżącym projekcie chcesz wykorzystać zawartość innych projektów, możesz wykorzystać polecenie
Warstwa → Osadź inny projekt.

8.9.1 Osadzanie warstw

Poniższe okno dialogowe umożliwia osadzenie warstw z innego projektu.

1. Naciśnij , aby wyszukać inny projekt ze zbioru danych Alaska.

2. Wybierz plik projektu grassland. Zobaczysz zawartość projektu (zob. figure_embed_dialog).

3. Przytrzymaj klawisz Ctrl i kliknij na warstwach grassland i regions. Przyciśniej [OK]. Wybrane
warstwy zostaną osadzone w legendzie i widoku mapy.

Rysunek 8.12: Zaznaczanie warstw i grup do osadzenia

Chociaż osadzone warstwy są edytowalne, nie można zmienić ich właściwości stylu i etykietowania.

8.9.2 Usuwanie osadzonych warstw

Kliknij prawym przyciskiem osadzoną warstwę i wybierz Usuń.

.
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ROZDZIAŁ 9

Konfiguracja QGIS

QGIS można skonfigurować na wiele różnych sposobów za pomocą pozycji menu Ustawienia. Można ustawiać
panele, paski narzędziowe, właściwości projektu, zmieniać opcje programu i dokonać jego personalizacji.

Informacja: QGIS umieszcza opcje i właściwości projektu w menu zgodnie z zaleceniami dla danego systemu
operacyjnego. Z tego względu, zależnie od tego, z jakiego systemu korzystasz, niektóre z wymienionych pozycji
menu mogą się znaleźć w menu :menuselection‘Widok‘ (Paski narzędziowe) lub w menu Projekt (Opcje).

9.1 Panele i paski narzędziowe

W menu Panele→ można włączać i wyłączać widżety QGIS. Menu :menuselection:‘Paski narzędzi–>‘umożliwia
włączanie i wyłączanie grup ikon na paskach (zob. figure_panels_toolbars).

Rysunek 9.1: Menu paneli i pasków narzędziowych

Wskazówka: Włączanie podglądu QGIS
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W QGIS można skorzystać z panelu podglądu, który przedstawia widok całego zakresu załadowanych warstw.
Można go włączyć w menu Ustawienia → Panele lub Widok → Panele. W podglądzie znajduje się prostokąt
wskazujący zakres bieżącego widoku mapy. Pozwala to w prosty sposób zorientować się, jaki fragment mapy
widzimy w danej chwili. Zauważ, że w podglądzie nie są wyświetlane etykiety, nawet jeśli warstwy znajdujące
się w podglądzie zostały ustawione tak, aby je etykietować. Gdy przesunie się czerwony prostokąt pokazujący
bieżący zakres, widok mapy zostanie odpowiednio zaktualizowany.

Wskazówka: Wgląd w teksty logów

Istnieje możliwość śledzenia komunikatów QGIS. Logi komunikatów można włączyć w menu Ustawienia
→ Panele lub Widok → Panele i obserwować pojawiające się w różnych zakładkach komunikaty.

9.2 Właściwości projektu

W oknie właściwości projektu, uruchamianym z menu Ustawienia → Właściwości projektu (kde) lub
Projekt → Właściwości projektu (Gnome), można zmieniać ustawienia specyficzne dla projektu. Obejmują one:

• W zakładce Ogólne znajdziemy tytuł projektu, kolory zaznaczenia i tła, jednostki miar, dokładność i opcję
zapisu względnych ścieżek do warstw. Jeśli włączone jest przeliczanie współrzędnych pomiędzy układami,
można wybrać elipsoidę do pomiarów odległości. Można określić jednostki obszaru mapy (jedynie, gdy
przeliczanie współrzędnych jest wyłączone) i dokładność, tj. ilość widocznych miejsc dziesiętnych po
przecinku. Można również stworzyć listę skal projektu, która zastąpi skale określone globalnie.

• Menu Układ współrzędnych umożliwia wybór układu dla bieżącego projektu oraz włączenie przeliczania
w locie współrzędnych warstw wektorowych i rastrowych w przypadku, gdy zapisane są w innym układzie
współrzędnych.

• W trzeciej zakładce Warstwy można określić, które warstwy będą reagować na narzędzie informacji o obiek-
cie. (Zobacz punkt Narzędzia mapy w rozdziale Opcje, gdzie opisano, jak włączyć identyfikowanie obiek-
tów dla wielu warstw naraz)

• Zakładka Domyślne style daje możliwość określenia, jak wyświetlane będą nowe warstwy, jeśli nie posi-
adają własnego zdefiniowanego stylu .qml. Można również podać domyślną przezroczystość dla nowych
warstw i to, czy symbolom przypisywane mają być losowe kolory. Jest również sekcja, w której można
określić kolory charakterystyczne dla bieżącego projektu. Z kolorów tych można później korzystać i
wybierać je z menu rozwijanego we wszystkich ustawieniach stylu.

• Zakładka Serwer OWS umożliwia podanie informacji o parametrach usług WMS i WFS QGIS Serwera,
takich jak dostępne warstwy, zasięg i układy współrzędnych.

• W zakładce Makra tworzy się moduły Pythona dla projektu. Obecnie można zdefiniować trzy
makra uruchamiane w czasie następujących zdarzeń: openProject(), saveProject() oraz
closeProject().

• Zakładka Relacje służy do definiowania relacji 1:n. Gdy określone zostaną relacje dla którejś z warstw, w
interfejsie użytkownika w widoku formularza pojawiać się będzie nowy element przedstawiający połączone
obiekty (np. podczas użycia narzędzia informacji o obiekcie i włączeniu jego formularza). Daje to potężne
możliwości przedstawiania dodatkowych informacji o obiektach, np. historycznych wynikach pomiarów
rurociągu lub długości drogi. Więcej informacji o relacjach 1:n można znaleźć w rozdziale Creating one to
many relations.

9.3 Opcje

Niektóre podstawowe opcje QGIS określane są w oknie Opcje. Wybierz menu Ustawienia→ Opcje. Poniżej
opisane są zakładki, w których możesz dostosowywać ustawienia.
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Rysunek 9.2: Ustawienia makr w QGIS

9.3.1 Zakładka Ogólne

Program

• W pozycji Motyw (wymaga restartu programu) wybierz spośród ‘Oxy-
gen’,’Windows’,’Motif’,’CDE’, ‘Plastique’ i ‘Cleanlooks’ ( ).

• Określenie Motywu ikon . Obecnie dostępny jest tylko ‘domyślny’.

• Określenie Rozmiaru ikon .

• Określenie Czcionki. Można wybrać pomiędzy domyślna a dowolnie określoną przez użytkownika.

• Zmiana Limitu czasu komunikatów .

• Nie pokazuj ekranu powitalnego przy starcie

• Pokazuj poradę przy starcie programu

• Pogrubiony tytuł grupy

• Styl QGIS grupy

• Automatyczna aktualizacja okien wyboru koloru

Pliki projektów

• Przy uruchamianiu otówrz projekt (wybierz spośród ‘Nowy’. ‘Ostatni’ and ‘Użytkownika’. Jeśli

wybierzesz ‘Użytkownika’, skorzystaj z przycisku do określenia położenia pliku projektu).

• Twórz nowe projekty na bazie domyślnego. Możesz wybrać :guilabel:Bieżący projekt jako domyślny‘
or lub Wyczyść domyślny. Możesz wskazać katalog, w którym znajdować się będą szablony projektów
zdefiniowane przez użytkownika. Gdy zapiszesz projekt w tym katalogu, pojawi się on jako pozycja w
menu Projekt → Nowy z szablonu.

• Informuj o konieczności zapisu, gdy projekt i źródło ulegną zmianie

• Ostrzegaj przy otwieraniu projektów zapisanych w starszych wersjach QGIS
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• Makra Pythona . Opcja ta została wprowadzona, aby umożliwić obsługę makr wykonujących dzi-
ałania w czasie określonych zdarzeń. Można wybrać spośród ‘nigdy’, ‘pytaj’, ‘tylko w tej sesji’ i ‘zawsze
(niezalecane)’.

9.3.2 Zakładka System

Środowisko

W zakładce System można teraz przeglądać wartości zmiennych środowiskowych, a wiele z nich można również
edytować (zob. figure_environment_variables). Może się to przydać na platformach takich jak Mac, gdzie ap-
likacje GUI nie dziedziczą ustawień środowiskowych powłoki. Jest to również przydatne przy przeglądaniu i
zmianie ustawień środowiska dla narzędzi zewnętrznych zarządzanych przez Geoprocesing (np. SAGA, GRASS)
i przy włączaniu wyjścia debugowania dla określonych partii kodu źródłowego.

• Zastosuj zmienne użytkownika (wymaga ponownego uruchomienia; zawiera separatory). Zmienne
można [Dodać] i [Usunąć]. Zdefiniowane dotychczas zmienna wyświetlane są w ramce Aktualne zmi-

enne środowiska, przy czym istnieje możliwość filtrowania zmiennych poprzez zaznaczenie opcji Pokaż
jedynie zmienne QGIS.

Rysunek 9.3: Zmienne środowiska w QGIS

Ścieżki wtyczek

[Dodaj] lub [Usuń] Ścieżki poszukiwań dodatkowych wtyczek C++

9.3.3 Zakładka Źródła danych

Tabela i atrybuty obiektów

• Otwórz tabelę atrybutów w oknie dokowalnym (wymaga restarty QGIS-a)
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• Kopiuj geometrię w formacie WKT z tabeli atrybutów. Powoduje to, że podczas użycia polecenia
Kopiuj zaznaczone wiersze do schowka w oknie Tabeli atrybutów, do schowka kopiowane są również współrzędne
punktów lub wierzchołków.

• Właściwości tabeli atrybutów . Są trzy możliwości: ‘Pozkaż wszystkie obiekty’, ‘Pokaż zaznaczone
obiekty’ and ‘Pokaż obiekty widoczne na mapie’.

• Cache wierszy tabeli atrybutów . Ten cache umożliwia zapisanie N ostatnio załadowanych wierszy
tabeli aby praca z tabelą była szybsza. Cache jest kasowany, gdy tabela atrybutów jest zamykana.

• Wartość NULL jest reprezentowana przez. Można tu określić wartość dla pól zawierających wartość NULL.

Obsługa źródeł danych

• Szukaj poprawnych obiektów w oknie przeglądarki . Możesz wybrać ‘Sprawdź rozszerzenie’ lub
‘Sprawdź zawartość pliku’.

• Szukaj w plikach skompresowanych (.zip) w oknie przeglądarki . Mamy następujące możliwości:
‘Nie’, ‘Podstawowy skan’ i ‘Pełny skan’.

• Pytaj o podwarstwy rastrowe przy otwieraniu. Niektóre rastry obsługują podwarstwy — w GDAL nazy-
wane są one podzbiorami danych (subdatasets). Przykładem mogą być pliki netcdf — gdy istnieje wiele
wariantów netcdf, GDAL rozpoznaje każdy z nich jako podzbiór danych. Ta opcja dotyczy sposobu, w jaki
traktowane mają być podwarstwy, gdy otwierany jest plik z podwarstwami. Mamy do wyboru:

– ‘Zawsze’: zawsze pytaj (czy istnieją podwarstwy)

– ‘Jeśli konieczne’: pytaj, czy warstwa nie ma pasm, a posiada podwarstwy

– ‘Nigdy’: nigdy nie pytaj i nie ładuj podwarstw.

– ‘Wczytaj wszystkie’: nigdy nie pytaj, ale załaduj wszystkie podwarstwy

• Ignoruj deklarację kodowania Shapefile. Jeśli Shapefile posiada deklarację kodowania, nie będzie ona
uwzględniana przez QGIS.

• Dodaj warstwy PostGIS podwójnym kliknięciem i wybierz w trybie rozszerzonym

• Dodaj warstwy Oracle podwójnym kliknięciem i wybierz w trybie rozszerzonym

9.3.4 Zakładka Renderowanie

Właściwości wyświetlania

• Domyślnie nowo dodawane warstwy są wyświetlane

• Użyj pamięci podręcznej aby przyspieszyć odświeżanie.

• Wykorzystuj wiele rdzeni CPU

• ale nie więcej niż

• Odświeżaj widok mapy co (dmyślnie 250 ms)

• Uproszczone wyświetlanie dla nowo wczytanych warstw

• Próg upraszczania (większe wartości to większe uproszczenia)

• Upraszczaj w źródle danych (jeśli to możliwe)

• Maksymalna skala upraszczania (1:1 - zawsze)

Jakość wyświetlania

• Pokaż linie jako mniej postrzępione kosztem wydajności wyświetlania
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Rastry

• W Kanały RGB możesz określić numery kanałów czrwonego, zielonego i niebieskiego.

Wzmocnienie kontrastu

• Jeden kanał . Obrazy jednokanałowe można ładować z opcjami: ‘Bez rozciągania’, ‘Rozciągnij do
MinMax’, ‘Rozciągnij i przytnij do MinMax’ oraz ‘Przytnij do MinMax’.

• Kolor wielokanałowy (bajt/kanał) . Z opcjami ‘Bez rozciągania’, ‘Rozciągnij do MinMax’, ‘Rozciąg-
nij i przytnij do MinMax’ oraz ‘Przytnij do MinMax’.

• Kolor wielokanałowy (>bajt/kanał) . Z opcjami ‘Bez rozciągania’, ‘Rozciągnij do MinMax’, ‘Roz-
ciągnij i przytnij do MinMax’ oraz ‘Przytnij do MinMax’

• Ogranicz do (min./max.) . Z opcjami ‘łącznej liczby pikseli’, ‘minimum/maksimum’, ‘odchylenia
standardowego’

• Łączna liczba pikseli

• Wielokrotność odchylenia standardowego

Śledzenie błędów

• Odświeżanie obszaru mapy

9.3.5 Kolory

To menu pozwala na określenie pewnych kolorów, które będą mogły być później wykorzystane we wszystkich
oknach ustawień stylów. Na początku w zakładce tej znajdziesz kilka kolorów, które umieszczono tam domyślnie,
ale możesz je sunąć lub zmienić. Co więcej, możesz określić jakiś kolor, a następnie skopiować go i wkleić.
Można też wyeksportować zestaw kolorów do pliku gpl i zaimportować go w innym projekcie.

9.3.6 Zakładka Mapa i legenda

Domyślny wygląd mapy (nadpisywany przez właściwości projektu)

• Określ kolor obiektów zaznaczonych i kolor tła.

Legenda warstwy

• Dwuklik na warstwie w legendzie może ‘otwierać właściwości warstwy’ albo ‘otwierać tabalę atry-
butów’.

• Można określić następujące opcje Stylu legendy:

– Nazwy warstw dużą literą

– Nazwy warstw pogrubione

– Nazwy grup pogrubione

– Wyświetl atrybuty klasyfikacji

– Twórz miniatury warstw rastrowych (może spowolnić program)

– Nowe warstwy dodawaj do aktywnej lub zaznaczonej grupy

50 Rozdział 9. Konfiguracja QGIS



QGIS User Guide, Wydanie 2.6

9.3.7 Zakładka Narzędzia mapy

Polecenie to pozwala na zmianę opcji narzędzia identyfikacji Informacje o obiekcie.

• Promień wyszukiwania przy wskazywaniu obiektów i wyświetlaniu podpowiedzi jest wskaźnikiem tolerancji
wyrażanym w procentach jednostkek mapy. Oznacza to, że narzędzie poda informacje o obiektach znajdu-
jących się w promieniu mniejszym od tej tolerancji.

• Kolor wybranych określa jakim kolorem rysowane będą identyfikowane obiekty.

• Otoczka wyrażana w jednostkach wyświetlania, określa odległość rysowania bufora podświetlenia wokół
identyfikowanych obiektów.

• Minimalna szerokość wyrażana w jednostkach wyświetlania, określa jaką grubością linii ma być rysowane
podświetlenie identyfikowanych obiektów.

Narzędzie pomiaru

• Określenie koloru linijki dla narzędzi pomiarowych

• Określenie Ilości cyfr dziesiętnych

• Zachowaj jednostki bazowe

• Preferowane jednostki długości (‘metry’, ‘stopy’, ‘mile morskie’ lub ‘stopnie’)‘

• Preferowane jednostki kątów (‘stopnie’, ‘radiany’ lub ‘grady’)

Przesuwanie i powiększanie

• Określanie działania kółka na myszce (‘Powiększ’, ‘Powiększ i wycentruj’, ‘Powiększ do kursora’,
‘Brak’)

• Określanie Współczynnika powiększenia dla kółka myszy

Zdefiniowane skale

Tutaj znajdziesz listę zdefiniowanych skal. Za pomocą przycisków [+] i [-] można dodawać i usuwać własne
skale.

9.3.8 Zakładka Wydruk

Domyślne ustawienia wydruku

Można określić Domyślną czcionkę.

Wygląd siatki

• Można określić Styl siatki (‘linie’, ‘punkty’, ‘krzyże’)

• oraz kolor...

Domyślne dla siatki

• Można określić Odstęp

• :guilabel:‘Przesunięcie ‘ w kierunku x i y

• oraz Tolerancję przyciągania

Domyślne dla prowadnic

• oraz Tolerancję przyciągania
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9.3.9 Zakładka Digitalizacja

Tworzenie obiektów

• Nie pokazuj okna z atrybutami po utworzeniu obiektu

• Użyj ostatnich wprowadzonych wartości atrybutu

• Sprawdzanie geometrii. Podczas edycji złożonych linii i poligonów z wieloma węzłami renderowanie może
być bardzo spowolnione. Jest tak ponieważ domyślna procedura sprawdzania w QGIS może zając sporo
czasu. Można przyspieszyć renderowanie poprzez zaznaczenie sprawdzania geometrii za pomocą GEOS
(począwszy od GEOS 3.3) lub wyłączając sprawdzanie. Sprawdzanie geometrii za pomocą GEOS jest
dużo szybsze, ale jego wadą jest to, że otrzymamy jedynie informację o pierwszym napotkanym błędzie
geometrii.

Linijka

• Określenie grubości linii i koloru linii

Przyciąganie

• Dokowane okno opcji (wymaga restartu QGIS-a)

• Określenie :guilabel:Domyślny tryb przyciągania‘ (‘do wierzchołka’, ‘do segmentu’, ‘do wierz-
chołka i segmentu’, ‘brak’)

• Domyślna tolerancja przyciągania w jednostkach mapy lub pikselach

• Określ Promień wyszukiwania przy edycji wierzchołków w jednostkach mapy lub pikselach

Znaczniki wierzchołków

• Wyświetl znaczniki jedynie dla wybranych obiektów

• Określ Styl znacznika dla wierzchołków (‘Krzyż’ (default), ‘Półprzezroczyste koło’ lub ‘Brak’)

• Określ Rozmiar markera wierzchołków

Przesunięcie krzywych

Następne trzy opcje dotyczą narzędzia Przesunięcie krzywej z Advanced digitizing. Poprzez zmianę tych ustawień
można uzyskać różne kształty przesuwanej krzywej. Opcje te dostępne są w GEOS od wersji 3.3.

• Styl połączenia

• Segmentów kwadrantu

• Limit fazy (uciosu)

9.3.10 Zakładka GDAL

GDAL jest biblioteką wymiany danych dla plików rastrowych. W tej zakładce można podać Opcje generowania
i Opcje piramid dla rastrów. Można także określić, który ze sterowników GDAL ma być wykorzystany dla
określonego formatu rastra, gdy, jak ma to czasem miejsce, dostępnych jest kilka.

9.3.11 Zakładka Układ współrzędnych

Domyślny układ współrzędnych dla nowych projektów

• Domyślnie wyłącz reprojekcję w locie

• Włącz reprojekcję w locie, jeśli warstwy mają różne układy współrzędnych

• Domyślnie włącz reprojekcję w locie
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• Zawsze stosuj ten układ dla nowych projektów i wybierz jakiś układ

Układ współrzędnych dla nowych warstw

To pole pozwala określić, co ma się zdarzyć, gdy tworzona jest nowa warstwa lub ładowana jest warstwa bez
określonego układu współrzędnych.

• pytaj o układ współrzędnych

• użyj układu współrzędnych projektu

• użyj poniższego domyślnego układu współrzędnych

Domyślne transformacje układów odniesienia

• Pytaj o transformację, gdy brak domyślnej

• Jeśli korzystałeś już z reprojekcji w locie, informację o tym znajdziesz w okienku poniżej. Są tam informa-
cje o źródłowych i docelowych układach współrzędnych płaskich i wysokościowych.

9.3.12 Zakładka Język

• Nadpisz ustawienia lokalne i Wybierz wersję językową

• Wykryte ustawienia lokalne w twoim systemie

9.3.13 Zakładka Sieć

Ogólne

• Adres przeszukiwania WMS, domyślny to http://geopole.org/wms/search?search=\%1\&type=rss

• Limit czasu dla zapytań sieciowych (ms) - domyślny wynosi 60000

• Czas przedawnienia dla kafli WMSC/WMTS (h) - domyślny to 24

• Można określić Limit prób przy błędach pobierania kafli

• Klient użytkownika (User-Agent)

Ustawienia cache

Katalog i Rozmiar dla cache.

• Użyj serwera proxy przy dostępie do sieci wymaga podania ‘Hosta’ i opcjonalnie ‘Portu’, ‘Użytkownika’
oraz ‘Hasła’.

• Ustaw Typ proxy odpowiedni dla twojego przypadku.

– Default Proxy: Proxy określany jest na podstawie ustawień aplikacji proxy

– Socks5Proxy: ogólny proxy dla wszelkiego typu połączeń. Obsługuje TCP, UDP, binding do portu
(dla połączeń przychodzących) oraz autoryzację.

– HttpProxy: zaimplementowany z użyciem komendy “CONNECT”, obsługuje jedynie połączenia
wychodzące. Obsługuje autoryzację.

– HttpCachingProxy: Zaimplementowany przy użyciu zwykłych poleceń HTTP, użyteczny jedynie w
kontekście zapytań HTTP.

– FtpCachingProxy: Zaimplementowany przy użyciu pproxy FTP, użyteczny jedynie w kontekście za-
pytań FTP.
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Rysunek 9.4: Ustawienia serwera proxy w QGIS
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Można dodać wykluczenia niektórych URL w okienku tekstowym poniżej ustawień proxy (zob. Fig-
ure_Network_Tab).

Jeśli będziesz potrzebował bardziej szczegółowych informacji o ustawieniach proxy, zajrzyj do man-
uala w dokumentacji biblioteki QT, która dostępna jest pod adresem http://qt-project.org/doc/qt-
4.8/qnetworkproxy.html#ProxyType-enum.

Wskazówka: Korzystanie z proxy
Korzystanie z proxy może być trudne. Można próbować kolejno wymienionych wyżej ustawień i sprawdzać, czy
działają.

Można zmieniać te opcje stosownie do własnych potrzeb. Niektóre zmiany odnoszą skutek dopiero po restarcie
QGIS.

• Ustawienia zapisywane są pliku tekstowym: $HOME/.config/QGIS/QGIS2.conf

• swoje ustawienia znajdziesz w: $HOME/Library/Preferences/org.qgis.qgis.plist

• Ustawienia zapisane są w rejestrze pod: HKEY\CURRENT_USER\Software\QGIS\qgis

9.4 Personalizacja

Personalizacja pozwala na włączanie i wyłączanie prawie każdego elementu interfejsu użytkownika QGIS. Może
to być bardzo pomocne, jeśli masz zainstalowanych wiele wtyczek, z których nie korzystasz, a które zajmują
miejsce na ekranie.

Rysunek 9.5: Okno personalizacji

Personalizacja QGIS podzielona jest na pięć części. W Menu ukrywa się lub pokazuje elementy paska menu.

W Panele znajdują się okna paneli. Są to aplikacje, które uruchamiane są jako okna pływające, okna na-
jwyższego rzędu lub jako okna osadzone w głównym oknie QGIS jako zadokowane widżety (zob. również Panele

i paski narzędziowe). W Pasek stanu‘można wyłączać elementy takie jak informacje o współrzędnych. W
|checkbox| :guilabel:‘Paski narzędziowe, można (dez)aktywować paski narzędziowe z ikonami poleceń QGIS, a

w Widżety można włączać i wyłączać różne okna dialogowe i ich przyciski.

Za pomocą Przełącz przechwytywanie widżetów w programie głównym można kliknąć element QGIS, który ma zostać ukryty
i w ten sposób zlokalizować go na liście Personalizacji (zob. figure_customization). Można zachować różne
ustawienia personalizacji do różnych zastosowań. Załadowanie nowych ustawień personalizacji z pliku wymaga
restartu QGIS.

.
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ROZDZIAŁ 10

Praca z układami współrzędnych

QGIS umożliwia zdefiniowanie globalnego układu współrzędnych i układu dla projektu, które będą stosowane dla
warstw bez określonego układu. Możliwe jest także definiowanie własnych układów współrzędnych i reprojekcja
współrzędnych w locie zarówno dla warstw wektorowych jak i rastrów. Umożliwia to użytkownikom poprawne
wyświetlanie i nakładanie na siebie warstw utworzonych w różnych układach współrzędnych.

10.1 Ogólne wiadomości o obsłudze układów współrzędnych

QGIS obsługuje około 2 700 znanych układów współrzędnych. Definicja każdego z tych układów przechowywana
jest w bazie SQLite, która instalowana jest razem z QGIS. Zwykle nie ma konieczności dokonywania zmian w
tej bazie. Co istotne, zmiany takie mogłyby uniemożliwić prawidłowe przeliczanie współrzędnych. W rozdziale
Układ współrzędnych użytkownika znajdziesz więcej informacji o zarządzaniu własnymi układami współrzęd-
nych.

Układy dostępne w QGIS korzystają z informacji podanych przez European Petroleum Search Group (EPSG)
oraz Institut Geographique National de France (IGNF) i w dużym stopniu zostały zaczerpnięte z tabel odniesień
przestrzennych wykorzystanych w GDAL. Baza układów zawiera identyfikatory EPSG i w QGIS można z nich
korzystać, aby określi układ współrzędnych.

Aby móc korzystać z reprojekcji w locie, dane muszą zawierać informacje o ich układach współrzędnych albo
będziesz musiał sam podać układ dla tej warstwy, układ globalny lub układ projektu. W przypadku warstw
PostGIS QGIS wykorzystuje identyfikator układu, który został podany w czasie tworzenia warstwy. W przypadku
danych ładowanych przez OGR, QGIS sprawdza istnienie któregoś ze znanych sposobów określania układu. Dla
plików shape jest to definicja układu w postaci well-known text (:index:’WKT’). Plik układu ma taką samą nazwę
co shape i rozszerzenie .prj. Na przykład plik shape alaska.shp będzie miał definicję układu w pliku
alaska.prj.

Gdy wybierasz jakiś nowy układ współrzędnych, automatycznie zmieniają się również jednostki warstwy
widoczne w zakładce Ogólne w oknie Właściwości projektu w menu Projekt (Windows, Gnome, OS X) lub
Ustawienia (KDE).

10.2 Specyfikacja odwzorowań globalnych

Każdy nowy projekt QGIS wykorzystuje domyślny globalny układ współrzędnych. Domyślnym układem
po zainstalowaniu QGIS jest EPSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84
+no_defs). To domyślne ustawienie można zmianić przyciskiem [Wybierz...] w pierwszej sekcji, w której
podajemy domyślny układ dla nowych projektów tak, jak to pokazano na rysunku figure_projection_1. Wybór ten
zostanie zapisany i użyty w kolejnych sesjach QGIS.

Gdy korzystasz z warstw, które nie mają określonego układu współrzędnych, musisz zdecydować w jaki sposób
QGIS traktuje te warstwy. Można to określić globalnie lub dla konkretnego projektu w zakładce Układ współrzęd-
nych w menu Ustawienia → Opcje.

Opcje pokazane na figure_projection_1 to:
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Rysunek 10.1: Zakładka Układ współrzędnych w oknie opcji QGIS
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• Pytaj o układ współrzędnych

• Użyj układu współrzędnych projektu

• Użyj poniższego domyślnego układu współrzędnych

Zmiany układu współrzędnych dla konkretnej warstwy możesz dokonać również w zakładce Ogólne okna właś-
ciwości warstwy wektorowej i rastra (zob. General Menu dla rastrów i General Menu dla wektorów). Jeśli twoja
warstwa ma już określony jakiś układ współrzędnych, zostanie on wyświetlony tak, jak to pokazano na rysunku
Vector Layer Properties Dialog .

Wskazówka: Układy współrzędnych w legendzie mapy
Klikając prawym przyciskiem myszy na legendzie mapy (rozdz. Legenda mapy) uzyskujemy dostęp do dwóch
skrótów do układu współrzędnych. Ustaw układ współrzędnych warstwy wyświetla bezpośrednio okno wyboru
układu współrzędnych warstwy (zob. figure_projection_2). Ustaw wsp. projektu z warstwy powoduje, że układem
projektu staje się układ warstwy.

10.3 Włączanie reprojekcji w locie

QGIS umożliwia reprojekcję w locie warstw wektorowych i rastrowych. Reprojekcja nie jest jednak domyślnie

włączona. Aby ją włączyć, należy zaznaczyć pole wyboru Reprojekcja w locie w zakładce Układ współrzęd-

nych okna Właściwości projektu.

Można to zrobić na trzy sposoby:

1. Wybierz polecenie Właściwości projektu z menu Projekt (Gnome, OSX, Windows) lub Ustawienia
(KDE).

2. Kliknij na ikonie Stan CRS z prawej strony paska stanu u dołu ekranu.

3. Włącz reprojekcję w locie w zakładce Układ współrzędnych okna Opcji i zaznacz pole wyboru Domyśl-
nie włącz reprojekcję w locie lub Włącz reprojekcję w locie, jeśli warstwy mają różne układy współrzędnych.

Jeśli już załadowałeś warstwę i chcesz włączyć reprojekcję w locie, najlepiej będzie otworzyć zakładkę Układ

współrzędnych w oknie Właściwości Projektu, wybrać jakiś układ, a następnie zaznaczyć pole Reprojekcja

w locie. Od tej chwili ikona Stan CRS nie jest już wyszarzona, a wszystkie warstwy są przeliczane do układu
wskazanego obok ikony.

Zakładka Układ współrzędnych okna Właściwości projektu zawiera pięć istotnych składników, jak pokazano na
rysunku Figure_projection_2 i opisano poniżej:

1. Reprojekcja w locie — to pole służy do włączania reprojekcji w locie. Gdy nie jest zaznaczone, każda
warstwa rysowana jest przy użyciu układu współrzędnych wczytanego razem z warstwą, a składniki opisane
poniżej są nieaktywne. Gdy pole jest zaznaczone, każda warstwa jest przeliczana do układu przypisanego
obszarowi mapy.

2. Filtr — jeśli znasz kod EPSG, identyfikator lub nazwę układu współrzędnych, możesz odnaleźć układ
korzystając z wyszukiwarki. Wpisz kod EPSG, identyfikator lub nazwę.

3. Ostatnio używane układy współrzędnych — jeśli regularnie używasz w swojej pracy pewnych układów
współrzędnych, będą one wyświetlone w tabeli. Aby wybrać jakiś układ, kliknij go.

4. Dostępne układy współrzędnych — jest to lista wszystkich układów obsługiwanych przez QGIS, zaw-
ierająca układy geograficzne i płaskie oraz układy zdefiniowane przez użytkownika. Aby określić układ,
rozwiń właściwą gałąź drzewka i wybierz układ z listy zaznaczając go.

5. PROJ4 text — jest to ciąg znaków opisujący układ współrzędnych używany przez PROJ4, silnik obsługu-
jący układy. Tekst ten jest tylko do odczytu i jest podany do informacji.
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Rysunek 10.2: Okno właściwości projektu

Wskazówka: Okno właściwości projektu
Jeśli otworzyłeś okno Właściwości projektu‘z menu :menuselection:‘Projekt, żeby zobaczyć ustawienia układu
wybierz zakładkę Układ współrzędnych.

Otwarcie okna właściwości za pomocą przycisku Stan CRS automatycznie wyświetli zakładkę Układ
współrzędnych.

10.4 Układ współrzędnych użytkownika

Jeśli QGIS nie obsługuje układu, którego potrzebujesz, możesz zdefiniować własny układ. W tym celu wybierz

polecenie Układ współrzędnych użytkownika... z menu Ustawienia. Układy użytkownika przechowywane są
w twojej bazie danych użytkownika QGIS. Poza twoimi układami, baza ta zawiera zakładki przestrzenne i inne
ustawienia osobiste.

Definiowanie własnego układu współrzędnych w QGIS wymaga od użytkownika odpowiedniej wiedzy o bib-
liotece odwzorowań PROJ4. Zanim zaczniesz, sprawdź “Cartographic Projection Procedures for the UNIX
Environment - A User’s Manual”, Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990
(dostępne pod adresem ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

Ten podręcznik opisuje wykorzystanie proj.4 i podobnych narzędzi w linii poleceń. Parametry kartograficzne
wykorzystane w proj.4 opisane w tym podręczniku są takie same, jak te, używane przez QGIS.

Aby zdefiniować układ użytkownika w oknie Definicji układu współrzędnych użytkownika należy podać jedynie
dwa parametry:

1. nazwę układu

2. parametry kartograficzne w formacie PROJ.4
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Rysunek 10.3: Okno układu współrzędnych użytkownika

Aby utworzyć nowy układ współrzędnych naciśnij przycisk Dodaj nowy, podaj nazwę dobrze opisującą układ
oraz jego parametry.

Zwróć uwagę na to, że aby Parametry właściwie opisywały nowy układ współrzędnych, powinny zaczynać się od
bloku +proj=.

Możesz przetestować twój układ i sprawdzić, czy dają rozsądne wyniki. W tym celu wpisz jakieś znane wartości
długości i szerokości geograficznej w pola Północ and Wschód. Kliknij [Przelicz] i sprawdź czy otrzymałeś
spodziewane wyniki w swoim układzie współrzędnych.

10.5 Domyślne transformacje układów odniesienia

Reprojekcja w locie zależy od tego, czy możliwa jest transformacja współrzędnych pomiędzy układem warstwy
a układem domyślnym. W przypadku pewnych układów możliwe są różne przeliczenia przy przejściu do innego
układu. QGIS pozwala na określenie sposobu transformacji, a jeśli. Jeśli tego nie uczynimy, QGIS zastosuje
transformację domyślną.

W zakładce Układ współrzędnych w menu Ustawienia → Opcje można:

• ustawić QGIS, aby pytał, gdy musi określić sposób transformacji, poprez zaznaczenie opcji Pytaj o
transformację, gdy brak domyślnej

• zmieniać listę domyślnych transformacji

QGIS pyta, której transformacji użyć, przy czym wyświetla tekst PROJ.4 opisujący układ źródłowy i docelowy.
Dalsze informacje wyświetlają się po najechaniu kursorem myszy na transformację. Ustawienia użytkownika
mogą być zapisane, jeśli zaznaczone będzie pole Zapamiętaj wybór.

.
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QGIS Browser

The QGIS Browser is a panel in QGIS that lets you easily navigate in your filesystem and manage geodata. You
can have access to common vector files (e.g., ESRI shapefiles or MapInfo files), databases (e.g., PostGIS, Oracle,
SpatiaLite or MS SQL Spatial) and WMS/WFS connections. You can also view your GRASS data (to get the data
into QGIS, see GRASS GIS Integration).

Rysunek 11.1: QGIS browser as a stand alone application

Use the QGIS Browser to preview your data. The drag-and-drop function makes it easy to get your data into the
map view and the map legend.

1. Activate the QGIS Browser: Right-click on the toolbar and check Browser or select it from Settings →
Panels.

2. Drag the panel into the legend window and release it.

3. Click on the Browser tab.

4. Browse in your filesystem and choose the shapefile folder from qgis_sample_data directory.

5. Press the Shift key and select the airports.shp and alaska.shp files.

6. Press the left mouse button, then drag and drop the files into the map canvas.
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7. Right-click on a layer and choose Set project CRS from layer. For more information see Praca z układami
współrzędnych.

8. Click on Zoom Full to make the layers visible.

There is a second browser available under Settings → Panels. This is handy when you need to move files or layers
between locations.

1. Activate a second QGIS Browser: Right-click on the toolbar and check Browser (2), or select it from
Settings → Panels.

2. Drag the panel into the legend window.

3. Navigate to the Browser (2) tab and browse for a shapefile in your file system.

4. Select a file with the left mouse button. Now you can use the Add Selected Layers icon to add it into the
current project.

QGIS automatically looks for the coordinate reference system (CRS) and zooms to the layer extent if you work
in a blank QGIS project. If there are already files in your project, the file will just be added, and in the case that
it has the same extent and CRS, it will be visualized. If the file has another CRS and layer extent, you must first
right-click on the layer and choose Set Project CRS from Layer. Then choose Zoom to Layer Extent.

The Filter files function works on a directory level. Browse to the folder where you want to filter files and enter
a search word or wildcard. The Browser will show only matching filenames – other data won’t be displayed.

It’s also possible to run the QGIS Browser as a stand-alone application.

Start the QGIS browser

• Type in “qbrowser” at a command prompt.

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the stand-alone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Metadata Menu). With the Preview tab, you can
have a look at your files without importing them into your QGIS project. It’s also possible to preview the attributes
of your files in the Attributes tab.

.
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Working with Vector Data

.

12.1 Obsługiwane formaty danych

Do odczytu i zapisu danych wektorowych, w tym ESRI Shapefile, plików w formatach MapInfo i MicroSta-
tion, AutoCAD DXF, baz danych PostGIS, SpatiaLite, Oracle Spatial i MSSQL Spatial i wielu innych, QGIS
wykorzystuje bibliotekę OGR. Obsługa danych wektorowych GRASS i baz PostgreSQL odbywa się za pomocą
natywnych wtyczek QGIS. Można też załadować do odczytu dane wektorowe znajdujące się w archiwach zip lub
gzip. Obecnie, gdy tworzona jest ta dokumentacja, za pomocą biblioteki OGR obsługiwanych jest 69 różnych
formatów wektorowych (zob. OGR-SOFTWARE-SUITE in Literature and Web References). Kompletna lista
formatów dostępna jest pod adresem http://www.gdal.org/ogr/ogr_formats.html.

Informacja: Może się zdarzyć, że nie wszystkie z przedstawionych formatów będą działać w QGIS. Niektóre
z nich mogą, na przykład, wymagać zewnętrznych komercyjnych bibliotek lub GDAL/OGR dla twojego sys-
temu został skompilowany bez obsługi formatu, którego chcesz użyć. Na liście typów plików podczas ładowania
warstwy wektorowej do QGIS będą się pojawiały tylko te formaty, które zostały dobrze przetestowane. Inne,
nieprzetestowane formaty, mogą być załadowane po wybraniu *.*.

Praca z danymi wektorowymi GRASS została opisana w rozdziale GRASS GIS Integration.

Bieżący rozdział poświęcony jest sposobom pracy z kilkoma popularnymi formatami: ESRI shapefile, warstwami
PostGIS i SpatiaLite, danymi wektorowymi OpenStreetMap oraz danych w formacie tekstowym (CSV).

12.1.1 ESRI Shapefiles

Standardowym formatem danych wektorowych wykorzystywanym w QGIS jest ESRI shapefile. Jest on obsługi-
wany za pomocą biblioteki OGR Simple Feature Library ( http://www.gdal.org/ogr/ ).

Shapefile składa się właściwie z kilku plików. Wymagane są trzy poniższe:

1. .shp zawierający geometrię obiektów

2. .dbf zawierający atrybuty w formacie dBase

3. .shx plik indeksu

Shapefile mogą również zawierać plik z rozszerzeniem .prj z informacją o układzie współrzędnych.
Plik z układem jest bardzo przydatny, ale nie jest obowiązkowy. Zbiór danych Shapefile może zawierać
jeszcze inne dodatkowe pliki. Więcej informacji o specyfikacji technicznej ESRI znajduje się pod adresem:
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Ładowanie Shapefile

Ładowanie shapefile odbywa się za pomocą polecenia Dodaj warstwę wektorową z paska narzędziowego lub za po-
mocą kombinacji klawiszy Ctrl+Shift+V. Spowoduje to otwarcie nowego okna (zob. figure_vector_1).

Rysunek 12.1: Okno dodawania warstwy wektorowej

Wybierz opcję Plik. Naciśnij przycisk [Przeglądaj]. Otworzy się standardowe okno otwierania pliku (zob. fig-
ure_vector_2), w którym można przeglądać system plików i załadować Shapefile lub dane w innym obsługiwanym

formacie. Pasek wyboru Filtr umożliwia wyświetlanie plików o określonym formacie, obsługiwanym przez
OGR.

Jeśli zachodzi taka potrzeba, można również wybrać typ kodowania dla otwieranego shapefile.

Rysunek 12.2: Okno otwierania warstwy wektorowej obsługiwanej przez OGR

Zaznaczenie któregoś Shapefile z listy i naciśnięcie [Otwórz] załaduje go do QGIS. Obrazek Figure_vector_3
pokazuje jak wygląda QGIS po załadowaniu pliku alaska.shp.

Wskazówka: Kolory warstwy
Gdy ładujesz warstwę do mapy, zostaje jej przypisany losowy kolor. Jeśli ładujesz naraz wiele warstw, wówczas
każdej z nich przypisany zostaje inny kolor.
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Rysunek 12.3: QGIS załadowanym plikiem Shapefile z Alaską

Po załadowaniu shapefile możesz go przeglądać w dowolnym powiększeniu korzystając z narzędzi nawigacji
mapy. Jeśli chcesz zmienić styl wyświetlania warstwy, otwórz okno Właściwości warstwy dwukrotnie klikając
lub klikając prawym przyciskiem myszy na nazwie warstwy w legendzie i wybierając z menu kontekstowego
polecenie Properties. Zobacz rozdział Style Menu poświęcony nadawaniu stylu warstwom.

Wskazówka: Ładowanie warstwy i projektu z zewnętrznego źródła danych w OS X
W OS X zewnętrzne nośniki danych montowane poza głównym dyskiem nie są widoczne w menu Plik → Otwórz
projekt, chociaż tego właśnie byśmy oczekiwali. Pracujemy nad stworzeniem okna otwierania/zapisywania plików
o naturze bliższej OS X, co powinno rozwiązać ten problem. Można obejść ten problem wpisując /Volumes w
polu nazwy pliku i naciskając Enter. Możesz potem przeglądać dyski zewnętrze i sieciowe.

Zwiększanie wydajności pracy z Shapefile

Można polepszyć wydajność wyświetlania Shapefile poprzez utworzenie przestrzennego indeksu. Indeks ten
poprawi szybkość powiększania i przeciągania widoku. Indeksy przestrzenne, z których korzysta QGIS mają
rozszerzenie .qix.

Indeks przestrzenny tworzy się w następujący sposób:

• Załaduj shapefile klikając ikonkę paska narzędziowego Dodaj warstwę wektorową lub naciskając klawisze
Ctrl+Shift+V.

• Otwórz okno Właściwości warstwy dwukrotnie klikając na nazwie Shapefile lub klikając prawym przy-
ciskiem myszy i wybierając z menu podręcznego Właściwości.

• W zakładce Ogólne kliknij przycisk [Twórz indeks przestrzenny].
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Problemy z ładowaniem pliku .prj z Shapefile

Gdy QGIS w czasie ładowania shapefile nie jest w stanie określić układu współrzędnych na podstawie pliku .prj,
będziesz musiał samodzielnie określić układ w zakładce Ogólne okna Właściwości warstwy klikając przycisk
[Podaj...]. Problem ten wynika z tego, że pliki .prj często nie zawierają kompletnej informacji o układzie
współrzędnych w rozumieniu QGIS, jak to widać w zakładce Układ współrzędnych.

Z tego względu, gdy tworzysz nowy Shapefile w QGIS, tworzone są dwa różne pliki z układem współrzędnych.
Plik .prj z ograniczoną ilością parametrów, kompatybilny z oprogramowaniem ESRI, oraz plik .qpj, zaw-
ierający komplet parametrów układu współrzędnych. Gdy QGIS napotka na plik .qpj, użyje go zamiast pliku
.prj.

12.1.2 Ładowanie warstwy MapInfo

Aby dodać warstwę MapInfo, naciśnij przycisk Dodaj warstwę wektorową znajdujący się na pasku narzędziowym

(możesz też naciśnąć kombinację klawiszy Ctrl+Shift+V), zmień filtru Typy plików : na ‘Mapinfo File
[OGR] (*.mif *.tab *.MIF *.TAB)’ i wybierz warstwę MapInfo, którą chcesz załadować.

12.1.3 Ładowanie ArcInfo Binary Coverage

Aby załadować ArcInfo Binary Coverage, naciśnij przycisk Dodaj warstwę wektorową z paska narzędzi lub
naciśnij kombinację klawiszy Ctrl+Shift+V. Otworzy się okno Dodaj warstwę wektorową. Wybierz pole

radio Katalog w polu:guilabel:Typ źródła danych. Zmień filtr typów na Pliki typu na ‘Arc/Info Binary
Coverage’. Przejdź do katalogu, który zawiera plik coverage i wybierz go.

W podobny sposób można załadować warstwy zapisane w strukturze katalogu w formacie UK National Transfer
Format oraz TIGER opracowany w US Census Bureau.

12.1.4 Pliki tekstowe z danymi rozdzielanymi separatorami

Dane rozdzielane tabulatorem są bardzo popularnym i chętnie używanym formatem ze względu na jego pros-
totę i możliwości odczytu – dane mogą być przeglądane i edytowane nawet w w prostym edytorze tekstu. Tekst
rozdzielany separatorami może stanowić tabelę atrybutów, której kolumny rozdzielone są pewnym umownym
znakiem, a wiersze rozdziela znak złamania wiersza. Pierwszy wiersz zawiera zwykle nazwy kolumn. Pop-
ularnym typem tekstu rozdzielanego separatorem jest CSV (Comma Separated Values), w którym kolumny
rozdzielone są przecinkiem.

Takie pliki danych mogą również zawierać informację przestrzenną w postaci:

• współrzędnych punktów w oddzielnych kolumnych

• jako geometria w postaci WKT (well-known text)

QGIS umożliwia załadowanie tekstu rozdzielanego separatorami jak warstwy lub zwykłej tabeli. Najpierw jednak
upewnij się, że plik spełnia poniższe warunki:

1. Plik musi posiadać nagłówek z nazwami pól rozdzielonymi separatorem. Musi to być pierwsza linia pliku
tekstowego.

2. Wiersz nagłówkowy musi zawierać pole lub pola definiujące geometrię. Pola te mogą mieć dowolną nazwę.

3. Współrzędne X i Y (jeśli geometria opisana jest współrzędnymi) muszą być podane jako liczby. Układ
współrzędnych nie ma znaczenia.

Jako przykład poprawnego pliku importujemy punktowe dane wysokościowe z pliku elevp.csv zawartego w
przykładowym zestawie danych QGIS (zob. rozdział Przykładowe dane):
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X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Uwagi dotyczące pliku tekstowego:

1. W przykładowym pliku znakiem rozdzielającym jest ; (średnik). Można użyć dowolnego innego znaku do
rozdzielenia pól.

2. Pierwszy wiersz to nagłówki. Zawiera on pola X, Y oraz ELEV.

3. Nie używa się cudzysłowu (") dla pól typu tekstowego.

4. Współrzędne x podane są w polu X.

5. Współrzędne y zawarte są w polu Y.

Ładowanie pliku tekstowego z separatorami

W celu otwarcia okna dialogowego Utwórz warstwę na podstawie pliku rozdzielanego separatorem, pokazanego

na rysunku figure_delimited_text_1, kliknij ikonkę Dodaj warstwę tekstową CSV na pasku narzędziowym Zarządzaj
warstwami.

Rysunek 12.4: Okno dialogowe pliku tekstowego z separatorem

Najpierw zaznacz plik do importu (np. qgis_sample_data/csv/elevp.csv) klikając na przycisk
[Przeglądaj]. Po wybraniu pliku QGIS próbuje go sparsować używając ostatnio wykorzystanego separatora,
w tym przypadku średnika (;). Aby umożliwić QGIS właściwe sparsowanie pliku, istotne jest, aby dobrać praw-
idłowy separator. Możesz go dobrać włączając Rozdzielone innym znakiem lub Wyrażenie regularne i
wpisując odpowiedni tekst w pole Wyrażenie. Na przykład w celu zmiany separatora na tabulację, wpisz \t (jest
to wyrażenie regularne dla znaku tabulacji).

Gdy ładowany plik zostanie sparsowany, określ Geometrię jako Współrzędne punktowe i wybierz atrybuty X

i Y z list rozwijalnych. Jeśli współrzędne podane są w stopniach/minutach/sekundach, zaznacz pole wyboru
Współrzędne SMS.
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Na koniec podaj nazwę dla tworzonej warstwy (np. elevp) jak pokazano na rys. figure_delimited_text_1 . Aby
dodać warstwę do mapy kliknij [OK]. Od tej chwili plik z danymi rozdzielanymi separatorem można traktować
jak normalną warstwę QGIS.

Istnieje również możliwość obcinania spacji poprzedzających i następujących po tekście poprzez zaznaczenie pola

wyboru Usuń spacje przed/po. W każdym rekordzie można też Pominąć puste kolumny. Można też, jeśli

zachodzi taka konieczność, określić Przecinek jako separator dziesiętny.

Jeśli informacja przestrzenna ma postać WKT, zaznacz pole WKT (well known text) i wybierz pole, zaw-
ierające definicję WKT obiektów punktowych, liniowych lub poligonowych. Jeśli plik nie zawiera informacji
przestrzennych, zaznacz pole bez geometrii (tylko tabela atrybutów), co spowoduje załadowanie pliku jako
zwykłej tabeli.

Możesz też dodatkowo włączyć:

• Indeks przestrzenny aby poprawić wydajność wyświetlania i zapytań przestrzennych

• Indeks filtrowania.

• :guilabel:Śledź plik‘ w celu obserwowania zmian w pliku dokonanych przez inne aplikacje, podczas
gdy QGIS jest uruchomiony.

12.1.5 Dane OpenStreetMap

W ostatnich latach projekt OpenStreetMap zyskał popularność ponieważ w wielu krajach nie są dostępne dane
przestrzenne dotyczące dróg. Celem projektu OSM jest stworzenie wolnej edytowalnej mapy świata sporządzonej
na podstawie danych GPS, zdjęć lotniczych i wiadomościach lokalnych. QGIS obsługuje dane OSM, aby wspierać
realizację tego celu.

Ładowanie warstw wektorowych OpenStreetMap

Import danych OpenStreetMap jest jednym z podstawowych narzędzi QGIS.

• Aby połączyć się z serwerem OSM i ściągnąć dane otwórz menu Wektor→ Openstreetmap → Pobierz dane.
Możesz pominąć ten krok, jeśli już ściągnąłeś plik XML .osm za pośrednictwem JOSM, Overpass API lub
z innego źródła.

• Polecenie Wektor → OpenStreetMap → Wczytaj topologię z XML... przetworzy plik .osm do bazy Spa-
tiaLite i utworzy stosowne połączenie z tą bazą.

• Polecenie Wektor → OpenStreetMap → Eksportuj topologię do SpatiaLite... umożliwia otwarcie połączenia
z bazą, wybór typu danych (punkty, linie lub poligony) oraz tagów do importu. Spowoduje to utworzenie

warstwy SpatiaLite, którą można załadować poleceniem Dodaj warstwę SpatiaLite z paska narzędzi lub
Dodaj warstwę SpatiaLite... z menu Warstwa (zob. rozdz. Warstwy SpatiaLite).

12.1.6 Warstwy PostGIS

Warstwy PostGIS umieszczone są w bazie danych PostgreSQL. Plusem korzystania z PostGIS są oferowane przez
niego możliwości przestrzennego indeksowania warstw, filtrowania i tworzenia zapytań. Użycie PostGIS sprawia,
że mechanizmy zaznaczania i uzyskiwania informacji o obiektach warstw wektorowych działają w QGIS lepiej
niż z warstwami OGR.

Tworzenie połączenia z bazą danych

Zanim skorzystasz z danych PostGIS, musisz utworzyć połączenie z bazą danych, w której zapisane są te dane.

Można zacząć od kliknięcia przycisku na pasku narzędziowym Dodaj warstwę PostGIS, od polecenia Dodaj
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warstwę PostGIS... z menu Warstwa lub wciśnięcia kombinacji klawiszy Ctrl+Shift+D. Można też skorzystać
z polecenia Dodaj warstwę wektorową i w oknie zmienić typ źródła danych na Baza danych. Przycisk [Nowe]
uruchamia menedżera połączeń w oknie Utwórz nowe połączenie PostGIS. Wymagane do połączenia parametry
to:

• Nazwa: nazwa połączenia. Może być taka sama jak Baza danych

• Usługa: parametr usługi, który może być używany zamiennie z host/port (i potencjalnie również z bazą
danych). Można to zdefiniować w pg_service.conf.

• Host: nazwa hosta, na którym znajduje się baza danych. Musi to być rozpoznawalna nazwa hosta, taka
sama, jaka mogłaby zostać użyta do otwarcia połączenia telnet lub pingowania hosta. Jeśli baza znajduje
się na tym samym komputerze, co QGIS, wpisz po prostu ‘localhost’.

• Port: numer portu, na którym nasłuchuje serwer bazy danych PostgreSQL. Domyślnym portem jest 5432.

• Baza danych: nazwa bazy danych.

• Tryb SSL: określa, jak będzie nawiązywane połączenie SSL z serwerem. Zauważ, że można uzyskać
znaczne przyspieszenie wyświetlania warstw PostGIS, gdy wyłączy się SSL. Możliwe są tutaj następujące
opcje:

– Wyłącz: nawiązane będzie połączenie nieszyfrowane.

– Zezwól: spróbuj nawiązać połączenie bez SSL, a gdy będzie to niemożliwe, spróbuj nawiązać połącze-
nie SSL.

– Preferuj (domyślne): spróbuj nawiązać połączenie SSL, a gdy jest to niemożliwe, spróbuj nawiązać
połączenie bez SSL.

– Wymagaj: próbuj nawiązać jedynie połączenie SSL.

• Użytkownik: nazwa użytkownika logującego się do bazy danych.

• Hasło: hasło Użytkownika logującego się do bazy danych.

Można też zaznaczyć następujące pola wyboru:

• Zapisz nazwę użytkownika

• Zapisz hasło

• Wyświetlaj tylko zarejestrowane warstwy

• Nie sprawdzaj typu dla kolumn GEOMETRY

• Sprawdź tylko schemat ‘public’

• Pokaż także tabele bez geometrii

• Użyj szacunkowych metadanych tabeli

Po podaniu parametrów i opcji połączenia można przetestować połączenie klikając na przycisk [Test połączenia].

Ładowanie warstwy PostGIS

Po zdefiniowaniu połączenia możesz ładować dane z bazy PostgreSQL. Oczywiście wymaga to posiadania
danych w PostgreSQL. Zobacz rozdział Importowane danych do PostgreSQL poświęcony importowi danych do
bazy.

W celu załadowania warstwy PostGIS wykonaj następujące czynności:

• Jeśli okno Dodaj tabele PostGIS jeszcze otwarte, użyj polecenia Dodaj warstwę PostGIS... z menu
Warstwa lub skorzystaj ze skrótu klawiaturowego Ctrl+Shift+D aby je otworzyć.

• Wybierz połączenie z bazą z listy rozijalnej i naciśnij [Połącz].
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• Wybierz lub odznacz Pokaż także tabele bez geometrii.

• Możesz również skorzystać z Opcji wyszukiwania aby określić, które obiekty z zaznaczonej warstwy
załadować lub wykorzystać przycisk [Ustaw filtr], żeby otworzyć okno kreatora zapytań.

• Na liście dostępnych warstw yszukaj warstwę(y), które chcesz dodać.

• Zaznacz ją poprzez kliknięcie. Można zaznaczać więcej warstw przytrzymując w czasie klikania klawisz
Shift. Zobacz Query Builder, gdzie opisano wykorzystanie kreatora zapytań PostgreSQL do jeszcze
dokładniejszego określania warstw.

• Naciśnij przycisk [Dodaj] aby dodać warstwę do mapy.

Wskazówka: Warstwy PostGIS
Zwykle warstwa PostGIS zdefiniowana jest przez wpis w tabeli geometry_columns. Począwszy od wersji 0.9
QGIS może ładować warstwy, które nie mają wpisu w tabeli geometry_columns. Dotyczy to zarówno tabel jak i
widoków. Definiowanie widoków daje potężne możliwości wizualizacji danych. Informacje o tworzeniu widoków
znajdziesz w podręczniku PostgreSQL.

Kilka szczegółów o warstwach PostgreSQL

Ten rozdział zawiera kilka szczegółów o dostępie QGIS do warstw PostgreSQL. W większości przypadków QGIS
powinien zwyczajnie pokazać listę tabel bazy danych, które mogą być załadowane i, jeśli sobie tego życzysz,
załadować je. Jeśli jednak okaże się, że masz kłopot z załadowaniem tabeli PostgreSQL do QGIS, to poniższe in-
formacje mogą okazać się pomocne w zrozumieniu komunikatów QGIS i zawiera wskazówki, jak zmodyfikować
tę tabelę lub zdefiniować widok, aby QGIS mógł ją załadować.

QGIS wymaga, aby warstwy PostgreSQL zawierały kolumnę, która może być jej unikatowym kluczem. W przy-
padku tabel oznacza to, że tabela musi posiadać klucz główny lub kolumnę z wymogiem niepowtarzalności.
Kolumna ta musi mieć w QGIS typ int4 (4-bajtowa liczba całkowita). Można też użyć kolumny ctid jako klucza
głównego. Jeśli kolumna ich nie posiada, wówczas używana jest do tego kolumna oid. Wydajność będzie większa,
jeśli kolumna ta jest zindeksowana (zauważ, że klucze główne są w PostgreSQL indeksowane automatycznie).

Jeśli warstwa PostgreSQL jest widokiem, obowiązują te same wymagania, ale widoki nie posiadają kluczy
głównych czy kolumn z ograniczeniem niepowtarzalności. Musisz zdefiniować klucz główny (musi to być typu
integer) w oknie QGIS zanim będziesz mógł załadować widok. Jeśli widok nie posiada odpowiedniej kolumny,
QGIS go nie załaduje. Sposobem na rozwiązanie może być wówczas przedefiniowanie widoku tak, aby zawierał
odpowiednią kolumnę (typu integer, z ograniczeniem niepowtarzalności, najlepiej zindeksowaną).

W QGIS istnieje opcja Wybierz poprzez id, która domyślnie jest aktywna. Oznacza to, że pobierane jest jedynie
pole id, co zwykle pozwala przyspieszyć pracę. W przypadku podłączania widoków, które długo się generują,
warto rozważyć odznaczenie tej opcji.

12.1.7 Importowane danych do PostgreSQL

Import danych do bazy PostgreSQL/PostGIS może się odbyć przy pomocy kilku narzędzi, takich jak wtyczka
SPIT lub narzędzia linii poleceń shp2pgsql i ogr2ogr.

Zarządzanie bazami

QGIS posiada wbudowaną wtyczkę DB Menadżer. Można jej użyć do załadowania do bazy plików shp i danych
w innych formatach. Narzędzie to obsługuje schematy bazy. Więcej informacji znajduje się w rozdziale DB
Manager Plugin.
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shp2pgsql

PostGIS zawiera narzędziezwane shp2pgsql, które może być wykorzystane do importu shapefile do bazy PostGIS.
Na przykład, aby zaimportować shapefile o nazwie lakes.shp do bazy PostgreSQL o nazwie gis_data,
skorzystaj z następującego polecenia:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Spowoduje to utworzenie nowej warstwy o nazwie lakes_neww bazie danych gis_data. Warstwa będzie mi-
ała miała nadany układ współrzędnych o identyfikatorze (SRID) 2964. Więcej informacji o układach odniesienia
i odwzorowaniach znajdziesz w rozdziale Praca z układami współrzędnych.

Wskazówka: Eksportowanie zbiorów danych z PostGIS
Podobnie do narzędzia importu shp2pgsql istnieje również narzędzie do eksportowania zbiorów danych z PostGIS
jako shapefile: pgsql2shp. Jest ono dołączone do twojej dystrybucji PostGIS.

ogr2ogr

Oprócz shp2pgsql i DB Menadżera jest jeszcze jedno narzędzie, któe może posłużyć do wsadzania danych do
bazy PostGIS: ogr2ogr. Jest ono częścią instalacji GDAL.

Importowanie shapefile do PostGIS odbywa się w następujący sposób:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Spowoduje to wgranie shapefile alaska.shp do bazy danych PostGIS postgis przy użyciu użytkownika post-
gres z hasłem topsecret na hoście myhost.de.

Zwróć uwagę, że OGR musi być skompilowany z PostgreSQL, aby obsługiwać PostGIS. Można to sprawdzić
wpisując (w )

ogrinfo --formats | grep -i post

Jeśli chciałbyś wykorzystać polecenie PostgreSQL COPY zamiast domyślnej metody INSERT INTO możesz

określić następującą zmienną środowiskową (przynajmniej na i ):

export PG_USE_COPY=YES

ogr2ogr nie tworzy indeksów przestrzennych, tak jak shp2pgsql. Musisz utworzyć go ręcznie osobnym polece-
niem SQLa CREATE INDEX (opis znajdziesz w następnym rozdziale Zwiększanie wydajności).

Zwiększanie wydajności

Wczytywanie obiektów z bazy danych PostgreSQL może zajmować dużo czasu, zwłaszcza po sieci. Można
poprawić wydajność wyświetlania warstw PostgreSQL sprawdzając, czy każda z warstw w bazie posiada in-
deks przestrzenny PostGIS. PostGIS pozwala na tworzenie indeksów GiST (Generalized Search Tree) w celu
przyspieszenia przestrzennego wyszukiwania danych (informacje o indeksie GIST zaczerpnięte są z dokumen-
tacji PostGIS dostępnej pod adresem http://postgis.refractions.net).

Składnia tworzenia indeksu GIST jest następująca:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Zwróć uwagę, że dla większych tabel tworzenie indeksu może trwać długo. Po utworzeniu indeksu
należy przeprowadzić VACUUM ANALYZE. Więcej informacji znajdziesz w dokumentacji PostGIS (POSTGIS-
PROJECT Literature and Web References).

Poniżej znajduje się przykład tworzenia indeksu GIST:
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gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Warstwy wektorowe przechodzące przez południk 180

Wiele pakietów GIS nie zawija map wektorowych w geograficznym układzie odniesienia (dłu-
gość/szerokość) przechodzących przez południk 180 (http://postgis.refractions.net/documentation/manual-
2.0/ST_Shift_Longitude.html). W rezultacie, gdy otworzymy taką mapę w QGIS, zobaczymy dwie oddalone od
siebie lokalizacje, które powinny przecież znajdować się blisko siebie. Na rysunku Figure_vector_4 mały punkt z
lewej strony obszaru mapy (Wyspy Chatham) powinien znajdować się w siatce, z prawej strony Nowej Zelandii.

Rysunek 12.5: Mapa w układzie geograficznym przechodząca przez południk 180°

Można to obejść korzystając z funkcji PostGIS o nazwie ST_Shift_Longitude. Czyta ona każdy
punkt/wierzchołek wszystkich części każdego obiektu w geometrii warstwy i, jeśli długość geogr. < 0°, dodaje do
niej 360°. W wyniku tego otrzymujemy wersję danych w przedziale 0° - 360° wycentrowaną na południku 180°.

Rysunek 12.6: Przejście przez południk 180° z zastosowaniem funkcji ST_Shift_Longitude

74 Rozdział 12. Working with Vector Data

http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html
http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html


QGIS User Guide, Wydanie 2.6

Sposób użycia

• Zaimportuj dane do PostGIS (Importowane danych do PostgreSQL) korzystając np. z wtyczki DB
Menadżer.

• Skorzystaj z linii poleceń PostGIS i wydaj następujące polecenie (jest to przykład, w
którym “TABLE” jest właściwą nazwą tabeli PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Jeśli wszystko pójdzie dobrze, otrzymasz potwierdzenie z liczbą obiektów, które zostały zaktualizowane i
będziesz mógł załadować mapę i zobaczyć różnicę (Figure_vector_5)

12.1.9 Warstwy SpatiaLite

Gdy ładujesz warstwy z bazy SpatiaLite po raz pierwszy, zacznij od kliknięcia na przycisk Dodaj warstwę SpatiaLite

z paska narzędziowego lub wybierz polecenie Dodaj warstwę SpatiaLite... z menu Warstwa lub naciśnij
skrót Ctrl+Shift+L. Spowoduje to otwarcie okna, w którym będzie można nawiązać połączenie z jakąś bazą
zarejestrowaną już w QGIS , którą można wybrać z listy rozwijalnej lub zdefiniować nowe połączenie do nowej
bazy. Nowe połączenie definiuje się za pomocą przycisku [Nowe] i wskazanie położenia nowej bazy SpatiaLite,
która jest plikiem z rozszerzeniem .sqlite.

Jeśli chcesz zapisać warstwę wektorową w formacie SpatiaLite, możesz to zrobić klikając prawym przyciskiem
warstwę w legendzie i wybierając polecenie Zapisz jako..., następnie podaj nazwę pliku, jako format zapisu
wybierz SpatiaLite i określ docelowy układ współrzędnych. Można również wybrać jako format zapisu ‘SQLite’,
a następnie, w okienku opcji danych wpisać SPATIALITE=YES. W ten sposób OGR utworzy bazę SpatiaLite.
Zobacz również http://www.gdal.org/ogr/drv_sqlite.html.

QGIS obsługuje edytowalne widoki SpatiaLite.

Tworzenie nowej warstwy SpatiaLite

Jeśli chcesz utworzyć nową warstwę SpatiaLite, zajrzyj do rozdziału Creating a new SpatiaLite layer.

Wskazówka: Wtyczki do zarządzania danymi SpatiaLite
Do zarządzania danymi w bazach SpatiaLite można użyć również kilku wtyczek: QSpatiaLite, SpatiaLite Manager
lub Zarządzanie bazami (ta ostatnia jest wtyczką domyślnie instalowaną z programem i jest polecana). Można je
pobrać i zainstalować za pomocą Menadżera Wtyczek.

12.1.10 Warstwy MSSQL Spatial

QGIS posiada także wbudowaną obsługę MS SQL 2008. Zanim skorzystasz z danych MSSQL Spatial, kliknij

przycisk z paska narzędziowego Dodaj warstwę MSSQL Spatial, lub wybierz polecenie Dodaj warstwę MSSQL
Spatial... z menu Warstwa lub wciśnij kombinację klawiszy Ctrl+Shift+M.

12.1.11 Warstwy Oracle Spatial

Narzędzia przestrzenne Oracle Spatial umożliwiają użytkownikom natywną obsługę danych geograficznych w
bazie Oracle. QGIS obsługuje te warstwy.
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Tworzenie połączenia z bazą danych

Zanim skorzystasz z danych Oracle Spatial, musisz utworzyć połączenie z bazą danych, w której zapisane są te

dane. Można zacząć od kliknięcia przycisku na pasku narzędziowym Dodaj warstwę Oracle Spatial, od polecenia
Dodaj warstwę Oracle Spatial... z menu Warstwa lub wciśnięcia kombinacji klawiszy Ctrl+Shift+O. Przycisk
[Nowe] uruchamia menedżera połączeń w oknie Utwórz nowe połączenie Oracle. Wymagane do połączenia
parametry to:

• Nazwa: nazwa połączenia. Może być taka sama jak Baza danych

• Database: SID lub SERVICE_NAME instancji Oracle.

• Host: nazwa hosta, na którym znajduje się baza danych. Musi to być rozpoznawalna nazwa hosta, taka
sama, jaka mogłaby zostać użyta do otwarcia połączenia telnet lub pingowania hosta. Jeśli baza znajduje
się na tym samym komputerze, co QGIS, wpisz po prostu ‘localhost’.

• Port: numer portu, na którym nasłuchuje serwer bazy danych Oracle. Domyślnym portem jest 1521.

• Użytkownik: nazwa użytkownika logującego się do bazy danych.

• Hasło: hasło Użytkownika logującego się do bazy danych.

Można też zaznaczyć następujące pola wyboru:

• Zapisz użytkownika Wskazuje, czy w danych konfiguracyjnych połączenia zapisać również nazwę
użytkownika.

• Zapisz hasło Wskazuje, czy w konfiguracji połączenia zapisać hasło użytkownika bazy.

• Przeszukaj tylko meta data table Ogranicza wyświetlane tabele tylko do zapisanych w widoku
all_sdo_geom_metadata. Może to znacząco przyspieszyć pierwsze wyświetlenie tabel przestrzennych.

• Szukaj tylko tabel użytkownika Ogranicz poszukiwanie tabel przestrzennych do będących własnością
użytkownika.

• Pokaż także tabele bez geometrii. Wskazuje, czy wyszczególnione mają zostać również tabele bez
geometrii.

• Użyj szacunkowych metadanych tabeli Oracle przechowuje liczne metadane o tabelach, takie jak liczba
rekordów, typ geometrii, zasięg przestrzenny danych geometrycznych. Jeśli tabela ma wiele rekordów,
uzyskanie tych informacji może być czasochłonne. Włączenie tych opcji spowoduje przyspieszenie tych op-
eracji poprzez: oszacowanie liczby rekordów z all_tables.num_rows. Zasięg tabeli będzie zawsze określany
funkcją SDO_TUNE.EXTENTS_OF, nawet jeśli użyto filtra warstwy. Tabela geometrii jest określana z
pierwszych 100 niepustych (NOT NULL) rekordów geometrii.

• Tylko istniejące typy geometrii. Wyszczególniaj tylko istniejące typy geometrii i nie oferuj dodawania
nowych.

Po podaniu parametrów i opcji połączenia można przetestować połączenie klikając na przycisk [Test połączenia].

Wskazówka: Ustawienia użytkownika QGIS a bezpieczeństwo
W zależności od tego, w jakim środowisku pracujesz, przechowywanie haseł w twoich ustawieniach QGIS może
narazić twoje bezpieczeństwo. Hasła zapisywane są otwartym tekstem w ustawieniach systemowych i plikach
projektu! Twoje ustawienia QGIS są, w zależności od systemu operacyjnego, przechowywane w:

• Ustawienia przechowywane są w twoim katalogu domowym w ~/.qgis2.

• Ustawienia przechowywane są w rejestrze.
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Ładowanie warstwy Oracle Spatial

Po zdefiniowaniu połączenia możesz ładować dane z bazy Oracle. Oczywiście wymaga to posiadania danych
w Oracle.

W celu załadowania warstwy z Oracle Spatial wykonaj następujące kroki/l

• Jeśli okno Dodaj tabele Oracle nie jest otwarte, kliknij Dodaj warstwę Oracle Spatial z paska narzędzi.

• Wybierz połączenie z bazą z listy rozijalnej i naciśnij [Połącz].

• Wybierz lub odznacz Pokaż także tabele bez geometrii.

• Możesz również skorzystać z Opcji wyszukiwania aby określić, które obiekty z zaznaczonej warstwy
załadować lub wykorzystać przycisk [Ustaw filtr], żeby otworzyć okno kreatora zapytań.

• Na liście dostępnych warstw yszukaj warstwę(y), które chcesz dodać.

• Zaznacz ją poprzez kliknięcie. Można zaznaczać więcej warstw przytrzymując w czasie klikania klawisz
Shift. Zobacz Query Builder, gdzie opisano wykorzystanie kreatora zapytań Oracle do jeszcze dokład-
niejszego określania warstw.

• Naciśnij przycisk [Dodaj] aby dodać warstwę do mapy.

Wskazówka: Warstwy Oracle Spatial
Zwykle warstwa Oracle Spatial zdefiniowana jest poprzez wpis w tabeli USER_SDO_METADATA.

.

12.2 The Symbol Library

12.2.1 Presentation

The Symbol Library is the place where users can create generic symbols to be used in several QGIS projects. It
allows users to export and import symbols, groups symbols and add, edit and remove symbols. You can open it
with the Settings → Style Library or from the Style tab in the vector layer’s Properties.

Share and import symbols

Users can export and import symbols in two main formats: qml (QGIS format) and SLD (OGC standard). Note
that SLD format is not fully supported by QGIS.

share item displays a drop down list to let the user import or export symbols.

Groups and smart groups

Groups are categories of Symbols and smart groups are dynamic groups.

To create a group, right-click on an existing group or on the main Groups directory in the left of the library. You

can also select a group and click on the add item button.

To add a symbol into a group, you can either right click on a symbol then choose Apply group and then the group

name added before. There is a second way to add several symbols into group: just select a group and click
and choose Group Symbols. All symbols display a checkbox that allow you to add the symbol into the selected
groups. When finished, you can click on the same button, and choose Finish Grouping.

12.2. The Symbol Library 77



QGIS User Guide, Wydanie 2.6

Create Smart Symbols is similar to creating group, but instead select Smart Groups. The dialog box allow user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.)

Add, edit, remove symbol

With the Style manager from the [Symbol] menu you can manage your symbols. You can add item,
edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns and ‘colour ramps’

can be used to create the symbols. The symbols are then assigned to ‘All Symbols’, ‘Groups’ or ‘Smart groups’.

For each kind of symbols, you will find always the same dialog structure:

• at the top left side a symbol representation

• under the symbol representation the symbol tree show the symbol layers

• at the right you can setup some parameter (unit,transparency, color, size and rotation)

• under these parameteres you find some symbol from the symbol library

The symbol tree allow adding, removing or protect new simple symbol. You can move up or down the symbol
layer.

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can define
Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. Settings will be
shown later in this chapter.

Wskazówka: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of
the whole symbol can be changed with the Size menu in the first level again. The size of the lower levels changes
accordingly, while the size ratio is maintained.

12.2.2 Marker Symbols

Marker symbols have several symbol layer types:

• Ellipse marker

• Font marker

• Simple marker (default)

• SVG marker

• Vector Field marker

The following settings are possible:

• Symbol layer type: You have the option to use Ellipse markers, Font markers, Simple markers, SVG markers
and Vector Field markers.

• colors

• Size

• Outline style

• Outline width

• Angle

• Offset X,Y: You can shift the symbol in the x- or y-direction.

• Anchor point

• Data defined properties ...
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12.2.3 Line Symbols

Line marker symbols have only two symbol layer types:

• Marker line

• Simple line (default)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location vertex, interval or central point. Marker line can have offset along the line or
offset line. Finally, rotation allows you to change the orientation of the symbol.

The following settings are possible:

• colour

• Pen width

• Offset

• Pen style

• Join style

• Cap style

• Use custom dash pattern

• Dash pattern unit

• Data defined properties ...

12.2.4 Polygon Symbols

Polygon marker symbols have also several symbol layer types:

• Centroid fill

• Gradient fill

• Line pattern fill

• Point pattern fill

• SVG fill

• Shapeburst fille

• Simple fill (default)

• Outline: Marker line (same as line marker)

• Outline: simple line (same as line marker)

The following settings are possible:

• Colors for the border and the fill.

• Fill style

• Border style

• Border width

• Offset X,Y

• Data defined properties ...

Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allow you to fill in the feature with transparency. You can also just clic on the button to open the palettte dialog.
Note that you can import color from some external software like GIMP.
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‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer. Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a
gradient is drawn from the boundary of a polygon towards the polygon’s centre. Configurable parameters include
distance from the boundary to shade, use of color ramps or simple two color gradients, optional blurring of the fill
and offsets.

It is possible to only draw polygon borders inside the polygon. Using ‘Outline: Simple line’ select Draw line
only inside polygon.

12.2.5 Color ramp

You can create a custom color ramp choosing New color ramp... from the color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, colorBrewer, or cpt-city. The first three have options for number

of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the data with
a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a for the
cpt-city dialog.

Rysunek 12.7: Example of custom gradient color ramp with multiple stops

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.

.

12.3 The Vector Properties Dialog

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
pop-up menu.
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Rysunek 12.8: cpt-city dialog with hundreds of color ramps
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Rysunek 12.9: Vector Layer Properties Dialog
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12.3.1 Style Menu

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You can
use Layer rendering → tools that are common to all vector data, as well as special symbolizing tools that were
designed for the different kinds of vector data.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see Presentation). The Style Manager allows you to edit and remove existing symbols and add new ones.

After having made any needed changes, the symbol can be added to the list of current style symbols (using

[Symbol] Save in symbol library), and then it can easily be used in the future. Furthermore, you can use

the [Save Style] button to save the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If you change the renderer type when setting the style of a vector layer the settings you made for the symbol will
be maintained. Be aware that this procedure only works for one change. If you repeat changing the renderer type
the settings for the symbol will get lost.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can save your layer style inside
a table of the database. Just clic on :guilabel:‘ Save Style‘ comboxbox and choose Save in database item then fill
in the dialog to define a style name, add a description, an ui file and if the style is a default style. When loading a
layer from the database, if a style already exists for this layer, QGIS will load the layer and its style. You can add
several style in the database. Only one will be the default style anyway.

Rysunek 12.10: Save Style in database Dialog

Wskazówka: Select and change multiple symbols
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Single Symbol Renderer
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The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, which can be adjusted in the Style menu, depend partially on the type of layer, but all types share the
following dialog structure. In the top-left part of the menu, there is a preview of the current symbol to be rendered.
On the right part of the menu, there is a list of symbols already defined for the current style, prepared to be used
by selecting them from the list. The current symbol can be modified using the menu on the right side. If you
click on the first level in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size,
Transparency, color and Rotation. Here, the layers are joined together.

Rysunek 12.11: Single symbol line properties

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol whose
color reflects the value of a selected feature’s attribute. The Style menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions)

• The symbol (using the Symbol dialog)

• The colors (using the color Ramp listbox)

Then click on Classify button to create classes from the distinct value of the attribute column. Each classes can
be disabled unchecking the checkbox at the left of the class name.

You can change symbol, value and/or label of the clic, just double clicking on the item you want to change.

Right-clic shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The [Advanced] button in the lower-right corner of the dialog allows you to set the fields containing rotation and
size scale information. For convenience, the center of the menu lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol whose
color reflects the assignment of a selected feature’s attribute to a class.
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Rysunek 12.12: Categorized Symbolizing options

Rysunek 12.13: Graduated Symbolizing options
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Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, the Style tab allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressions chapter)

• The symbol (using the Symbol Properties button)

• The colors (using the color Ramp list)

Additionally, you can specify the number of classes and also the mode for classifying features within the classes
(using the Mode list). The available modes are:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;

• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: the same of natural breaks but the extremes number of each class are integers.

The listbox in the center part of the Style menu lists the classes together with their ranges, labels and symbols that
will be rendered.

Click on Classify button to create classes using the choosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

You can change symbol, value and/or label of the clic, just double clicking on the item you want to change.

Right-clic shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_4 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Wskazówka: Thematic maps using an expression
Categorized and graduated thematic maps can now be created using the result of an expression. In the properties
dialog for vector layers, the attribute chooser has been augmented with a Set column expression function. So
now you no longer need to write the classification attribute to a new column in your attribute table if you want the
classification attribute to be a composite of multiple fields, or a formula of some sort.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule based symbols whose color
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expressions). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
match. Since QGIS 2.6 the label for the rules appears in a pseudotree in the map legend. Just double-klick the
rules in the map legend and the Style menu of the layer properties appears showing the rule that is the background
for the symbol in the pseudotree.
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Rysunek 12.14: Rule-based Symbolizing options

Point displacement

The Point Displacement Renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Wskazówka: Export vector symbology
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Inverted Polygon

Inverted polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As before you
can select a subrenderers. These subrenderers are the same as for the main renderers.

Color Picker

Regardless the type of style to be used, the select color dialog will show when you click to choose a color - either

border or fill color. This dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker.

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is
populated with one of three methods: Recent colors, Standard colors or Project colors

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Wskazówka: quick color picker + copy/paste colors
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Rysunek 12.15: Point displacement dialog
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Rysunek 12.16: Inverted Polygon dialog

Rysunek 12.17: Color picker ramp tab
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Rysunek 12.18: Color picker swatcher tab

You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the
drop-down arrow that follows a current color box.

Rysunek 12.19: Quick color picker menu

Layer rendering

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it. The colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

90 Rozdział 12. Working with Vector Data



QGIS User Guide, Wydanie 2.6

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with the other. In case of values
above one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the corresponding
pixels for the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

– Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a
very intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer from the other. In case of negative
values, black is displayed.

12.3.2 Labels Menu

The Labels core application provides smart labeling for vector point, line and polygon layers, and it only
requires a few parameters. This new application also supports on-the-fly transformed layers. The core functions
of the application have been redesigned. In QGIS, there are a number of other features that improve the labeling.
The following menus have been created for labeling the vector layers:

• Text

• Formatting

• Buffer

• Background

• Shadow

• Placement

• Rendering

Let us see how the new menus can be used for various vector layers. Labeling point layers

Start QGIS and load a vector point layer. Activate the layer in the legend and click on the Layer Labeling Options

icon in the QGIS toolbar menu.

The first step is to activate the Label this layer with checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

The following steps describe a simple labeling without using the Data defined override functions, which are
situated next to the drop-down menus.
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You can define the text style in the Text menu (see Figure_labels_1 ). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the blend modes to create effects known from graphics programs (see blend_modes).

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’

function. Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places
may be inserted. If you enable this option, three decimal places are initially set by default.

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.
Here, you can also use blend modes (see blend_modes).

If the color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see blend_modes).

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode (see blend_modes).

Choose the Placement menu for the label placement and the labeling priority. Using the Offset from point
setting, you now have the option to use Quadrants to place your label. Additionally, you can alter the angle of
the label placement with the Rotation setting. Thus, a placement in a certain quadrant with a certain rotation is
possible.

In the Rendering menu, you can define label and feature options. Under Label options, you find the scale-based

visibility setting now. You can prevent QGIS from rendering only selected labels with the Show all labels for
this layer (including colliding labels) checkbox. Under Feature options, you can define whether every part of a
multipart feature is to be labeled. It’s possible to define whether the number of features to be labeled is limited

and to Discourage labels from covering features.

Labeling line layers

The first step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column
to use for labeling. Click if you want to define labels based on expressions - See labeling_with_expressions.

After that, you can define the text style in the Text menu. Here, you can use the same settings as for point layers.

Also, in the Formatting menu, the same settings as for point layers are possible.

The Buffer menu has the same functions as described in section labeling_point_layers.

The Background menu has the same entries as described in section labeling_point_layers.

Also, the Shadow menu has the same entries as described in section labeling_point_layers.

In the Placement menu, you find special settings for line layers. The label can be placed Parallel, Curved

or Horizontal. With the Parallel and Curved option, you can define the position Above line,

On line and Below line. It’s possible to select several options at once. In that case, QGIS will look for the
optimal position of the label. Remember that here you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_2 ).
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Rysunek 12.20: Smart labeling of vector point layers

You can set up a minimum distance for repeating labels. Distance can be in mm or in map units.

Some Placement setup will display more options, for example, Curved and Parallel Placements will allow the user
to set up the position of the label (above, belw or on the line), distance from the line and for Curved, the user can
also setup inside/outside max angle between curved label.

The Rendering menu has nearly the same entries as for point layers. In the Feature options, you can now Suppress
labeling of features smaller than.

Labeling polygon layers

The first step is to activate the Label this layer checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

In the Text menu, define the text style. The entries are the same as for point and line layers.

The Formatting menu allows you to format multiple lines, also similar to the cases of point and line layers.

As with point and line layers, you can create a text buffer in the Buffer menu.

Use the Background menu to create a complex user-defined background for the polygon layer. You can use the
menu also as with the point and line layers.

The entries in the Shadow menu are the same as for point and line layers.

In the Placement menu, you find special settings for polygon layers (see Figure_labels_3). Offset from centroid,
Horizontal (slow), Around centroid, Free and Using perimeter are possible.

In the Offset from centroid settings, you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label with the quadrants here, and define offset and rotation. The Around centroid setting makes it possible to
place the label around the centroid with a certain distance. Again, you can define visible polygon or whole
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Rysunek 12.21: Smart labeling of vector line layers

polygon for the centroid. With the Using perimeter settings, you can define a position and a distance for the

label. For the position, Above line, On line, Below line and Line orientation dependent position
are possible.

Related to the choose of Label Placement, several options will appear. As for Point Placement you can choose the
distance for the polygon outline, repeat the label around the polygon perimeter.

The entries in the Rendering menu are the same as for line layers. You can also use Suppress labeling of features
smaller than in the Feature options. Define labels based on expressions

QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function ‘$area()’ in combination with ‘format_number()’
to make it look nicer.

Expression based labeling is easy to work with. All you have to take care of is, that you need to combine all
elements (strings, fields and functions) with a string concatenation sign ‘||’ and that fields a written in “double
quotes” and strings in ‘single quotes’. Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a comma as separater
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ separated by comma
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
I live in Paris
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Rysunek 12.22: Smart labeling of vector polygon layers

Rysunek 12.23: Using expressions for labeling
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# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town

As you can see in the expression builder, you have hundreds if functions available to create simple and very
complex expressions to label your data in QGIS. See Expressions chapter for more information and example on
expressions.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoom into a lake.

5. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6 ). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

12.3.3 Fields Menu

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.

Edit Widget

Within the Fields menu, you also find an edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. If you click on the [edit widget]
button, a dialog opens, where you can define different widgets. These widgets are:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style menu of the properties dialog.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Date/Time: Displays a line fields which can opens a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.
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Rysunek 12.24: Labeling of vector polygon layers with data-defined override

Rysunek 12.25: Move labels
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Rysunek 12.26: Dialog to select an edit widget for an attribute column
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• File name: Simplifies the selection by adding a file chooser dialog.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Photo: Field contains a filename for a picture. The width and height of the field can be defined.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Relation Reference: This widged lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

• Text edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.

• Unique values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

• Value map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• Webview: Field contains a URL. The width and height of the field is variable.

With the Attribute editor layout, you can now define built-in forms for data entry jobs (see figure_fields_2).

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category that will then be
shown during the digitizing session (see figure_fields_3). The next step will be to assign the relevant fields to the

category with the icon. You can create more categories and use the same fields again. When creating a new
category, QGIS will insert a new tab for the category in the built-in form.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’. ‘Autogenerate’ just creates editors for all
fields and tabulates them. The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-
Designer. Using a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: MyForms.open

MyForms.py must live on PYTHONPATH, in .qgis2/python, or inside the project folder.

12.3.4 General Menu

Use this menu to make general settings for the vector layer. There are several options available:

Layer Info

• Change the display name of the layer in displayed as

• Define the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file

Coordinate Reference System

• Specify the coordinate reference system. Here, you can view or change the projection of the specific vector
layer.
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Rysunek 12.27: Dialog to create categories with the Attribute editor layout

Rysunek 12.28: Resulting built-in form in a data entry session
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• Create a Spatial Index (only for OGR-supported formats)

• Update Extents information for a layer

• View or change the projection of the specific vector layer, clicking on Specify ...

Scale dependent visibility

• You can set the Maximum (inclusive) and Minimum (exclusive) scale. The scale can also be set by the
[Current] buttons.

Feature subset

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Query Builder).

Rysunek 12.29: General menu in vector layers properties dialog

12.3.5 Rendering Menu

QGIS 2.2 introduces support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a new global setting that enables generalisation by default for newly
added layers (see section Opcje). Note: Feature generalisation may introduce artefacts into your rendered output
in some cases. These may include slivers between polygons and inaccurate rendering when using offset-based
symbol layers.
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12.3.6 Display Menu

This menu is specifically created for Map Tips. It includes a new feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is now possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → MapTips. Figure Display 1 shows an example of HTML code.

Rysunek 12.30: HTML code for map tip

Rysunek 12.31: Map tip made with HTML code

12.3.7 Actions Menu

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.
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Rysunek 12.32: Overview action dialog with some sample actions

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Generic, Mac, Windows and Unix actions start an external process.

• Python actions execute a Python expression.

• Generic and Python actions are visible everywhere.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Add default actions]. One
example is performing a search based on an attribute value. This concept is used in the following discussion.

Defining Actions

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions menu. Go to the Action properties. Select ‘Generic’ as type and provide
a descriptive name for the action. The action itself must contain the name of the application that will be executed
when the action is invoked. You can add one or more attribute field values as arguments to the application. When
the action is invoked, any set of characters that start with a % followed by the name of a field will be replaced by
the value of that field. The special characters %% will be replaced by the value of the field that was selected from
the identify results or attribute table (see using_actions below). Double quote marks can be used to group text into
a single argument to the program, script or command. Double quotes will be ignored if preceded by a backslash.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
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information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by preceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.
Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

If you are invoking an action that uses the %% notation, right-click on the field value in the Identify Results dialog
or the Attribute Table dialog that you wish to pass to the application or script.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

After selecting a few localities and running the action on each one, opening the output file will show something
like this:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Make sure the lakes layer is loaded.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Click on the Actions menu.

4. Enter a name for the action, for example Google Search.

5. For the action, we need to provide the name of the external program to run. In this case, we can use Firefox.
If the program is not in your path, you need to provide the full path.

6. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=
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7. The text in the Action field should now look like this: firefox http://google.com/search?q=

8. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert Field] button.

9. From the drop-down box, select ‘NAMES’ and click [Insert Field].

10. Your action text now looks like this:

firefox http://google.com/search?q=%NAMES

11. To finalize the action, click the [Add to action list] button.

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

We can now use the action. Close the Layer Properties dialog and zoom in to an area of interest. Make sure the
lakes layer is active and identify a lake. In the result box you’ll now see that our action is visible:

Rysunek 12.33: Select feature and choose action

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.

We can also make more complex examples, for instance, using Python actions.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
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layerpath = layer.source() if layer.providerType() == ’ogr’
else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

To add a raster (a TIF image in this example), it becomes:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.3.8 Joins Menu

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Additionally, the add vector join dialog allows you to:

• Cache join layer in virtual memory

• Create attribute index on the join field

12.3.9 Diagrams Menu

The Diagrams menu allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for pie charts, text diagrams and histograms.
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Rysunek 12.34: Join an attribute table to an existing vector layer

The menu is divided into four tabs: Appearance, Size, Postion and Options.

In the cases of the text diagram and pie chart, text values of different data columns are displayed one below the
other with a circle or a box and dividers. In the Size tab, diagram size is based on a fixed size or on linear scaling
according to a classification attribute. The placement of the diagrams, which is done in the Position tab, interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition,
chart positions can be fixed manually.

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Przykładowe
dane).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Diagrams menu, activate Display diagrams, and from the Diagram type combo box,
select ‘Text diagram’.

4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

First select T_F_JAN as Attributes and click the button, then T_F_JUL, and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Deactivate the Fixed size and set the size of the diagrams on
the basis of an attribute with the [Find maximum value] button and the Size menu. If the diagrams appear

too small on the screen, you can activate the Increase size of small diagrams checkbox and define the
minimum size of the diagrams.
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Rysunek 12.35: Vector properties dialog with diagram menu

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_2 gives an idea of the result.

10. Finally, click [Ok].

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression. See Expressions
chapter for more information and example.

12.3.10 Metadata Menu

The Metadata menu consists of Description, Attribution, MetadataURL and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and
location, number of features, feature type, and editing capabilities. The Extents table provides you with layer
extent information and the Layer Spatial Reference System, which is information about the CRS of the layer. This
is a quick way to get information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field. Use Attribution to get attribute data from an
XML metadata catalogue. In MetadataUrl, you can define the general path to the XML metadata catalogue. This
information will be saved in the QGIS project file for subsequent sessions and will be used for QGIS server.

.
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Rysunek 12.36: Diagram from temperature data overlayed on a map

Rysunek 12.37: Metadata menu in vector layers properties dialog
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12.4 Expressions

The Expressions feature are available through the field calculator or the add a new column button in the attribut
table or the Field tab in the Layer properties ; through the graduaded, categorized and rule-based rendering in the

Style tab of the Layer properties ; through the expression-based labeling in the Labeling core application
; through the feature selection and through the diagram tab of the Layer properties.

There are powerful way to manipulate attribute value in order to dynamicly change the final value in order to
change the geometry style, the content of the label, the value for diagram, select some feature or create virtual
column.

12.4.1 Functions List

The Function List contains functions as well as fields and values. View the help function in the Selected Func-
tion Help. In Expression you see the calculation expressions you create with the Function List. For the most
commonly used operators, see Operators.

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally,
you can use the various fields, values and functions to construct the calculation expression, or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side, the Field Values list opens with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provide several functions. In Operators,
you find mathematical operators. Look in Math for mathematical functions. The Conversions group contains
functions that convert one data type to another. The String group provides functions for data strings. In the
Geometry group, you find functions for geometry objects. With Record group functions, you can add a numeration
to your data set. To add a function to the Field calculator Expression box, click on the > and then double click the
function.

Operators

This group contains operators (e.g., +, -, *).

a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three

times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match
case-insensitive)

IS returns 1 if a is the same as b
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OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name, take

care to not be confused with simple
quote, see below

’string’ a string value, take care to not be
confused with double quote, see above

NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed

Some example:

• Joins a string and a value from a column name:

’My feature’s id is: ’ || "gid"

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
caracter):

"description" LIKE ’Hello%’

Conditionals

This group contains functions to handle conditional checks in expressions.

CASE evaluates multiple expressions and returns a
result

CASE ELSE evaluates multiple expressions and returns a
result

coalesce returns the first non-NULL value from the
expression list

regexp_match returns true if any part of a string matches
the supplied regular expression

Some example:

• Send back a value if the first condition is true, else another value:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’

Mathematical Functions

This group contains math functions (e.g., square root, sin and cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two

arguments to determine the quadrant of the
result

exp exponential of a value
ln value of the natural logarithm of the passed

expression
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log10 value of the base 10 logarithm of the passed
expression

log value of the logarithm of the passed value
and base

round round to number of decimal places
rand random integer within the range specified by

the minimum
and maximum argument (inclusive)

randf random float within the range specified by
the minimum
and maximum argument (inclusive)

max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified

range
scale_linear transforms a given value from an input

domain to an output
range using linear interpolation

scale_exp transforms a given value from an input
domain to an output
range using an exponential curve

floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Conversions

This group contains functions to convert one data type to another (e.g., string to integer, integer to string).

toint converts a string to integer number
toreal converts a string to real number
tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be

used to take days, hours, months, etc. off a
date)

Date and Time Functions

This group contains functions for handling date and time data.

$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from

an interval
month extract the month part from a date, or the number of months

from an interval
week extract the week number from a date, or the number of weeks

from an interval
day extract the day from a date, or the number of days from an

interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

Some example:
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• Get the month and the year of today in the format “10/2014”

month($now) || ’/’ || year($now)

String Functions

This group contains functions that operate on strings (e.g., that replace, convert to upper case).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title

case (all words lower case with leading
capital letter)

trim removes all leading and trailing white
space (spaces, tabs, etc.) from a string

wordwrap returns a string wrapped to a maximum/
minimum number of characters

length length of string a
replace returns a string with the supplied string

replaced
regexp_replace(a,this,that) returns a string with the supplied regular

expression replaced
regexp_substr returns the portion of a string which matches

a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression

in a string
left returns a substring that contains the n

leftmost characters of the string
right returns a substring that contains the n

rightmost characters of the string
rpad returns a string with supplied width padded

using the fill character
lpad returns a string with supplied width padded

using the fill character
format formats a string using supplied arguments
format_number returns a number formatted with the locale

separator for thousands (also truncates the
number to the number of supplied places)

format_date formats a date type or string into a custom
string format

Color Functions

This group contains functions for manipulating colors.

color_rgb returns a string representation of a color based on its
red, green, and blue components

color_rgba returns a string representation of a color based on its
red, green, blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its

hue, saturation, and lightness attributes
color_hsla returns a string representation of a color based on its

hue, saturation, lightness and alpha (transparency)
attributes

color_hsv returns a string representation of a color based on its
hue, saturation, and value attributes

color_hsva returns a string representation of a color based on its
hue, saturation, value and alpha (transparency) attributes
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color_cmyk returns a string representation of a color based on its
cyan, magenta, yellow and black components

color_cmyka returns a string representation of a color based on its
cyan, magenta, yellow, black and alpha (transparency)
components

Geometry Functions

This group contains functions that operate on geometry objects (e.g., length, area).

$geometry returns the geometry of the current feature (can be used
for processing with other functions)

$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
$y returns the y coordinate of the current feature
xat retrieves the nth x coordinate of the current feature.

n given as a parameter of the function
yat retrieves the nth y coordinate of the current feature.

n given as a parameter of the function
xmin returns the minimum x coordinate of a geometry.

Calculations are in the Spatial Reference System of this
Geometry

xmax returns the maximum x coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymin returns the minimum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

ymax returns the maximum y coordinate of a geometry.
Calculations are in the Spatial Reference System of this
Geometry

geomFromWKT returns a geometry created from a well-known text (WKT)
representation

geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space

together
intersects returns 1 if the geometries spatially intersect

(share any portion of space) and 0 if they don’t
touches returns 1 if the geometries have at least one point in

common, but their interiors do not intersect
crosses returns 1 if the supplied geometries have some, but not

all, interior points in common
contains returns true if and only if no points of b lie in the

exterior of a, and at least one point of the interior
of b lies in the interior of a

overlaps returns 1 if the geometries share space, are of the
same dimension, but are not completely contained by
each other

within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose

distance from this geometry is less than or equal to
distance

centroid returns the geometric center of a geometry
bounds returns a geometry which represents the bounding box of

an input geometry. Calculations are in the Spatial
Reference System of this Geometry.

bounds_width returns the width of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.
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bounds_height returns the height of the bounding box of a geometry.
Calculations are in the Spatial Reference System of
this Geometry.

convexHull returns the convex hull of a geometry (this represents
the minimum convex geometry that encloses all geometries
within the set)

difference returns a geometry that represents that part of geometry
a that does not intersect with geometry b

distance returns the minimum distance (based on spatial ref)
between two geometries in projected units

intersection returns a geometry that represents the shared portion
of geometry a and geometry b

symDifference returns a geometry that represents the portions of a and
b that do not intersect

combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of

the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata

Record Functions

This group contains functions that operate on record identifiers.

$rownum returns the number of the current row
$id returns the feature id of the current row
$currentfeature returns the current feature being evaluated.

This can be used with the ’attribute’ function
to evaluate attribute values from the current
feature.

$scale returns the current scale of the map canvas
$uuid generates a Universally Unique Identifier (UUID)

for each row. Each UUID is 38 characters long.
getFeature returns the first feature of a layer matching a

given attribute value.
attribute returns the value of a specified attribute from

a feature.
$map returns the id of the current map item if the map

is being drawn in a composition, or "canvas" if
the map is being drawn within the main QGIS
window.

Fields and Values

Contains a list of fields from the layer. Sample values can also be accessed via right-click.

Select the field name from the list, then right-click to access a context menu with options to load sample values
from the selected field.

Fields name should be double-quoted. Values or string should be simple-quoted.

.

12.5 Editing

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Informacja: The procedure for editing GRASS layers is different - see section Digitizing and editing a GRASS
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vector layer for details.

Wskazówka: Concurrent Edits
This version of QGIS does not track if somebody else is editing a feature at the same time as you are. The last
person to save their edits wins.

12.5.1 Setting the Snapping Tolerance and Search Radius

Before we can edit vertices, we must set the snapping tolerance and search radius to a value that allows us an
optimal editing of the vector layer geometries.

Snapping tolerance

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QGIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. A layer-based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer-based snapping overrides the global snapping option set in the Digitizing tab. So, if you need
to edit one layer and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer that
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Rysunek 12.38: Edit snapping options on a layer basis
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Search radius

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing, and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project- wide snapping tolerance.

12.5.2 Zooming and Panning

Before editing a layer, you should zoom in to your area of interest. This avoids waiting while all the vertex markers
are rendered across the entire layer.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

Zooming and panning with the mouse wheel

While digitizing, you can press the mouse wheel to pan inside of the main window, and you can roll the mouse
wheel to zoom in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Panning with the arrow keys

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area,
and click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow
key to pan south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.

12.5.3 Topological editing

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, you can activate the column Avoid Int., which avoids intersection of new polygons.

Enable topological editing

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic, so you only have to move the vertex once, and QGIS will
take care of updating the other boundary.
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Avoid intersections of new polygons

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons, avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitize the second one such that both intersect, and QGIS then cuts the second
polygon to the common boundary. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Enable snapping on intersections

Another option is to use Enable snapping on intersection. It allows you to snap on an intersection of back-
ground layers, even if there’s no vertex on the intersection.

12.5.4 Digitizing an existing layer

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Advanced digitizing. You can select and unselect both under View
→ Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Icon Purpose Icon Purpose

Current edits Toggle editing

Adding Features: Capture Point Adding Features: Capture Line

Adding Features: Capture Polygon Move Feature

Node Tool Delete Selected

Cut Features Copy Features

Paste Features Save layer edits

Table Editing: Vector layer basic editing toolbar

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for a given layer.

Alternatively, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.

Wskazówka: Save Regularly

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Adding Features

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to put the QGIS cursor into
digitizing mode.

For each feature, you first digitize the geometry, then enter its attributes. To digitize the geometry, left-click on
the map area to create the first point of your new feature.
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For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing menu under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature and Reuse last entered
attribute values.

Rysunek 12.39: Enter Attribute Values Dialog after digitizing a new vector feature

With the Move Feature(s) icon on the toolbar, you can move existing features.

Wskazówka: Attribute Value Types
For editing, the attribute types are validated during entry. Because of this, it is not possible to enter a number into
a text column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the attributes
in a second step within the Attribute table dialog.

Current Edits

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

The same functions are available for editing all layers of the project.

Node Tool

For shapefile-based layers as well as SpatialLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle Spatial tables,

the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It is possible to
simply select multiple vertices at once and to move, add or delete them altogether. The node tool also works with
‘on the fly’ projection turned on, and it supports the topological editing feature. This tool is, unlike other tools in
QGIS, persistent, so when some operation is done, selection stays active for this feature and tool. If the node tool
is unable to find any features, a warning will be displayed.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e., 10). Otherwise, QGIS will not be able to tell which vertex is being edited.

Wskazówka: Vertex Markers
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.
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Basic operations

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Deleting vertices: After selecting vertices for deletion, click the Delete key. Note that you cannot use the
Node Tool to delete a complete feature; QGIS will ensure it retains the minimum number of vertices for

the feature type you are working on. To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move. Click on a selected vertex or edge and drag in
the direction you wish to move. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Cutting, Copying and Pasting Features

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However, in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

As an example, we will copy some lakes to a new layer:

1. Load the layer you want to copy from (source layer)

2. Load or create the layer you want to copy to (target layer)

3. Start editing for target layer

4. Make the source layer active by clicking on it in the legend

5. Use the Select Single Feature tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Make the destination layer active by clicking on it in the legend

8. Click on the Paste Features tool
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9. Stop editing and save the changes

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Wskazówka: Congruency of Pasted Features
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Deleting Selected Features

If we want to delete an entire polygon, we can do that by first selecting the polygon using the regular
Select Single Feature tool. You can select multiple features for deletion. Once you have the selection set, use the

Delete Selected tool to delete the features.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Saving Edited Layers

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Wskazówka: Data Integrity
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.
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12.5.5 Advanced digitizing

Icon Purpose Icon Purpose

Undo Redo

Rotate Feature(s) Simplify Feature

Add Ring Add Part

Fill Ring Delete Ring

Delete Part Reshape Features

Offset Curve Split Features

Split Parts Merge Selected Features

Merge Attributes of Selected Features Rotate Point Symbols

Table Advanced Editing: Vector layer advanced editing toolbar

Undo and Redo

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Rysunek 12.40: Redo and Undo digitizing steps

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example, changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

To use the undo/redo history widget, simply click to select an operation in the history list. All features will be
reverted to the state they were in after the selected operation.

Rotate Feature(s)

Use Rotate Feature(s) to rotate one or multiple selected features in the map canvas. You first need to select the

features and then press the Rotate Feature(s) icon. The centroid of the feature(s) appears and will be the rotation
anchor point. If you selected multiple features, the rotation anchor point will be the common center of the features.
Press and drag the left mouse button in the desired direction to rotate the selected features.

It’s also possible to create a user-defined rotation anchor point around which the selected feature will rotate. Select

the features to rotate and activate the Rotate Feature(s) tool. Press and hold the Ctrl button and move the mouse
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pointer (without pressing the mouse button) to the place where you want the rotation anchor to be moved. Release
the Ctrl button when the desired rotation anchor point is reached. Now, press and drag the left mouse button in
the desired direction to rotate the selected feature(s).

Simplify Feature

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change and geometry type is not a multi geometry. First, select a feature. It will be highlighted by a red
rubber band and a slider will appear. Moving the slider, the red rubber band will change its shape to show how
the feature is being simplified. Click [OK] to store the new, simplified geometry. If a feature cannot be simplified
(e.g. multi-polygons), a message will appear.

Add Ring

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Add Part

You can add part polygons to a selected multipolygon. The new part polygon must be digitized outside the
selected multi-polygon.

Fill Ring

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Thus you need not first use the Add Ring icon and then the Add feature function anymore.

Delete Ring

The Delete Ring tool allows you to delete ring polygons inside an existing area. This tool only works with
polygon layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used
on polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.

Delete Part

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). It won’t delete the last part of the feature; this last part will stay untouched. This tool works with all
multi-part geometries: point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.

Reshape Features

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
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to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

For example, you can edit the boundary of a polygon with this tool. First, click in the inner area of the polygon
next to the point where you want to add a new vertex. Then, cross the boundary and add the vertices outside the
polygon. To finish, right-click in the inner area of the polygon. The tool will automatically add a node where the
new line crosses the border. It is also possible to remove part of the area from the polygon, starting the new line
outside the polygon, adding vertices inside, and ending the line outside the polygon with a right click.

Informacja: The reshape tool may alter the starting position of a polygon ring or a closed line. So, the point that
is represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Offset Curves

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar.

To create a shift of a line layer, you must first go into editing mode and then select the feature. You can make

the Offset Curve tool active and drag the cross to the desired distance. Your changes may then be saved with the
Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.

Split Features

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Split parts

In QGIS 2.0 it is now possible to split the parts of a multi part feature so that the number of parts is increased. Just

draw a line across the part you want to split using the Split Parts icon.

Merge selected features

The Merge Selected Features tool allows you to merge features that have common boundaries. A new dialog will
allow you to choose which value to choose between each selected features or select a fonction (Minimum, Maxi-
mum, Median, Sum, Skip Attribute) to use for each column.

Merge attributes of selected features

The Merge Attributes of Selected Features tool allows you to merge attributes of features with common boundaries

and attributes without merging their boundaries. First, select several features at once. Then press the
Merge Attributes of Selected Features button. Now QGIS asks you which attributes are to be applied to all selected objects.
As a result, all selected objects have the same attribute entries.
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Rotate Point Symbols

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Rysunek 12.41: Rotate Point Symbols

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

Informacja: If you hold the Ctrl key pressed, the rotation will be done in 15 degree steps.

12.5.6 Creating new Vector layers

QGIS allows you to create new shapefile layers, new SpatiaLite layers, and new GPX layers. Creation of a new
GRASS layer is supported within the GRASS plugin. Please refer to section Creating a new GRASS vector layer
for more information on creating GRASS vector layers.

Creating a new Shapefile layer

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name
for the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has
been created, it will be added to the map, and you can edit it in the same way as described in section Digitizing an
existing layer above.
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Rysunek 12.42: Creating a new Shapefile layer Dialog

Creating a new SpatiaLite layer

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_6.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitizing an existing layer above.

Further management of SpatiaLite layers can be done with the DB Manager. See DB Manager Plugin.

Creating a new GPX layer

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.
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Rysunek 12.43: Creating a New SpatiaLite layer Dialog
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12.5.7 Working with the Attribute Table

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Rysunek 12.44: Attribute Table for regions layer

Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Field Calculator). The query result can then be saved as a new vector layer. For example, if you want to find
regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and Values
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menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all unique
values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Query Builder.

To show selected records only, use Show Selected Features from the menu at the bottom left.

The other buttons at the top of the attribute table window provide the following functionality:

• Toggle editing mode to edit single values and to enable functionalities described below (also with Ctrl+E)

• Save Edits (also with Ctrl+S)

• Unselect all (also with Ctrl+U)

• Move selected to top (also with Ctrl+T)

• Invert selection (also with Ctrl+R)

• Copy selected rows to clipboard (also with Ctrl+C)

• Zoom map to the selected rows (also with Ctrl+J)

• Pan map to the selected rows (also with Ctrl+P)

• Delete selected features (also with Ctrl+D)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+W)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+L)

• Open field calculator (also with Ctrl+I)

Below these buttons is the Field Calculator bar, which allows calculations to be quickly applied attributes visible

in the table. This bar uses the same expressions as the Field Calculator (see Field Calculator).

Wskazówka: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Legenda mapy). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.
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Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Fields Menu to find out more.

12.5.8 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

Rysunek 12.45: Alaska region with airports

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).
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This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.

Layers

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demostrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in
Settings → Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Rysunek 12.46: Relation Manager

12.5. Editing 131



QGIS User Guide, Wydanie 2.6

Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Rysunek 12.47: Identification dialog regions with relation to airports

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

.
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Rysunek 12.48: Identification dialog airport with relation to regions

12.6 Query Builder

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause and to display the
result in the main window. The query result can then be saved as a new vector layer.

12.6.1 Query

Open the Query Builder by opening the Layer Properties and going to the General menu. Under Feature subset,
click on the [Query Builder] button to open the Query builder. For example, if you have a regions layer with a
TYPE_2 field, you could select only regions that are borough in the Provider specific filter expression box of the
Query Builder. Figure_attributes_2 shows an example of the Query Builder populated with the regions.shp
layer from the QGIS sample data. The Fields, Values and Operators sections help you to construct the SQL-like
query.

Rysunek 12.49: Query Builder

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
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the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Ankorage, because that is a ‘Manicpality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

.

12.7 Field Calculator

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

Wskazówka: Virtual Fields
• Virtual fields are not permanent and are not saved.

• To make a field virtual it must be done when the field is made.

The field calculator is now available on any layer that supports edit. When you click on the field calculator icon
the dialog opens (see figure_attributes_3). If the layer is not in edit mode, a warning is displayed and using the
field calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar in top of the attribute table is only visible if the layer is editable.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on Update All button.

In the field calculator dialog, you first must select whether you want to only update selected features, create a new
attribute field where the results of the calculation will be added or update an existing field.

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how the field calculator works. We want to calculate the length in km of the
railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.
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Rysunek 12.50: Field Calculator
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4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Complete the expression by typing ‘’/ 1000” in the Field calculator expression box and click [Ok].

7. You can now find a new field length in the attribute table.

The available functions are listed in Expressions chapter.

.
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Working with Raster Data

.

13.1 Working with Raster Data

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

As of the date of this document, more than 100 raster formats are supported by the GDAL library
(see GDAL-SOFTWARE-SUITE in Literature and Web References). A complete list is available at
http://www.gdal.org/formats_list.html.

Informacja: Not all of the listed formats may work in QGIS for various reasons. For example, some require
external commercial libraries, or the GDAL installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
raster into QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Working with GRASS raster data is described in section GRASS GIS Integration.

13.1.1 What is raster data?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.
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Once a raster layer is loaded in the map legend, you can click on the layer name with the right mouse button to
select and activate layer-specific features or to open a dialog to set raster properties for the layer.

Right mouse button menu for raster layers

• Zoom to Layer Extent

• Zoom to Best Scale (100%)

• Stretch Using Current Extend

• Show in Overview

• Remove

• Duplicate

• Set Layer CRS

• Set Project CRS from Layer

• Save as ...

• Properties

• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

.

13.2 Raster Properties Dialog

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog
(see figure_raster_1).

There are several menus in the dialog:

• General

• Style

• Transparency

• Pyramids

• Histogram

• Metadata

13.2.1 General Menu

Layer Info

The General menu displays basic information about the selected raster, including the layer source path, the display
name in the legend (which can be modified), and the number of columns, rows and no-data values of the raster.
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Rysunek 13.1: Raster Layers Properties Dialog

Coordinate reference system

Here, you find the coordinate reference system (CRS) information printed as a PROJ.4 string. If this setting is not
correct, it can be modified by clicking the [Specify] button.

Scale Dependent visibility

Additionally scale-dependent visibility can be set in this tab. You will need to check the checkbox and set an
appropriate scale where your data will be displayed in the map canvas.

At the bottom, you can see a thumbnail of the layer, its legend symbol, and the palette.

13.2.2 Style Menu

Band rendering

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands)

2. Paletted - if a single band file comes with an indexed palette (e.g., used with a digital topographic map)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continous palette (e.g., used with a shaded relief
map)

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map)
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Multiband color

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. You can choose several Contrast
enhancement methods: ‘No enhancement’, ‘Stretch to MinMax’, ‘Stretch and clip to MinMax’ and ‘Clip to min
max’.

Rysunek 13.2: Raster Renderer - Multiband color

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Wskazówka: Viewing a Single Band of a Multiband Raster
If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to “Not Set”. But this is not the correct way. To display the Red band, set the image type to
‘Singleband gray’, then select Red as the band to use for Gray.

Paletted

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS 2.2.
it’s now possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Contrast enhancement

Informacja: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to
stretch to min max, regardless of if this is set to another value in the QGIS general options.
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Rysunek 13.3: Raster Renderer - Paletted

Singleband gray

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Rysunek 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Singleband pseudocolor

13.2. Raster Properties Dialog 141



QGIS User Guide, Wydanie 2.6

This is a render option for single-band files, including a continous palette. You can also create individual color
maps for the single bands here. Three types of color interpolation are available:

Rysunek 13.5: Raster Renderer - Singleband pseudocolor

1. Discrete

2. Linear

3. Exact

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
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original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Color rendering

For every Band rendering, a Color rendering is possible.

You can also achieve special rendering effects for your raster file(s) using one of the blending modes (see The
Vector Properties Dialog).

Further settings can be made in modifiying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Resampling

The Resampling option makes its appearance when you zoom in and out of an image. Resampling modes can
optimize the appearance of the map. They calculate a new gray value matrix through a geometric transformation.

Rysunek 13.6: Raster Rendering - Resampling

When applying the ‘Nearest neighbour’ method, the map can have a pixelated structure when zooming in. This
appearance can be improved by using the ‘Bilinear’ or ‘Cubic’ method, which cause sharp features to be blurred.
The effect is a smoother image. This method can be applied, for instance, to digital topographic raster maps.

13.2.3 Transparency Menu

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Additionally, you can enter a raster value that should be treated as NODATA in the Additional no data value menu.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are neccessary:
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1. Load the raster file landcover.tif.

2. Open the Properties dialog by double-clicking on the raster name in the legend, or by right-clicking and
choosing Properties from the pop-up menu.

3. Select the Transparency menu.

4. From the Transparency band menu, choose ‘None’.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Enter the raster value in the ‘From’ and ‘To’ column (we use 0 here), and adjust the transparency to 20%.

7. Press the [Apply] button and have a look at the map.

You can repeat steps 5 and 6 to adjust more values with custom transparency.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Pyramids Menu

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

You must have write access in the directory where the original data is stored to build pyramids.

Several resampling methods can be used to calculate the pyramids:

• Nearest Neighbour

• Average

• Gauss

• Cubic

• Mode

• None

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

Please note that building pyramids may alter the original data file, and once created they cannot be removed. If
you wish to preserve a ‘non-pyramided’ version of your raster, make a backup copy prior to building pyramids.

13.2.5 Histogram Menu

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.
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Rysunek 13.7: The Pyramids Menu

Rysunek 13.8: Raster Histogram
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13.2.6 Metadata Menu

The Metadata menu displays a wealth of information about the raster layer, including statistics about each band in
the current raster layer. From this menu, entries may be made for the Description, Attribution, MetadataUrl and
Properties. In Properties, statistics are gathered on a ‘need to know’ basis, so it may well be that a given layer’s
statistics have not yet been collected.

Rysunek 13.9: Raster Metadata

.

13.3 Raster Calculator

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

13.3.1 Examples

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:
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Rysunek 13.10: Raster Calculator

"elevation@1" * 3.28

Using a mask

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("eleevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

.
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ROZDZIAŁ 14

Working with OGC Data

.

14.1 QGIS as OGC Data Client

The Open Geospatial Consortium (OGC) is an international organization with membership of more than 300
commercial, governmental, nonprofit and research organizations worldwide. Its members develop and implement
standards for geospatial content and services, GIS data processing and exchange.

Describing a basic data model for geographic features, an increasing number of specifications are developed
by OGC to serve specific needs for interoperable location and geospatial technology, including GIS. Further
information can be found at http://www.opengeospatial.org/.

Important OGC specifications supported by QGIS are:

• WMS — Web Map Service (WMS/WMTS Client)

• WMTS — Web Map Tile Service (WMS/WMTS Client)

• WFS — Web Feature Service (WFS and WFS-T Client)

• WFS-T — Web Feature Service - Transactional (WFS and WFS-T Client)

• WCS — Web Coverage Service (WCS Client)

• SFS — Simple Features for SQL (Warstwy PostGIS)

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section Warstwy PostGIS).

14.1.1 WMS/WMTS Client

Overview of WMS Support

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.
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WMS layers can be added quite simply, as long as you know the URL to access the WMS server, you have a
serviceable connection to that server, and the server understands HTTP as the data transport mechanism.

Overview of WMTS Support

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

In order to display the data at a variety of scales close to what the user might want, the WMTS tile sets are
produced at several different scale levels and are made available for the GIS client to request them.

This diagram illustrates the concept of tile sets:

Rysunek 14.1: Concept of WMTS tile sets

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

An example of this type of address is

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

For testing the topo2 layer in this WMTS works nicely. Adding this string indicates that a WMTS web service is
to be used instead of a WMS service.

2. The RESTful WMTS service takes a different form, a straightforward URL. The format recommended by
the OGC is:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by simply
adding its address in the WMS setup in the URL field of the form. An example of this type of address for the case
of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Informacja: You can still find some old services called WMS-C. These services are quite similar to WMTS
(i.e., same purpose but working a little bit differently). You can manage them the same as you do WMTS services.
Just add ?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.
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When you read WMTS, you can often think WMS-C also.

Selecting WMS/WMTS Servers

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some servers
to play with by clicking the [Add default servers] button. This will add two WMS demo servers for you to use:
the WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the Layers tab, select
the [New] button. Then enter the parameters to connect to your desired WMS server, as listed in table_OGC_1:

Name A name for this connection. This name will be used in the Server Connections drop-down
box so that you can distinguish it from other WMS servers.

URL URL of the server providing the data. This must be a resolvable host name – the same
format as you would use to open a telnet connection or ping a host.

Username Username to access a secured WMS server. This parameter is optional.
Password Password for a basic authenticated WMS server. This parameter is optional.

Ignore GetMap
URI

Ignore GetMap URI reported in capabilities. Use given URI from URL field above.

Ignore
GetFeatureInfo
URI

Ignore GetFeatureInfo URI reported in capabilities. Use given URI from URL field
above.

Table OGC 1: WMS Connection Parameters

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Wskazówka: On WMS Server URLs
Be sure, when entering the WMS server URL, that you have the base URL only. For example, you shouldn’t have
fragments such as request=GetCapabilities or version=1.0.0 in your URL.

Loading WMS/WMTS Layers

Once you have successfully filled in your parameters, you can use the [Connect] button to retrieve the capabilities
of the selected server. This includes the image encoding, layers, layer styles and projections. Since this is a
network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the lower left of the
WMS dialog.

Your screen should now look a bit like figure_OGR_1, which shows the response provided by the DM Solutions
Group WMS server.

Image Encoding

The Image encoding section lists the formats that are supported by both the client and server. Choose one depend-
ing on your image accuracy requirements.

Wskazówka: Image Encoding
You will typically find that a WMS server offers you the choice of JPEG or PNG image encoding. JPEG is a lossy
compression format, whereas PNG faithfully reproduces the raw raster data.
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Rysunek 14.2: Dialog for adding a WMS server, showing its available layers
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Use JPEG if you expect the WMS data to be photographic in nature and/or you don’t mind some loss in picture
quality. This trade-off typically reduces by five times the data transfer requirement compared with PNG.

Use PNG if you want precise representations of the original data and you don’t mind the increased data transfer
requirements.

Options

The Options area of the dialog provides a text field where you can add a Layer name for the WMS layer. This
name will appear in the legend after loading the layer.

Below the layer name, you can define Tile size if you want to set tile sizes (e.g., 256x256) to split up the WMS
request into multiple requests.

The Feature limit for GetFeatureInfo defines what features from the server to query.

If you select a WMS from the list, a field with the default projection provided by the mapserver appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS
provided by the WMS server.

Layer Order

The Layer Order tab lists the selected layers available from the current connected WMS server. You may notice
that some layers are expandable; this means that the layer can be displayed in a choice of image styles.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Wskazówka: WMS Layer Ordering
WMS layers rendered by a server are overlaid in the order listed in the Layers section, from top to bottom of the
list. If you want to change the overlay order, you can use the Layer Order tab.

Transparency

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Wskazówka: WMS Layer Transparency
The availability of WMS image transparency depends on the image encoding used: PNG and GIF support trans-
parency, whilst JPEG leaves it unsupported.

Coordinate Reference System

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Each WMS layer can be presented in multiple CRSs, depending on the capability of the WMS server.

To choose a CRS, select [Change...] and a dialog similar to Figure Projection 3 in Praca z układami współrzędnych
will appear. The main difference with the WMS version of the dialog is that only those CRSs supported by the
WMS server will be shown.

Server search

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
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Rysunek 14.3: Dialog for searching WMS servers after some keywords

of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Basically, this option is a front end to the API of http://geopole.org.

Tilesets

When using WMTS (Cached WMS) services like

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE and Windows) or View → Panels (Gnome and MacOSX), then choosing Tile
scale. This gives you the available scales from the tile server with a nice slider docked in.

Using the Identify Tool

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Format selection

If multiple output formats are supported by the server, a combo box with supported formats is automatically added
to the identify results dialog and the selected format may be stored in the project for the layer. GML format
support

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
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are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Viewing Properties

Once you have added a WMS server, you can view its properties by right-clicking on it in the legend and selecting
Properties. Metadata Tab

The tab Metadata displays a wealth of information about the WMS server, generally collected from the capabilities
statement returned from that server. Many definitions can be gleaned by reading the WMS standards (see OPEN-
GEOSPATIAL-CONSORTIUM in Literature and Web References), but here are a few handy definitions:

• Server Properties

– WMS Version — The WMS version supported by the server.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Layer Properties

– Selected — Whether or not this layer was selected when its server was added to this project.

– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Can Identify — Whether or not this layer will return any results when the Identify tool is used on it.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Cascade Count — WMS servers can act as a proxy to other WMS servers to get the raster data for a
layer. This entry shows how many times the request for this layer is forwarded to peer WMS servers
for a result.
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– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Available in CRS — The projections that this layer can be rendered in by the WMS server. These are
listed in the WMS-native format.

– Available in style — The image styles that this layer can be rendered in by the WMS server.

Show WMS legend graphic in table of contents and composer

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

If a legendGraphic is available, it is shown below the layer. It is little and you have to click on it to open it in real
dimension (due to QgsLegendInterface architectural limitation). Clicking on the layer’s legend will open a frame
with the legend at full resolution.

In the print composer, the legend will be integrated at it’s original (dowloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend -> WMS LegendGraphic to match your printing
requirements

The legend will display contextual information based on your current scale. The WMS legend will be shown only
if the WMS server has GetLegendGraphic capability and the layer has getCapability url specified, so you have to
select a styling.

WMS Client Limitations

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

Editing WMS Layer Settings

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

WMS Servers Requiring Authentication

Currently, publicly accessible and secured WMS services are supported. The secured WMS servers can be ac-
cessed by public authentication. You can add the (optional) credentials when you add a WMS server. See section
Selecting WMS/WMTS Servers for details.

Wskazówka: Accessing secured OGC-layers
If you need to access secured layers with secured methods other than basic authentication, you can use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found in the
InteProxy manual at http://inteproxy.wald.intevation.org.

Wskazówka: QGIS WMS Mapserver
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.
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14.1.2 WCS Client

A Web Coverage Service (WCS) provides access to raster data in forms that are useful for client-side render-
ing, as input into scientific models, and for other clients. The WCS may be compared to the WFS and the WMS.
As WMS and WFS service instances, a WCS allows clients to choose portions of a server’s information holdings
based on spatial constraints and other query criteria.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

14.1.3 WFS and WFS-T Client

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

In general, adding a WFS layer is very similar to the procedure used with WMS. The difference is that there are
no default servers defined, so we have to add our own.

Loading a WFS Layer

As an example, we use the DM Solutions WFS server and display a layer. The URL is:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Click on the Add WFS Layer tool on the Layers toolbar. The Add WFS Layer from a Server dialog appears.

2. Click on [New].

3. Enter ‘DM Solutions’ as name.

4. Enter the URL (see above).

5. Click [OK].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Click [Connect].

8. Wait for the list of layers to be populated.

9. Select the Parks layer in the list.

10. Click [Apply] to add the layer to the map.

Note that any proxy settings you may have set in your preferences are also recognized.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Only WFS 1.0.0 is supported. At this time, there have not been many tests against WFS versions implemented in
other WFS servers. If you encounter problems with any other WFS server, please do not hesitate to contact the
development team. Please refer to section Pomoc i wsparcie for further information about the mailing lists.

Wskazówka: Finding WFS Servers
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

.
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Rysunek 14.4: Adding a WFS layer

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd). It
is funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In one of the following manuals, we will provide a sample configuration to set up a QGIS Server. For now, we
recommend to read one of the following URLs to get more information:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Sample installation on Debian Squeeze

At this point, we will give a short and simple sample installation how-to for Debian Squeeze. Many other OSs
provide packages for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

Apart from QGIS and QGIS Server, you need a web server, in our case apache2. You can install all packages with
aptitude or apt-get install together with other necessary dependency packages. After installation, you
should test to confirm that the web server and QGIS Server work as expected. Make sure the apache server is
running with /etc/init.d/apache2 start. Open a web browser and type URL: http://localhost.
If apache is up, you should see the message ‘It works!’.

Now we test the QGIS Server installation. The qgis_mapserv.fcgi is available at
/usr/lib/cgi-bin/qgis_mapserv.fcgi and provides a standard WMS that shows the state boundaries
of Alaska. Add the WMS with the URL http://localhost/cgi-bin/qgis_mapserv.fcgi as
described in Selecting WMS/WMTS Servers.
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Rysunek 14.5: Standard WMS with USA boundaries included in the QGIS Server (KDE)
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14.2.2 Creating a WMS/WFS/WCS from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Rysunek 14.6: Definitions for a QGIS Server WMS/WFS/WCS project (KDE)

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRS from the Coordinate Reference System Selector, or click Used to
add the CRS used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetCapabilities response, and they
can be used by the GetPrint request to create prints, using one of the print composer layouts as a template. This
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is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries at once.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format choosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of his attributes, also this information will be shown
in the GetFeatureInfo output.

WFS capabilities

In the WFS capabilities area, you can select the layers that you want to publish as WFS, and specify if they
will allow the update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS
capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, we create a new
folder /usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a
copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Loading
WMS/WMTS Layers, WFS and WFS-T Client and WCS Client to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

Fine tuning your OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you want a specific
attribute not to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See section Annotation Tools in Podstawowe narzędzia for instructions on creating annotations.
For annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the
Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of
the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths
(in the General menu of the Project → Project Properties dialog) or to manually modify the path to the SVG
image in a way that it represents a valid relative path.

Extra parameters supported by the WMS GetMap request

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OCG WMS 1.3.0 specification:
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• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• DPI parameter: The DPI parameter can be used to specify the requested output resolution.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• OPACITIES parameter: Opacity can be set on layer or group level. Allowed values range from 0 (fully
transparent) to 255 (fully opaque).

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

QGIS Server logging

To log requests send to server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that server has proper permissions
for writing to file. File should be created automatically, just send some requests to server. If it’s not there,
check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. Available values are:

– 0 INFO (log all requests),

– 1 WARNING,

– 2 CRITICAL (log just critical errors, suitable for production purposes).

Example:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note

• When using Fcgid module use FcgidInitialEnv instead of SetEnv!

• Server logging is enabled also if executable is compiled in release mode.

Environment variables

• QGIS_OPTIONS_PATH: The variable specifies path to directory with settings. It works
the same ways as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini. For exaple, to set QGIS server on Apache to use
/path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

.
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Working with GPS Data

.

15.1 GPS Plugin

15.1.1 What is GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Loading GPS data from a file

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, two buttons with a small handheld GPS
device will show up in the toolbar:

• Create new GPX Layer

• GPS Tools

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Przykładowe dane for more infor-
mation about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Rysunek 15.1: The GPS Tools dialog window

Informacja: GPS units allow you to store data in different coordinate systems. When downloading a GPX
file (from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the
GPX file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importing GPS data

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

15.1.5 Downloading GPS data from a device

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Defining new device types).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• On Linux, this is something like /dev/ttyS0 or /dev/ttyS1.

• On Windows, it is COM1 or COM2.
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Rysunek 15.2: The download tool

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

15.1.6 Uploading GPS data to a device

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Defining new device types

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.

Once you have created a new device type, it will appear in the device lists for the download and upload tools.

15.1. GPS Plugin 165

http://www.gpsbabel.org


QGIS User Guide, Wydanie 2.6

15.1.8 Download of points/tracks from GPS units

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

After that is necessary to be sure that the garmin_gps kernel module is not loaded

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (only Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Use same command (or settings if you use GPSBabel GUI) as in Windows. On Linux it maybe somehow common
to get a message like

skytraq: Too many read errors on serial port

it is just a matter to turn off and on the datalogger and try again.

BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

Informacja: It needs to install its drivers before using it on Windows 7. See in the manufacturer site for the
proper download.

Downloading with GPSBabel, both with USB and BT returns always an error like

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1
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Ubuntu/Mint GNU/Linux

With USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

With Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

.

15.2 Live GPS tracking

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

There are four possible screens in this GPS tracking window:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Ostrzeżenie: If you want to record your position to the canvas, you have to create a new vector layer first and
switch it to editable status to be able to record your track.

15.2.1 Position and additional attributes

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 GPS signal strength

Here, you can see the signal strength of the satellites you are receiving signals from.

15.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Rysunek 15.3: GPS tracking position and additional attributes

Rysunek 15.4: GPS tracking signal strength
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Rysunek 15.5: GPS tracking polar window

15.2.4 GPS options

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Connect to a Bluetooth GPS for live tracking

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Remember the number of the COM port assigned to the GPS connection as resulting by the Bluetooth properties.

After the GPS has been recognized, make the pairing for the connection. Usually the autorization code is 0000.
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Rysunek 15.6: GPS tracking options window
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Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

15.2.6 Using GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Then load the garmin_gps kernel module

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

And finally connect with the QGIS live tracking tool.

15.2.7 Using BTGP-38KM datalogger (only Bluetooth)

Using GPSD (under Linux) or GPSGate (under Windows) is effortless.

15.2.8 Using BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

For USB

The live tracking works both with GPSD

gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

For Bluetooth

The live tracking works both with GPSD
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gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).

.
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GRASS GIS Integration

The GRASS plugin provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Lit-
erature and Web References). This includes visualizing GRASS raster and vector layers, digitizing vector layers,
editing vector attributes, creating new vector layers and analysing GRASS 2-D and 3-D data with more than 400
GRASS modules.

In this section, we’ll introduce the plugin functionalities and give some examples of managing and working with
GRASS data. The following main features are provided with the toolbar menu when you start the GRASS plugin,
as described in section sec_starting_grass:

• Open mapset

• New mapset

• Close mapset

• Add GRASS vector layer

• Add GRASS raster layer

• Create new GRASS vector

• Edit GRASS vector layer

• Open GRASS tools

• Display current GRASS region

• Edit current GRASS region

16.1 Starting the GRASS plugin

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore, go to the menu Plugins → Manage Plugins, select

GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section
sec_load_grassdata). Or, you can create a new GRASS LOCATION with QGIS (see section Creating a new
GRASS LOCATION) and import some raster and vector data (see section Importing data into a GRASS LOCA-
TION) for further analysis with the GRASS Toolbox (see section The GRASS Toolbox).
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16.2 Loading GRASS raster and vector layers

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu.
As an example, we will use the QGIS Alaska dataset (see section Przykładowe dane). It includes a small sample
GRASS LOCATION with three vector layers and one raster elevation map.

1. Create a new folder called grassdata, download the QGIS ‘Alaska’ dataset
qgis_sample_data.zip from http://download.osgeo.org/qgis/data/ and unzip the file into
grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase, browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click [OK]. The Alaska boundary
vector layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as
described in chapter The Vector Properties Dialog (e.g., change opacity, fill and outline color).

10. Also load the other two vector layers, rivers and airports, and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See the following sections for
editing GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the
GRASS website at http://grass.osgeo.org/download/sample-data/.

Wskazówka: GRASS Data Loading
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section Starting the GRASS plugin.

16.3 GRASS LOCATION and MAPSET

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Literature and Web References). In
order to analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION.
(This is not strictly true – with the GRASS modules r.external and v.external you can create read-only
links to external GDAL/OGR-supported datasets without importing them. But because this is not the usual way
for beginners to work with GRASS, this functionality will not be described here.)

16.3.1 Creating a new GRASS LOCATION

As an example, here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
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Rysunek 16.1: GRASS data in the alaska LOCATION

will be used for all examples and exercises in the following GRASS-related sections. It is useful to download and
install the dataset on your computer (see Przykładowe dane).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Ładowanie Shapefile) from the QGIS Alaska dataset (see
Przykładowe dane).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Adding
a new MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_location_2).

6. Enter a name for the LOCATION – we used ‘alaska’ – and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Praca z układami współrzędnych)).

9. In Filter, insert 2964 to select the projection.

10. Click [Next].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current |qg| extent], to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Click [Next].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Literature and Web References).

14. Check out the summary to make sure it’s correct and click [Finish].

15. The new LOCATION, ‘alaska’, and two MAPSETs, ‘demo’ and ‘PERMANENT’, are created. The currently
opened working set is ‘demo’, as you defined.
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16. Notice that some of the tools in the GRASS toolbar that were disabled are now enabled.

Rysunek 16.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importing data into a GRASS LOCATION). You
can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included in
the QGIS ‘Alaska’ dataset Przykładowe dane, and move on to section The GRASS vector data model.

16.3.2 Adding a new MAPSET

A user has write access only to a GRASS MAPSET he or she created. This means that besides access to your own
MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify or remove
only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Literature and Web References, and section The GRASS region
tool).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION ‘alaska’, where we
want to add a further MAPSET called ‘test’.

4. Click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Enter the name text for the new MAPSET. Below in the wizard, you see a list of existing MAPSETs and
corresponding owners.

7. Click [Next], check out the summary to make sure it’s all correct and click [Finish].

16.4 Importing data into a GRASS LOCATION

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset. Therefore, we use the landcover raster map landcover.img and the
vector GML file lakes.gml from the QGIS ‘Alaska’ dataset (see Przykładowe dane).
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1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS Toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Succesfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

16.5 The GRASS vector data model

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Attributes can be stored inside the GRASS LOCATION as dBase or SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.
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Attributes in database tables are linked to geometry elements using a ‘category’ value.

‘Category’ (key, ID) is an integer attached to geometry primitives, and it is used as the link to one key column in
the database table.

Wskazówka: Learning the GRASS Vector Model
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/documentation/manuals/ for
more information, books and tutorials in several languages.

16.6 Creating a new GRASS vector layer

To create a new GRASS vector layer with the GRASS plugin, click the Create new GRASS vector toolbar icon. Enter
a name in the text box, and you can start digitizing point, line or polygon geometries following the procedure
described in section Digitizing and editing a GRASS vector layer.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creating new Vector layers).

Wskazówka: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

16.7 Digitizing and editing a GRASS vector layer

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

Wskazówka: Digitizing polygons in GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason for this is that a topological vector model links the attribute information of a polygon always to the
centroid and not to the boundary.

Toolbar

In figure_grass_digitizing_1, you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.

Rysunek 16.3: GRASS Digitizing Toolbar
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Icon Tool Purpose

New Point Digitize new point

New Line Digitize new line

New
Boundary

Digitize new boundary (finish by selecting new tool)

New
Centroid

Digitize new centroid (label existing area)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move
element

Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line into two parts

Delete
element

Delete existing boundary, line, point or centroid (confirm selected element by another
click)

Edit
attributes

Edit attributes of selected element (note that one element can represent more features,
see above)

Close Close session and save current status (rebuilds topology afterwards)

Table GRASS Digitizing 1: GRASS Digitizing Tools

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Rysunek 16.4: GRASS Digitizing Category Tab

• Mode: The category value that will be applied to new geometry elements.

– Next not used - Apply next not yet used category value to geometry element.

– Manual entry - Manually define the category value for the geometry element in the ‘Category’ entry
field.

– No category - Do not apply a category value to the geometry element. This is used, for instance, for
area boundaries, because the category values are connected via the centroid.

• Category - The number (ID) that is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

16.7. Digitizing and editing a GRASS vector layer 179



QGIS User Guide, Wydanie 2.6

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. The default layer number is 1.

Wskazówka: Creating an additional GRASS ‘layer’ with |qg|
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab, you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Rysunek 16.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g., closed / opened boundary).

Rysunek 16.6: GRASS Digitizing Symbology Tab

Table Tab

The Table tab provides information about the database table for a given ‘layer’. Here, you can add new columns
to an existing attribute table, or create a new database table for a new GRASS vector layer (see section Creating a
new GRASS vector layer).

Wskazówka: GRASS Edit Permissions
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Rysunek 16.7: GRASS Digitizing Table Tab

You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permission.

16.8 The GRASS region tool

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon, you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution, and click [OK].
The dialog also allows you to select a new region interactively with your mouse on the QGIS canvas. Therefore,
click with the left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again
and click [OK].

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section The
GRASS Toolbox.

16.9 The GRASS Toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

16.9.1 Working with GRASS modules

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.
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Rysunek 16.8: GRASS Toolbox and Module Tree

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.6 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

It is also possible to customize the GRASS Toolbox content. This procedure is described in section Customizing
the GRASS Toolbox.

As shown in figure_grass_toolbox_1, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

Options

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Wskazówka: Display results immediately
If you want to display your calculation results immediately in your map canvas, you can use the ‘View Output’
button at the bottom of the module tab.
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Rysunek 16.9: GRASS Toolbox Module Options

Rysunek 16.10: GRASS Toolbox Module Output
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Rysunek 16.11: GRASS Toolbox Module Manual

16.9.2 GRASS module examples

The following examples will demonstrate the power of some of the GRASS modules.

Creating contour lines

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importing data into a GRASS LOCATION.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories, double-click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Working with
GRASS modules). The gtopo30 raster should appear as the Name of input raster.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Type into the Name for output vector map the name ctour_100.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [Close].

Since this is a large region, it will take a while to display. After it finishes rendering, you can open the layer
properties window to change the line color so that the contours appear clearly over the elevation raster, as in The
Vector Properties Dialog.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
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their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Wskazówka: The simplify tool
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Check that the ‘ctour_100’ vector appears as the Name of input vector.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].

• You may change the color of the vector to display it clearly on the raster background and to contrast with
the original contour lines. You will notice that the new contour lines have smoother corners than the original
while staying faithful to the original overall shape.

Rysunek 16.12: GRASS module v.generalize to smooth a vector map

Wskazówka: Other uses for r.contour
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The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.

Creating a Hillshade 3-D effect

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Then click r.shaded.relief to open the module.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• When the process completes, add the hillshade raster to the map. You should see it displayed in grayscale.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

You should now have the gtopo30 elevation with its colormap and transparency setting displayed above the
grayscale hillshade map. In order to see the visual effects of the hillshading, turn off the gtopo30_shade map,
then turn it back on.

Using the GRASS shell

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Raster statistics in a vector map

The next example shows how a GRASS module can aggregate raster data and add columns of statistics for each
polygon in a vector map.

• Again using the Alaska data, refer to Importing data into a GRASS LOCATION to import the trees shapefile
from the shapefiles directory into GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).
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Rysunek 16.13: The GRASS shell, r.shaded.relief module

Rysunek 16.14: Displaying shaded relief created with the GRASS module r.shaded.relief
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• From the Toolbox, choose Vector → Manage features, and open the module v.centroids.

• Enter as the output vector map ‘forest_areas’ and run the module.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Style Menu of the vector section.)

• Next, reopen the GRASS Toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30 and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.

16.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7,
you can see the current working LOCATION with its MAPSETs.

In the left browser windows, you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta-information for selected raster or vector layers (e.g., resolution, bounding box,
data source, connected attribute table for vector data, and a command history).

Rysunek 16.15: GRASS LOCATION browser

The toolbar inside the Browser tab offers the following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map
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• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.

16.9.4 Customizing the GRASS Toolbox

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.

A sample XML file for generating the module v.buffer (v.buffer.qgm) looks like this:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

.
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QGIS processing framework

.

17.1 Introduction

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

In the following sections, we will review how to use the graphical elements of this framework and make the most
out of each one of them.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox, as we will see) can be accessed from the Processing menu item. (You will see more than four
entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter.)

• The toolbox. The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

Rysunek 17.1: Processing Toolbox
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• The graphical modeler. Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

Rysunek 17.2: Processing Modeler

• The history manager. All actions performed using any of the aforementioned elements are stored in a history
file and can be later easily reproduced using the history manager.

• The batch processing interface. This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

In the following sections, we will review each one of these elements in detail.

.

17.2 The toolbox

The Toolbox is the main element of the processing GUI, and the one that you are more likely to use in your daily
work. It shows the list of all available algorithms grouped in different blocks, and it is the access point to run them,
whether as a single process or as a batch process involving several executions of the same algorithm on different
sets of inputs.

The toolbox contains all the available algorithms, divided into predefined groups. All these groups are found under
a single tree entry named Geoalgorithms.

Additionally, two more entries are found, namely Models and Scripts. These include user-created algorithms, and
they allow you to define your own workflows and processing tasks. We will devote a full section to them a bit
later.

In the upper part of the toolbox, you will find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those that contain the text you have entered in their
names.

In the lower part, you will find a box that allows you to switch between the simplified algorithm list (the one
explained above) and the advanced list. If you change to the advanced mode, the toolbox will look like this:
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Rysunek 17.3: Processing History

Rysunek 17.4: Batch Processing interface

17.2. The toolbox 193



QGIS User Guide, Wydanie 2.6

Rysunek 17.5: Processing Toolbox

Rysunek 17.6: Processing Toolbox (advanced mode)
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In the advanced view, each group represents a so-called ‘algorithm provider’, which is a set of algorithms coming
from the same source, for instance, from a third-party application with geoprocessing capabilities. Some of
these groups represent algorithms from third-party applications like SAGA, GRASS or R, while others contain
algorithms directly coded as part of the processing plugin, not relying on any additional software.

This view is recommended to those users who have a certain knowledge of the applications that are backing the
algorithms, since they will be shown with their original names and groups.

Also, some additional algorithms are available only in the advanced view, such as LiDAR tools and scripts based
on the R statistical computing software, among others. Independent QGIS plugins that add new algorithms to the
toolbox will only be shown in the advanced view.

In particular, the simplified view contains algorithms from the following providers:

• GRASS

• SAGA

• OTB

• Native QGIS algorithms

In the case of running QGIS under Windows, these algorithms are fully-functional in a fresh installation of QGIS,
and they can be run without requiring any additional installation. Also, running them requires no prior knowledge
of the external applications they use, making them more accesible for first-time users.

If you want to use an algorithm not provided by any of the above providers, switch to the advanced mode by
selecting the corresponding option at the bottom of the toolbox.

To execute an algorithm, just double-click on its name in the toolbox.

17.2.1 The algorithm dialog

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Rysunek 17.7: Parameters Dialog

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It of course has a different content, depending on the require-
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ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side, the value of the parameter can be set.

Although the number and type of parameters depend on the characteristics of the algorithm, the structure is similar
for all of them. The parameters found in the table can be of one of the following types.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see a button by each vector layer selector, as shown in the figure below.

Rysunek 17.8: Vector iterator button

If the algorithm contains several of them, you will be able to toggle just one of them. If the button corresponding to
a vector input is toggled, the algorithm will be executed iteratively on each one of its features, instead of just once
for the whole layer, producing as many outputs as times the algorithm is executed. This allows for automating the
process when all features in a layer have to be processed separately.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

Rysunek 17.9: Number Selector

• A range, with min and max values to be introduced in two text boxes.
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• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A coordinate reference system. You can type the EPSG code directly in the text box, or select it from the
CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you two options:
to select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

Rysunek 17.10: Extent selector

If you select the first option, you will see a window like the next one.

Rysunek 17.11: Extent List

If you select the second one, the parameters window will hide itself, so you can click and drag onto the
canvas. Once you have defined the selected rectangle, the dialog will reappear, containing the values in the
extent text box.

Rysunek 17.12: Extent Drag

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Click on the button on the right side to see the table and edit its values.
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Rysunek 17.13: Multiple Selection

Rysunek 17.14: Fixed Table
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Depending on the algorithm, the number of rows can be modified or not by using the buttons on the right
side of the window.

You will find a [Help] tab in the the parameters dialog. If a help file is available, it will be shown, giving you
more information about the algorithm and detailed descriptions of what each parameter does. Unfortunately, most
algorithms lack good documentation, but if you feel like contributing to the project, this would be a good place to
start.

A note on projections

Algorithms run from the processing framework — this is also true of most of the external applications whose
algorithms are exposed through it. Do not perform any reprojection on input layers and assume that all of them
are already in a common coordinate system and ready to be analized. Whenever you use more than one layer as
input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same coordinate
system.

Note that, due to QGIS‘s on-the-fly reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common
coordinate system. That reprojection should be done manually, and then the resulting files should be used as input
to the algorithm. Also, note that the reprojection process can be performed with the algorithms that are available
in the processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the processing configuration dialog, unchecking the Show CRS
option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown.

You still can execute the algorithm, but be aware that in most cases that will produce wrong results, such as empty
layers due to input layers not overlapping.

17.2.2 Data objects generated by algorithms

Data objects generated by an algorithm can be of any of the following types:

• A raster layer

• A vector layer

• A table

• An HTML file (used for text and graphical outputs)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but the architecture
allows for any other way of storing it. For instance, a vector layer can be stored in a database or even uploaded
to a remote server using a WFS-T service. Although solutions like these are not yet implemented, the processing
framework is prepared to handle them, and we expect to add new kinds of output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save file
dialog, where you can select the desired file path. Supported file extensions are shown in the file format selector
of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension (usually .dbf‘ for tables, .tif for raster layers and .shp for vector layers) will
be appended to the file path, and the file format corresponding to that extension will be used to save the layer or
table.
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If you do not enter any filename, the result will be saved as a temporary file in the corresponding default file
format, and it will be deleted once you exit QGIS (take care with that, in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
Processing menu), and in the General group, you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when executing an
algorithm.

When running an algorithm that uses a vector layer in iterative mode, the entered file path is used as the base path
for all generated files, which are named using the base name and appending a number representing the index of
the iteration. The file extension (and format) is used for all such generated files.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

For all the other types of output, you will find a checkbox that you can use to tell the algorithm whether to load
the file once it is generated by the algorithm or not. By default, all files are opened.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

17.2.3 Configuring the processing framework

As has been mentioned, the configuration menu gives access to a new dialog where you can configure how algo-
rithms work. Configuration parameters are structured in separate blocks that you can select on the left-hand side
of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Rendering styles can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles. You will see a dialog like the one shown
next.

Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are listed below:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.
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Rysunek 17.15: Rendering Styles

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

.

17.3 The graphical modeler

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead.
Using the graphical modeler, that chain of processes can be wrapped into a single process, so it is as easy and
convenient to execute as a single process later on a different set of inputs. No matter how many steps and different
algorithms it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger
models.

The modeler can be opened from the processing menu.

The modeler has a working canvas where the structure of the model and the workflow it represents are shown. On
the left part of the window, a panel with two tabs can be used to add new elements to the model.

Creating a model involves two steps:

1. Definition of necessary inputs. These inputs will be added to the parameters window, so the user can set their
values when executing the model. The model itself is an algorithm, so the parameters window is generated
automatically as it happens with all the algorithms available in the processing framework.

2. Definition of the workflow. Using the input data of the model, the workflow is defined by adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.

17.3.1 Definition of inputs

The first step to create a model is to define the inputs it needs. The following elements are found in the Inputs tab
on the left side of the modeler window:

• Raster layer
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Rysunek 17.16: Modeler

• Vector layer

• String

• Table field

• Table

• Extent

• Number

• Boolean

• File

Double-clicking on any of these elements, a dialog is shown to define its characteristics. Depending on the
parameter itself, the dialog may contain just one basic element (the description, which is what the user will see
when executing the model) or more of them. For instance, when adding a numerical value, as can be seen in the
next figure, apart from the description of the parameter, you have to set a default value and a range of valid values.

For each added input, a new element is added to the modeler canvas.

You can also add inputs by dragging the input type from the list and dropping it in the modeler canvas, in the
position where you want to place it.

17.3.2 Definition of the workflow

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.

The appearance of the toolbox has two modes here as well: simplified and advanced. However, there is no element
to switch between views in the modeler, so you have to do it in the toolbox. The mode that is selected in the toolbox
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Rysunek 17.17: Model Parameters

Rysunek 17.18: Model Parameters

Rysunek 17.19: Model Parameters
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is the one that will be used for the list of algorithms in the modeler.

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm, the same example we saw in the section dedicated to the toolbox.

Rysunek 17.20: Model Parameters

As you can see, some differences exist. Instead of the file output box that was used to set the file path for output
layers and tables, a simple text box is used here. If the layer generated by the algorithm is just a temporary result
that will be used as the input of another algorithm and should not be kept as a final result, just do not edit that text
box. Typing anything in it means that the result is final and the text that you supply will be the description for the
output, which will be the output the user will see when executing the model.

Selecting the value of each parameter is also a bit different, since there are important differences between the
context of the modeler and that of the toolbox. Let’s see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerical values. Literal values can be introduced directly in the text box. But this text box is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
take the value introduced by the user when executing the model.

• String. As in the case of numerical values, literal strings can be typed, or an input string can be selected.

• Table field. The fields of the parent table or layer cannot be known at design time, since they depend on the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the text box, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked at run time.

In all cases, you will find an additional parameter named Parent algorithms that is not available when calling
the algorithm from the toolbox. This parameter allows you to define the order in which algorithms are executed
by explicitly defining one algorithm as a parent of the current one, which will force the parent algorithm to be
executed before the current one.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
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in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes an SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Once all the parameters have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, that provide objects
that are used as inputs for that algorithm.

Elements can be dragged to a different position within the canvas, to change the way the module structure is
displayed and make it more clear and intuitive. Links between elements are updated automatically. You can zoom
in and out by using the mouse wheel.

You can run your algorithm anytime by clicking on the [Run] button. However, in order to use the algorithm from
the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.3 Saving and loading models

Use the [Save] button to save the current model and the [Open] button to open any model previously saved.
Models are saved with the .model extension. If the model has been previously saved from the modeler window,
you will not be prompted for a filename. Since there is already a file associated with that model, the same file will
be used for any subsequent saves.

Before saving a model, you have to enter a name and a group for it, using the text boxes in the upper part of the
window.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, it searches the models
folder for files with the .model extension and loads the models they contain. Since a model is itself an algorithm,
it can be added to the toolbox just like any other algorithm.

The models folder can be set from the processing configuration dialog, under the Modeler group.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

In some cases, a model might not be loaded because not all the algorithms included in its workflow are available.
If you have used a given algorithm as part of your model, it should be available (that is, it should appear in the
toolbox) in order to load that model. Deactivating an algorithm provider in the processing configuration window
renders all the algorithms in that provider unusable by the modeler, which might cause problems when loading
models. Keep that in mind when you have trouble loading or executing models.

17.3.4 Editing a model

You can edit the model you are currently creating, redefining the workflow and the relationships between the
algorithms and inputs that define the model itself.

If you right-click on an algorithm in the canvas representing the model, you will see a context menu like the one
shown next:

Rysunek 17.21: Modeler Right Click
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Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms depending on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, a warning message like the one you
can see below will be shown:

Rysunek 17.22: Cannot Delete Algorithm

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

17.3.5 Editing model help files and meta-information

You can document your models from the modeler itself. Just click on the [Edit model help] button and a dialog
like the one shown next will appear.

Rysunek 17.23: Help Edition

On the right-hand side, you will see a simple HTML page, created using the description of the input parameters
and outputs of the algorithm, along with some additional items like a general description of the model or its author.
The first time you open the help editor, all these descriptions are empty, but you can edit them using the elements
on the left-hand side of the dialog. Select an element on the upper part and then write its description in the text
box below.

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.
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17.3.6 About available algorithms

You might notice that some algorithms that can be be executed from the toolbox do not appear in the list of
available algorithms when you are designing a model. To be included in a model, an algorithm must have a
correct semantic, so as to be properly linked to others in the workflow. If an algorithm does not have such a
well-defined semantic (for instance, if the number of output layers cannot be known in advance), then it is not
possible to use it within a model, and thus, it does not appear in the list of algorithms that you can find in the
modeler dialog.

Additionally, you will see some algorithms in the modeler that are not found in the toolbox. These algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tool is really useful within a model, but
outside of that context, it doesn’t make too much sense.

.

17.4 The batch processing interface

17.4.1 Introduction

All algorithms (including models) can be executed as a batch process. That is, they can be executed using not just
a single set of inputs, but several of them, executing the algorithm as many times as needed. This is useful when
processing large amounts of data, since it is not necessary to launch the algorithm many times from the toolbox.

To execute an algorithm as a batch process, right-click on its name in the toolbox and select the Execute as batch
process option in the pop-up menu that will appear.

Rysunek 17.24: Batch Processing Right Click

17.4.2 The parameters table

Executing a batch process is similar to performing a single execution of an algorithm. Parameter values have to
be defined, but in this case we need not just a single value for each parameter, but a set of them instead, one for
each time the algorithm has to be executed. Values are introduced using a table like the one shown next.

Each line of this table represents a single execution of the algorithm, and each cell contains the value of one of the
parameters. It is similar to the parameters dialog that you see when executing an algorithm from the toolbox, but
with a different arrangement.

By default, the table contains just two rows. You can add or remove rows using the buttons on the lower part of
the window.

Once the size of the table has been set, it has to be filled with the desired values.

17.4.3 Filling the parameters table

For most parameters, setting the value is trivial. Just type the value or select it from the list of available options,
depending on the parameter type.

The main differences are found for parameters representing layers or tables, and for output file paths. Regarding
input layers and tables, when an algorithm is executed as part of a batch process, those input data objects are taken
directly from files, and not from the set of them already opened in QGIS. For this reason, any algorithm can be
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Rysunek 17.25: Batch Processing

executed as a batch process, even if no data objects at all are opened and the algorithm cannot be run from the
toolbox.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If
the input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If the parameter represents a multiple input, all the selected files will be
added to a single cell, separated by semicolons (;).

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving to
a temporary file is not permitted. You can type the name directly or use the file chooser dialog that appears when
clicking on the accompanying button.

Once you select the file, a new dialog is shown to allow for autocompletion of other cells in the same column
(same parameter).

Rysunek 17.26: Batch Processing Save

If the default value (‘Do not autocomplete’) is selected, it will just put the selected filename in the selected cell
from the parameters table. If any of the other options is selected, all the cells below the selected one will be
automatically filled based on a defined criteria. This way, it is much easier to fill the table, and the batch process
can be defined with less effort.

Automatic filling can be done by simply adding correlative numbers to the selected file path, or by appending the
value of another field at the same row. This is particularly useful for naming output data objects according to input
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ones.

Rysunek 17.27: Batch Processing File Path

17.4.4 Executing the batch process

To execute the batch process once you have introduced all the necessary values, just click on [OK]. Progress of
the global batch task will be shown in the progress bar in the lower part of the dialog.

.

17.5 Using processing algorithms from the console

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other GUI elements of the processing framework. Models involving several algorithms
can be defined using the command-line interface, and additional operations such as loops and conditional sentences
can be added to create more flexible and powerful workflows.

There is not a proccesing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

The code that you can execute from the Python console, even if it does not call any specific processing method,
can be converted into a new algorithm that you can later call from the toolbox, the graphical modeler or any other
component, just like you do with any other algorithm. In fact, some algorithms that you can find in the toolbox
are simple scripts.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

17.5.1 Calling algorithms from the Python console

The first thing you have to do is to import the processing functions with the following line:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the algslist()
method. Type the following line in your console:

>>> processing.alglist()

You will see something like this.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
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Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

That’s a list of all the available algorithms, alphabetically ordered, along with their corresponding command-line
names.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

This result might change depending on the algorithms you have available.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. There is a method to describe an algorithm in detail, which can be used to get a
list of the parameters that an algorithm requires and the outputs that it will generate. To get this information, you
can use the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm,
not the full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Depending on the type of parameter, values are introduced differently. The next list gives a quick review of how
to introduce values for each type of input parameter:
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• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions() command, as shown in the
following example:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one such parameter, with seven options. Notice that ordering is zero-based.

• Multiple input. The value is a string with input descriptors separated by semicolons (;). As in the case of
single layers or tables, each input descriptor can be the data object name, or its file path.

• Table Field from XXX. Use a string with the name of the field to use. This parameter is case-sensitive.

• Fixed Table. Type the list of all table values separated by commas (,) and enclosed between quotes (").
Values start on the upper row and go from left to right. You can also use a 2-D array of values representing
the table.

• CRS. Enter the EPSG code number of the desired CRS.

• Extent. You must use a string with xmin, xmax, ymin and ymax values separated by commas (,).

Boolean, file, string and numerical parameters do not need any additional explanations.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
in the corresponding parameter entry.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter
a file extension not supported by the algorithm, the default file format for that output type will be used, and its
corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

The runalg method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values. You can load those layers by passing the corresponding file
paths to the load() method.

17.5.2 Additional functions for handling data

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.
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• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Table of Contents.

• values(layer, fields): Returns the values in the attributes table of a vector layer, for the passed
fields. Fields can be passed as field names or as zero-based field indices. Returns a dict of lists, with the
passed field identifiers as keys. It considers the existing selection.

• features(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.

• uniqueValues(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

17.5.3 Creating scripts and running them from the toolbox

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
editing dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default folder when you open the save file dialog) with .py extension will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have a look at the following code, which calculates the Topographic Wetness Index (TWI) directly from a
DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, the calculation involves three algorithms, all of them coming from SAGA. The last one calculates
the TWI, but it needs a slope layer and a flow accumulation layer. We do not have these layers, but since we have
the DEM, we can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide the information
that is needed to turn your code into an algorithm that can be run from any of the GUI components, like the toolbox
or the graphical modeler.

These lines start with a double Python comment symbol (##) and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer.

• vector. A vector layer.

• table. A table.

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4.

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.
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• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder.

• file. A filename.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a file path. It will correspond to a temporary file
path in case the user has not entered any output filename.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, just when working with the console line. If a layer is
created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly use
the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, you have to assign a value to them. To do so,
just set the value of a variable with the name you used to declare that output. For instance, if you have used this
declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two possible methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.
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Several examples are provided. Please check them to see real examples of how to create algorithms using the
processing framework classes. You can right-click on any script algorithm and select Edit script to edit its code or
just to see it.

17.5.4 Documenting your scripts

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them. In the script editing dialog, you will find an [Edit script help] button. Click on it and it will
take you to the help editing dialog. Check the section about the graphical modeler to know more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving the script for the first time. If you later close the script editing dialog
without saving the script (i.e., you discard it), the help content you wrote will be lost. If your script was already
saved and is associated to a filename, saving the help content is done automatically.

17.5.5 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing configuration dialog, you will find two entries named Pre-execution script
file and Post-execution script file where the filename of the scripts to be run in each case can be entered.

.

17.6 The history manager

17.6.1 The processing history

Every time you execute an algorithm, information about the process is stored in the history manager. Along with
the parameters used, the date and time of the execution are also saved.

This way, it is easy to track and control all the work that has been developed using the processing framework, and
easily reproduce it.

The history manager is a set of registry entries grouped according to their date of execution, making it easier to
find information about an algorithm executed at any particular moment.

Process information is kept as a command-line expression, even if the algorithm was launched from the toolbox.
This makes it also useful for those learning how to use the command-line interface, since they can call an algorithm
using the toolbox and then check the history manager to see how that same algorithm could be called from the
command line.

Apart from browsing the entries in the registry, you can also re-execute processes by simply double-clicking on
the corresponding entry.

Along with recording algorithm executions, the processing framework communicates with the user by means of
the other groups of the registry, namely Errors, Warnings and Information. In case something is not working
properly, having a look at the Errors might help you to see what is happening. If you get in contact with a
developer to report a bug or error, the information in that group will be very useful for her or him to find out what
is going wrong.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is stored in the Information group
each time you run one of those algorithms. If, for instance, you are having problems executing a SAGA algorithm,
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look for an entry named ‘SAGA execution console output’ to check all the messages generated by SAGA and try
to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to the Warning block if they detect potential problems with the data, in order to warn you. Make sure
you check those messages if you are having unexpected results.

17.7 Writing new Processing algorithms as python scripts

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
edition dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default one when you open the save file dialog), with .py extension, will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
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we can calculate them calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
chapter. The first lines, however, need some additional explanation. They provide the information that is needed to
turn your code into an algorithm that can be run from any of the GUI components, like the toolbox or the graphical
modeler.

These lines start with a double Python comment symbol (##) and have the following structure

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processign scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• longstring. Same as string, but a larger text box will be shown, so it is better suited for long strings,
such as for a script expecting a small code snippet.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder

• file. A filename

• crs. A Coordinate Reference System

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited it to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string
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• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

17.8 Handing data produced by the algorithm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

17.9 Communicating with the user

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

17.10 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
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saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.11 Example scripts

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.

17.12 Best practices for writing script algorithms

Here’s a quick summary of ideas to consider when creating your script algorithms and, epsecially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as decalring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your agorithm might be executed in a context other than the Processing
toolbox.

17.13 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

.

17.14 Configuring external applications

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external application are managed by their own algorithm provider.
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This section will show you how to configure the processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the configuration dialog. Make sure that the corresponding application is already installed in your
system. Enabling an algorithm provider without installing the application it needs will cause the algorithms to
appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and provide the information
needed about the algorithm) are not included with each application, but with QGIS instead. That is, they are part
of QGIS, so you have them in your installation even if you have not installed any other software. Running the
algorithm, however, needs the application binaries to be installed in your system.

17.14.1 A note for Windows users

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration. If installing through OSGeo4W application, make sure you select for insttallation SAGA and OTB
as well.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.

17.14.2 A note on file formats

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Using GRASS raster layers is, for instance, one case in which you might have trouble and not be able to complete
your work if you call an external algorithm using such a layer as input. For this reason, these layers will not appear
as available to algorithms.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common raster layer formats that can later
be transformed by QGIS automatically. As in the case of input layers, if this conversion is needed, that might
increase the processing time.

If the extension of the filename specified when calling an algorithm does not match the extension of any of the
formats supported by QGIS, then a suffix will be added to set a default format. In the case of raster layers, the
.tif extension is used, while .shp is used for vector layers.

17.14.3 A note on vector layer selections

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
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external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

In other cases, exporting only selected features is needed, which causes execution times to be longer.

SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself (remember, you need version 2.1), the path to the SAGA executable must be
configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named SAGA
Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you are
ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with SEXTANTE, so you have to download and install
the software yourself. Please check the SAGA website for more information. SAGA 2.1 is needed.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folders.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

17.14.4 About SAGA grid system limitations

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the settings window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent by setting the values of the following parameters:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cell size of the target layer is the maximum of all cell sizes of the input layers.

For algorithms that do not use multiple raster layers, or for those that do not need a unique input grid system, no
resampling is performed before calling SAGA, and those parameters are not used.

17.14.5 Limitations for multi-band layers

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
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- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

17.14.6 Limitations in cell size

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

17.14.7 Logging

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Most other providers that use an external application and call it through the command-line have similar options,
so you will find them as well in other places in the processing settings list.

R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Once again, this is different in Linux, and you just have to make sure that the R folder is included in the PATH
environment variable. If you can start R just typing R in a console, then you are ready to go.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again.

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of a
parameter is also the name of the variable that we can use in R for accesing the value of that parameter (thus, you
should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it into R.

Additionally, raster files can be read using the readGDAL() command instead of brick() by using the
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilename tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

With the above information, we can now understand the first line of our first example script (the first line not
starting with a Python comment).

pts=spsample(polyg,numpoints,type="random")

The variable polygon already contains a SpatialPolygonsDataFrame object, so it can be used to call the
spsample method, just like the numpoints one, which indicates the number of points to add to the created
sample grid.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
#dontuserasterpackage option. In you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the #passfilename option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).
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If your algorithm creates any kind of graphics (using the plot() method), add the following line:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Both graphics and console results will be shown in the processing results manager.

For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Informacja: rgdal and maptools libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R distribution).
However, other additional libraries that you might need have to be explicitly loaded. Just add the necessary com-
mands at the beginning of your script. You also have to make sure that the corresponding packages are installed in
the R distribution used by QGIS. The processing framework will not take care of any package installation. If you
run a script that requires a package that is not installed, the execution will fail, and SEXTANTE will try to detect
which packages are missing. You must install those missing libraries manually before you can run the algorithm.

GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

If you are running Linux, you just have to make sure that GRASS is correctly installed, and that it can be run
without problem from a console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behaviour you prefer, just check the
Use min covering region option in the GRASS configuration parameters.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and the
processing framework creates a temporary one for each execution. You have to specify if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are runing Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

17.14. Configuring external applications 223



QGIS User Guide, Wydanie 2.6

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use the OSGeo4W installer, then install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder. These values should be configured by de-
fault, but if you have a different OTB installation, configure them to the corresponding values in your
system.

TauDEM

To use this provider, you need to install TauDEM command line tools.

17.14.8 Windows

Please visit the TauDEM homepage for installation instructions and precompiled binaries for 32-bit and 64-bit
systems. IMPORTANT: You need TauDEM 5.0.6 executables. Version 5.2 is currently not supported.

17.14.9 Linux

There are no packages for most Linux distributions, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Alternatively, TauDEM works fine with Open
MPI, so you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract the files in some folder.

Open the linearpart.h file, and after line

#include "mpi.h"

add a new line with

#include <stdint.h>

so you’ll get

#include "mpi.h"
#include <stdint.h>

Save the changes and close the file. Now open tiffIO.h, find line #include "stdint.h" and replace
quotes ("") with <>, so you’ll get

#include <stdint.h>

Save the changes and close the file. Create a build directory and cd into it

mkdir build
cd build

Configure your build with the command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile
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make

Finally, to install TauDEM into /usr/local/bin, run

sudo make install

.

17.15 The QGIS Commander

Processing includes a practical tool that allows you to run algorithms without having to use the toolbox, but just
by typing the name of the algorithm you want to run.

This tool is known as the QGIS commander, and it is just a simple text box with autocompletion where you type
the command you want to run.

Rysunek 17.29: The QGIS Commander

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). Apart from
executing Processing algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

17.15.1 Available commands

The commands available in the Commander fall in the following categories:

• Processing algorithms. These are shown as Processing algorithm: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Python functions. You can create short Python functions that will be then included in the list of available
commands. They are shown as Function: <function name>.

To run any of the above, just start typing and then select the corresponding element from the list of available
commands that appears after filtering the whole list of commands with the text you have entered.

In the case of calling a Python function, you can select the entry in the list, which is pre-
fixed by Function: (for instance, Function: removeall), or just directly type the
function name (‘‘removeall in the previous example). There is no need to add brackets after the func-
tion name.
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17.15.2 Creating custom functions

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis/sextante/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.

The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favorite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

For instance, you can add the following function, which removes all layers:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Once you have added the function, it will be available in the Commander, and you can invoke it by typing
removeall. There is no need to do anything apart from writing the function itself.

Functions can receive parameters. Add *args to your function definition to receive arguments. When calling the
function from the Commander, parameters have to be passed separated by spaces.

Here is an example of a function that loads a layer and takes a parameter with the filename of the layer to load.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type load /home/myuser/points.shp
in the Commander text box.

.
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ROZDZIAŁ 18

Processing providers and algorithms

.

18.1 GDAL algorithm provider

GDAL (Geospatial Data Abstraction Library) is a translator library for raster and vector geospatial data formats.

.

18.1.1 GDAL analysis

Aspect

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Use Zevenbergen&Thorne formula (instead of the Horn’s one) [boolean] <put parame-
ter description here>

Default: False

Return trigonometric angle (instead of azimuth) [boolean] <put parameter description
here>

Default: False

Return o for flat (instead of -9999) [boolean] <put parameter description here>

Default: False
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Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:aspect’, input, band, compute_edges, zevenbergen, trig_angle, zero_flat, output)

See also

Color relief

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Color configuration file [file] <put parameter description here>

Matching mode [selection] <put parameter description here>

Options:

• 0 — “0,0,0,0” RGBA

• 1 — Exact color

• 2 — Nearest color

Default: 0

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:colorrelief’, input, band, compute_edges, color_table, match_mode, output)

See also

Fill nodata

Description

<put algortithm description here>
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Parameters

Input layer [raster] <put parameter description here>

Search distance [number] <put parameter description here>

Default: 100

Smooth iterations [number] <put parameter description here>

Default: 0

Band to operate on [number] <put parameter description here>

Default: 1

Validity mask [raster] Optional.

<put parameter description here>

Do not use default validity mask [boolean] <put parameter description here>

Default: False

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:fillnodata’, input, distance, iterations, band, mask, no_default_mask, output)

See also

Grid (Moving average)

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Z field [tablefield: numeric] Optional.

<put parameter description here>

Radius 1 [number] <put parameter description here>

Default: 0.0

Radius 2 [number] <put parameter description here>

Default: 0.0

Min points [number] <put parameter description here>

Default: 0.0

Angle [number] <put parameter description here>

Default: 0.0
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Nodata [number] <put parameter description here>

Default: 0.0

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:gridaverage’, input, z_field, radius_1, radius_2, min_points, angle, nodata, rtype, output)

See also

Grid (Data metrics)

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Z field [tablefield: numeric] Optional.

<put parameter description here>

Metrics [selection] <put parameter description here>

Options:

• 0 — Minimum

• 1 — Maximum

• 2 — Range
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• 3 — Count

• 4 — Average distance

• 5 — Average distance between points

Default: 0

Radius 1 [number] <put parameter description here>

Default: 0.0

Radius 2 [number] <put parameter description here>

Default: 0.0

Min points [number] <put parameter description here>

Default: 0.0

Angle [number] <put parameter description here>

Default: 0.0

Nodata [number] <put parameter description here>

Default: 0.0

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:griddatametrics’, input, z_field, metric, radius_1, radius_2, min_points, angle, nodata, rtype, output)
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See also

Grid (Inverse distance to a power)

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Z field [tablefield: numeric] Optional.

<put parameter description here>

Power [number] <put parameter description here>

Default: 2.0

Smothing [number] <put parameter description here>

Default: 0.0

Radius 1 [number] <put parameter description here>

Default: 0.0

Radius 2 [number] <put parameter description here>

Default: 0.0

Max points [number] <put parameter description here>

Default: 0.0

Min points [number] <put parameter description here>

Default: 0.0

Angle [number] <put parameter description here>

Default: 0.0

Nodata [number] <put parameter description here>

Default: 0.0

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32
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• 10 — CFloat64

Default: 5

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:gridinvdist’, input, z_field, power, smothing, radius_1, radius_2, max_points, min_points, angle, nodata, rtype, output)

See also

Grid (Nearest neighbor)

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Z field [tablefield: numeric] Optional.

<put parameter description here>

Radius 1 [number] <put parameter description here>

Default: 0.0

Radius 2 [number] <put parameter description here>

Default: 0.0

Angle [number] <put parameter description here>

Default: 0.0

Nodata [number] <put parameter description here>

Default: 0.0

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32
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• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:gridnearestneighbor’, input, z_field, radius_1, radius_2, angle, nodata, rtype, output)

See also

Hillshade

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Use Zevenbergen&Thorne formula (instead of the Horn’s one) [boolean] <put parame-
ter description here>

Default: False

Z factor (vertical exaggeration) [number] <put parameter description here>

Default: 1.0

Scale (ratio of vert. units to horiz.) [number] <put parameter description here>

Default: 1.0

Azimuth of the light [number] <put parameter description here>

Default: 315.0

Altitude of the light [number] <put parameter description here>

Default: 45.0

Outputs

Output file [raster] <put output description here>
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Console usage

processing.runalg(’gdalogr:hillshade’, input, band, compute_edges, zevenbergen, z_factor, scale, azimuth, altitude, output)

See also

Near black

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

How far from black (white) [number] <put parameter description here>

Default: 15

Search for nearly white pixels instead of nearly black [boolean] <put parameter de-
scription here>

Default: False

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:nearblack’, input, near, white, output)

See also

Proximity (raster distance)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Values [string] <put parameter description here>

Default: (not set)

Dist units [selection] <put parameter description here>

Options:

• 0 — GEO

• 1 — PIXEL
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Default: 0

Max dist (negative value to ignore) [number] <put parameter description here>

Default: -1

No data (negative value to ignore) [number] <put parameter description here>

Default: -1

Fixed buf val (negative value to ignore) [number] <put parameter description here>

Default: -1

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:proximity’, input, values, units, max_dist, nodata, buf_val, rtype, output)

See also

Roughness

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1
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Compute edges [boolean] <put parameter description here>

Default: False

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:roughness’, input, band, compute_edges, output)

See also

Sieve

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Threshold [number] <put parameter description here>

Default: 2

Pixel connection [selection] <put parameter description here>

Options:

• 0 — 4

• 1 — 8

Default: 0

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:sieve’, input, threshold, connections, output)

See also

Slope

Description

<put algortithm description here>
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Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Use Zevenbergen&Thorne formula (instead of the Horn’s one) [boolean] <put parame-
ter description here>

Default: False

Slope expressed as percent (instead of degrees) [boolean] <put parameter description
here>

Default: False

Scale (ratio of vert. units to horiz.) [number] <put parameter description here>

Default: 1.0

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:slope’, input, band, compute_edges, zevenbergen, as_percent, scale, output)

See also

TPI (Topographic Position Index)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Outputs

Output file [raster] <put output description here>
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Console usage

processing.runalg(’gdalogr:tpitopographicpositionindex’, input, band, compute_edges, output)

See also

TRI (Terrain Ruggedness Index)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1

Compute edges [boolean] <put parameter description here>

Default: False

Outputs

Output file [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:triterrainruggednessindex’, input, band, compute_edges, output)

See also

.

18.1.2 GDAL conversion

gdal2xyz

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band number [number] <put parameter description here>

Default: 1
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Outputs

Output file [table] <put output description here>

Console usage

processing.runalg(’gdalogr:gdal2xyz’, input, band, output)

See also

PCT to RGB

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Band to convert [selection] <put parameter description here>

Options:

• 0 — 1

• 1 — 2

• 2 — 3

• 3 — 4

• 4 — 5

• 5 — 6

• 6 — 7

• 7 — 8

• 8 — 9

• 9 — 10

• 10 — 11

• 11 — 12

• 12 — 13

• 13 — 14

• 14 — 15

• 15 — 16

• 16 — 17

• 17 — 18

• 18 — 19

• 19 — 20

• 20 — 21
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• 21 — 22

• 22 — 23

• 23 — 24

• 24 — 25

Default: 0

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:pcttorgb’, input, nband, output)

See also

Polygonize (raster to vector)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Output field name [string] <put parameter description here>

Default: DN

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:polygonize’, input, field, output)

See also

Rasterize (vector to raster)

Description

<put algortithm description here>
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Parameters

Input layer [vector: any] <put parameter description here>

Attribute field [tablefield: any] <put parameter description here>

Write values inside an existing raster layer(*) [boolean] <put parameter description
here>

Default: False

Set output raster size (ignored if above option is checked) [selection] <put pa-
rameter description here>

Options:

• 0 — Output size in pixels

• 1 — Output resolution in map units per pixel

Default: 1

Horizontal [number] <put parameter description here>

Default: 100.0

Vertical [number] <put parameter description here>

Default: 100.0

Raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 0

Outputs

Output layer: mandatory to choose an existing raster layer if the (*) option is selected [raster]
<put output description here>

Console usage

processing.runalg(’gdalogr:rasterize’, input, field, writeover, dimensions, width, height, rtype, output)
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See also

RGB to PCT

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Number of colors [number] <put parameter description here>

Default: 2

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:rgbtopct’, input, ncolors, output)

See also

Translate (convert format)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Set the size of the output file (In pixels or %) [number] <put parameter description
here>

Default: 100

Output size is a percentage of input size [boolean] <put parameter description here>

Default: True

Nodata value, leave as none to take the nodata value from input [string] <put pa-
rameter description here>

Default: none

Expand [selection] <put parameter description here>

Options:

• 0 — none

• 1 — gray

• 2 — rgb
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• 3 — rgba

Default: 0

Output projection for output file [leave blank to use input projection] [crs]
<put parameter description here>

Default: None

Subset based on georeferenced coordinates [extent] <put parameter description here>

Default: 0,1,0,1

Copy all subdatasets of this file to individual output files [boolean] <put
parameter description here>

Default: False

Additional creation parameters [string] Optional.

<put parameter description here>

Default: (not set)

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:translate’, input, outsize, outsize_perc, no_data, expand, srs, projwin, sds, extra, rtype, output)

See also

.
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18.1.3 GDAL extraction

Clip raster by extent

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Nodata value, leave as none to take the nodata value from input [string] <put pa-
rameter description here>

Default: none

Clipping extent [extent] <put parameter description here>

Default: 0,1,0,1

Additional creation parameters [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:cliprasterbyextent’, input, no_data, projwin, extra, output)

See also

Clip raster by mask layer

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Mask layer [vector: polygon] <put parameter description here>

Nodata value, leave as none to take the nodata value from input [string] <put pa-
rameter description here>

Default: none

Create and output alpha band [boolean] <put parameter description here>

Default: False
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Keep resolution of output raster [boolean] <put parameter description here>

Default: False

Additional creation parameters [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:cliprasterbymasklayer’, input, mask, no_data, alpha_band, keep_resolution, extra, output)

See also

Contour

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Interval between contour lines [number] <put parameter description here>

Default: 10.0

Attribute name (if not set, no elevation attribute is attached) [string]
Optional.

<put parameter description here>

Default: ELEV

Additional creation parameters [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Output file for contour lines (vector) [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:contour’, input_raster, interval, field_name, extra, output_vector)
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See also

.

18.1.4 GDAL miscellaneous

Build Virtual Raster

Description

<put algortithm description here>

Parameters

Input layers [multipleinput: rasters] <put parameter description here>

Resolution [selection] <put parameter description here>

Options:

• 0 — average

• 1 — highest

• 2 — lowest

Default: 0

Layer stack [boolean] <put parameter description here>

Default: True

Allow projection difference [boolean] <put parameter description here>

Default: False

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:buildvirtualraster’, input, resolution, separate, proj_difference, output)

See also

Merge

Description

<put algortithm description here>
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Parameters

Input layers [multipleinput: rasters] <put parameter description here>

Grab pseudocolor table from first layer [boolean] <put parameter description here>

Default: False

Layer stack [boolean] <put parameter description here>

Default: False

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:merge’, input, pct, separate, rtype, output)

See also

Build overviews (pyramids)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Overview levels [string] <put parameter description here>

Default: 2 4 8 16

248 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

Remove all existing overviews [boolean] <put parameter description here>

Default: False

Resampling method [selection] <put parameter description here>

Options:

• 0 — nearest

• 1 — average

• 2 — gauss

• 3 — cubic

• 4 — average_mp

• 5 — average_magphase

• 6 — mode

Default: 0

Overview format [selection] <put parameter description here>

Options:

• 0 — Internal (if possible)

• 1 — External (GTiff .ovr)

• 2 — External (ERDAS Imagine .aux)

Default: 0

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:overviews’, input, levels, clean, resampling_method, format)

See also

Information

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Suppress GCP info [boolean] <put parameter description here>

Default: False

Suppress metadata info [boolean] <put parameter description here>

Default: False
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Outputs

Layer information [html] <put output description here>

Console usage

processing.runalg(’gdalorg:rasterinfo’, input, nogcp, nometadata, output)

See also

.

18.1.5 GDAL projections

Extract projection

Description

<put algortithm description here>

Parameters

Input file [raster] <put parameter description here>

Create also .prj file [boolean] <put parameter description here>

Default: False

Outputs

Console usage

processing.runalg(’gdalogr:extractprojection’, input, prj_file)

See also

Warp (reproject)

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Source SRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326

Destination SRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326
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Output file resolution in target georeferenced units (leave 0 for no change) [number]
<put parameter description here>

Default: 0.0

Resampling method [selection] <put parameter description here>

Options:

• 0 — near

• 1 — bilinear

• 2 — cubic

• 3 — cubicspline

• 4 — lanczos

Default: 0

Additional creation parameters [string] Optional.

<put parameter description here>

Default: (not set)

Output raster type [selection] <put parameter description here>

Options:

• 0 — Byte

• 1 — Int16

• 2 — UInt16

• 3 — UInt32

• 4 — Int32

• 5 — Float32

• 6 — Float64

• 7 — CInt16

• 8 — CInt32

• 9 — CFloat32

• 10 — CFloat64

Default: 5

Outputs

Output layer [raster] <put output description here>

Console usage

processing.runalg(’gdalogr:warpreproject’, input, source_srs, dest_srs, tr, method, extra, rtype, output)

See also

.
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18.1.6 OGR conversion

Convert format

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Destination Format [selection] <put parameter description here>

Options:

• 0 — ESRI Shapefile

• 1 — GeoJSON

• 2 — GeoRSS

• 3 — SQLite

• 4 — GMT

• 5 — MapInfo File

• 6 — INTERLIS 1

• 7 — INTERLIS 2

• 8 — GML

• 9 — Geoconcept

• 10 — DXF

• 11 — DGN

• 12 — CSV

• 13 — BNA

• 14 — S57

• 15 — KML

• 16 — GPX

• 17 — PGDump

• 18 — GPSTrackMaker

• 19 — ODS

• 20 — XLSX

• 21 — PDF

Default: 0

Creation Options [string] Optional.

<put parameter description here>

Default: (not set)
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Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:convertformat’, input_layer, format, options, output_layer)

See also

.

18.1.7 OGR geoprocessing

Clip vectors by extent

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Clip extent [extent] <put parameter description here>

Default: 0,1,0,1

Additional creation Options [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:clipvectorsbyextent’, input_layer, clip_extent, options, output_layer)

See also

Clip vectors by polygon

Description

<put algortithm description here>
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Parameters

Input layer [vector: any] <put parameter description here>

Clip layer [vector: polygon] <put parameter description here>

Additional creation Options [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:clipvectorsbypolygon’, input_layer, clip_layer, options, output_layer)

See also

.

18.1.8 OGR miscellaneous

Execute SQL

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

SQL [string] <put parameter description here>

Default: (not set)

Outputs

SQL result [vector] <put output description here>

Console usage

processing.runalg(’gdalogr:executesql’, input, sql, output)
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See also

Import Vector into PostGIS database (available connections)

Description

<put algortithm description here>

Parameters

Database (connection name) [selection] <put parameter description here>

Options:

• 0 — local

Default: 0

Input layer [vector: any] <put parameter description here>

Output geometry type [selection] <put parameter description here>

Options:

• 0 —

• 1 — NONE

• 2 — GEOMETRY

• 3 — POINT

• 4 — LINESTRING

• 5 — POLYGON

• 6 — GEOMETRYCOLLECTION

• 7 — MULTIPOINT

• 8 — MULTIPOLYGON

• 9 — MULTILINESTRING

Default: 5

Input CRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326

Output CRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326

Schema name [string] Optional.

<put parameter description here>

Default: public

Table name, leave blank to use input name [string] Optional.

<put parameter description here>

Default: (not set)

Primary Key [string] Optional.

<put parameter description here>

Default: id
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Geometry column name [string] Optional.

<put parameter description here>

Default: geom

Vector dimensions [selection] <put parameter description here>

Options:

• 0 — 2

• 1 — 3

Default: 0

Distance tolerance for simplification [string] Optional.

<put parameter description here>

Default: (not set)

Maximum distance between 2 nodes (densification) [string] Optional.

<put parameter description here>

Default: (not set)

Select features by extent (defined in input layer CRS) [extent] <put parameter de-
scription here>

Default: 0,1,0,1

Clip the input layer using the above (rectangle) extent [boolean] <put parameter de-
scription here>

Default: False

Select features using a SQL "WHERE" statement (Ex: column="value") [string]
Optional.

<put parameter description here>

Default: (not set)

Group "n" features per transaction (Default: 20000) [string] Optional.

<put parameter description here>

Default: (not set)

Overwrite existing table? [boolean] <put parameter description here>

Default: True

Append to existing table? [boolean] <put parameter description here>

Default: False

Append and add new fields to existing table? [boolean] <put parameter description here>

Default: False

Do not launder columns/table name/s? [boolean] <put parameter description here>

Default: False

Do not create Spatial Index? [boolean] <put parameter description here>

Default: False

Continue after a failure, skipping the failed feature [boolean] <put parameter de-
scription here>

Default: False
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Additional creation options [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Console usage

processing.runalg(’gdalogr:importvectorintopostgisdatabaseavailableconnections’, database, input_layer, gtype, s_srs, t_srs, schema, table, pk, geocolumn, dim, simplify, segmentize, spat, clip, where, gt, overwrite, append, addfields, launder, index, skipfailures, options)

See also

Import Vector into PostGIS database (new connection)

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Output geometry type [selection] <put parameter description here>

Options:

• 0 —

• 1 — NONE

• 2 — GEOMETRY

• 3 — POINT

• 4 — LINESTRING

• 5 — POLYGON

• 6 — GEOMETRYCOLLECTION

• 7 — MULTIPOINT

• 8 — MULTIPOLYGON

• 9 — MULTILINESTRING

Default: 5

Input CRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326

Output CRS (EPSG Code) [crs] <put parameter description here>

Default: EPSG:4326

Host [string] <put parameter description here>

Default: localhost

Port [string] <put parameter description here>

Default: 5432
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Username [string] <put parameter description here>

Default: (not set)

Database Name [string] <put parameter description here>

Default: (not set)

Password [string] <put parameter description here>

Default: (not set)

Schema name [string] Optional.

<put parameter description here>

Default: public

Table name, leave blank to use input name [string] Optional.

<put parameter description here>

Default: (not set)

Primary Key [string] Optional.

<put parameter description here>

Default: id

Geometry column name [string] Optional.

<put parameter description here>

Default: geom

Vector dimensions [selection] <put parameter description here>

Options:

• 0 — 2

• 1 — 3

Default: 0

Distance tolerance for simplification [string] Optional.

<put parameter description here>

Default: (not set)

Maximum distance between 2 nodes (densification) [string] Optional.

<put parameter description here>

Default: (not set)

Select features by extent (defined in input layer CRS) [extent] <put parameter de-
scription here>

Default: 0,1,0,1

Clip the input layer using the above (rectangle) extent [boolean] <put parameter de-
scription here>

Default: False

Select features using a SQL "WHERE" statement (Ex: column="value") [string]
Optional.

<put parameter description here>

Default: (not set)
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Group "n" features per transaction (Default: 20000) [string] Optional.

<put parameter description here>

Default: (not set)

Overwrite existing table? [boolean] <put parameter description here>

Default: True

Append to existing table? [boolean] <put parameter description here>

Default: False

Append and add new fields to existing table? [boolean] <put parameter description here>

Default: False

Do not launder columns/table name/s? [boolean] <put parameter description here>

Default: False

Do not create Spatial Index? [boolean] <put parameter description here>

Default: False

Continue after a failure, skipping the failed feature [boolean] <put parameter de-
scription here>

Default: False

Additional creation options [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Console usage

processing.runalg(’gdalogr:importvectorintopostgisdatabasenewconnection’, input_layer, gtype, s_srs, t_srs, host, port, user, dbname, password, schema, table, pk, geocolumn, dim, simplify, segmentize, spat, clip, where, gt, overwrite, append, addfields, launder, index, skipfailures, options)

See also

Information

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Outputs

Layer information [html] <put output description here>
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Console usage

processing.runalg(’gdalogr:information’, input, output)

See also

.

18.2 LAStools

LAStools is a collection of highly efficient, multicore command line tools for LiDAR data processing.

18.2.1 las2las_filter

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

filter (by return, classification, flags) [selection] <put parameter description here>

Options:

• 0 — —

• 1 — keep_last

• 2 — keep_first

• 3 — keep_middle

• 4 — keep_single

• 5 — drop_single

• 6 — keep_double

• 7 — keep_class 2

• 8 — keep_class 2 8

• 9 — keep_class 8

• 10 — keep_class 6

• 11 — keep_class 9

• 12 — keep_class 3 4 5

• 13 — keep_class 2 6

• 14 — drop_class 7

• 15 — drop_withheld

260 Rozdział 18. Processing providers and algorithms

http://rapidlasso.com/lastools/


QGIS User Guide, Wydanie 2.6

Default: 0

second filter (by return, classification, flags) [selection] <put parameter description
here>

Options:

• 0 — —

• 1 — keep_last

• 2 — keep_first

• 3 — keep_middle

• 4 — keep_single

• 5 — drop_single

• 6 — keep_double

• 7 — keep_class 2

• 8 — keep_class 2 8

• 9 — keep_class 8

• 10 — keep_class 6

• 11 — keep_class 9

• 12 — keep_class 3 4 5

• 13 — keep_class 2 6

• 14 — drop_class 7

• 15 — drop_withheld

Default: 0

filter (by coordinate, intensity, GPS time, ...) [selection] <put parameter description
here>

Options:

• 0 — —

• 1 — clip_x_above

• 2 — clip_x_below

• 3 — clip_y_above

• 4 — clip_y_below

• 5 — clip_z_above

• 6 — clip_z_below

• 7 — drop_intensity_above

• 8 — drop_intensity_below

• 9 — drop_gps_time_above

• 10 — drop_gps_time_below

• 11 — drop_scan_angle_above

• 12 — drop_scan_angle_below

• 13 — keep_point_source

• 14 — drop_point_source

• 15 — drop_point_source_above
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• 16 — drop_point_source_below

• 17 — keep_user_data

• 18 — drop_user_data

• 19 — drop_user_data_above

• 20 — drop_user_data_below

• 21 — keep_every_nth

• 22 — keep_random_fraction

• 23 — thin_with_grid

Default: 0

value for filter (by coordinate, intensity, GPS time, ...) [string] <put parameter
description here>

Default: (not set)

second filter (by coordinate, intensity, GPS time, ...) [selection] <put parameter
description here>

Options:

• 0 — —

• 1 — clip_x_above

• 2 — clip_x_below

• 3 — clip_y_above

• 4 — clip_y_below

• 5 — clip_z_above

• 6 — clip_z_below

• 7 — drop_intensity_above

• 8 — drop_intensity_below

• 9 — drop_gps_time_above

• 10 — drop_gps_time_below

• 11 — drop_scan_angle_above

• 12 — drop_scan_angle_below

• 13 — keep_point_source

• 14 — drop_point_source

• 15 — drop_point_source_above

• 16 — drop_point_source_below

• 17 — keep_user_data

• 18 — drop_user_data

• 19 — drop_user_data_above

• 20 — drop_user_data_below

• 21 — keep_every_nth

• 22 — keep_random_fraction

• 23 — thin_with_grid

Default: 0
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value for second filter (by coordinate, intensity, GPS time, ...) [string] <put
parameter description here>

Default: (not set)

Outputs

output LAS/LAZ file [file] <put output description here>

Console usage

processing.runalg(’lidartools:las2lasfilter’, verbose, input_laslaz, filter_return_class_flags1, filter_return_class_flags2, filter_coords_intensity1, filter_coords_intensity1_arg, filter_coords_intensity2, filter_coords_intensity2_arg, output_laslaz)

See also

18.2.2 las2las_project

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

source projection [selection] <put parameter description here>

Options:

• 0 — —

• 1 — utm

• 2 — sp83

• 3 — sp27

• 4 — longlat

• 5 — latlong

Default: 0

source utm zone [selection] <put parameter description here>

Options:

• 0 — —

• 1 — 1 (north)

• 2 — 2 (north)

• 3 — 3 (north)

• 4 — 4 (north)

• 5 — 5 (north)

• 6 — 6 (north)
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• 7 — 7 (north)

• 8 — 8 (north)

• 9 — 9 (north)

• 10 — 10 (north)

• 11 — 11 (north)

• 12 — 12 (north)

• 13 — 13 (north)

• 14 — 14 (north)

• 15 — 15 (north)

• 16 — 16 (north)

• 17 — 17 (north)

• 18 — 18 (north)

• 19 — 19 (north)

• 20 — 20 (north)

• 21 — 21 (north)

• 22 — 22 (north)

• 23 — 23 (north)

• 24 — 24 (north)

• 25 — 25 (north)

• 26 — 26 (north)

• 27 — 27 (north)

• 28 — 28 (north)

• 29 — 29 (north)

• 30 — 30 (north)

• 31 — 31 (north)

• 32 — 32 (north)

• 33 — 33 (north)

• 34 — 34 (north)

• 35 — 35 (north)

• 36 — 36 (north)

• 37 — 37 (north)

• 38 — 38 (north)

• 39 — 39 (north)

• 40 — 40 (north)

• 41 — 41 (north)

• 42 — 42 (north)

• 43 — 43 (north)

• 44 — 44 (north)

• 45 — 45 (north)
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• 46 — 46 (north)

• 47 — 47 (north)

• 48 — 48 (north)

• 49 — 49 (north)

• 50 — 50 (north)

• 51 — 51 (north)

• 52 — 52 (north)

• 53 — 53 (north)

• 54 — 54 (north)

• 55 — 55 (north)

• 56 — 56 (north)

• 57 — 57 (north)

• 58 — 58 (north)

• 59 — 59 (north)

• 60 — 60 (north)

• 61 — 1 (south)

• 62 — 2 (south)

• 63 — 3 (south)

• 64 — 4 (south)

• 65 — 5 (south)

• 66 — 6 (south)

• 67 — 7 (south)

• 68 — 8 (south)

• 69 — 9 (south)

• 70 — 10 (south)

• 71 — 11 (south)

• 72 — 12 (south)

• 73 — 13 (south)

• 74 — 14 (south)

• 75 — 15 (south)

• 76 — 16 (south)

• 77 — 17 (south)

• 78 — 18 (south)

• 79 — 19 (south)

• 80 — 20 (south)

• 81 — 21 (south)

• 82 — 22 (south)

• 83 — 23 (south)

• 84 — 24 (south)
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• 85 — 25 (south)

• 86 — 26 (south)

• 87 — 27 (south)

• 88 — 28 (south)

• 89 — 29 (south)

• 90 — 30 (south)

• 91 — 31 (south)

• 92 — 32 (south)

• 93 — 33 (south)

• 94 — 34 (south)

• 95 — 35 (south)

• 96 — 36 (south)

• 97 — 37 (south)

• 98 — 38 (south)

• 99 — 39 (south)

• 100 — 40 (south)

• 101 — 41 (south)

• 102 — 42 (south)

• 103 — 43 (south)

• 104 — 44 (south)

• 105 — 45 (south)

• 106 — 46 (south)

• 107 — 47 (south)

• 108 — 48 (south)

• 109 — 49 (south)

• 110 — 50 (south)

• 111 — 51 (south)

• 112 — 52 (south)

• 113 — 53 (south)

• 114 — 54 (south)

• 115 — 55 (south)

• 116 — 56 (south)

• 117 — 57 (south)

• 118 — 58 (south)

• 119 — 59 (south)

• 120 — 60 (south)

Default: 0

source state plane code [selection] <put parameter description here>

Options:
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• 0 — —

• 1 — AK_10

• 2 — AK_2

• 3 — AK_3

• 4 — AK_4

• 5 — AK_5

• 6 — AK_6

• 7 — AK_7

• 8 — AK_8

• 9 — AK_9

• 10 — AL_E

• 11 — AL_W

• 12 — AR_N

• 13 — AR_S

• 14 — AZ_C

• 15 — AZ_E

• 16 — AZ_W

• 17 — CA_I

• 18 — CA_II

• 19 — CA_III

• 20 — CA_IV

• 21 — CA_V

• 22 — CA_VI

• 23 — CA_VII

• 24 — CO_C

• 25 — CO_N

• 26 — CO_S

• 27 — CT

• 28 — DE

• 29 — FL_E

• 30 — FL_N

• 31 — FL_W

• 32 — GA_E

• 33 — GA_W

• 34 — HI_1

• 35 — HI_2

• 36 — HI_3

• 37 — HI_4

• 38 — HI_5
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• 39 — IA_N

• 40 — IA_S

• 41 — ID_C

• 42 — ID_E

• 43 — ID_W

• 44 — IL_E

• 45 — IL_W

• 46 — IN_E

• 47 — IN_W

• 48 — KS_N

• 49 — KS_S

• 50 — KY_N

• 51 — KY_S

• 52 — LA_N

• 53 — LA_S

• 54 — MA_I

• 55 — MA_M

• 56 — MD

• 57 — ME_E

• 58 — ME_W

• 59 — MI_C

• 60 — MI_N

• 61 — MI_S

• 62 — MN_C

• 63 — MN_N

• 64 — MN_S

• 65 — MO_C

• 66 — MO_E

• 67 — MO_W

• 68 — MS_E

• 69 — MS_W

• 70 — MT_C

• 71 — MT_N

• 72 — MT_S

• 73 — NC

• 74 — ND_N

• 75 — ND_S

• 76 — NE_N

• 77 — NE_S

268 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

• 78 — NH

• 79 — NJ

• 80 — NM_C

• 81 — NM_E

• 82 — NM_W

• 83 — NV_C

• 84 — NV_E

• 85 — NV_W

• 86 — NY_C

• 87 — NY_E

• 88 — NY_LI

• 89 — NY_W

• 90 — OH_N

• 91 — OH_S

• 92 — OK_N

• 93 — OK_S

• 94 — OR_N

• 95 — OR_S

• 96 — PA_N

• 97 — PA_S

• 98 — PR

• 99 — RI

• 100 — SC_N

• 101 — SC_S

• 102 — SD_N

• 103 — SD_S

• 104 — St.Croix

• 105 — TN

• 106 — TX_C

• 107 — TX_N

• 108 — TX_NC

• 109 — TX_S

• 110 — TX_SC

• 111 — UT_C

• 112 — UT_N

• 113 — UT_S

• 114 — VA_N

• 115 — VA_S

• 116 — VT
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• 117 — WA_N

• 118 — WA_S

• 119 — WI_C

• 120 — WI_N

• 121 — WI_S

• 122 — WV_N

• 123 — WV_S

• 124 — WY_E

• 125 — WY_EC

• 126 — WY_W

• 127 — WY_WC

Default: 0

target projection [selection] <put parameter description here>

Options:

• 0 — —

• 1 — utm

• 2 — sp83

• 3 — sp27

• 4 — longlat

• 5 — latlong

Default: 0

target utm zone [selection] <put parameter description here>

Options:

• 0 — —

• 1 — 1 (north)

• 2 — 2 (north)

• 3 — 3 (north)

• 4 — 4 (north)

• 5 — 5 (north)

• 6 — 6 (north)

• 7 — 7 (north)

• 8 — 8 (north)

• 9 — 9 (north)

• 10 — 10 (north)

• 11 — 11 (north)

• 12 — 12 (north)

• 13 — 13 (north)

• 14 — 14 (north)

• 15 — 15 (north)
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• 16 — 16 (north)

• 17 — 17 (north)

• 18 — 18 (north)

• 19 — 19 (north)

• 20 — 20 (north)

• 21 — 21 (north)

• 22 — 22 (north)

• 23 — 23 (north)

• 24 — 24 (north)

• 25 — 25 (north)

• 26 — 26 (north)

• 27 — 27 (north)

• 28 — 28 (north)

• 29 — 29 (north)

• 30 — 30 (north)

• 31 — 31 (north)

• 32 — 32 (north)

• 33 — 33 (north)

• 34 — 34 (north)

• 35 — 35 (north)

• 36 — 36 (north)

• 37 — 37 (north)

• 38 — 38 (north)

• 39 — 39 (north)

• 40 — 40 (north)

• 41 — 41 (north)

• 42 — 42 (north)

• 43 — 43 (north)

• 44 — 44 (north)

• 45 — 45 (north)

• 46 — 46 (north)

• 47 — 47 (north)

• 48 — 48 (north)

• 49 — 49 (north)

• 50 — 50 (north)

• 51 — 51 (north)

• 52 — 52 (north)

• 53 — 53 (north)

• 54 — 54 (north)

18.2. LAStools 271



QGIS User Guide, Wydanie 2.6

• 55 — 55 (north)

• 56 — 56 (north)

• 57 — 57 (north)

• 58 — 58 (north)

• 59 — 59 (north)

• 60 — 60 (north)

• 61 — 1 (south)

• 62 — 2 (south)

• 63 — 3 (south)

• 64 — 4 (south)

• 65 — 5 (south)

• 66 — 6 (south)

• 67 — 7 (south)

• 68 — 8 (south)

• 69 — 9 (south)

• 70 — 10 (south)

• 71 — 11 (south)

• 72 — 12 (south)

• 73 — 13 (south)

• 74 — 14 (south)

• 75 — 15 (south)

• 76 — 16 (south)

• 77 — 17 (south)

• 78 — 18 (south)

• 79 — 19 (south)

• 80 — 20 (south)

• 81 — 21 (south)

• 82 — 22 (south)

• 83 — 23 (south)

• 84 — 24 (south)

• 85 — 25 (south)

• 86 — 26 (south)

• 87 — 27 (south)

• 88 — 28 (south)

• 89 — 29 (south)

• 90 — 30 (south)

• 91 — 31 (south)

• 92 — 32 (south)

• 93 — 33 (south)
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• 94 — 34 (south)

• 95 — 35 (south)

• 96 — 36 (south)

• 97 — 37 (south)

• 98 — 38 (south)

• 99 — 39 (south)

• 100 — 40 (south)

• 101 — 41 (south)

• 102 — 42 (south)

• 103 — 43 (south)

• 104 — 44 (south)

• 105 — 45 (south)

• 106 — 46 (south)

• 107 — 47 (south)

• 108 — 48 (south)

• 109 — 49 (south)

• 110 — 50 (south)

• 111 — 51 (south)

• 112 — 52 (south)

• 113 — 53 (south)

• 114 — 54 (south)

• 115 — 55 (south)

• 116 — 56 (south)

• 117 — 57 (south)

• 118 — 58 (south)

• 119 — 59 (south)

• 120 — 60 (south)

Default: 0

target state plane code [selection] <put parameter description here>

Options:

• 0 — —

• 1 — AK_10

• 2 — AK_2

• 3 — AK_3

• 4 — AK_4

• 5 — AK_5

• 6 — AK_6

• 7 — AK_7

• 8 — AK_8
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• 9 — AK_9

• 10 — AL_E

• 11 — AL_W

• 12 — AR_N

• 13 — AR_S

• 14 — AZ_C

• 15 — AZ_E

• 16 — AZ_W

• 17 — CA_I

• 18 — CA_II

• 19 — CA_III

• 20 — CA_IV

• 21 — CA_V

• 22 — CA_VI

• 23 — CA_VII

• 24 — CO_C

• 25 — CO_N

• 26 — CO_S

• 27 — CT

• 28 — DE

• 29 — FL_E

• 30 — FL_N

• 31 — FL_W

• 32 — GA_E

• 33 — GA_W

• 34 — HI_1

• 35 — HI_2

• 36 — HI_3

• 37 — HI_4

• 38 — HI_5

• 39 — IA_N

• 40 — IA_S

• 41 — ID_C

• 42 — ID_E

• 43 — ID_W

• 44 — IL_E

• 45 — IL_W

• 46 — IN_E

• 47 — IN_W

274 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

• 48 — KS_N

• 49 — KS_S

• 50 — KY_N

• 51 — KY_S

• 52 — LA_N

• 53 — LA_S

• 54 — MA_I

• 55 — MA_M

• 56 — MD

• 57 — ME_E

• 58 — ME_W

• 59 — MI_C

• 60 — MI_N

• 61 — MI_S

• 62 — MN_C

• 63 — MN_N

• 64 — MN_S

• 65 — MO_C

• 66 — MO_E

• 67 — MO_W

• 68 — MS_E

• 69 — MS_W

• 70 — MT_C

• 71 — MT_N

• 72 — MT_S

• 73 — NC

• 74 — ND_N

• 75 — ND_S

• 76 — NE_N

• 77 — NE_S

• 78 — NH

• 79 — NJ

• 80 — NM_C

• 81 — NM_E

• 82 — NM_W

• 83 — NV_C

• 84 — NV_E

• 85 — NV_W

• 86 — NY_C
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• 87 — NY_E

• 88 — NY_LI

• 89 — NY_W

• 90 — OH_N

• 91 — OH_S

• 92 — OK_N

• 93 — OK_S

• 94 — OR_N

• 95 — OR_S

• 96 — PA_N

• 97 — PA_S

• 98 — PR

• 99 — RI

• 100 — SC_N

• 101 — SC_S

• 102 — SD_N

• 103 — SD_S

• 104 — St.Croix

• 105 — TN

• 106 — TX_C

• 107 — TX_N

• 108 — TX_NC

• 109 — TX_S

• 110 — TX_SC

• 111 — UT_C

• 112 — UT_N

• 113 — UT_S

• 114 — VA_N

• 115 — VA_S

• 116 — VT

• 117 — WA_N

• 118 — WA_S

• 119 — WI_C

• 120 — WI_N

• 121 — WI_S

• 122 — WV_N

• 123 — WV_S

• 124 — WY_E

• 125 — WY_EC
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• 126 — WY_W

• 127 — WY_WC

Default: 0

Outputs

output LAS/LAZ file [file] <put output description here>

Console usage

processing.runalg(’lidartools:las2lasproject’, verbose, input_laslaz, source_projection, source_utm, source_sp, target_projection, target_utm, target_sp, output_laslaz)

See also

18.2.3 las2las_transform

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

transform (coordinates) [selection] <put parameter description here>

Options:

• 0 — —

• 1 — translate_x

• 2 — translate_y

• 3 — translate_z

• 4 — scale_x

• 5 — scale_y

• 6 — scale_z

• 7 — clamp_z_above

• 8 — clamp_z_below

Default: 0

value for transform (coordinates) [string] <put parameter description here>

Default: (not set)

second transform (coordinates) [selection] <put parameter description here>

Options:

• 0 — —
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• 1 — translate_x

• 2 — translate_y

• 3 — translate_z

• 4 — scale_x

• 5 — scale_y

• 6 — scale_z

• 7 — clamp_z_above

• 8 — clamp_z_below

Default: 0

value for second transform (coordinates) [string] <put parameter description here>

Default: (not set)

transform (intensities, scan angles, GPS times, ...) [selection] <put parameter
description here>

Options:

• 0 — —

• 1 — scale_intensity

• 2 — translate_intensity

• 3 — clamp_intensity_above

• 4 — clamp_intensity_below

• 5 — scale_scan_angle

• 6 — translate_scan_angle

• 7 — translate_gps_time

• 8 — set_classification

• 9 — set_user_data

• 10 — set_point_source

• 11 — scale_rgb_up

• 12 — scale_rgb_down

• 13 — repair_zero_returns

Default: 0

value for transform (intensities, scan angles, GPS times, ...) [string] <put
parameter description here>

Default: (not set)

second transform (intensities, scan angles, GPS times, ...) [selection] <put pa-
rameter description here>

Options:

• 0 — —

• 1 — scale_intensity

• 2 — translate_intensity

• 3 — clamp_intensity_above

• 4 — clamp_intensity_below
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• 5 — scale_scan_angle

• 6 — translate_scan_angle

• 7 — translate_gps_time

• 8 — set_classification

• 9 — set_user_data

• 10 — set_point_source

• 11 — scale_rgb_up

• 12 — scale_rgb_down

• 13 — repair_zero_returns

Default: 0

value for second transform (intensities, scan angles, GPS times, ...) [string]
<put parameter description here>

Default: (not set)

operations (first 7 need an argument) [selection] <put parameter description here>

Options:

• 0 — —

• 1 — set_point_type

• 2 — set_point_size

• 3 — set_version_minor

• 4 — set_version_major

• 5 — start_at_point

• 6 — stop_at_point

• 7 — remove_vlr

• 8 — auto_reoffset

• 9 — week_to_adjusted

• 10 — adjusted_to_week

• 11 — scale_rgb_up

• 12 — scale_rgb_down

• 13 — remove_all_vlrs

• 14 — remove_extra

• 15 — clip_to_bounding_box

Default: 0

argument for operation [string] <put parameter description here>

Default: (not set)

Outputs

output LAS/LAZ file [file] <put output description here>
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Console usage

processing.runalg(’lidartools:las2lastransform’, verbose, input_laslaz, transform_coordinate1, transform_coordinate1_arg, transform_coordinate2, transform_coordinate2_arg, transform_other1, transform_other1_arg, transform_other2, transform_other2_arg, operation, operationarg, output_laslaz)

See also

18.2.4 las2txt

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

parse_string [string] <put parameter description here>

Default: xyz

Outputs

Output ASCII file [file] <put output description here>

Console usage

processing.runalg(’lidartools:las2txt’, verbose, input_laslaz, parse_string, output)

See also

18.2.5 lasindex

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

is mobile or terrestrial LiDAR (not airborne) [boolean] <put parameter description here>

Default: False
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Outputs

Console usage

processing.runalg(’lidartools:lasindex’, verbose, input_laslaz, mobile_or_terrestrial)

See also

18.2.6 lasinfo

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

Outputs

Output ASCII file [file] <put output description here>

Console usage

processing.runalg(’lidartools:lasinfo’, verbose, input_laslaz, output)

See also

18.2.7 lasmerge

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

files are flightlines [boolean] <put parameter description here>

Default: True

input LAS/LAZ file [file] Optional.

<put parameter description here>

2nd file [file] Optional.

<put parameter description here>
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3rd file [file] Optional.

<put parameter description here>

4th file [file] Optional.

<put parameter description here>

5th file [file] Optional.

<put parameter description here>

6th file [file] Optional.

<put parameter description here>

7th file [file] Optional.

<put parameter description here>

Outputs

output LAS/LAZ file [file] <put output description here>

Console usage

processing.runalg(’lidartools:lasmerge’, verbose, files_are_flightlines, input_laslaz, file2, file3, file4, file5, file6, file7, output_laslaz)

See also

18.2.8 lasprecision

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

Outputs

Output ASCII file [file] <put output description here>

Console usage

processing.runalg(’lidartools:lasprecision’, verbose, input_laslaz, output)
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See also

18.2.9 lasquery

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

area of interest [extent] <put parameter description here>

Default: 0,1,0,1

Outputs

Console usage

processing.runalg(’lidartools:lasquery’, verbose, aoi)

See also

18.2.10 lasvalidate

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

Outputs

Output XML file [file] <put output description here>

Console usage

processing.runalg(’lidartools:lasvalidate’, verbose, input_laslaz, output)
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See also

18.2.11 laszip

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

input LAS/LAZ file [file] Optional.

<put parameter description here>

only report size [boolean] <put parameter description here>

Default: False

Outputs

output LAS/LAZ file [file] <put output description here>

Console usage

processing.runalg(’lidartools:laszip’, verbose, input_laslaz, report_size, output_laslaz)

See also

18.2.12 txt2las

Description

<put algortithm description here>

Parameters

verbose [boolean] <put parameter description here>

Default: False

Input ASCII file [file] Optional.

<put parameter description here>

parse lines as [string] <put parameter description here>

Default: xyz

skip the first n lines [number] <put parameter description here>

Default: 0

resolution of x and y coordinate [number] <put parameter description here>

Default: 0.01
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resolution of z coordinate [number] <put parameter description here>

Default: 0.01

Outputs

output LAS/LAZ file [file] <put output description here>

Console usage

processing.runalg(’lidartools:txt2las’, verbose, input, parse_string, skip, scale_factor_xy, scale_factor_z, output_laslaz)

See also

.

18.3 Modeler Tools

18.3.1 Calculator

Description

<put algortithm description here>

Parameters

Formula [string] <put parameter description here>

Default: (not set)

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0
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dummy [number] <put parameter description here>

Default: 0.0

dummy [number] <put parameter description here>

Default: 0.0

Outputs

Result [number] <put output description here>

Console usage

processing.runalg(’modelertools:calculator’, formula, number0, number1, number2, number3, number4, number5, number6, number7, number8, number9)

See also

18.3.2 Raster layer bounds

Description

<put algortithm description here>

Parameters

Layer [raster] <put parameter description here>

Outputs

min X [number] <put output description here>

max X [number] <put output description here>

min Y [number] <put output description here>

max Y [number] <put output description here>

Extent [extent] <put output description here>

Console usage

processing.runalg(’modelertools:rasterlayerbounds’, layer)

See also

18.3.3 Vector layer bounds

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>
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Outputs

min X [number] <put output description here>

max X [number] <put output description here>

min Y [number] <put output description here>

max Y [number] <put output description here>

Extent [extent] <put output description here>

Console usage

processing.runalg(’modelertools:vectorlayerbounds’, layer)

See also

.

18.4 OrfeoToolbox algorithm provider

Orfeo ToolBox (OTB) is an open source library of image processing algorithms. OTB is based on the medical
image processing library ITK and offers particular functionalities for remote sensing image processing in gen-
eral and for high spatial resolution images in particular. Targeted algorithms for high resolution optical images
(Pleiades, SPOT, QuickBird, WorldView, Landsat, Ikonos), hyperspectral sensors (Hyperion) or SAR (TerraSarX,
ERS, Palsar) are available.

Informacja: Please remember that Processing contains only the interface description, so you need to install OTB
by yourself and configure Processing properly.

.

18.4.1 Calibration

Optical calibration

Description

<put algortithm description here>

Parameters

Input [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Calibration Level [selection] <put parameter description here>

Options:

• 0 — toa

Default: 0
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Convert to milli reflectance [boolean] <put parameter description here>

Default: True

Clamp of reflectivity values between [0, 100] [boolean] <put parameter description here>

Default: True

Relative Spectral Response File [file] Optional.

<put parameter description here>

Outputs

Output [raster] <put output description here>

Console usage

processing.runalg(’otb:opticalcalibration’, -in, -ram, -level, -milli, -clamp, -rsr, -out)

See also

.

18.4.2 Feature extrcation

BinaryMorphologicalOperation (closing)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — closing

Default: 0
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Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:binarymorphologicaloperationclosing’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

BinaryMorphologicalOperation (dilate)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — dilate

Default: 0

Foreground Value [number] <put parameter description here>

Default: 1

Background Value [number] <put parameter description here>

Default: 0

Outputs

Feature Output Image [raster] <put output description here>
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Console usage

processing.runalg(’otb:binarymorphologicaloperationdilate’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -filter.dilate.foreval, -filter.dilate.backval, -out)

See also

BinaryMorphologicalOperation (erode)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — erode

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:binarymorphologicaloperationerode’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

BinaryMorphologicalOperation (opening)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — opening

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:binarymorphologicaloperationopening’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

EdgeExtraction (gradient)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Edge feature [selection] <put parameter description here>

Options:
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• 0 — gradient

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:edgeextractiongradient’, -in, -channel, -ram, -filter, -out)

See also

EdgeExtraction (sobel)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Edge feature [selection] <put parameter description here>

Options:

• 0 — sobel

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:edgeextractionsobel’, -in, -channel, -ram, -filter, -out)

See also

EdgeExtraction (touzi)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Edge feature [selection] <put parameter description here>

Options:

• 0 — touzi

Default: 0

The Radius [number] <put parameter description here>

Default: 1

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:edgeextractiontouzi’, -in, -channel, -ram, -filter, -filter.touzi.xradius, -out)

See also

GrayScaleMorphologicalOperation (closing)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5
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Morphological Operation [selection] <put parameter description here>

Options:

• 0 — closing

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:grayscalemorphologicaloperationclosing’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

GrayScaleMorphologicalOperation (dilate)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — dilate

Default: 0

Outputs

Feature Output Image [raster] <put output description here>
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Console usage

processing.runalg(’otb:grayscalemorphologicaloperationdilate’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

GrayScaleMorphologicalOperation (erode)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — erode

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:grayscalemorphologicaloperationerode’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

GrayScaleMorphologicalOperation (opening)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Structuring Element Type [selection] <put parameter description here>

Options:

• 0 — ball

Default: 0

The Structuring Element Radius [number] <put parameter description here>

Default: 5

Morphological Operation [selection] <put parameter description here>

Options:

• 0 — opening

Default: 0

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:grayscalemorphologicaloperationopening’, -in, -channel, -ram, -structype, -structype.ball.xradius, -filter, -out)

See also

Haralick Texture Extraction

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

X Radius [number] <put parameter description here>

Default: 2
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Y Radius [number] <put parameter description here>

Default: 2

X Offset [number] <put parameter description here>

Default: 1

Y Offset [number] <put parameter description here>

Default: 1

Image Minimum [number] <put parameter description here>

Default: 0

Image Maximum [number] <put parameter description here>

Default: 255

Histogram number of bin [number] <put parameter description here>

Default: 8

Texture Set Selection [selection] <put parameter description here>

Options:

• 0 — simple

• 1 — advanced

• 2 — higher

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:haralicktextureextraction’, -in, -channel, -ram, -parameters.xrad, -parameters.yrad, -parameters.xoff, -parameters.yoff, -parameters.min, -parameters.max, -parameters.nbbin, -texture, -out)

See also

Line segment detection

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

No rescaling in [0, 255] [boolean] <put parameter description here>

Default: True
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Outputs

Output Detected lines [vector] <put output description here>

Console usage

processing.runalg(’otb:linesegmentdetection’, -in, -norescale, -out)

See also

Local Statistic Extraction

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Selected Channel [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Neighborhood radius [number] <put parameter description here>

Default: 3

Outputs

Feature Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:localstatisticextraction’, -in, -channel, -ram, -radius, -out)

See also

Multivariate alteration detector

Description

<put algortithm description here>
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Parameters

Input Image 1 [raster] <put parameter description here>

Input Image 2 [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Change Map [raster] <put output description here>

Console usage

processing.runalg(’otb:multivariatealterationdetector’, -in1, -in2, -ram, -out)

See also

Radiometric Indices

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Blue Channel [number] <put parameter description here>

Default: 1

Green Channel [number] <put parameter description here>

Default: 1

Red Channel [number] <put parameter description here>

Default: 1

NIR Channel [number] <put parameter description here>

Default: 1

Mir Channel [number] <put parameter description here>

Default: 1

Available Radiometric Indices [selection] <put parameter description here>

Options:

• 0 — ndvi

• 1 — tndvi

• 2 — rvi
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• 3 — savi

• 4 — tsavi

• 5 — msavi

• 6 — msavi2

• 7 — gemi

• 8 — ipvi

• 9 — ndwi

• 10 — ndwi2

• 11 — mndwi

• 12 — ndpi

• 13 — ndti

• 14 — ri

• 15 — ci

• 16 — bi

• 17 — bi2

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:radiometricindices’, -in, -ram, -channels.blue, -channels.green, -channels.red, -channels.nir, -channels.mir, -list, -out)

See also

.

18.4.3 Geometry

Image Envelope

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Sampling Rate [number] <put parameter description here>

Default: 0
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Projection [string] Optional.

<put parameter description here>

Default: None

Outputs

Output Vector Data [vector] <put output description here>

Console usage

processing.runalg(’otb:imageenvelope’, -in, -sr, -proj, -out)

See also

OrthoRectification (epsg)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Output Cartographic Map Projection [selection] <put parameter description here>

Options:

• 0 — epsg

Default: 0

EPSG Code [number] <put parameter description here>

Default: 4326

Parameters estimation modes [selection] <put parameter description here>

Options:

• 0 — autosize

• 1 — autospacing

Default: 0

Default pixel value [number] <put parameter description here>

Default: 0

Default elevation [number] <put parameter description here>

Default: 0

Interpolation [selection] <put parameter description here>

Options:

• 0 — bco

• 1 — nn

• 2 — linear
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Default: 0

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Resampling grid spacing [number] <put parameter description here>

Default: 4

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:orthorectificationepsg’, -io.in, -map, -map.epsg.code, -outputs.mode, -outputs.default, -elev.default, -interpolator, -interpolator.bco.radius, -opt.ram, -opt.gridspacing, -io.out)

See also

OrthoRectification (fit-to-ortho)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Parameters estimation modes [selection] <put parameter description here>

Options:

• 0 — orthofit

Default: 0

Model ortho-image [raster] Optional.

<put parameter description here>

Default pixel value [number] <put parameter description here>

Default: 0

Default elevation [number] <put parameter description here>

Default: 0

Interpolation [selection] <put parameter description here>

Options:

• 0 — bco

• 1 — nn

• 2 — linear

Default: 0
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Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Resampling grid spacing [number] <put parameter description here>

Default: 4

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:orthorectificationfittoortho’, -io.in, -outputs.mode, -outputs.ortho, -outputs.default, -elev.default, -interpolator, -interpolator.bco.radius, -opt.ram, -opt.gridspacing, -io.out)

See also

OrthoRectification (lambert-WGS84)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Output Cartographic Map Projection [selection] <put parameter description here>

Options:

• 0 — lambert2

• 1 — lambert93

• 2 — wgs

Default: 0

Parameters estimation modes [selection] <put parameter description here>

Options:

• 0 — autosize

• 1 — autospacing

Default: 0

Default pixel value [number] <put parameter description here>

Default: 0

Default elevation [number] <put parameter description here>

Default: 0

Interpolation [selection] <put parameter description here>

Options:
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• 0 — bco

• 1 — nn

• 2 — linear

Default: 0

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Resampling grid spacing [number] <put parameter description here>

Default: 4

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:orthorectificationlambertwgs84’, -io.in, -map, -outputs.mode, -outputs.default, -elev.default, -interpolator, -interpolator.bco.radius, -opt.ram, -opt.gridspacing, -io.out)

See also

OrthoRectification (utm)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Output Cartographic Map Projection [selection] <put parameter description here>

Options:

• 0 — utm

Default: 0

Zone number [number] <put parameter description here>

Default: 31

Northern Hemisphere [boolean] <put parameter description here>

Default: True

Parameters estimation modes [selection] <put parameter description here>

Options:

• 0 — autosize

• 1 — autospacing

Default: 0
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Default pixel value [number] <put parameter description here>

Default: 0

Default elevation [number] <put parameter description here>

Default: 0

Interpolation [selection] <put parameter description here>

Options:

• 0 — bco

• 1 — nn

• 2 — linear

Default: 0

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Resampling grid spacing [number] <put parameter description here>

Default: 4

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:orthorectificationutm’, -io.in, -map, -map.utm.zone, -map.utm.northhem, -outputs.mode, -outputs.default, -elev.default, -interpolator, -interpolator.bco.radius, -opt.ram, -opt.gridspacing, -io.out)

See also

Pansharpening (bayes)

Description

<put algortithm description here>

Parameters

Input PAN Image [raster] <put parameter description here>

Input XS Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — bayes

Default: 0

Weight [number] <put parameter description here>

Default: 0.9999
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S coefficient [number] <put parameter description here>

Default: 1

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:pansharpeningbayes’, -inp, -inxs, -method, -method.bayes.lambda, -method.bayes.s, -ram, -out)

See also

Pansharpening (lmvm)

Description

<put algortithm description here>

Parameters

Input PAN Image [raster] <put parameter description here>

Input XS Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — lmvm

Default: 0

X radius [number] <put parameter description here>

Default: 3

Y radius [number] <put parameter description here>

Default: 3

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:pansharpeninglmvm’, -inp, -inxs, -method, -method.lmvm.radiusx, -method.lmvm.radiusy, -ram, -out)
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See also

Pansharpening (rcs)

Description

<put algortithm description here>

Parameters

Input PAN Image [raster] <put parameter description here>

Input XS Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — rcs

Default: 0

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:pansharpeningrcs’, -inp, -inxs, -method, -ram, -out)

See also

RigidTransformResample (id)

Description

<put algortithm description here>

Parameters

Input image [raster] <put parameter description here>

Type of transformation [selection] <put parameter description here>

Options:

• 0 — id

Default: 0

X scaling [number] <put parameter description here>

Default: 1
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Y scaling [number] <put parameter description here>

Default: 1

Interpolation [selection] <put parameter description here>

Options:

• 0 — nn

• 1 — linear

• 2 — bco

Default: 2

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:rigidtransformresampleid’, -in, -transform.type, -transform.type.id.scalex, -transform.type.id.scaley, -interpolator, -interpolator.bco.radius, -ram, -out)

See also

RigidTransformResample (rotation)

Description

<put algortithm description here>

Parameters

Input image [raster] <put parameter description here>

Type of transformation [selection] <put parameter description here>

Options:

• 0 — rotation

Default: 0

Rotation angle [number] <put parameter description here>

Default: 0

X scaling [number] <put parameter description here>

Default: 1

Y scaling [number] <put parameter description here>

Default: 1
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Interpolation [selection] <put parameter description here>

Options:

• 0 — nn

• 1 — linear

• 2 — bco

Default: 2

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:rigidtransformresamplerotation’, -in, -transform.type, -transform.type.rotation.angle, -transform.type.rotation.scalex, -transform.type.rotation.scaley, -interpolator, -interpolator.bco.radius, -ram, -out)

See also

RigidTransformResample (translation)

Description

<put algortithm description here>

Parameters

Input image [raster] <put parameter description here>

Type of transformation [selection] <put parameter description here>

Options:

• 0 — translation

Default: 0

The X translation (in physical units) [number] <put parameter description here>

Default: 0

The Y translation (in physical units) [number] <put parameter description here>

Default: 0

X scaling [number] <put parameter description here>

Default: 1

Y scaling [number] <put parameter description here>

Default: 1
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Interpolation [selection] <put parameter description here>

Options:

• 0 — nn

• 1 — linear

• 2 — bco

Default: 2

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:rigidtransformresampletranslation’, -in, -transform.type, -transform.type.translation.tx, -transform.type.translation.ty, -transform.type.translation.scalex, -transform.type.translation.scaley, -interpolator, -interpolator.bco.radius, -ram, -out)

See also

Superimpose sensor

Description

<put algortithm description here>

Parameters

Reference input [raster] <put parameter description here>

The image to reproject [raster] <put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Spacing of the deformation field [number] <put parameter description here>

Default: 4

Interpolation [selection] <put parameter description here>

Options:

• 0 — bco

• 1 — nn

• 2 — linear

Default: 0

Radius for bicubic interpolation [number] <put parameter description here>

Default: 2
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Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output image [raster] <put output description here>

Console usage

processing.runalg(’otb:superimposesensor’, -inr, -inm, -elev.default, -lms, -interpolator, -interpolator.bco.radius, -ram, -out)

See also

.

18.4.4 Image filtering

DimensionalityReduction (ica)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — ica

Default: 0

number of iterations [number] <put parameter description here>

Default: 20

Give the increment weight of W in [0, 1] [number] <put parameter description here>

Default: 1

Number of Components [number] <put parameter description here>

Default: 0

Normalize [boolean] <put parameter description here>

Default: True

Outputs

Output Image [raster] <put output description here>

‘‘ Inverse Output Image‘‘ [raster] <put output description here>

Transformation matrix output [file] <put output description here>
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Console usage

processing.runalg(’otb:dimensionalityreductionica’, -in, -method, -method.ica.iter, -method.ica.mu, -nbcomp, -normalize, -out, -outinv, -outmatrix)

See also

DimensionalityReduction (maf)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — maf

Default: 0

Number of Components. [number] <put parameter description here>

Default: 0

Normalize. [boolean] <put parameter description here>

Default: True

Outputs

Output Image [raster] <put output description here>

Transformation matrix output [file] <put output description here>

Console usage

processing.runalg(’otb:dimensionalityreductionmaf’, -in, -method, -nbcomp, -normalize, -out, -outmatrix)

See also

DimensionalityReduction (napca)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — napca

Default: 0

Set the x radius of the sliding window. [number] <put parameter description here>

Default: 1

Set the y radius of the sliding window. [number] <put parameter description here>

Default: 1

Number of Components. [number] <put parameter description here>

Default: 0

Normalize. [boolean] <put parameter description here>

Default: True

Outputs

Output Image [raster] <put output description here>

‘‘ Inverse Output Image‘‘ [raster] <put output description here>

Transformation matrix output [file] <put output description here>

Console usage

processing.runalg(’otb:dimensionalityreductionnapca’, -in, -method, -method.napca.radiusx, -method.napca.radiusy, -nbcomp, -normalize, -out, -outinv, -outmatrix)

See also

DimensionalityReduction (pca)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Algorithm [selection] <put parameter description here>

Options:

• 0 — pca

Default: 0

Number of Components. [number] <put parameter description here>

Default: 0
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Normalize. [boolean] <put parameter description here>

Default: True

Outputs

Output Image [raster] <put output description here>

‘‘ Inverse Output Image‘‘ [raster] <put output description here>

Transformation matrix output [file] <put output description here>

Console usage

processing.runalg(’otb:dimensionalityreductionpca’, -in, -method, -nbcomp, -normalize, -out, -outinv, -outmatrix)

See also

Mean Shift filtering (can be used as Exact Large-Scale Mean-Shift segmentation, step 1)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Spatial radius [number] <put parameter description here>

Default: 5

Range radius [number] <put parameter description here>

Default: 15

Mode convergence threshold [number] <put parameter description here>

Default: 0.1

Maximum number of iterations [number] <put parameter description here>

Default: 100

Range radius coefficient [number] <put parameter description here>

Default: 0

Mode search. [boolean] <put parameter description here>

Default: True

Outputs

Filtered output [raster] <put output description here>

Spatial image [raster] <put output description here>
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Console usage

processing.runalg(’otb:meanshiftfilteringcanbeusedasexactlargescalemeanshiftsegmentationstep1’, -in, -spatialr, -ranger, -thres, -maxiter, -rangeramp, -modesearch, -fout, -foutpos)

See also

Smoothing (anidif)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Smoothing Type [selection] <put parameter description here>

Options:

• 0 — anidif

Default: 2

Time Step [number] <put parameter description here>

Default: 0.125

Nb Iterations [number] <put parameter description here>

Default: 10

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:smoothinganidif’, -in, -ram, -type, -type.anidif.timestep, -type.anidif.nbiter, -out)

See also

Smoothing (gaussian)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Smoothing Type [selection] <put parameter description here>

Options:

• 0 — gaussian

Default: 2

Radius [number] <put parameter description here>

Default: 2

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:smoothinggaussian’, -in, -ram, -type, -type.gaussian.radius, -out)

See also

Smoothing (mean)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Smoothing Type [selection] <put parameter description here>

Options:

• 0 — mean

Default: 2

Radius [number] <put parameter description here>

Default: 2

Outputs

Output Image [raster] <put output description here>
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Console usage

processing.runalg(’otb:smoothingmean’, -in, -ram, -type, -type.mean.radius, -out)

See also

.

18.4.5 Image manipulation

ColorMapping (continuous)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Operation [selection] <put parameter description here>

Options:

• 0 — labeltocolor

Default: 0

Color mapping method [selection] <put parameter description here>

Options:

• 0 — continuous

Default: 0

Look-up tables [selection] <put parameter description here>

Options:

• 0 — red

• 1 — green

• 2 — blue

• 3 — grey

• 4 — hot

• 5 — cool

• 6 — spring

• 7 — summer

• 8 — autumn

• 9 — winter

• 10 — copper
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• 11 — jet

• 12 — hsv

• 13 — overunder

• 14 — relief

Default: 0

Mapping range lower value [number] <put parameter description here>

Default: 0

Mapping range higher value [number] <put parameter description here>

Default: 255

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:colormappingcontinuous’, -in, -ram, -op, -method, -method.continuous.lut, -method.continuous.min, -method.continuous.max, -out)

See also

ColorMapping (custom)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Operation [selection] <put parameter description here>

Options:

• 0 — labeltocolor

Default: 0

Color mapping method [selection] <put parameter description here>

Options:

• 0 — custom

Default: 0

Look-up table file [file] <put parameter description here>
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Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:colormappingcustom’, -in, -ram, -op, -method, -method.custom.lut, -out)

See also

ColorMapping (image)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Operation [selection] <put parameter description here>

Options:

• 0 — labeltocolor

Default: 0

Color mapping method [selection] <put parameter description here>

Options:

• 0 — image

Default: 0

Support Image [raster] <put parameter description here>

NoData value [number] <put parameter description here>

Default: 0

lower quantile [number] <put parameter description here>

Default: 2

upper quantile [number] <put parameter description here>

Default: 2

Outputs

Output Image [raster] <put output description here>
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Console usage

processing.runalg(’otb:colormappingimage’, -in, -ram, -op, -method, -method.image.in, -method.image.nodatavalue, -method.image.low, -method.image.up, -out)

See also

ColorMapping (optimal)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Operation [selection] <put parameter description here>

Options:

• 0 — labeltocolor

Default: 0

Color mapping method [selection] <put parameter description here>

Options:

• 0 — optimal

Default: 0

Background label [number] <put parameter description here>

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:colormappingoptimal’, -in, -ram, -op, -method, -method.optimal.background, -out)

See also

ExtractROI (fit)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Extraction mode [selection] <put parameter description here>

Options:

• 0 — fit

Default: 0

Reference image [raster] <put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:extractroifit’, -in, -ram, -mode, -mode.fit.ref, -mode.fit.elev.default, -out)

See also

ExtractROI (standard)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Extraction mode [selection] <put parameter description here>

Options:

• 0 — standard

Default: 0

Start X [number] <put parameter description here>

Default: 0

Start Y [number] <put parameter description here>

Default: 0
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Size X [number] <put parameter description here>

Default: 0

Size Y [number] <put parameter description here>

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:extractroistandard’, -in, -ram, -mode, -startx, -starty, -sizex, -sizey, -out)

See also

Images Concatenation

Description

<put algortithm description here>

Parameters

Input images list [multipleinput: rasters] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:imagesconcatenation’, -il, -ram, -out)

See also

Image Tile Fusion

Description

<put algortithm description here>
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Parameters

Input Tile Images [multipleinput: rasters] <put parameter description here>

Number of tile columns [number] <put parameter description here>

Default: 0

Number of tile rows [number] <put parameter description here>

Default: 0

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:imagetilefusion’, -il, -cols, -rows, -out)

See also

Read image information

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Display the OSSIM keywordlist [boolean] <put parameter description here>

Default: True

GCPs Id [string] <put parameter description here>

Default: None

GCPs Info [string] <put parameter description here>

Default: None

GCPs Image Coordinates [string] <put parameter description here>

Default: None

GCPs Geographic Coordinates [string] <put parameter description here>

Default: None

Outputs

Console usage

processing.runalg(’otb:readimageinformation’, -in, -keywordlist, -gcp.ids, -gcp.info, -gcp.imcoord, -gcp.geocoord)
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See also

Rescale Image

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Output min value [number] <put parameter description here>

Default: 0

Output max value [number] <put parameter description here>

Default: 255

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:rescaleimage’, -in, -ram, -outmin, -outmax, -out)

See also

Split Image

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output Image [file] <put output description here>
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Console usage

processing.runalg(’otb:splitimage’, -in, -ram, -out)

See also

.

18.4.6 Learning

Classification Map Regularization

Description

<put algortithm description here>

Parameters

Input classification image [raster] <put parameter description here>

Structuring element radius (in pixels) [number] <put parameter description here>

Default: 1

Multiple majority: Undecided(X)/Original [boolean] <put parameter description here>

Default: True

Label for the NoData class [number] <put parameter description here>

Default: 0

Label for the Undecided class [number] <put parameter description here>

Default: 0

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output regularized image [raster] <put output description here>

Console usage

processing.runalg(’otb:classificationmapregularization’, -io.in, -ip.radius, -ip.suvbool, -ip.nodatalabel, -ip.undecidedlabel, -ram, -io.out)

See also

ComputeConfusionMatrix (raster)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Ground truth [selection] <put parameter description here>

Options:

• 0 — raster

Default: 0

Input reference image [raster] <put parameter description here>

Value for nodata pixels [number] <put parameter description here>

Default: 0

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Matrix output [file] <put output description here>

Console usage

processing.runalg(’otb:computeconfusionmatrixraster’, -in, -ref, -ref.raster.in, -nodatalabel, -ram, -out)

See also

ComputeConfusionMatrix (vector)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Ground truth [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Input reference vector data [file] <put parameter description here>

Field name [string] Optional.

<put parameter description here>

Default: Class

Value for nodata pixels [number] <put parameter description here>

Default: 0

326 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Matrix output [file] <put output description here>

Console usage

processing.runalg(’otb:computeconfusionmatrixvector’, -in, -ref, -ref.vector.in, -ref.vector.field, -nodatalabel, -ram, -out)

See also

Compute Images second order statistics

Description

<put algortithm description here>

Parameters

Input images [multipleinput: rasters] <put parameter description here>

Background Value [number] <put parameter description here>

Default: 0.0

Outputs

Output XML file [file] <put output description here>

Console usage

processing.runalg(’otb:computeimagessecondorderstatistics’, -il, -bv, -out)

See also

FusionOfClassifications (dempstershafer)

Description

<put algortithm description here>

Parameters

Input classifications [multipleinput: rasters] <put parameter description here>

Fusion method [selection] <put parameter description here>

Options:
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• 0 — dempstershafer

Default: 0

Confusion Matrices [multipleinput: files] <put parameter description here>

Mass of belief measurement [selection] <put parameter description here>

Options:

• 0 — precision

• 1 — recall

• 2 — accuracy

• 3 — kappa

Default: 0

Label for the NoData class [number] <put parameter description here>

Default: 0

Label for the Undecided class [number] <put parameter description here>

Default: 0

Outputs

The output classification image [raster] <put output description here>

Console usage

processing.runalg(’otb:fusionofclassificationsdempstershafer’, -il, -method, -method.dempstershafer.cmfl, -method.dempstershafer.mob, -nodatalabel, -undecidedlabel, -out)

See also

FusionOfClassifications (majorityvoting)

Description

<put algortithm description here>

Parameters

Input classifications [multipleinput: rasters] <put parameter description here>

Fusion method [selection] <put parameter description here>

Options:

• 0 — majorityvoting

Default: 0

Label for the NoData class [number] <put parameter description here>

Default: 0

Label for the Undecided class [number] <put parameter description here>

Default: 0
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Outputs

The output classification image [raster] <put output description here>

Console usage

processing.runalg(’otb:fusionofclassificationsmajorityvoting’, -il, -method, -nodatalabel, -undecidedlabel, -out)

See also

Image Classification

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Input Mask [raster] Optional.

<put parameter description here>

Model file [file] <put parameter description here>

Statistics file [file] Optional.

<put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:imageclassification’, -in, -mask, -model, -imstat, -ram, -out)

See also

SOM Classification

Description

<put algortithm description here>
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Parameters

InputImage [raster] <put parameter description here>

ValidityMask [raster] Optional.

<put parameter description here>

TrainingProbability [number] <put parameter description here>

Default: 1

TrainingSetSize [number] <put parameter description here>

Default: 0

StreamingLines [number] <put parameter description here>

Default: 0

SizeX [number] <put parameter description here>

Default: 32

SizeY [number] <put parameter description here>

Default: 32

NeighborhoodX [number] <put parameter description here>

Default: 10

NeighborhoodY [number] <put parameter description here>

Default: 10

NumberIteration [number] <put parameter description here>

Default: 5

BetaInit [number] <put parameter description here>

Default: 1

BetaFinal [number] <put parameter description here>

Default: 0.1

InitialValue [number] <put parameter description here>

Default: 0

Available RAM (Mb) [number] <put parameter description here>

Default: 128

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

OutputImage [raster] <put output description here>

SOM Map [raster] <put output description here>

Console usage

processing.runalg(’otb:somclassification’, -in, -vm, -tp, -ts, -sl, -sx, -sy, -nx, -ny, -ni, -bi, -bf, -iv, -ram, -rand, -out, -som)
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See also

TrainImagesClassifier (ann)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — ann

Default: 0

Train Method Type [selection] <put parameter description here>

Options:

• 0 — reg

• 1 — back

Default: 0

Number of neurons in each intermediate layer [string] <put parameter description here>

Default: None

Neuron activation function type [selection] <put parameter description here>

Options:

• 0 — ident

• 1 — sig
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• 2 — gau

Default: 1

Alpha parameter of the activation function [number] <put parameter description here>

Default: 1

Beta parameter of the activation function [number] <put parameter description here>

Default: 1

Strength of the weight gradient term in the BACKPROP method [number] <put param-
eter description here>

Default: 0.1

Strength of the momentum term (the difference between weights on the 2 previous iterations) [number]
<put parameter description here>

Default: 0.1

Initial value Delta_0 of update-values Delta_{ij} in RPROP method [number]
<put parameter description here>

Default: 0.1

Update-values lower limit Delta_{min} in RPROP method [number] <put parameter de-
scription here>

Default: 1e-07

Termination criteria [selection] <put parameter description here>

Options:

• 0 — iter

• 1 — eps

• 2 — all

Default: 2

Epsilon value used in the Termination criteria [number] <put parameter description
here>

Default: 0.01

Maximum number of iterations used in the Termination criteria [number] <put pa-
rameter description here>

Default: 1000

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierann’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.ann.t, -classifier.ann.sizes, -classifier.ann.f, -classifier.ann.a, -classifier.ann.b, -classifier.ann.bpdw, -classifier.ann.bpms, -classifier.ann.rdw, -classifier.ann.rdwm, -classifier.ann.term, -classifier.ann.eps, -classifier.ann.iter, -rand, -io.confmatout, -io.out)
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See also

TrainImagesClassifier (bayes)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — bayes

Default: 0

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierbayes’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -rand, -io.confmatout, -io.out)
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See also

TrainImagesClassifier (boost)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — boost

Default: 0

Boost Type [selection] <put parameter description here>

Options:

• 0 — discrete

• 1 — real

• 2 — logit

• 3 — gentle

Default: 1

Weak count [number] <put parameter description here>

Default: 100

Weight Trim Rate [number] <put parameter description here>

Default: 0.95
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Maximum depth of the tree [number] <put parameter description here>

Default: 1

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierboost’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.boost.t, -classifier.boost.w, -classifier.boost.r, -classifier.boost.m, -rand, -io.confmatout, -io.out)

See also

TrainImagesClassifier (dt)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — dt
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Default: 0

Maximum depth of the tree [number] <put parameter description here>

Default: 65535

Minimum number of samples in each node [number] <put parameter description here>

Default: 10

Termination criteria for regression tree [number] <put parameter description here>

Default: 0.01

Cluster possible values of a categorical variable into K <= cat clusters to find a suboptimal split [number]
<put parameter description here>

Default: 10

K-fold cross-validations [number] <put parameter description here>

Default: 10

Set Use1seRule flag to false [boolean] <put parameter description here>

Default: True

Set TruncatePrunedTree flag to false [boolean] <put parameter description here>

Default: True

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierdt’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.dt.max, -classifier.dt.min, -classifier.dt.ra, -classifier.dt.cat, -classifier.dt.f, -classifier.dt.r, -classifier.dt.t, -rand, -io.confmatout, -io.out)

See also

TrainImagesClassifier (gbt)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>
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Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — gbt

Default: 0

Number of boosting algorithm iterations [number] <put parameter description here>

Default: 200

Regularization parameter [number] <put parameter description here>

Default: 0.01

Portion of the whole training set used for each algorithm iteration [number]
<put parameter description here>

Default: 0.8

Maximum depth of the tree [number] <put parameter description here>

Default: 3

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifiergbt’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.gbt.w, -classifier.gbt.s, -classifier.gbt.p, -classifier.gbt.max, -rand, -io.confmatout, -io.out)
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See also

TrainImagesClassifier (knn)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — knn

Default: 0

Number of Neighbors [number] <put parameter description here>

Default: 32

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>
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Console usage

processing.runalg(’otb:trainimagesclassifierknn’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.knn.k, -rand, -io.confmatout, -io.out)

See also

TrainImagesClassifier (libsvm)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — libsvm

Default: 0

SVM Kernel Type [selection] <put parameter description here>

Options:

• 0 — linear

• 1 — rbf

• 2 — poly

• 3 — sigmoid

Default: 0
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Cost parameter C [number] <put parameter description here>

Default: 1

Parameters optimization [boolean] <put parameter description here>

Default: True

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierlibsvm’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.libsvm.k, -classifier.libsvm.c, -classifier.libsvm.opt, -rand, -io.confmatout, -io.out)

See also

TrainImagesClassifier (rf)

Description

<put algortithm description here>

Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class
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Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — rf

Default: 0

Maximum depth of the tree [number] <put parameter description here>

Default: 5

Minimum number of samples in each node [number] <put parameter description here>

Default: 10

Termination Criteria for regression tree [number] <put parameter description here>

Default: 0

Cluster possible values of a categorical variable into K <= cat clusters to find a suboptimal split [number]
<put parameter description here>

Default: 10

Size of the randomly selected subset of features at each tree node [number]
<put parameter description here>

Default: 0

Maximum number of trees in the forest [number] <put parameter description here>

Default: 100

Sufficient accuracy (OOB error) [number] <put parameter description here>

Default: 0.01

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifierrf’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.rf.max, -classifier.rf.min, -classifier.rf.ra, -classifier.rf.cat, -classifier.rf.var, -classifier.rf.nbtrees, -classifier.rf.acc, -rand, -io.confmatout, -io.out)

See also

TrainImagesClassifier (svm)

Description

<put algortithm description here>
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Parameters

Input Image List [multipleinput: rasters] <put parameter description here>

Input Vector Data List [multipleinput: any vectors] <put parameter description here>

Input XML image statistics file [file] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Maximum training sample size per class [number] <put parameter description here>

Default: 1000

Maximum validation sample size per class [number] <put parameter description here>

Default: 1000

On edge pixel inclusion [boolean] <put parameter description here>

Default: True

Training and validation sample ratio [number] <put parameter description here>

Default: 0.5

Name of the discrimination field [string] <put parameter description here>

Default: Class

Classifier to use for the training [selection] <put parameter description here>

Options:

• 0 — svm

Default: 0

SVM Model Type [selection] <put parameter description here>

Options:

• 0 — csvc

• 1 — nusvc

• 2 — oneclass

Default: 0

SVM Kernel Type [selection] <put parameter description here>

Options:

• 0 — linear

• 1 — rbf

• 2 — poly

• 3 — sigmoid

Default: 0

Cost parameter C [number] <put parameter description here>

Default: 1

Parameter nu of a SVM optimization problem (NU_SVC / ONE_CLASS) [number] <put
parameter description here>

Default: 0
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Parameter coef0 of a kernel function (POLY / SIGMOID) [number] <put parameter de-
scription here>

Default: 0

Parameter gamma of a kernel function (POLY / RBF / SIGMOID) [number] <put param-
eter description here>

Default: 1

Parameter degree of a kernel function (POLY) [number] <put parameter description here>

Default: 1

Parameters optimization [boolean] <put parameter description here>

Default: True

set user defined seed [number] <put parameter description here>

Default: 0

Outputs

Output confusion matrix [file] <put output description here>

Output model [file] <put output description here>

Console usage

processing.runalg(’otb:trainimagesclassifiersvm’, -io.il, -io.vd, -io.imstat, -elev.default, -sample.mt, -sample.mv, -sample.edg, -sample.vtr, -sample.vfn, -classifier, -classifier.svm.m, -classifier.svm.k, -classifier.svm.c, -classifier.svm.nu, -classifier.svm.coef0, -classifier.svm.gamma, -classifier.svm.degree, -classifier.svm.opt, -rand, -io.confmatout, -io.out)

See also

Unsupervised KMeans image classification

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Validity Mask [raster] Optional.

<put parameter description here>

Training set size [number] <put parameter description here>

Default: 100

Number of classes [number] <put parameter description here>

Default: 5

Maximum number of iterations [number] <put parameter description here>

Default: 1000
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Convergence threshold [number] <put parameter description here>

Default: 0.0001

Outputs

Output Image [raster] <put output description here>

Centroid filename [file] <put output description here>

Console usage

processing.runalg(’otb:unsupervisedkmeansimageclassification’, -in, -ram, -vm, -ts, -nc, -maxit, -ct, -out, -outmeans)

See also

.

18.4.7 Miscellaneous

Band Math

Description

<put algortithm description here>

Parameters

Input image list [multipleinput: rasters] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Expression [string] <put parameter description here>

Default: None

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:bandmath’, -il, -ram, -exp, -out)

See also

ComputeModulusAndPhase-one (OneEntry)

Description

<put algortithm description here>
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Parameters

Number Of inputs [selection] <put parameter description here>

Options:

• 0 — one

Default: 0

Input image [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Modulus [raster] <put output description here>

Phase [raster] <put output description here>

Console usage

processing.runalg(’otb:computemodulusandphaseoneoneentry’, -nbinput, -nbinput.one.in, -ram, -mod, -pha)

See also

ComputeModulusAndPhase-two (TwoEntries)

Description

<put algortithm description here>

Parameters

Number Of inputs [selection] <put parameter description here>

Options:

• 0 — two

Default: 0

Real part input [raster] <put parameter description here>

Imaginary part input [raster] <put parameter description here>

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Modulus [raster] <put output description here>

Phase [raster] <put output description here>
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Console usage

processing.runalg(’otb:computemodulusandphasetwotwoentries’, -nbinput, -nbinput.two.re, -nbinput.two.im, -ram, -mod, -pha)

See also

Images comparaison

Description

<put algortithm description here>

Parameters

Reference image [raster] <put parameter description here>

Reference image channel [number] <put parameter description here>

Default: 1

Measured image [raster] <put parameter description here>

Measured image channel [number] <put parameter description here>

Default: 1

Start X [number] <put parameter description here>

Default: 0

Start Y [number] <put parameter description here>

Default: 0

Size X [number] <put parameter description here>

Default: 0

Size Y [number] <put parameter description here>

Default: 0

Outputs

Console usage

processing.runalg(’otb:imagescomparaison’, -ref.in, -ref.channel, -meas.in, -meas.channel, -roi.startx, -roi.starty, -roi.sizex, -roi.sizey)

See also

Image to KMZ Export

Description

<put algortithm description here>
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Parameters

Input image [raster] <put parameter description here>

Tile Size [number] <put parameter description here>

Default: 512

Image logo [raster] Optional.

<put parameter description here>

Image legend [raster] Optional.

<put parameter description here>

Default elevation [number] <put parameter description here>

Default: 0

Outputs

Output .kmz product [file] <put output description here>

Console usage

processing.runalg(’otb:imagetokmzexport’, -in, -tilesize, -logo, -legend, -elev.default, -out)

See also

.

18.4.8 Segmentation

Connected Component Segmentation

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Mask expression [string] Optional.

<put parameter description here>

Default: None

Connected Component Expression [string] <put parameter description here>

Default: None

Minimum Object Size [number] <put parameter description here>

Default: 2
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OBIA Expression [string] Optional.

<put parameter description here>

Default: None

Default elevation [number] <put parameter description here>

Default: 0

Outputs

Output Shape [vector] <put output description here>

Console usage

processing.runalg(’otb:connectedcomponentsegmentation’, -in, -mask, -expr, -minsize, -obia, -elev.default, -out)

See also

Exact Large-Scale Mean-Shift segmentation, step 2

Description

<put algortithm description here>

Parameters

Filtered image [raster] <put parameter description here>

Spatial image [raster] Optional.

<put parameter description here>

Range radius [number] <put parameter description here>

Default: 15

Spatial radius [number] <put parameter description here>

Default: 5

Minimum Region Size [number] <put parameter description here>

Default: 0

Size of tiles in pixel (X-axis) [number] <put parameter description here>

Default: 500

Size of tiles in pixel (Y-axis) [number] <put parameter description here>

Default: 500

Directory where to write temporary files [file] Optional.

<put parameter description here>

Temporary files cleaning [boolean] <put parameter description here>

Default: True
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Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:exactlargescalemeanshiftsegmentationstep2’, -in, -inpos, -ranger, -spatialr, -minsize, -tilesizex, -tilesizey, -tmpdir, -cleanup, -out)

See also

Exact Large-Scale Mean-Shift segmentation, step 3 (optional)

Description

<put algortithm description here>

Parameters

Input image [raster] <put parameter description here>

Segmented image [raster] <put parameter description here>

Minimum Region Size [number] <put parameter description here>

Default: 50

Size of tiles in pixel (X-axis) [number] <put parameter description here>

Default: 500

Size of tiles in pixel (Y-axis) [number] <put parameter description here>

Default: 500

Outputs

Output Image [raster] <put output description here>

Console usage

processing.runalg(’otb:exactlargescalemeanshiftsegmentationstep3optional’, -in, -inseg, -minsize, -tilesizex, -tilesizey, -out)

See also

Exact Large-Scale Mean-Shift segmentation, step 4

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Segmented image [raster] <put parameter description here>

Size of tiles in pixel (X-axis) [number] <put parameter description here>

Default: 500

Size of tiles in pixel (Y-axis) [number] <put parameter description here>

Default: 500

Outputs

Output GIS vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:exactlargescalemeanshiftsegmentationstep4’, -in, -inseg, -tilesizex, -tilesizey, -out)

See also

Hoover compare segmentation

Description

<put algortithm description here>

Parameters

Input ground truth [raster] <put parameter description here>

Input machine segmentation [raster] <put parameter description here>

Background label [number] <put parameter description here>

Default: 0

Overlapping threshold [number] <put parameter description here>

Default: 0.75

Correct detection score [number] <put parameter description here>

Default: 0.0

Over-segmentation score [number] <put parameter description here>

Default: 0.0

Under-segmentation score [number] <put parameter description here>

Default: 0.0

Missed detection score [number] <put parameter description here>

Default: 0.0
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Outputs

Colored ground truth output [raster] <put output description here>

Colored machine segmentation output [raster] <put output description here>

Console usage

processing.runalg(’otb:hoovercomparesegmentation’, -ingt, -inms, -bg, -th, -rc, -rf, -ra, -rm, -outgt, -outms)

See also

Segmentation (cc)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Segmentation algorithm [selection] <put parameter description here>

Options:

• 0 — cc

Default: 0

Condition [string] <put parameter description here>

Default: None

Processing mode [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Writing mode for the output vector file [selection] <put parameter description here>

Options:

• 0 — ulco

• 1 — ovw

• 2 — ulovw

• 3 — ulu

Default: 0

Mask Image [raster] Optional.

<put parameter description here>

8-neighbor connectivity [boolean] <put parameter description here>

Default: True
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Stitch polygons [boolean] <put parameter description here>

Default: True

Minimum object size [number] <put parameter description here>

Default: 1

Simplify polygons [number] <put parameter description here>

Default: 0.1

Layer name [string] <put parameter description here>

Default: layer

Geometry index field name [string] <put parameter description here>

Default: DN

Tiles size [number] <put parameter description here>

Default: 1024

Starting geometry index [number] <put parameter description here>

Default: 1

OGR options for layer creation [string] Optional.

<put parameter description here>

Default: None

Outputs

Output vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:segmentationcc’, -in, -filter, -filter.cc.expr, -mode, -mode.vector.outmode, -mode.vector.inmask, -mode.vector.neighbor, -mode.vector.stitch, -mode.vector.minsize, -mode.vector.simplify, -mode.vector.layername, -mode.vector.fieldname, -mode.vector.tilesize, -mode.vector.startlabel, -mode.vector.ogroptions, -mode.vector.out)

See also

Segmentation (edison)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Segmentation algorithm [selection] <put parameter description here>

Options:

• 0 — edison

Default: 0

Spatial radius [number] <put parameter description here>

Default: 5
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Range radius [number] <put parameter description here>

Default: 15

Minimum region size [number] <put parameter description here>

Default: 100

Scale factor [number] <put parameter description here>

Default: 1

Processing mode [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Writing mode for the output vector file [selection] <put parameter description here>

Options:

• 0 — ulco

• 1 — ovw

• 2 — ulovw

• 3 — ulu

Default: 0

Mask Image [raster] Optional.

<put parameter description here>

8-neighbor connectivity [boolean] <put parameter description here>

Default: True

Stitch polygons [boolean] <put parameter description here>

Default: True

Minimum object size [number] <put parameter description here>

Default: 1

Simplify polygons [number] <put parameter description here>

Default: 0.1

Layer name [string] <put parameter description here>

Default: layer

Geometry index field name [string] <put parameter description here>

Default: DN

Tiles size [number] <put parameter description here>

Default: 1024

Starting geometry index [number] <put parameter description here>

Default: 1

OGR options for layer creation [string] Optional.

<put parameter description here>

Default: None

18.4. OrfeoToolbox algorithm provider 353



QGIS User Guide, Wydanie 2.6

Outputs

Output vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:segmentationedison’, -in, -filter, -filter.edison.spatialr, -filter.edison.ranger, -filter.edison.minsize, -filter.edison.scale, -mode, -mode.vector.outmode, -mode.vector.inmask, -mode.vector.neighbor, -mode.vector.stitch, -mode.vector.minsize, -mode.vector.simplify, -mode.vector.layername, -mode.vector.fieldname, -mode.vector.tilesize, -mode.vector.startlabel, -mode.vector.ogroptions, -mode.vector.out)

See also

Segmentation (meanshift)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Segmentation algorithm [selection] <put parameter description here>

Options:

• 0 — meanshift

Default: 0

Spatial radius [number] <put parameter description here>

Default: 5

Range radius [number] <put parameter description here>

Default: 15

Mode convergence threshold [number] <put parameter description here>

Default: 0.1

Maximum number of iterations [number] <put parameter description here>

Default: 100

Minimum region size [number] <put parameter description here>

Default: 100

Processing mode [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Writing mode for the output vector file [selection] <put parameter description here>

Options:

• 0 — ulco

• 1 — ovw

• 2 — ulovw
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• 3 — ulu

Default: 0

Mask Image [raster] Optional.

<put parameter description here>

8-neighbor connectivity [boolean] <put parameter description here>

Default: True

Stitch polygons [boolean] <put parameter description here>

Default: True

Minimum object size [number] <put parameter description here>

Default: 1

Simplify polygons [number] <put parameter description here>

Default: 0.1

Layer name [string] <put parameter description here>

Default: layer

Geometry index field name [string] <put parameter description here>

Default: DN

Tiles size [number] <put parameter description here>

Default: 1024

Starting geometry index [number] <put parameter description here>

Default: 1

OGR options for layer creation [string] Optional.

<put parameter description here>

Default: None

Outputs

Output vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:segmentationmeanshift’, -in, -filter, -filter.meanshift.spatialr, -filter.meanshift.ranger, -filter.meanshift.thres, -filter.meanshift.maxiter, -filter.meanshift.minsize, -mode, -mode.vector.outmode, -mode.vector.inmask, -mode.vector.neighbor, -mode.vector.stitch, -mode.vector.minsize, -mode.vector.simplify, -mode.vector.layername, -mode.vector.fieldname, -mode.vector.tilesize, -mode.vector.startlabel, -mode.vector.ogroptions, -mode.vector.out)

See also

Segmentation (mprofiles)

Description

<put algortithm description here>
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Parameters

Input Image [raster] <put parameter description here>

Segmentation algorithm [selection] <put parameter description here>

Options:

• 0 — mprofiles

Default: 0

Profile Size [number] <put parameter description here>

Default: 5

Initial radius [number] <put parameter description here>

Default: 1

Radius step. [number] <put parameter description here>

Default: 1

Threshold of the final decision rule [number] <put parameter description here>

Default: 1

Processing mode [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Writing mode for the output vector file [selection] <put parameter description here>

Options:

• 0 — ulco

• 1 — ovw

• 2 — ulovw

• 3 — ulu

Default: 0

Mask Image [raster] Optional.

<put parameter description here>

8-neighbor connectivity [boolean] <put parameter description here>

Default: True

Stitch polygons [boolean] <put parameter description here>

Default: True

Minimum object size [number] <put parameter description here>

Default: 1

Simplify polygons [number] <put parameter description here>

Default: 0.1

Layer name [string] <put parameter description here>

Default: layer
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Geometry index field name [string] <put parameter description here>

Default: DN

Tiles size [number] <put parameter description here>

Default: 1024

Starting geometry index [number] <put parameter description here>

Default: 1

OGR options for layer creation [string] Optional.

<put parameter description here>

Default: None

Outputs

Output vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:segmentationmprofiles’, -in, -filter, -filter.mprofiles.size, -filter.mprofiles.start, -filter.mprofiles.step, -filter.mprofiles.sigma, -mode, -mode.vector.outmode, -mode.vector.inmask, -mode.vector.neighbor, -mode.vector.stitch, -mode.vector.minsize, -mode.vector.simplify, -mode.vector.layername, -mode.vector.fieldname, -mode.vector.tilesize, -mode.vector.startlabel, -mode.vector.ogroptions, -mode.vector.out)

See also

Segmentation (watershed)

Description

<put algortithm description here>

Parameters

Input Image [raster] <put parameter description here>

Segmentation algorithm [selection] <put parameter description here>

Options:

• 0 — watershed

Default: 0

Depth Threshold [number] <put parameter description here>

Default: 0.01

Flood Level [number] <put parameter description here>

Default: 0.1

Processing mode [selection] <put parameter description here>

Options:

• 0 — vector

Default: 0

Writing mode for the output vector file [selection] <put parameter description here>

Options:
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• 0 — ulco

• 1 — ovw

• 2 — ulovw

• 3 — ulu

Default: 0

Mask Image [raster] Optional.

<put parameter description here>

8-neighbor connectivity [boolean] <put parameter description here>

Default: True

Stitch polygons [boolean] <put parameter description here>

Default: True

Minimum object size [number] <put parameter description here>

Default: 1

Simplify polygons [number] <put parameter description here>

Default: 0.1

Layer name [string] <put parameter description here>

Default: layer

Geometry index field name [string] <put parameter description here>

Default: DN

Tiles size [number] <put parameter description here>

Default: 1024

Starting geometry index [number] <put parameter description here>

Default: 1

OGR options for layer creation [string] Optional.

<put parameter description here>

Default: None

Outputs

Output vector file [vector] <put output description here>

Console usage

processing.runalg(’otb:segmentationwatershed’, -in, -filter, -filter.watershed.threshold, -filter.watershed.level, -mode, -mode.vector.outmode, -mode.vector.inmask, -mode.vector.neighbor, -mode.vector.stitch, -mode.vector.minsize, -mode.vector.simplify, -mode.vector.layername, -mode.vector.fieldname, -mode.vector.tilesize, -mode.vector.startlabel, -mode.vector.ogroptions, -mode.vector.out)

See also

.
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18.4.9 Stereo

Stereo Framework

Description

<put algortithm description here>

Parameters

Input images list [multipleinput: rasters] <put parameter description here>

Couples list [string] Optional.

<put parameter description here>

Default: None

Image channel used for the block matching [number] <put parameter description here>

Default: 1

Default elevation [number] <put parameter description here>

Default: 0

Output resolution [number] <put parameter description here>

Default: 1

NoData value [number] <put parameter description here>

Default: -32768

Method to fuse measures in each DSM cell [selection] <put parameter description here>

Options:

• 0 — max

• 1 — min

• 2 — mean

• 3 — acc

Default: 0

Parameters estimation modes [selection] <put parameter description here>

Options:

• 0 — fit

• 1 — user

Default: 0

Upper Left X [number] <put parameter description here>

Default: 0.0

Upper Left Y [number] <put parameter description here>

Default: 0.0

Size X [number] <put parameter description here>

Default: 0
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Size Y [number] <put parameter description here>

Default: 0

Pixel Size X [number] <put parameter description here>

Default: 0.0

Pixel Size Y [number] <put parameter description here>

Default: 0.0

Output Cartographic Map Projection [selection] <put parameter description here>

Options:

• 0 — utm

• 1 — lambert2

• 2 — lambert93

• 3 — wgs

• 4 — epsg

Default: 3

Zone number [number] <put parameter description here>

Default: 31

Northern Hemisphere [boolean] <put parameter description here>

Default: True

EPSG Code [number] <put parameter description here>

Default: 4326

Step of the deformation grid (in pixels) [number] <put parameter description here>

Default: 16

Sub-sampling rate for epipolar grid inversion [number] <put parameter description here>

Default: 10

Block-matching metric [selection] <put parameter description here>

Options:

• 0 — ssdmean

• 1 — ssd

• 2 — ncc

• 3 — lp

Default: 0

p value [number] <put parameter description here>

Default: 1

Radius of blocks for matching filter (in pixels) [number] <put parameter description
here>

Default: 2

Minimum altitude offset (in meters) [number] <put parameter description here>

Default: -20
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Maximum altitude offset (in meters) [number] <put parameter description here>

Default: 20

Use bijection consistency in block matching strategy [boolean] <put parameter de-
scription here>

Default: True

Use median disparities filtering [boolean] <put parameter description here>

Default: True

Correlation metric threshold [number] <put parameter description here>

Default: 0.6

Input left mask [raster] Optional.

<put parameter description here>

Input right mask [raster] Optional.

<put parameter description here>

Discard pixels with low local variance [number] <put parameter description here>

Default: 50

Available RAM (Mb) [number] <put parameter description here>

Default: 128

Outputs

Output DSM [raster] <put output description here>

Console usage

processing.runalg(’otb:stereoframework’, -input.il, -input.co, -input.channel, -elev.default, -output.res, -output.nodata, -output.fusionmethod, -output.mode, -output.mode.user.ulx, -output.mode.user.uly, -output.mode.user.sizex, -output.mode.user.sizey, -output.mode.user.spacingx, -output.mode.user.spacingy, -map, -map.utm.zone, -map.utm.northhem, -map.epsg.code, -stereorect.fwdgridstep, -stereorect.invgridssrate, -bm.metric, -bm.metric.lp.p, -bm.radius, -bm.minhoffset, -bm.maxhoffset, -postproc.bij, -postproc.med, -postproc.metrict, -mask.left, -mask.right, -mask.variancet, -ram, -output.out)

See also

.

18.4.10 Vector

Concatenate

Description

<put algortithm description here>

Parameters

Input VectorDatas to concatenate [multipleinput: any vectors] <put parameter description here>
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Outputs

Concatenated VectorData [vector] <put output description here>

Console usage

processing.runalg(’otb:concatenate’, -vd, -out)

See also

.

18.5 QGIS algorithm provider

QGIS algortihm provider implements various analysis and geoprocessing operations using mostly only QGIS API.
So almost all algorthms from this provider will work “out of the box” without any additional configuration.

This provider incorporates fTools functionality, some algorithms from mmQGIS plugin and also adds its own
algorithms.

.

18.5.1 Database

Import into PostGIS

Description

<put algortithm description here>

Parameters

Layer to import [vector: any] <put parameter description here>

Database (connection name) [selection] <put parameter description here>

Options:

• 0 — local

Default: 0

Schema (schema name) [string] <put parameter description here>

Default: public

Table to import to (leave blank to use layer name) [string] <put parameter description
here>

Default: (not set)

Primary key field [tablefield: any] Optional.

<put parameter description here>

Geometry column [string] <put parameter description here>

Default: geom
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Overwrite [boolean] <put parameter description here>

Default: True

Create spatial index [boolean] <put parameter description here>

Default: True

Convert field names to lowercase [boolean] <put parameter description here>

Default: True

Drop length constraints on character fields [boolean] <put parameter description here>

Default: False

Outputs

Console usage

processing.runalg(’qgis:importintopostgis’, input, database, schema, tablename, primary_key, geometry_column, overwrite, createindex, lowercase_names, drop_string_length)

See also

PostGIS execute SQL

Description

<put algortithm description here>

Parameters

Database [string] <put parameter description here>

Default: (not set)

SQL query [string] <put parameter description here>

Default: (not set)

Outputs

Console usage

processing.runalg(’qgis:postgisexecutesql’, database, sql)

See also

.
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18.5.2 Raster general

Set style for raster layer

Description

<put algortithm description here>

Parameters

Raster layer [raster] <put parameter description here>

Style file [file] <put parameter description here>

Outputs

Styled layer [raster] <put output description here>

Console usage

processing.runalg(’qgis:setstyleforrasterlayer’, input, style)

See also

.

18.5.3 Raster

Hypsometric curves

Description

Calculate hypsometric curves for features of polygon layer and save them as CSV file for further processing.

Parameters

DEM to analyze [raster] DEM to use for calculating altitudes.

Boundary layer [vector: polygon] Polygonal vector layer with boundaries of areas used to calculate hypso-
metric curves.

Step [number] Distanse between curves.

Default: 100.0

Use % of area instead of absolute value [boolean] Write area percentage to “Area” field of the
CSV file instead of absolute area value.

Default: False
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Outputs

Output directory [directory] Directory where output will be saved. For each feature from input vector
layer CSV file with area and altitude values will be created.

File name consists of prefix hystogram_ followed by layer name and feature ID.

Console usage

processing.runalg(’qgis:hypsometriccurves’, input_dem, boundary_layer, step, use_percentage, output_directory)

See also

Raster layer statistics

Description

Calculates basic statistics of the raster layer.

Parameters

Input layer [raster] Raster to analyze.

Outputs

Statistics [html] Analysis results in HTML format.

Minimum value [number] Minimum cell value.

Maximum value [number] Maximum cell value.

Sum [number] Sum of all cells values.

Mean value [number] Mean cell value.

valid cells count [number] Number of cell with data.

No-data cells count [number] Number of NODATA cells.

Standard deviation [number] Standard deviation of cells values.

Console usage

processing.runalg(’qgis:rasterlayerstatistics’, input, output_html_file)

See also

Zonal Statistics

Description

Calculates some statistics values for pixels of input raster inside certain zones, defined as polygon layer.

Following values calculated for each zone:

• minimum
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• maximum

• sum

• count

• mean

• standard deviation

• number of unique values

• range

• variance

Parameters

Raster layer [raster] Raster to analyze.

Raster band [number] Number of raster band to analyze.

Default: 1

Vector layer containing zones [vector: polygon] Layer with zones boundaries.

Output column prefix [string] Prefix for output fields.

Default: _

Load whole raster in memory [boolean] Determines if raster band will be loaded in memory (True)
or readed by chunks (False). Useful only when disk IO or raster scanning inefficiencies are your limiting
factor.

Default: True

Outputs

Output layer [vector] The resulting layer. Basically this is same layer as zones layer with new columns
containing statistics added.

Console usage

processing.runalg(’qgis:zonalstatistics’, input_raster, raster_band, input_vector, column_prefix, global_extent, output_layer)

See also

.

18.5.4 Table

Frequency analysis

Description

<put algortithm description here>
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Parameters

input [vector: any] <put parameter description here>

fields [string] <put parameter description here>

Default: (not set)

Outputs

output [table] <put output description here>

Console usage

processing.runalg(’qgis:frequencyanalysis’, input, fields, output)

See also

.

18.5.5 Vector analysis

Count points in polygon

Description

Counts the number of points present in each feature of a polygon layer.

Parameters

Polygons [vector: polygon] Polygons layer.

Points [vector: point] Points layer.

Count field name [string] The name of the attribute table column containing the points number.

Default: NUMPOINTS

Outputs

Result [vector] Resulting layer with the attribute table containing the new column of the points count.

Console usage

processing.runalg(’qgis:countpointsinpolygon’, polygons, points, field, output)
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See also

Count points in polygon (weighted)

Description

Counts the number of points in each feature of a polygon layer and calculates the mean of the selected field for
each feature of the polygon layer. These values will be added to the attribute table of the resulting polygon layer.

Parameters

Polygons [vector: polygon] Polygons layer.

Points [vector: point] Points layer.

Weight field [tablefield: any] Weight field of the points attribute table.

Count field name [string] Name of the column for the new weighted field.

Default: NUMPOINTS

Outputs

Result [vector] The resulting polygons layer.

Console usage

processing.runalg(’qgis:countpointsinpolygonweighted’, polygons, points, weight, field, output)

See also

Count unique points in polygon

Description

Counts the number of unique values of a points in a polygons layer. Creates a new polygons layer with an extra
column in the attribute table containing the count of unique values for each feature.

Parameters

Polygons [vector: polygon] Polygons layer.

Points [vector: point] Points layer.

Class field [tablefield: any] Points layer column name of the unique value chosen.

Count field name [string] Column name containing the count of unique values in the resulting polygons
layer.

Default: NUMPOINTS

Outputs

Result [vector] The resulting polygons layer.
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Console usage

processing.runalg(’qgis:countuniquepointsinpolygon’, polygons, points, classfield, field, output)

See also

Distance matrix

Description

<put algortithm description here>

Parameters

Input point layer [vector: point] <put parameter description here>

Input unique ID field [tablefield: any] <put parameter description here>

Target point layer [vector: point] <put parameter description here>

Target unique ID field [tablefield: any] <put parameter description here>

Output matrix type [selection] <put parameter description here>

Options:

• 0 — Linear (N*k x 3) distance matrix

• 1 — Standard (N x T) distance matrix

• 2 — Summary distance matrix (mean, std. dev., min, max)

Default: 0

Use only the nearest (k) target points [number] <put parameter description here>

Default: 0

Outputs

Distance matrix [table] <put output description here>

Console usage

processing.runalg(’qgis:distancematrix’, input_layer, input_field, target_layer, target_field, matrix_type, nearest_points, distance_matrix)

See also

Distance to nearest hub

Description

<put algortithm description here>
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Parameters

Source points layer [vector: any] <put parameter description here>

Destination hubs layer [vector: any] <put parameter description here>

Hub layer name attribute [tablefield: any] <put parameter description here>

Output shape type [selection] <put parameter description here>

Options:

• 0 — Point

• 1 — Line to hub

Default: 0

Measurement unit [selection] <put parameter description here>

Options:

• 0 — Meters

• 1 — Feet

• 2 — Miles

• 3 — Kilometers

• 4 — Layer units

Default: 0

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:distancetonearesthub’, points, hubs, field, geometry, unit, output)

See also

Generate points (pixel centroids) along line

Description

<put algortithm description here>

Parameters

Raster layer [raster] <put parameter description here>

Vector layer [vector: line] <put parameter description here>

Outputs

Output layer [vector] <put output description here>
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Console usage

processing.runalg(’qgis:generatepointspixelcentroidsalongline’, input_raster, input_vector, output_layer)

See also

Generate points (pixel centroids) inside polygons

Description

<put algortithm description here>

Parameters

Raster layer [raster] <put parameter description here>

Vector layer [vector: polygon] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:generatepointspixelcentroidsinsidepolygons’, input_raster, input_vector, output_layer)

See also

Hub lines

Description

Creates hub and spoke diagrams with lines drawn from points on the Spoke Point layer to matching points in
the Hub Point layer. Determination of which hub goes with each point is based on a match between the Hub
ID field on the hub points and the Spoke ID field on the spoke points.

Parameters

Hub point layer [vector: any] <put parameter description here>

Hub ID field [tablefield: any] <put parameter description here>

Spoke point layer [vector: any] <put parameter description here>

Spoke ID field [tablefield: any] <put parameter description here>

Outputs

Output [vector] The resulting layer.
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Console usage

processing.runalg(’qgis:hublines’, hubs, hub_field, spokes, spoke_field, output)

See also

Mean coordinate(s)

Description

Calculates the mean of the coordinates of a layer starting from a field of the attribute table.

Parameters

Input layer [vector: any] <put parameter description here>

Weight field [tablefield: numeric] Optional.

Field to use if you want to perform a weighted mean.

Unique ID field [tablefield: numeric] Optional.

Unique field on which the calculation of the mean will be made.

Outputs

Result [vector] The resulting points layer.

Console usage

processing.runalg(’qgis:meancoordinates’, points, weight, uid, output)

See also

Nearest neighbour analysis

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Outputs

Result [html] <put output description here>

Observed mean distance [number] <put output description here>

Expected mean distance [number] <put output description here>

Nearest neighbour index [number] <put output description here>
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Number of points [number] <put output description here>

Z-Score [number] <put output description here>

Console usage

processing.runalg(’qgis:nearestneighbouranalysis’, points, output)

See also

Sum line lengths

Description

<put algortithm description here>

Parameters

Lines [vector: line] <put parameter description here>

Polygons [vector: polygon] <put parameter description here>

Lines length field name [string] <put parameter description here>

Default: LENGTH

Lines count field name [string] <put parameter description here>

Default: COUNT

Outputs

Result [vector] <put output description here>

Console usage

processing.runalg(’qgis:sumlinelengths’, lines, polygons, len_field, count_field, output)

See also

.

18.5.6 Vector creation

Create grid

Description

Creates a grid.
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Parameters

Grid type [selection] Grid type.

Options:

• 0 — Rectangle (line)

• 1 — Rectangle (polygon)

• 2 — Diamond (polygon)

• 3 — Hexagon (polygon)

Default: 0

Width [number] Horizontal extent of the grid.

Default: 360.0

Height [number] Vertical extent of the grid.

Default: 180.0

Horizontal spacing [number] X-axes spacing between the lines.

Default: 10.0

Vertical spacing [number] Y-axes spacing between the lines.

Default: 10.0

Center X [number] X-coordinate of the grid center.

Default: 0.0

Center Y [number] Y-coordinate of the grid center.

Default: 0.0

Output CRS [crs] Coordinate reference system for grid.

Default: EPSG:4326

Outputs

Output [vector] The resulting grid layer (lines or polygons).

Console usage

processing.runalg(’qgis:creategrid’, type, width, height, hspacing, vspacing, centerx, centery, crs, output)

See also

Points layer from table

Description

Creates points layer from geometryless table with columns that contain point coordinates.
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Parameters

Input layer [table] Input table

X field [tablefield: any] Table column containing the X coordinate.

Y field [tablefield: any] Table column containing the Y coordinate.

Target CRS [crs] Coordinate reference system to use for layer.

Default: EPSG:4326

Outputs

Output layer [vector] The resulting layer.

Console usage

processing.runalg(’qgis:pointslayerfromtable’, input, xfield, yfield, target_crs, output)

See also

Points to path

Description

<put algortithm description here>

Parameters

Input point layer [vector: point] <put parameter description here>

Group field [tablefield: any] <put parameter description here>

Order field [tablefield: any] <put parameter description here>

Date format (if order field is DateTime) [string] Optional.

<put parameter description here>

Default: (not set)

Outputs

Paths [vector] <put output description here>

Directory [directory] <put output description here>

Console usage

processing.runalg(’qgis:pointstopath’, vector, group_field, order_field, date_format, output_lines, output_text)
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See also

Random points along line

Description

<put algortithm description here>

Parameters

Input layer [vector: line] <put parameter description here>

Number of points [number] <put parameter description here>

Default: 1

Minimum distance [number] <put parameter description here>

Default: 0.0

Outputs

Random points [vector] <put output description here>

Console usage

processing.runalg(’qgis:randompointsalongline’, vector, point_number, min_distance, output)

See also

Random points in extent

Description

<put algortithm description here>

Parameters

Input extent [extent] <put parameter description here>

Default: 0,1,0,1

Points number [number] <put parameter description here>

Default: 1

Minimum distance [number] <put parameter description here>

Default: 0.0

Outputs

Random points [vector] <put output description here>
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Console usage

processing.runalg(’qgis:randompointsinextent’, extent, point_number, min_distance, output)

See also

Random points in layer bounds

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Points number [number] <put parameter description here>

Default: 1

Minimum distance [number] <put parameter description here>

Default: 0.0

Outputs

Random points [vector] <put output description here>

Console usage

processing.runalg(’qgis:randompointsinlayerbounds’, vector, point_number, min_distance, output)

See also

Random points inside polygons (fixed)

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Sampling strategy [selection] <put parameter description here>

Options:

• 0 — Points count

• 1 — Points density

Default: 0
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Number or density of points [number] <put parameter description here>

Default: 1.0

Minimum distance [number] <put parameter description here>

Default: 0.0

Outputs

Random points [vector] <put output description here>

Console usage

processing.runalg(’qgis:randompointsinsidepolygonsfixed’, vector, strategy, value, min_distance, output)

See also

Random points inside polygons (variable)

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Sampling strategy [selection] <put parameter description here>

Options:

• 0 — Points count

• 1 — Points density

Default: 0

Number field [tablefield: numeric] <put parameter description here>

Minimum distance [number] <put parameter description here>

Default: 0.0

Outputs

Random points [vector] <put output description here>

Console usage

processing.runalg(’qgis:randompointsinsidepolygonsvariable’, vector, strategy, field, min_distance, output)
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See also

Regular points

Description

<put algortithm description here>

Parameters

Input extent [extent] <put parameter description here>

Default: 0,1,0,1

Point spacing/count [number] <put parameter description here>

Default: 0.0001

Initial inset from corner (LH side) [number] <put parameter description here>

Default: 0.0

Apply random offset to point spacing [boolean] <put parameter description here>

Default: False

Use point spacing [boolean] <put parameter description here>

Default: True

Outputs

Regular points [vector] <put output description here>

Console usage

processing.runalg(’qgis:regularpoints’, extent, spacing, inset, randomize, is_spacing, output)

See also

Vector grid

Description

<put algortithm description here>

Parameters

Grid extent [extent] <put parameter description here>

Default: 0,1,0,1

X spacing [number] <put parameter description here>

Default: 0.0001

Y spacing [number] <put parameter description here>

Default: 0.0001
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Grid type [selection] <put parameter description here>

Options:

• 0 — Output grid as polygons

• 1 — Output grid as lines

Default: 0

Outputs

Grid [vector] <put output description here>

Console usage

processing.runalg(’qgis:vectorgrid’, extent, step_x, step_y, type, output)

See also

.

18.5.7 Vector general

Delete duplicate geometries

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:deleteduplicategeometries’, input, output)

See also

Join atributes by location

Description

<put algortithm description here>
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Parameters

Target vector layer [vector: any] <put parameter description here>

Join vector layer [vector: any] <put parameter description here>

Attribute summary [selection] <put parameter description here>

Options:

• 0 — Take attributes of the first located feature

• 1 — Take summary of intersecting features

Default: 0

Statistics for summary (comma separated) [string] <put parameter description here>

Default: sum,mean,min,max,median

Output table [selection] <put parameter description here>

Options:

• 0 — Only keep matching records

• 1 — Keep all records (including non-matching target records)

Default: 0

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:joinatributesbylocation’, target, join, summary, stats, keep, output)

See also

Join attributes table

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Input layer 2 [table] <put parameter description here>

Table field [tablefield: any] <put parameter description here>

Table field 2 [tablefield: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>
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Console usage

processing.runalg(’qgis:joinattributestable’, input_layer, input_layer_2, table_field, table_field_2, output_layer)

See also

Merge vector layers

Description

<put algortithm description here>

Parameters

Input layer 1 [vector: any] <put parameter description here>

Input layer 2 [vector: any] <put parameter description here>

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:mergevectorlayers’, layer1, layer2, output)

See also

Polygon from layer extent

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Calculate extent for each feature separately [boolean] <put parameter description here>

Default: False

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:polygonfromlayerextent’, input_layer, by_feature, output)
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See also

Reproject layer

Description

Reprojects a vector layer in a different CRS.

Parameters

Input layer [vector: any] Layer to reproject.

Target CRS [crs] Destination coordinate reference system.

Default: EPSG:4326

Outputs

Reprojected layer [vector] The resulting layer.

Console usage

processing.runalg(’qgis:reprojectlayer’, input, target_crs, output)

See also

Save selected features

Description

Saves the selected features as a new layer.

Parameters

Input layer [vector: any] Layer to process.

Outputs

Output layer with selected features [vector] The resulting layer.

Console usage

processing.runalg(’qgis:saveselectedfeatures’, input_layer, output_layer)
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See also

Set style for vector layer

Description

<put algortithm description here>

Parameters

Vector layer [vector: any] <put parameter description here>

Style file [file] <put parameter description here>

Outputs

Styled layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:setstyleforvectorlayer’, input, style)

See also

Snap points to grid

Description

<put algortithm description here>

Parameters

Input Layer [vector: any] <put parameter description here>

Horizontal spacing [number] <put parameter description here>

Default: 0.1

Vertical spacing [number] <put parameter description here>

Default: 0.1

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:snappointstogrid’, input, hspacing, vspacing, output)
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See also

Split vector layer

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Unique ID field [tablefield: any] <put parameter description here>

Outputs

Output directory [directory] <put output description here>

Console usage

processing.runalg(’qgis:splitvectorlayer’, input, field, output)

See also

.

18.5.8 Vector geometry

Concave hull

Description

<put algortithm description here>

Parameters

Input point layer [vector: point] <put parameter description here>

Threshold (0-1, where 1 is equivalent with Convex Hull) [number] <put parameter
description here>

Default: 0.3

Allow holes [boolean] <put parameter description here>

Default: True

Split multipart geometry into singleparts geometries [boolean] <put parameter de-
scription here>

Default: False
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Outputs

Concave hull [vector] <put output description here>

Console usage

processing.runalg(’qgis:concavehull’, input, alpha, holes, no_multigeometry, output)

See also

Convert geometry type

Description

Converts a geometry type to another one.

Parameters

Input layer [vector: any] Layer in input.

New geometry type [selection] Type of conversion to perform.

Options:

• 0 — Centroids

• 1 — Nodes

• 2 — Linestrings

• 3 — Multilinestrings

• 4 — Polygons

Default: 0

Outputs

Output [vector] The resulting layer.

Console usage

processing.runalg(’qgis:convertgeometrytype’, input, type, output)

See also

Convex hull

Description

<put algortithm description here>
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Parameters

Input layer [vector: any] <put parameter description here>

Field (optional, only used if creating convex hulls by classes) [tablefield: any]
Optional.

<put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — Create single minimum convex hull

• 1 — Create convex hulls based on field

Default: 0

Outputs

Convex hull [vector] <put output description here>

Console usage

processing.runalg(’qgis:convexhull’, input, field, method, output)

See also

Create points along lines

Description

<put algortithm description here>

Parameters

lines [vector: any] <put parameter description here>

distance [number] <put parameter description here>

Default: 1

startpoint [number] <put parameter description here>

Default: 0

endpoint [number] <put parameter description here>

Default: 0

Outputs

output [vector] <put output description here>
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Console usage

processing.runalg(’qgis:createpointsalonglines’, lines, distance, startpoint, endpoint, output)

See also

Delaunay triangulation

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Outputs

Delaunay triangulation [vector] <put output description here>

Console usage

processing.runalg(’qgis:delaunaytriangulation’, input, output)

See also

Densify geometries given an interval

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon, line] <put parameter description here>

Interval between Vertices to add [number] <put parameter description here>

Default: 1.0

Outputs

Densified layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:densifygeometriesgivenaninterval’, input, interval, output)
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See also

Densify geometries

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon, line] <put parameter description here>

Vertices to add [number] <put parameter description here>

Default: 1

Outputs

Densified layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:densifygeometries’, input, vertices, output)

See also

Dissolve

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon, line] <put parameter description here>

Dissolve all (do not use field) [boolean] <put parameter description here>

Default: True

Unique ID field [tablefield: any] Optional.

<put parameter description here>

Outputs

Dissolved [vector] <put output description here>

Console usage

processing.runalg(’qgis:dissolve’, input, dissolve_all, field, output)
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See also

Eliminate sliver polygons

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Use current selection in input layer (works only if called from toolbox) [boolean]
<put parameter description here>

Default: False

Selection attribute [tablefield: any] <put parameter description here>

Comparison [selection] <put parameter description here>

Options:

• 0 — ==

• 1 — !=

• 2 — >

• 3 — >=

• 4 — <

• 5 — <=

• 6 — begins with

• 7 — contains

Default: 0

Value [string] <put parameter description here>

Default: 0

Merge selection with the neighbouring polygon with the [selection] <put parameter de-
scription here>

Options:

• 0 — Largest area

• 1 — Smallest Area

• 2 — Largest common boundary

Default: 0

Outputs

Cleaned layer [vector] <put output description here>
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Console usage

processing.runalg(’qgis:eliminatesliverpolygons’, input, keepselection, attribute, comparison, comparisonvalue, mode, output)

See also

Explode lines

Description

<put algortithm description here>

Parameters

Input layer [vector: line] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:explodelines’, input, output)

See also

Extract nodes

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon, line] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:extractnodes’, input, output)
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See also

Fill holes

Description

<put algortithm description here>

Parameters

Polygons [vector: any] <put parameter description here>

Max area [number] <put parameter description here>

Default: 100000

Outputs

Results [vector] <put output description here>

Console usage

processing.runalg(’qgis:fillholes’, polygons, max_area, results)

See also

Fixed distance buffer

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Distance [number] <put parameter description here>

Default: 10.0

Segments [number] <put parameter description here>

Default: 5

Dissolve result [boolean] <put parameter description here>

Default: False

Outputs

Buffer [vector] <put output description here>
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Console usage

processing.runalg(’qgis:fixeddistancebuffer’, input, distance, segments, dissolve, output)

See also

Keep n biggest parts

Description

<put algortithm description here>

Parameters

Polygons [vector: polygon] <put parameter description here>

To keep [number] <put parameter description here>

Default: 1

Outputs

Results [vector] <put output description here>

Console usage

processing.runalg(’qgis:keepnbiggestparts’, polygons, to_keep, results)

See also

Lines to polygons

Description

<put algortithm description here>

Parameters

Input layer [vector: line] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:linestopolygons’, input, output)
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See also

Multipart to singleparts

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:multiparttosingleparts’, input, output)

See also

Points displacement

Description

Moves overlapped points at small distance, that they all become visible. The result is very similar to the output of
the “Point displacement” renderer but it is permanent.

Parameters

Input layer [vector: point] Layer with overlapped points.

Displacement distance [number] Desired displacement distance NOTE: displacement distance should
be in same units as layer.

Default: 0.00015

Horizontal distribution for two point case [boolean] Controls distrobution direction in case
of two overlapped points. If True points wwill be distributed horizontally, otherwise they will be distributed
vertically.

Default: True

Outputs

Output layer [vector] The resulting layer with shifted overlapped points.

Console usage

processing.runalg(’qgis:pointsdisplacement’, input_layer, distance, horizontal, output_layer)
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See also

Polygon centroids

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:polygoncentroids’, input_layer, output_layer)

See also

Polygonize

Description

<put algortithm description here>

Parameters

Input layer [vector: line] <put parameter description here>

Keep table structure of line layer [boolean] <put parameter description here>

Default: False

Create geometry columns [boolean] <put parameter description here>

Default: True

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:polygonize’, input, fields, geometry, output)
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See also

Polygons to lines

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:polygonstolines’, input, output)

See also

Simplify geometries

Description

<put algortithm description here>

Parameters

Input layer [vector: polygon, line] <put parameter description here>

Tolerance [number] <put parameter description here>

Default: 1.0

Outputs

Simplified layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:simplifygeometries’, input, tolerance, output)

396 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

See also

Singleparts to multipart

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Unique ID field [tablefield: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:singlepartstomultipart’, input, field, output)

See also

Variable distance buffer

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Distance field [tablefield: any] <put parameter description here>

Segments [number] <put parameter description here>

Default: 5

Dissolve result [boolean] <put parameter description here>

Default: False

Outputs

Buffer [vector] <put output description here>

Console usage

processing.runalg(’qgis:variabledistancebuffer’, input, field, segments, dissolve, output)
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See also

Voronoi polygons

Description

<put algortithm description here>

Parameters

Input layer [vector: point] <put parameter description here>

Buffer region [number] <put parameter description here>

Default: 0.0

Outputs

Voronoi polygons [vector] <put output description here>

Console usage

processing.runalg(’qgis:voronoipolygons’, input, buffer, output)

See also

.

18.5.9 Vector overlay

Clip

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Clip layer [vector: any] <put parameter description here>

Outputs

Clipped [vector] <put output description here>

Console usage

processing.runalg(’qgis:clip’, input, overlay, output)
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See also

Difference

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Difference layer [vector: any] <put parameter description here>

Outputs

Difference [vector] <put output description here>

Console usage

processing.runalg(’qgis:difference’, input, overlay, output)

See also

Intersection

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Intersect layer [vector: any] <put parameter description here>

Outputs

Intersection [vector] <put output description here>

Console usage

processing.runalg(’qgis:intersection’, input, input2, output)
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See also

Line intersections

Description

<put algortithm description here>

Parameters

Input layer [vector: line] <put parameter description here>

Intersect layer [vector: line] <put parameter description here>

Input unique ID field [tablefield: any] <put parameter description here>

Intersect unique ID field [tablefield: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:lineintersections’, input_a, input_b, field_a, field_b, output)

See also

Symetrical difference

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Difference layer [vector: any] <put parameter description here>

Outputs

Symetrical difference [vector] <put output description here>

Console usage

processing.runalg(’qgis:symetricaldifference’, input, overlay, output)
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See also

Union

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Input layer 2 [vector: any] <put parameter description here>

Outputs

Union [vector] <put output description here>

Console usage

processing.runalg(’qgis:union’, input, input2, output)

See also

.

18.5.10 Vector selection

Extract by attribute

Description

<put algortithm description here>

Parameters

Input Layer [vector: any] <put parameter description here>

Selection attribute [tablefield: any] <put parameter description here>

Operator [selection] <put parameter description here>

Options:

• 0 — =

• 1 — !=

• 2 — >

• 3 — >=

• 4 — <

• 5 — <=

• 6 — begins with
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• 7 — contains

Default: 0

Value [string] <put parameter description here>

Default: (not set)

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:extractbyattribute’, input, field, operator, value, output)

See also

Extract by location

Description

<put algortithm description here>

Parameters

Layer to select from [vector: any] <put parameter description here>

Additional layer (intersection layer) [vector: any] <put parameter description here>

Include input features that touch the selection features [boolean] <put parameter
description here>

Default: False

Include input features that overlap/cross the selection features [boolean] <put
parameter description here>

Default: False

Include input features completely within the selection features [boolean] <put
parameter description here>

Default: False

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:extractbylocation’, input, intersect, touches, overlaps, within, output)
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See also

Random extract

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — Number of selected features

• 1 — Percentage of selected features

Default: 0

Number/percentage of selected features [number] <put parameter description here>

Default: 10

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:randomextract’, input, method, number, output)

See also

Random extract within subsets

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

ID Field [tablefield: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — Number of selected features

• 1 — Percentage of selected features

Default: 0
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Number/percentage of selected features [number] <put parameter description here>

Default: 10

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:randomextractwithinsubsets’, input, field, method, number, output)

See also

Random selection

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — Number of selected features

• 1 — Percentage of selected features

Default: 0

Number/percentage of selected features [number] <put parameter description here>

Default: 10

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:randomselection’, input, method, number)

See also

Random selection within subsets

Description

<put algortithm description here>
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Parameters

Input layer [vector: any] <put parameter description here>

ID Field [tablefield: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — Number of selected features

• 1 — Percentage of selected features

Default: 0

Number/percentage of selected features [number] <put parameter description here>

Default: 10

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:randomselectionwithinsubsets’, input, field, method, number)

See also

Select by attribute

Description

Selects and saves as new layer all features from input layer that satisfy condition.

NOTE: algorithm is case-sensitive (“qgis” is different from “Qgis” and “QGIS”)

Parameters

Input Layer [vector: any] Layer to process.

Selection attribute [tablefield: any] Field on which perform the selection.

Operator [selection] Comparison operator.

Options:

• 0 — =

• 1 — !=

• 2 — >

• 3 — >=

• 4 — <

• 5 — <=

• 6 — begins with

• 7 — contains
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Default: 0

Value [string] Value to compare.

Default: (not set)

Outputs

Output [vector] The resulting layer.

Console usage

processing.runalg(’qgis:selectbyattribute’, input, field, operator, value, output)

See also

Select by expression

Description

<put algortithm description here>

Parameters

Input Layer [vector: any] <put parameter description here>

Expression [string] <put parameter description here>

Default: (not set)

Modify current selection by [selection] <put parameter description here>

Options:

• 0 — creating new selection

• 1 — adding to current selection

• 2 — removing from current selection

Default: 0

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:selectbyexpression’, layername, expression, method)
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See also

Select by location

Description

<put algortithm description here>

Parameters

Layer to select from [vector: any] <put parameter description here>

Additional layer (intersection layer) [vector: any] <put parameter description here>

Include input features that touch the selection features [boolean] <put parameter
description here>

Default: False

Include input features that overlap/cross the selection features [boolean] <put
parameter description here>

Default: False

Include input features completely within the selection features [boolean] <put
parameter description here>

Default: False

Modify current selection by [selection] <put parameter description here>

Options:

• 0 — creating new selection

• 1 — adding to current selection

• 2 — removing from current selection

Default: 0

Outputs

Selection [vector] <put output description here>

Console usage

processing.runalg(’qgis:selectbylocation’, input, intersect, touches, overlaps, within, method)

See also

.
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18.5.11 Vector table

Add autoincremental field

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:addautoincrementalfield’, input, output)

See also

Add field to attributes table

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Field name [string] <put parameter description here>

Default: (not set)

Field type [selection] <put parameter description here>

Options:

• 0 — Integer

• 1 — Float

• 2 — String

Default: 0

Field length [number] <put parameter description here>

Default: 10

Field precision [number] <put parameter description here>

Default: 0
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Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:addfieldtoattributestable’, input_layer, field_name, field_type, field_length, field_precision, output_layer)

See also

Advanced Python field calculator

Description

<put algorithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Result field name [string] <put parameter description here>

Default: NewField

Field type [selection] <put parameter description here>

Options:

• 0 — Integer

• 1 — Float

• 2 — String

Default: 0

Field length [number] <put parameter description here>

Default: 10

Field precision [number] <put parameter description here>

Default: 0

Global expression [string] Optional.

<put parameter description here>

Default: (not set)

Formula [string] <put parameter description here>

Default: value =

Outputs

Output layer [vector] <put output description here>
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Console usage

processing.runalg(’qgis:advancedpythonfieldcalculator’, input_layer, field_name, field_type, field_length, field_precision, global, formula, output_layer)

See also

Basic statistics for numeric fields

Description

<put algortithm description here>

Parameters

Input vector layer [vector: any] <put parameter description here>

Field to calculate statistics on [tablefield: numeric] <put parameter description here>

Outputs

Statistics for numeric field [html] <put output description here>

Coefficient of Variation [number] <put output description here>

Minimum value [number] <put output description here>

Maximum value [number] <put output description here>

Sum [number] <put output description here>

Mean value [number] <put output description here>

Count [number] <put output description here>

Range [number] <put output description here>

Median [number] <put output description here>

Number of unique values [number] <put output description here>

Standard deviation [number] <put output description here>

Console usage

processing.runalg(’qgis:basicstatisticsfornumericfields’, input_layer, field_name, output_html_file)

See also

Basic statistics for text fields

Description

<put algortithm description here>
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Parameters

Input vector layer [vector: any] <put parameter description here>

Field to calculate statistics on [tablefield: string] <put parameter description here>

Outputs

Statistics for text field [html] <put output description here>

Minimum length [number] <put output description here>

Maximum length [number] <put output description here>

Mean length [number] <put output description here>

Count [number] <put output description here>

Number of empty values [number] <put output description here>

Number of non-empty values [number] <put output description here>

Number of unique values [number] <put output description here>

Console usage

processing.runalg(’qgis:basicstatisticsfortextfields’, input_layer, field_name, output_html_file)

See also

Create equivalent numerical field

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Class field [tablefield: any] <put parameter description here>

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:createequivalentnumericalfield’, input, field, output)
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See also

Delete column

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Field to delete [tablefield: any] <put parameter description here>

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:deletecolumn’, input, column, output)

See also

Export/Add geometry columns

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Calculate using [selection] <put parameter description here>

Options:

• 0 — Layer CRS

• 1 — Project CRS

• 2 — Ellipsoidal

Default: 0

Outputs

Output layer [vector] <put output description here>

Console usage
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processing.runalg(’qgis:exportaddgeometrycolumns’, input, calc_method, output)

See also

Field calculator

Description

<put algortithm description here>

Parameters

Input layer [vector: any] <put parameter description here>

Result field name [string] <put parameter description here>

Default: (not set)

Field type [selection] <put parameter description here>

Options:

• 0 — Float

• 1 — Integer

• 2 — String

• 3 — Date

Default: 0

Field length [number] <put parameter description here>

Default: 10

Field precision [number] <put parameter description here>

Default: 3

Create new field [boolean] <put parameter description here>

Default: True

Formula [string] <put parameter description here>

Default: (not set)

Outputs

Output layer [vector] <put output description here>

Console usage

processing.runalg(’qgis:fieldcalculator’, input_layer, field_name, field_type, field_length, field_precision, new_field, formula, output_layer)
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See also

List unique values

Description

Lists unique values of an attribute table field and counts their number.

Parameters

Input layer [vector: any] Layer to analyze.

Target field [tablefield: any] Field to analyze.

Outputs

Unique values [html] Analysis results in HTML format.

Total unique values [number] Total number of unique values in given field.

Unique values [string] List of all unique values in given field.

Console usage

processing.runalg(’qgis:listuniquevalues’, input_layer, field_name, output)

See also

Number of unique values in classes

Description

<put algortithm description here>

Parameters

input [vector: any] <put parameter description here>

class field [tablefield: any] <put parameter description here>

value field [tablefield: any] <put parameter description here>

Outputs

output [vector] <put output description here>

Console usage

processing.runalg(’qgis:numberofuniquevaluesinclasses’, input, class_field, value_field, output)
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See also

Statistics by categories

Description

<put algortithm description here>

Parameters

Input vector layer [vector: any] <put parameter description here>

Field to calculate statistics on [tablefield: numeric] <put parameter description here>

Field with categories [tablefield: any] <put parameter description here>

Outputs

Statistics [table] <put output description here>

Console usage

processing.runalg(’qgis:statisticsbycategories’, input_layer, values_field_name, categories_field_name, output)

See also

Text to float

Description

<put algortithm description here>

Parameters

Input Layer [vector: any] <put parameter description here>

Text attribute to convert to float [tablefield: string] <put parameter description here>

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’qgis:texttofloat’, input, field, output)

See also

.
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18.6 R algorithm provider

R also called GNU S, is a strongly functional language and environment to statistically explore data sets, make
many graphical displays of data from custom data sets

Informacja: Please remember that Processing contains only R scripts, so you need to install R by yourself and
configure Processing properly.

.

18.6.1 Basic statistics

Frequency table

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Outputs

R Console Output [html] <put output description here>

Console usage

processing.runalg(’r:frequencytable’, layer, field, r_console_output)

See also

Kolmogrov-Smirnov test

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Outputs

R Console Output [html] <put output description here>
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Console usage

processing.runalg(’r:kolmogrovsmirnovtest’, layer, field, r_console_output)

See also

Summary statistics

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Outputs

R Console Output [html] <put output description here>

Console usage

processing.runalg(’r:summarystatistics’, layer, field, r_console_output)

See also

.

18.6.2 Home range

Characteristic hull method

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Outputs

Home_ranges [vector] <put output description here>
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Console usage

processing.runalg(’r:characteristichullmethod’, layer, field, home_ranges)

See also

Kernel h ref

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Grid [number] <put parameter description here>

Default: 10.0

Percentage [number] <put parameter description here>

Default: 10.0

Folder [directory] Optional.

<put parameter description here>

Outputs

Home_ranges [vector] <put output description here>

Console usage

processing.runalg(’r:kernelhref’, layer, field, grid, percentage, folder, home_ranges)

See also

Minimum convex polygon

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Percentage [number] <put parameter description here>

Default: 10.0

Field [tablefield: any] <put parameter description here>
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Outputs

Home_ranges [vector] <put output description here>

Console usage

processing.runalg(’r:minimumconvexpolygon’, layer, percentage, field, home_ranges)

See also

Single-linkage cluster analysis

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Percentage [number] <put parameter description here>

Default: 10.0

Outputs

R Plots [html] <put output description here>

Home_ranges [vector] <put output description here>

Console usage

processing.runalg(’r:singlelinkageclusteranalysis’, layer, field, percentage, rplots, home_ranges)

See also

.

18.6.3 Point pattern

F function

Description

<put algortithm description here>
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Parameters

Layer [vector: any] <put parameter description here>

Nsim [number] <put parameter description here>

Default: 10.0

Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:ffunction’, layer, nsim, rplots)

See also

G function

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Nsim [number] <put parameter description here>

Default: 10.0

Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:gfunction’, layer, nsim, rplots)

See also

Monte-Carlo spatial randomness

Description

<put algortithm description here>
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Parameters

Layer [vector: any] <put parameter description here>

Simulations [number] <put parameter description here>

Default: 100.0

Optional plot name [string] <put parameter description here>

Default: (not set)

Outputs

R Plots [html] <put output description here>

R Console Output [html] <put output description here>

Console usage

processing.runalg(’r:montecarlospatialrandomness’, layer, simulations, optional_plot_name, rplots, r_console_output)

See also

Quadrat analysis

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Outputs

R Plots [html] <put output description here>

R Console Output [html] <put output description here>

Console usage

processing.runalg(’r:quadratanalysis’, layer, rplots, r_console_output)

See also

Random sampling grid

Description

<put algortithm description here>
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Parameters

Layer [vector: any] <put parameter description here>

Size [number] <put parameter description here>

Default: 10.0

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’r:randomsamplinggrid’, layer, size, output)

See also

Regular sampling grid

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Size [number] <put parameter description here>

Default: 10.0

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’r:regularsamplinggrid’, layer, size, output)

See also

Relative distribution (distance covariate)

Description

<put algortithm description here>
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Parameters

Layer [vector: any] <put parameter description here>

Covariate [vector: any] <put parameter description here>

Covariate name [string] <put parameter description here>

Default: mandatory_covariate_name_(no_spaces)

x label [string] <put parameter description here>

Default: (not set)

Plot name [string] <put parameter description here>

Default: (not set)

Legend position [string] <put parameter description here>

Default: float

Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:relativedistributiondistancecovariate’, layer, covariate, covariate_name, x_label, plot_name, legend_position, rplots)

See also

Relative distribution (raster covariate)

Description

<put algortithm description here>

Parameters

points [vector: any] <put parameter description here>

covariate [raster] <put parameter description here>

covariate name [string] <put parameter description here>

Default: mandatory_covariate_name_(no_spaces)

x label [string] <put parameter description here>

Default: (not set)

plot name [string] <put parameter description here>

Default: (not set)

legend position [string] <put parameter description here>

Default: float
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Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:relativedistributionrastercovariate’, points, covariate, covariate_name, x_label, plot_name, legend_position, rplots)

See also

Ripley - Rasson spatial domain

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’r:ripleyrassonspatialdomain’, layer, output)

See also

.

18.6.4 Raster processing

Advanced raster histogram

Description

<put algortithm description here>

Parameters

Layer [raster] <put parameter description here>

Dens or Hist [string] <put parameter description here>

Default: Hist
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Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:advancedrasterhistogram’, layer, dens_or_hist, rplots)

See also

Raster histogram

Description

<put algortithm description here>

Parameters

Layer [raster] <put parameter description here>

Outputs

R Plots [html] <put output description here>

Console usage

processing.runalg(’r:rasterhistogram’, layer, rplots)

See also

.

18.6.5 Vector processing

Histogram

Description

<put algortithm description here>

Parameters

Layer [vector: any] <put parameter description here>

Field [tablefield: any] <put parameter description here>

Outputs

R Plots [html] <put output description here>
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Console usage

processing.runalg(’r:histogram’, layer, field, rplots)

See also

.

18.7 SAGA algorithm provider

SAGA (System for Automated Geoscientific Analyses) is a free, hybrid, cross-platform GIS software. SAGA
provides many geoscientific methods which are bundled in so-called module libraries.

Informacja: Please remember that Processing contains only the interface description, so you need to install
SAGA by yourself and configure Processing properly.

.

18.7.1 Geostatistics

Directional statistics for single grid

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Points [vector: any] Optional.

<put parameter description here>

Direction [Degree] [number] <put parameter description here>

Default: 0.0

Tolerance [Degree] [number] <put parameter description here>

Default: 0.0

Maximum Distance [Cells] [number] <put parameter description here>

Default: 0

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0
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Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Outputs

Arithmetic Mean [raster] <put output description here>

Difference from Arithmetic Mean [raster] <put output description here>

Minimum [raster] <put output description here>

Maximum [raster] <put output description here>

Range [raster] <put output description here>

Variance [raster] <put output description here>

Standard Deviation [raster] <put output description here>

Mean less Standard Deviation [raster] <put output description here>

Mean plus Standard Deviation [raster] <put output description here>

Deviation from Arithmetic Mean [raster] <put output description here>

Percentile [raster] <put output description here>

Directional Statistics for Points [vector] <put output description here>

Console usage

processing.runalg(’saga:directionalstatisticsforsinglegrid’, grid, points, direction, tolerance, maxdistance, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, mean, difmean, min, max, range, var, stddev, stddevlo, stddevhi, devmean, percent, points_out)

See also

Fast representativeness

Description

<put algortithm description here>

Parameters

Input [raster] <put parameter description here>

Level of Generalisation [number] <put parameter description here>

Default: 16
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Outputs

Output [raster] <put output description here>

Output Lod [raster] <put output description here>

Output Seeds [raster] <put output description here>

Console usage

processing.runalg(’saga:fastrepresentativeness’, input, lod, result, result_lod, seeds)

See also

Geographically weighted multiple regression (points/grids)

Description

<put algortithm description here>

Parameters

Predictors [multipleinput: rasters] <put parameter description here>

Output of Regression Parameters [boolean] <put parameter description here>

Default: True

Points [vector: point] <put parameter description here>

Dependent Variable [tablefield: any] <put parameter description here>

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)
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Default: 0

Search Radius [number] <put parameter description here>

Default: 100

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of observations

• 1 — [1] all points

Default: 0

Maximum Number of Observations [number] <put parameter description here>

Default: 10

Minimum Number of Observations [number] <put parameter description here>

Default: 4

Outputs

Regression [raster] <put output description here>

Coefficient of Determination [raster] <put output description here>

Regression Parameters [raster] <put output description here>

Residuals [vector] <put output description here>

Console usage

processing.runalg(’saga:geographicallyweightedmultipleregressionpointsgrids’, predictors, parameters, points, dependent, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, range, radius, mode, npoints, maxpoints, minpoints, regression, quality, slopes, residuals)

See also

Geographically weighted multiple regression (points)

Description

<put algortithm description here>

Parameters

Points [vector: any] <put parameter description here>

Dependent Variable [tablefield: any] <put parameter description here>

Distance Weighting [selection] <put parameter description here>

Options:
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• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)

Default: 0

Search Radius [number] <put parameter description here>

Default: 100

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of observations

• 1 — [1] all points

Default: 0

Maximum Number of Observations [number] <put parameter description here>

Default: 10

Minimum Number of Observations [number] <put parameter description here>

Default: 4

Outputs

Regression [vector] <put output description here>
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Console usage

processing.runalg(’saga:geographicallyweightedmultipleregressionpoints’, points, dependent, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, range, radius, mode, npoints, maxpoints, minpoints, regression)

See also

Geographically weighted multiple regression

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Dependent Variable [tablefield: any] <put parameter description here>

Target Grids [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)

Default: 0

Search Radius [number] <put parameter description here>

Default: 100

Search Mode [selection] <put parameter description here>

Options:
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• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of observations

• 1 — [1] all points

Default: 0

Maximum Number of Observations [number] <put parameter description here>

Default: 10

Minimum Number of Observations [number] <put parameter description here>

Default: 4

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Quality [raster] <put output description here>

Intercept [raster] <put output description here>

Quality [raster] <put output description here>

Intercept [raster] <put output description here>

Console usage

processing.runalg(’saga:geographicallyweightedmultipleregression’, points, dependent, target, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, range, radius, mode, npoints, maxpoints, minpoints, output_extent, user_size, user_quality, user_intercept, grid_quality, grid_intercept)

See also

Geographically weighted regression (points/grid)

Description

<put algortithm description here>

Parameters

Predictor [raster] <put parameter description here>

Points [vector: point] <put parameter description here>

Dependent Variable [tablefield: any] <put parameter description here>

Distance Weighting [selection] <put parameter description here>

Options:
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• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)

Default: 0

Search Radius [number] <put parameter description here>

Default: 0

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of observations

• 1 — [1] all points

Default: 0

Maximum Number of Observations [number] <put parameter description here>

Default: 10

Minimum Number of Observations [number] <put parameter description here>

Default: 4

Outputs

Regression [raster] <put output description here>

Coefficient of Determination [raster] <put output description here>

Intercept [raster] <put output description here>

Slope [raster] <put output description here>

Residuals [vector] <put output description here>
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Console usage

processing.runalg(’saga:geographicallyweightedregressionpointsgrid’, predictor, points, dependent, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, range, radius, mode, npoints, maxpoints, minpoints, regression, quality, intercept, slope, residuals)

See also

Geographically weighted regression

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Dependent Variable [tablefield: any] <put parameter description here>

Predictor [tablefield: any] <put parameter description here>

Target Grids [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 0

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 0.0

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)

Default: 0

Search Radius [number] <put parameter description here>

Default: 100
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Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of observations

• 1 — [1] all points

Default: 0

Maximum Number of Observations [number] <put parameter description here>

Default: 10

Minimum Number of Observations [number] <put parameter description here>

Default: 4

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Quality [raster] <put output description here>

Intercept [raster] <put output description here>

Slope [raster] <put output description here>

Console usage

processing.runalg(’saga:geographicallyweightedregression’, points, dependent, predictor, target, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, range, radius, mode, npoints, maxpoints, minpoints, output_extent, user_size, user_grid, user_quality, user_intercept, user_slope)

See also

Global moran’s i for grids

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Case of contiguity [selection] <put parameter description here>

Options:
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• 0 — [0] Rook

• 1 — [1] Queen

Default: 0

Outputs

Result [table] <put output description here>

Console usage

processing.runalg(’saga:globalmoransiforgrids’, grid, contiguity, result)

See also

Minimum distance analysis

Description

Performs a complete distance analysis of a point layer:

• minimum distance of points

• maximum distance of points

• average distance of all the points

• standard deviation of the distance

• duplicated points

Parameters

Points [vector: point] Layer to analyze.

Outputs

Minimum Distance Analysis [table] The resulting table.

Console usage

processing.runalg(’saga:minimumdistanceanalysis’, points, table)

See also

Multi-band variation

Description

<put algortithm description here>
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Parameters

Grids [multipleinput: rasters] <put parameter description here>

Radius [Cells] [number] <put parameter description here>

Default: 1

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Outputs

Mean Distance [raster] <put output description here>

Standard Deviation [raster] <put output description here>

Distance [raster] <put output description here>

Console usage

processing.runalg(’saga:multibandvariation’, bands, radius, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, mean, stddev, diff)

See also

Multiple regression analysis (grid/grids)

Description

<put algortithm description here>

Parameters

Dependent [raster] <put parameter description here>

Grids [multipleinput: rasters] <put parameter description here>

Grid Interpolation [selection] <put parameter description here>

Options:
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• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Include X Coordinate [boolean] <put parameter description here>

Default: True

Include Y Coordinate [boolean] <put parameter description here>

Default: True

Method [selection] <put parameter description here>

Options:

• 0 — [0] include all

• 1 — [1] forward

• 2 — [2] backward

• 3 — [3] stepwise

Default: 0

P in [number] <put parameter description here>

Default: 5

P out [number] <put parameter description here>

Default: 5

Outputs

Regression [raster] <put output description here>

Residuals [raster] <put output description here>

Details: Coefficients [table] <put output description here>

Details: Model [table] <put output description here>

Details: Steps [table] <put output description here>

Console usage

processing.runalg(’saga:multipleregressionanalysisgridgrids’, dependent, grids, interpol, coord_x, coord_y, method, p_in, p_out, regression, residuals, info_coeff, info_model, info_steps)

See also

Multiple regression analysis (points/grids)

Description

<put algortithm description here>
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Parameters

Grids [multipleinput: rasters] <put parameter description here>

Shapes [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Grid Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Include X Coordinate [boolean] <put parameter description here>

Default: True

Include Y Coordinate [boolean] <put parameter description here>

Default: True

Method [selection] <put parameter description here>

Options:

• 0 — [0] include all

• 1 — [1] forward

• 2 — [2] backward

• 3 — [3] stepwise

Default: 0

P in [number] <put parameter description here>

Default: 5

P out [number] <put parameter description here>

Default: 5

Outputs

Details: Coefficients [table] <put output description here>

Details: Model [table] <put output description here>

Details: Steps [table] <put output description here>

Residuals [vector] <put output description here>

Regression [raster] <put output description here>

Console usage

processing.runalg(’saga:multipleregressionanalysispointsgrids’, grids, shapes, attribute, interpol, coord_x, coord_y, method, p_in, p_out, info_coeff, info_model, info_steps, residuals, regression)
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See also

Polynomial regression

Description

<put algortithm description here>

Parameters

Points [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Polynom [selection] <put parameter description here>

Options:

• 0 — [0] simple planar surface

• 1 — [1] bi-linear saddle

• 2 — [2] quadratic surface

• 3 — [3] cubic surface

• 4 — [4] user defined

Default: 0

Maximum X Order [number] <put parameter description here>

Default: 4

Maximum Y Order [number] <put parameter description here>

Default: 4

Maximum Total Order [number] <put parameter description here>

Default: 4

Trend Surface [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Residuals [vector] <put output description here>

Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:polynomialregression’, points, attribute, polynom, xorder, yorder, torder, target, output_extent, user_size, residuals, user_grid)

See also

Radius of variance (grid)

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Standard Deviation [number] <put parameter description here>

Default: 1.0

Maximum Search Radius (cells) [number] <put parameter description here>

Default: 20

Type of Output [selection] <put parameter description here>

Options:

• 0 — [0] Cells

• 1 — [1] Map Units

Default: 0

Outputs

Variance Radius [raster] <put output description here>

Console usage

processing.runalg(’saga:radiusofvariancegrid’, input, variance, radius, output, result)

See also

Regression analysis

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Shapes [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Grid Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Regression Function [selection] <put parameter description here>

Options:

• 0 — [0] Y = a + b * X (linear)

• 1 — [1] Y = a + b / X

• 2 — [2] Y = a / (b - X)

• 3 — [3] Y = a * X^b (power)

• 4 — [4] Y = a e^(b * X) (exponential)

• 5 — [5] Y = a + b * ln(X) (logarithmic)

Default: 0

Outputs

Regression [raster] <put output description here>

Residuals [vector] <put output description here>

Console usage

processing.runalg(’saga:regressionanalysis’, grid, shapes, attribute, interpol, method, regression, residual)

See also

Representativeness

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Radius (Cells) [number] <put parameter description here>

Default: 10

Exponent [number] <put parameter description here>

Default: 1

Outputs

Representativeness [raster] <put output description here>

Console usage

processing.runalg(’saga:representativeness’, input, radius, exponent, result)

See also

Residual analysis

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Radius (Cells) [number] <put parameter description here>

Default: 7

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0
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Outputs

Mean Value [raster] <put output description here>

Difference from Mean Value [raster] <put output description here>

Standard Deviation [raster] <put output description here>

Value Range [raster] <put output description here>

Minimum Value [raster] <put output description here>

Maximum Value [raster] <put output description here>

Deviation from Mean Value [raster] <put output description here>

Percentile [raster] <put output description here>

Console usage

processing.runalg(’saga:residualanalysis’, grid, radius, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, mean, diff, stddev, range, min, max, devmean, percent)

See also

Spatial point pattern analysis

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Vertex Distance [Degree] [number] <put parameter description here>

Default: 5

Outputs

Mean Centre [vector] <put output description here>

Standard Distance [vector] <put output description here>

Bounding Box [vector] <put output description here>

Console usage

processing.runalg(’saga:spatialpointpatternanalysis’, points, step, centre, stddist, bbox)

See also

Statistics for grids

Description

<put algortithm description here>
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Parameters

Grids [multipleinput: rasters] <put parameter description here>

Outputs

Arithmetic Mean [raster] <put output description here>

Minimum [raster] <put output description here>

Maximum [raster] <put output description here>

Variance [raster] <put output description here>

Standard Deviation [raster] <put output description here>

Mean less Standard Deviation [raster] <put output description here>

Mean plus Standard Deviation [raster] <put output description here>

Console usage

processing.runalg(’saga:statisticsforgrids’, grids, mean, min, max, var, stddev, stddevlo, stddevhi)

See also

Variogram cloud

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Maximum Distance [number] <put parameter description here>

Default: 0.0

Skip Number [number] <put parameter description here>

Default: 1

Outputs

Variogram Cloud [table] <put output description here>

Console usage

processing.runalg(’saga:variogramcloud’, points, field, distmax, nskip, result)
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See also

Variogram surface

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Number of Distance Classes [number] <put parameter description here>

Default: 10

Skip Number [number] <put parameter description here>

Default: 1

Outputs

Number of Pairs [raster] <put output description here>

Variogram Surface [raster] <put output description here>

Covariance Surface [raster] <put output description here>

Console usage

processing.runalg(’saga:variogramsurface’, points, field, distcount, nskip, count, variance, covariance)

See also

Zonal grid statistics

Description

<put algortithm description here>

Parameters

Zone Grid [raster] <put parameter description here>

Categorial Grids [multipleinput: rasters] Optional.

<put parameter description here>

Grids to analyse [multipleinput: rasters] Optional.

<put parameter description here>

Aspect [raster] Optional.

<put parameter description here>
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Short Field Names [boolean] <put parameter description here>

Default: True

Outputs

Zonal Statistics [table] <put output description here>

Console usage

processing.runalg(’saga:zonalgridstatistics’, zones, catlist, statlist, aspect, shortnames, outtab)

See also

.

18.7.2 Grid analysis

Accumulated cost (anisotropic)

Description

<put algortithm description here>

Parameters

Cost Grid [raster] <put parameter description here>

Direction of max cost [raster] <put parameter description here>

Destination Points [raster] <put parameter description here>

k factor [number] <put parameter description here>

Default: 1

Threshold for different route [number] <put parameter description here>

Default: 0

Outputs

Accumulated Cost [raster] <put output description here>

Console usage

processing.runalg(’saga:accumulatedcostanisotropic’, cost, direction, points, k, threshold, acccost)
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See also

Accumulated cost (isotropic)

Description

<put algortithm description here>

Parameters

Cost Grid [raster] <put parameter description here>

Destination Points [raster] <put parameter description here>

Threshold for different route [number] <put parameter description here>

Default: 0.0

Outputs

Accumulated Cost [raster] <put output description here>

Closest Point [raster] <put output description here>

Console usage

processing.runalg(’saga:accumulatedcostisotropic’, cost, points, threshold, acccost, closestpt)

See also

Aggregation index

Description

<put algortithm description here>

Parameters

Input Grid [raster] <put parameter description here>

Max. Number of Classes [number] <put parameter description here>

Default: 5

Outputs

Result [table] <put output description here>

Console usage

processing.runalg(’saga:aggregationindex’, input, maxnumclass, result)
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See also

Analytical hierarchy process

Description

<put algortithm description here>

Parameters

Input Grids [multipleinput: rasters] <put parameter description here>

Pairwise Comparisons Table [table] <put parameter description here>

Outputs

Output Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:analyticalhierarchyprocess’, grids, table, output)

See also

Cross-classification and tabulation

Description

<put algortithm description here>

Parameters

Input Grid 1 [raster] <put parameter description here>

Input Grid 2 [raster] <put parameter description here>

Max. Number of Classes [number] <put parameter description here>

Default: 5

Outputs

Cross-Classification Grid [raster] <put output description here>

Cross-Tabulation Table [table] <put output description here>

Console usage

processing.runalg(’saga:crossclassificationandtabulation’, input, input2, maxnumclass, resultgrid, resulttable)
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See also

Fragmentation (alternative)

Description

<put algortithm description here>

Parameters

Classification [raster] <put parameter description here>

Class Identifier [number] <put parameter description here>

Default: 1

Neighborhood Min [number] <put parameter description here>

Default: 1

Neighborhood Max [number] <put parameter description here>

Default: 1

Level Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] average

• 1 — [1] multiplicative

Default: 0

Add Border [boolean] <put parameter description here>

Default: True

Connectivity Weighting [number] <put parameter description here>

Default: 1.1

Minimum Density [Percent] [number] <put parameter description here>

Default: 10

Minimum Density for Interior Forest [Percent] [number] <put parameter description here>

Default: 99

Search Distance Increment [number] <put parameter description here>

Default: 0.0

Density from Neighbourhood [boolean] <put parameter description here>

Default: True

Outputs

Density [Percent] [raster] <put output description here>

Connectivity [Percent] [raster] <put output description here>

Fragmentation [raster] <put output description here>

Summary [table] <put output description here>
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Console usage

processing.runalg(’saga:fragmentationalternative’, classes, class, neighborhood_min, neighborhood_max, aggregation, border, weight, density_min, density_int, level_grow, density_mean, density, connectivity, fragmentation, fragstats)

See also

Fragmentation classes from density and connectivity

Description

<put algortithm description here>

Parameters

Density [Percent] [raster] <put parameter description here>

Connectivity [Percent] [raster] <put parameter description here>

Add Border [boolean] <put parameter description here>

Default: True

Connectivity Weighting [number] <put parameter description here>

Default: 0

Minimum Density [Percent] [number] <put parameter description here>

Default: 10

Minimum Density for Interior Forest [Percent] [number] <put parameter description here>

Default: 99

Outputs

Fragmentation [raster] <put output description here>

Console usage

processing.runalg(’saga:fragmentationclassesfromdensityandconnectivity’, density, connectivity, border, weight, density_min, density_int, fragmentation)

See also

Fragmentation (standard)

Description

<put algortithm description here>

18.7. SAGA algorithm provider 451



QGIS User Guide, Wydanie 2.6

Parameters

Classification [raster] <put parameter description here>

Class Identifier [number] <put parameter description here>

Default: 1

Neighborhood Min [number] <put parameter description here>

Default: 1

Neighborhood Max [number] <put parameter description here>

Default: 3

Level Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] average

• 1 — [1] multiplicative

Default: 0

Add Border [boolean] <put parameter description here>

Default: True

Connectivity Weighting [number] <put parameter description here>

Default: 1.1

Minimum Density [Percent] [number] <put parameter description here>

Default: 10

Minimum Density for Interior Forest [Percent] [number] <put parameter description here>

Default: 99

Neighborhood Type [selection] <put parameter description here>

Options:

• 0 — [0] square

• 1 — [1] circle

Default: 0

Include diagonal neighbour relations [boolean] <put parameter description here>

Default: True

Outputs

Density [Percent] [raster] <put output description here>

Connectivity [Percent] [raster] <put output description here>

Fragmentation [raster] <put output description here>

Summary [table] <put output description here>

Console usage

processing.runalg(’saga:fragmentationstandard’, classes, class, neighborhood_min, neighborhood_max, aggregation, border, weight, density_min, density_int, circular, diagonal, density, connectivity, fragmentation, fragstats)
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See also

Layer of extreme value

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Maximum

• 1 — [1] Minimum

Default: 0

Outputs

Result [raster] <put output description here>

Console usage

processing.runalg(’saga:layerofextremevalue’, grids, criteria, result)

See also

Least cost paths

Description

<put algortithm description here>

Parameters

Source Point(s) [vector: point] <put parameter description here>

Accumulated cost [raster] <put parameter description here>

Values [multipleinput: rasters] Optional.

<put parameter description here>

Outputs

Profile (points) [vector] <put output description here>

Profile (lines) [vector] <put output description here>
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Console usage

processing.runalg(’saga:leastcostpaths’, source, dem, values, points, line)

See also

Ordered Weighted Averaging

Description

<put algortithm description here>

Parameters

Input Grids [multipleinput: rasters] <put parameter description here>

Weights [fixedtable] <put parameter description here>

Outputs

Output Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:orderedweightedaveraging’, grids, weights, output)

See also

Pattern analysis

Description

<put algortithm description here>

Parameters

Input Grid [raster] <put parameter description here>

Size of Analysis Window [selection] <put parameter description here>

Options:

• 0 — [0] 3 X 3

• 1 — [1] 5 X 5

• 2 — [2] 7 X 7

Default: 0

Max. Number of Classes [number] <put parameter description here>

Default: 0
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Outputs

Relative Richness [raster] <put output description here>

Diversity [raster] <put output description here>

Dominance [raster] <put output description here>

Fragmentation [raster] <put output description here>

Number of Different Classes [raster] <put output description here>

Center Versus Neighbours [raster] <put output description here>

Console usage

processing.runalg(’saga:patternanalysis’, input, winsize, maxnumclass, relative, diversity, dominance, fragmentation, ndc, cvn)

See also

Soil texture classification

Description

<put algortithm description here>

Parameters

Sand [raster] Optional.

<put parameter description here>

Silt [raster] Optional.

<put parameter description here>

Clay [raster] Optional.

<put parameter description here>

Outputs

Soil Texture [raster] <put output description here>

Sum [raster] <put output description here>

Console usage

processing.runalg(’saga:soiltextureclassification’, sand, silt, clay, texture, sum)

See also

.
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18.7.3 Grid calculus

Function

Description

<put algortithm description here>

Parameters

xmin [number] <put parameter description here>

Default: 0.0

xmax [number] <put parameter description here>

Default: 0.0

ymin [number] <put parameter description here>

Default: 0.0

ymax [number] <put parameter description here>

Default: 0.0

Formula [string] <put parameter description here>

Default: (not set)

Outputs

Function [raster] <put output description here>

Console usage

processing.runalg(’saga:function’, xmin, xmax, ymin, ymax, formul, result)

See also

Fuzzify

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

A [number] <put parameter description here>

Default: 0.0

B [number] <put parameter description here>

Default: 0.0
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C [number] <put parameter description here>

Default: 0.0

D [number] <put parameter description here>

Default: 0.0

Membership Function Type [selection] <put parameter description here>

Options:

• 0 — [0] linear

• 1 — [1] sigmoidal

• 2 — [2] j-shaped

Default: 0

Adjust to Grid [boolean] <put parameter description here>

Default: True

Outputs

Fuzzified Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:fuzzify’, input, a, b, c, d, type, autofit, output)

See also

Fuzzy intersection (and)

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Operator Type [selection] <put parameter description here>

Options:

• 0 — [0] min(a, b) (non-interactive)

• 1 — [1] a * b

• 2 — [2] max(0, a + b - 1)

Default: 0

Outputs

Intersection [raster] <put output description here>
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Console usage

processing.runalg(’saga:fuzzyintersectionand’, grids, type, and)

See also

Fuzzy union (or)

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Operator Type [selection] <put parameter description here>

Options:

• 0 — [0] max(a, b) (non-interactive)

• 1 — [1] a + b - a * b

• 2 — [2] min(1, a + b)

Default: 0

Outputs

Union [raster] <put output description here>

Console usage

processing.runalg(’saga:fuzzyunionor’, grids, type, or)

See also

Geometric figures

Description

Draws simple geometric figures.

Parameters

Cell Count [number] Number of cells to use.

Default: 0

Cell Size [number] Size of the single cell.

Default: 0
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Figure [selection] Type of the figure.

Options:

• 0 — [0] Cone (up)

• 1 — [1] Cone (down)

• 2 — [2] Plane

Default: 0

Direction of Plane [Degree] [number] Rotation factor in degrees.

Default: 0

Outputs

Result [raster] The resulting layer.

Console usage

processing.runalg(’saga:geometricfigures’, cell_count, cell_size, figure, plane, result)

See also

Gradient vector from cartesian to polar coordinates

Description

<put algortithm description here>

Parameters

X Component [raster] <put parameter description here>

Y Component [raster] <put parameter description here>

Polar Angle Units [selection] <put parameter description here>

Options:

• 0 — [0] radians

• 1 — [1] degree

Default: 0

Polar Coordinate System [selection] <put parameter description here>

Options:

• 0 — [0] mathematical

• 1 — [1] geographical

• 2 — [2] user defined

Default: 0

User defined Zero Direction [number] <put parameter description here>

Default: 0.0
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User defined Orientation [selection] <put parameter description here>

Options:

• 0 — [0] clockwise

• 1 — [1] counterclockwise

Default: 0

Outputs

Direction [raster] <put output description here>

Length [raster] <put output description here>

Console usage

processing.runalg(’saga:gradientvectorfromcartesiantopolarcoordinates’, dx, dy, units, system, system_zero, system_orient, dir, len)

See also

Gradient vector from polar to cartesian coordinates

Description

<put algortithm description here>

Parameters

Direction [raster] <put parameter description here>

Length [raster] <put parameter description here>

Polar Angle Units [selection] <put parameter description here>

Options:

• 0 — [0] radians

• 1 — [1] degree

Default: 0

Polar Coordinate System [selection] <put parameter description here>

Options:

• 0 — [0] mathematical

• 1 — [1] geographical

• 2 — [2] user defined

Default: 0

User defined Zero Direction [number] <put parameter description here>

Default: 0.0

User defined Orientation [selection] <put parameter description here>

Options:

• 0 — [0] clockwise
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• 1 — [1] counterclockwise

Default: 0

Outputs

X Component [raster] <put output description here>

Y Component [raster] <put output description here>

Console usage

processing.runalg(’saga:gradientvectorfrompolartocartesiancoordinates’, dir, len, units, system, system_zero, system_orient, dx, dy)

See also

Grid difference

Description

Creates a new grid layer as the result of the difference between two other grid layers.

Parameters

A [raster] First layer.

B [raster] Second layer.

Outputs

Difference (A - B) [raster] The resulting layer.

Console usage

processing.runalg(’saga:griddifference’, a, b, c)

See also

Grid division

Description

Creates a new grid layer as the result of the division between two other grid layers.

Parameters

Dividend [raster] First layer.

Divisor [raster] Second layer.
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Outputs

Quotient [raster] The resulting layer.

Console usage

processing.runalg(’saga:griddivision’, a, b, c)

See also

Grid normalisation

Description

Normalises the grid values according to minimum and maximum values chosen.

Parameters

Grid [raster] Grid to normalize.

Target Range (min) [number] Minimum value.

Default: 0

Target Range (max) [number] Maximum value.

Default: 1

Outputs

Normalised Grid [raster] The resulting layer.

Console usage

processing.runalg(’saga:gridnormalisation’, input, range_min, range_max, output)

See also

Grids product

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Outputs

Product [raster] <put output description here>
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Console usage

processing.runalg(’saga:gridsproduct’, grids, result)

See also

Grids sum

Description

Creates a new grid layer as the result of the sum of two or more grid layers.

Parameters

Grids [multipleinput: rasters] Grid layers to sum

Outputs

Sum [raster] The resulting layer.

Console usage

processing.runalg(’saga:gridssum’, grids, result)

See also

Grid standardisation

Description

Standardises the grid layer values.

Parameters

Grid [raster] Grid to process.

Stretch Factor [number] stretching factor.

Default: 1.0

Outputs

Standardised Grid [raster] The resulting layer.

Console usage

processing.runalg(’saga:gridstandardisation’, input, stretch, output)
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See also

Grid volume

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Count Only Above Base Level

• 1 — [1] Count Only Below Base Level

• 2 — [2] Subtract Volumes Below Base Level

• 3 — [3] Add Volumes Below Base Level

Default: 0

Base Level [number] <put parameter description here>

Default: 0.0

Outputs

Console usage

processing.runalg(’saga:gridvolume’, grid, method, level)

See also

Metric conversions

Description

Performs numerical conversions of the grid values.

Parameters

Grid [raster] Grid to process.

Conversion [selection] Conversion type.

Options:

• 0 — [0] radians to degree

• 1 — [1] degree to radians

• 2 — [2] Celsius to Fahrenheit

• 3 — [3] Fahrenheit to Celsius

Default: 0
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Outputs

Converted Grid [raster] The resulting layer.

Console usage

processing.runalg(’saga:metricconversions’, grid, conversion, conv)

See also

Polynomial trend from grids

Description

<put algortithm description here>

Parameters

Dependent Variables [multipleinput: rasters] <put parameter description here>

Independent Variable (per Grid and Cell) [multipleinput: rasters] Optional.

<put parameter description here>

Independent Variable (per Grid) [fixedtable] <put parameter description here>

Type of Approximated Function [selection] <put parameter description here>

Options:

• 0 — [0] first order polynom (linear regression)

• 1 — [1] second order polynom

• 2 — [2] third order polynom

• 3 — [3] fourth order polynom

• 4 — [4] fifth order polynom

Default: 0

Outputs

Polynomial Coefficients [raster] <put output description here>

Coefficient of Determination [raster] <put output description here>

Console usage

processing.runalg(’saga:polynomialtrendfromgrids’, grids, y_grids, y_table, polynom, parms, quality)
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See also

Random field

Description

Generates a random grid layer.

Parameters

Width (Cells) [number] Width of the layer in cells.

Default: 100

Height (Cells) [number] Height of the layer in cells.

Default: 100

Cellsize [number] Cell size to use.

Default: 100.0

West [number] West coordinate of the bottom-left corner of the grid.

Default: 0.0

South [number] South coordinate of the bottom-left corner of the grid.

Default: 0.0

Method [selection] Statistical method used for the calculation.

Options:

• 0 — [0] Uniform

• 1 — [1] Gaussian

Default: 0

Range Min [number] Minimum cell value to use.

Default: 0.0

Range Max [number] Maximum cell value to use.

Default: 1.0

Arithmetic Mean [number] Mean of all the cell values to use.

Default: 0.0

Standard Deviation [number] Standard deviation of all the cell values to use.

Default: 1.0

Outputs

Random Field [raster] The resulting layer.

Console usage

processing.runalg(’saga:randomfield’, nx, ny, cellsize, xmin, ymin, method, range_min, range_max, mean, stddev, output)
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See also

Random terrain generation

Description

<put algortithm description here>

Parameters

Radius (cells) [number] <put parameter description here>

Default: 10

Iterations [number] <put parameter description here>

Default: 10

Target Dimensions [selection] <put parameter description here>

Options:

• 0 — [0] User defined

Default: 0

Grid Size [number] <put parameter description here>

Default: 1.0

Cols [number] <put parameter description here>

Default: 100

Rows [number] <put parameter description here>

Default: 100

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:randomterraingeneration’, radius, iterations, target_type, user_cell_size, user_cols, user_rows, target_grid)

See also

Raster calculator

Description

<put algortithm description here>
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Parameters

Main input layer [raster] <put parameter description here>

Additional layers [multipleinput: rasters] Optional.

<put parameter description here>

Formula [string] <put parameter description here>

Default: (not set)

Outputs

Result [raster] <put output description here>

Console usage

processing.runalg(’saga:rastercalculator’, grids, xgrids, formula, result)

See also

.

18.7.4 Grid filter

Dtm filter (slope-based)

Description

<put algortithm description here>

Parameters

Grid to filter [raster] <put parameter description here>

Search Radius [number] <put parameter description here>

Default: 2

Approx. Terrain Slope [number] <put parameter description here>

Default: 30.0

Use Confidence Interval [boolean] <put parameter description here>

Default: True

Outputs

Bare Earth [raster] <put output description here>

Removed Objects [raster] <put output description here>
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Console usage

processing.runalg(’saga:dtmfilterslopebased’, input, radius, terrainslope, stddev, ground, nonground)

See also

Filter clumps

Description

<put algortithm description here>

Parameters

Input Grid [raster] <put parameter description here>

Min. Size [number] <put parameter description here>

Default: 10

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:filterclumps’, grid, threshold, output)

See also

Gaussian filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Standard Deviation [number] <put parameter description here>

Default: 1

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0

Search Radius [number] <put parameter description here>

Default: 3
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Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:gaussianfilter’, input, sigma, mode, radius, result)

See also

Laplacian filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] standard kernel 1

• 1 — [1] standard kernel 2

• 2 — [2] Standard kernel 3

• 3 — [3] user defined kernel

Default: 0

Standard Deviation (Percent of Radius) [number] <put parameter description here>

Default: 0

Radius [number] <put parameter description here>

Default: 1

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] square

• 1 — [1] circle

Default: 0

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:laplacianfilter’, input, method, sigma, radius, mode, result)
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See also

Majority filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0

Radius [number] <put parameter description here>

Default: 1

Threshold [Percent] [number] <put parameter description here>

Default: 0

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:majorityfilter’, input, mode, radius, threshold, result)

See also

Morphological filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0
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Radius [number] <put parameter description here>

Default: 1

Method [selection] <put parameter description here>

Options:

• 0 — [0] Dilation

• 1 — [1] Erosion

• 2 — [2] Opening

• 3 — [3] Closing

Default: 0

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:morphologicalfilter’, input, mode, radius, method, result)

See also

Multi direction lee filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Estimated Noise (absolute) [number] <put parameter description here>

Default: 1.0

Estimated Noise (relative) [number] <put parameter description here>

Default: 1.0

Weighted [boolean] <put parameter description here>

Default: True

Method [selection] <put parameter description here>

Options:

• 0 — [0] noise variance given as absolute value

• 1 — [1] noise variance given relative to mean standard deviation

• 2 — [2] original calculation (Ringeler)

Default: 0
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Outputs

Filtered Grid [raster] <put output description here>

Minimum Standard Deviation [raster] <put output description here>

Direction of Minimum Standard Deviation [raster] <put output description here>

Console usage

processing.runalg(’saga:multidirectionleefilter’, input, noise_abs, noise_rel, weighted, method, result, stddev, dir)

See also

Rank filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0

Radius [number] <put parameter description here>

Default: 1

Rank [Percent] [number] <put parameter description here>

Default: 50

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:rankfilter’, input, mode, radius, rank, result)

See also

Simple filter

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0

Filter [selection] <put parameter description here>

Options:

• 0 — [0] Smooth

• 1 — [1] Sharpen

• 2 — [2] Edge

Default: 0

Radius [number] <put parameter description here>

Default: 2

Outputs

Filtered Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:simplefilter’, input, mode, method, radius, result)

See also

User defined filter

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Filter Matrix [table] Optional.

<put parameter description here>

Default Filter Matrix (3x3) [fixedtable] <put parameter description here>

Outputs

Filtered Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:userdefinedfilter’, input, filter, filter_3x3, result)

See also

.

18.7.5 Grid gridding

Inverse distance weighted

Description

Inverse distance grid interpolation from irregular distributed points.

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] inverse distance to a power

• 1 — [1] linearly decreasing within search radius

• 2 — [2] exponential weighting scheme

• 3 — [3] gaussian weighting scheme

Default: 0

Inverse Distance Power [number] <put parameter description here>

Default: 2

Exponential and Gaussian Weighting Bandwidth [number] <put parameter description here>

Default: 1

Search Range [selection] <put parameter description here>

Options:

• 0 — [0] search radius (local)

• 1 — [1] no search radius (global)

Default: 0

Search Radius [number] <put parameter description here>

Default: 100.0
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Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Number of Points [selection] <put parameter description here>

Options:

• 0 — [0] maximum number of points

• 1 — [1] all points

Default: 0

Maximum Number of Points [number] <put parameter description here>

Default: 10

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:inversedistanceweighted’, shapes, field, target, weighting, power, bandwidth, range, radius, mode, points, npoints, output_extent, user_size, user_grid)

See also

Kernel density estimation

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Weight [tablefield: any] <put parameter description here>

Radius [number] <put parameter description here>

Default: 10

Kernel [selection] <put parameter description here>

Options:

• 0 — [0] quartic kernel

• 1 — [1] gaussian kernel
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Default: 0

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:kerneldensityestimation’, points, population, radius, kernel, target, output_extent, user_size, user_grid)

See also

Modifed quadratic shepard

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Quadratic Neighbors [number] <put parameter description here>

Default: 13

Weighting Neighbors [number] <put parameter description here>

Default: 19

Left [number] <put parameter description here>

Default: 0.0

Right [number] <put parameter description here>

Default: 0.0
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Bottom [number] <put parameter description here>

Default: 0.0

Top [number] <put parameter description here>

Default: 0.0

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:modifedquadraticshepard’, shapes, field, target, quadratic_neighbors, weighting_neighbors, user_xmin, user_xmax, user_ymin, user_ymax, user_size, user_grid)

See also

Natural neighbour

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Sibson [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:naturalneighbour’, shapes, field, target, sibson, output_extent, user_size, user_grid)

See also

Nearest neighbour

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:nearestneighbour’, shapes, field, target, output_extent, user_size, user_grid)

See also

Shapes to grid

Description

<put algortithm description here>
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Parameters

Shapes [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Method for Multiple Values [selection] <put parameter description here>

Options:

• 0 — [0] first

• 1 — [1] last

• 2 — [2] minimum

• 3 — [3] maximum

• 4 — [4] mean

Default: 0

Method for Lines [selection] <put parameter description here>

Options:

• 0 — [0] thin

• 1 — [1] thick

Default: 0

Preferred Target Grid Type [selection] <put parameter description here>

Options:

• 0 — [0] Integer (1 byte)

• 1 — [1] Integer (2 byte)

• 2 — [2] Integer (4 byte)

• 3 — [3] Floating Point (4 byte)

• 4 — [4] Floating Point (8 byte)

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:shapestogrid’, input, field, multiple, line_type, grid_type, output_extent, user_size, user_grid)

480 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

See also

Triangulation

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:triangulation’, shapes, field, target, output_extent, user_size, user_grid)

See also

.

18.7.6 Grid spline

B-spline approximation

Description

<put algortithm description here>
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Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Resolution [number] <put parameter description here>

Default: 1.0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:bsplineapproximation’, shapes, field, target, level, output_extent, user_size, user_grid)

See also

Cubic spline approximation

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Minimal Number of Points [number] <put parameter description here>

Default: 3

Maximal Number of Points [number] <put parameter description here>

Default: 20
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Points per Square [number] <put parameter description here>

Default: 5

Tolerance [number] <put parameter description here>

Default: 140.0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:cubicsplineapproximation’, shapes, field, target, npmin, npmax, nppc, k, output_extent, user_size, user_grid)

See also

Multilevel b-spline interpolation (from grid)

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Method [selection] <put parameter description here>

Options:

• 0 — [0] without B-spline refinement

• 1 — [1] with B-spline refinement

Default: 0

Threshold Error [number] <put parameter description here>

Default: 0.0001

Maximum Level [number] <put parameter description here>

Default: 11.0

Data Type [selection] <put parameter description here>

Options:
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• 0 — [0] same as input grid

• 1 — [1] floating point

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:multilevelbsplineinterpolationfromgrid’, gridpoints, target, method, epsilon, level_max, datatype, output_extent, user_size, user_grid)

See also

Multilevel b-spline interpolation

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Method [selection] <put parameter description here>

Options:

• 0 — [0] without B-spline refinement

• 1 — [1] with B-spline refinement

Default: 0

Threshold Error [number] <put parameter description here>

Default: 0.0001

Maximum Level [number] <put parameter description here>

Default: 11.0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1
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Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:multilevelbsplineinterpolation’, shapes, field, target, method, epsilon, level_max, output_extent, user_size, user_grid)

See also

Thin plate spline (global)

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Regularisation [number] <put parameter description here>

Default: 0.0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:thinplatesplineglobal’, shapes, field, target, regul, output_extent, user_size, user_grid)
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See also

Thin plate spline (local)

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Regularisation [number] <put parameter description here>

Default: 0.0001

Search Radius [number] <put parameter description here>

Default: 100.0

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] all directions

• 1 — [1] quadrants

Default: 0

Points Selection [selection] <put parameter description here>

Options:

• 0 — [0] all points in search radius

• 1 — [1] maximum number of points

Default: 0

Maximum Number of Points [number] <put parameter description here>

Default: 10

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:thinplatesplinelocal’, shapes, field, target, regul, radius, mode, select, maxpoints, output_extent, user_size, user_grid)

See also

Thin plate spline (tin)

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Regularisation [number] <put parameter description here>

Default: 0.0

Neighbourhood [selection] <put parameter description here>

Options:

• 0 — [0] immediate

• 1 — [1] level 1

• 2 — [2] level 2

Default: 0

Add Frame [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:thinplatesplinetin’, shapes, field, target, regul, level, frame, output_extent, user_size, user_grid)
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See also

.

18.7.7 Grid tools

Aggregate

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Aggregation Size [number] <put parameter description here>

Default: 3

Method [selection] <put parameter description here>

Options:

• 0 — [0] Sum

• 1 — [1] Min

• 2 — [2] Max

Default: 0

Outputs

Console usage

processing.runalg(’saga:aggregate’, input, size, method)

See also

Change grid values

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Replace Condition [selection] <put parameter description here>

Options:

• 0 — [0] Grid value equals low value

• 1 — [1] Low value < grid value < high value
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• 2 — [2] Low value <= grid value < high value

Default: 0

Lookup Table [fixedtable] <put parameter description here>

Outputs

Changed Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:changegridvalues’, grid_in, method, lookup, grid_out)

See also

Close gaps

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Mask [raster] Optional.

<put parameter description here>

Tension Threshold [number] <put parameter description here>

Default: 0.1

Outputs

Changed Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:closegaps’, input, mask, threshold, result)

See also

Close gaps with spline

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Mask [raster] Optional.

<put parameter description here>

Only Process Gaps with Less Cells [number] <put parameter description here>

Default: 0

Maximum Points [number] <put parameter description here>

Default: 1000

Number of Points for Local Interpolation [number] <put parameter description here>

Default: 10

Extended Neighourhood [boolean] <put parameter description here>

Default: True

Neighbourhood [selection] <put parameter description here>

Options:

• 0 — [0] Neumann

• 1 — [1] Moore

Default: 0

Radius (Cells) [number] <put parameter description here>

Default: 0

Relaxation [number] <put parameter description here>

Default: 0.0

Outputs

Closed Gaps Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:closegapswithspline’, grid, mask, maxgapcells, maxpoints, localpoints, extended, neighbours, radius, relaxation, closed)

See also

Close one cell gaps

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>
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Outputs

Changed Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:closeonecellgaps’, input, result)

See also

Convert data storage type

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Data storage type [selection] <put parameter description here>

Options:

• 0 — [0] bit

• 1 — [1] unsigned 1 byte integer

• 2 — [2] signed 1 byte integer

• 3 — [3] unsigned 2 byte integer

• 4 — [4] signed 2 byte integer

• 5 — [5] unsigned 4 byte integer

• 6 — [6] signed 4 byte integer

• 7 — [7] 4 byte floating point number

• 8 — [8] 8 byte floating point number

Default: 0

Outputs

Converted Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:convertdatastoragetype’, input, type, output)
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See also

Crop to data

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Outputs

Cropped layer [raster] <put output description here>

Console usage

processing.runalg(’saga:croptodata’, input, output)

See also

Grid buffer

Description

<put algortithm description here>

Parameters

Features Grid [raster] <put parameter description here>

Distance [number] <put parameter description here>

Default: 1000

Buffer Distance [selection] <put parameter description here>

Options:

• 0 — [0] Fixed

• 1 — [1] Cell value

Default: 0

Outputs

Buffer Grid [raster] <put output description here>

Console usage
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processing.runalg(’saga:gridbuffer’, features, dist, buffertype, buffer)

See also

Grid masking

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Mask [raster] <put parameter description here>

Outputs

Masked Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:gridmasking’, grid, mask, masked)

See also

Grid orientation

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Copy

• 1 — [1] Flip

• 2 — [2] Mirror

• 3 — [3] Invert

Default: 0

Outputs

Changed Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:gridorientation’, input, method, result)

See also

Grid proximity buffer

Description

<put algortithm description here>

Parameters

Source Grid [raster] <put parameter description here>

Buffer distance [number] <put parameter description here>

Default: 500.0

Equidistance [number] <put parameter description here>

Default: 100.0

Outputs

Distance Grid [raster] <put output description here>

Allocation Grid [raster] <put output description here>

Buffer Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:gridproximitybuffer’, source, dist, ival, distance, alloc, buffer)

See also

Grid shrink/expand

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Operation [selection] <put parameter description here>

Options:

• 0 — [0] Shrink

• 1 — [1] Expand
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Default: 0

Search Mode [selection] <put parameter description here>

Options:

• 0 — [0] Square

• 1 — [1] Circle

Default: 0

Radius [number] <put parameter description here>

Default: 1

Method [selection] <put parameter description here>

Options:

• 0 — [0] min

• 1 — [1] max

• 2 — [2] mean

• 3 — [3] majority

Default: 0

Outputs

Result Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:gridshrinkexpand’, input, operation, mode, radius, method_expand, result)

See also

Invert data/no-data

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Outputs

Result [raster] <put output description here>

Console usage

processing.runalg(’saga:invertdatanodata’, input, output)
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See also

Merge raster layers

Description

<put algortithm description here>

Parameters

Grids to Merge [multipleinput: rasters] <put parameter description here>

Preferred data storage type [selection] <put parameter description here>

Options:

• 0 — [0] 1 bit

• 1 — [1] 1 byte unsigned integer

• 2 — [2] 1 byte signed integer

• 3 — [3] 2 byte unsigned integer

• 4 — [4] 2 byte signed integer

• 5 — [5] 4 byte unsigned integer

• 6 — [6] 4 byte signed integer

• 7 — [7] 4 byte floating point

• 8 — [8] 8 byte floating point

Default: 0

Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Overlapping Cells [selection] <put parameter description here>

Options:

• 0 — [0] mean value

• 1 — [1] first value in order of grid list

Default: 0

Outputs

Merged Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:mergerasterlayers’, grids, type, interpol, overlap, merged)

See also

Patching

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Patch Grid [raster] <put parameter description here>

Interpolation Method [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Outputs

Completed Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:patching’, original, additional, interpolation, completed)

See also

Proximity grid

Description

<put algortithm description here>

Parameters

Features [raster] <put parameter description here>
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Outputs

Distance [raster] <put output description here>

Direction [raster] <put output description here>

Allocation [raster] <put output description here>

Console usage

processing.runalg(’saga:proximitygrid’, features, distance, direction, allocation)

See also

Reclassify grid values

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] single

• 1 — [1] range

• 2 — [2] simple table

Default: 0

old value (for single value change) [number] <put parameter description here>

Default: 0.0

new value (for single value change) [number] <put parameter description here>

Default: 1.0

operator (for single value change) [selection] <put parameter description here>

Options:

• 0 — [0] =

• 1 — [1] <

• 2 — [2] <=

• 3 — [3] >=

• 4 — [4] >

Default: 0

minimum value (for range) [number] <put parameter description here>

Default: 0.0
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maximum value (for range) [number] <put parameter description here>

Default: 1.0

new value(for range) [number] <put parameter description here>

Default: 2.0

operator (for range) [selection] <put parameter description here>

Options:

• 0 — [0] <=

• 1 — [1] <

Default: 0

Lookup Table [fixedtable] <put parameter description here>

operator (for table) [selection] <put parameter description here>

Options:

• 0 — [0] min <= value < max

• 1 — [1] min <= value <= max

• 2 — [2] min < value <= max

• 3 — [3] min < value < max

Default: 0

replace no data values [boolean] <put parameter description here>

Default: True

new value for no data values [number] <put parameter description here>

Default: 0.0

replace other values [boolean] <put parameter description here>

Default: True

new value for other values [number] <put parameter description here>

Default: 0.0

Outputs

Reclassified Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:reclassifygridvalues’, input, method, old, new, soperator, min, max, rnew, roperator, retab, toperator, nodataopt, nodata, otheropt, others, result)

See also

Resampling

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Preserve Data Type [boolean] <put parameter description here>

Default: True

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Interpolation Method (Scale Up) [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

• 5 — [5] Mean Value

• 6 — [6] Mean Value (cell area weighted)

• 7 — [7] Minimum Value

• 8 — [8] Maximum Value

• 9 — [9] Majority

Default: 0

Interpolation Method (Scale Down) [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Cellsize [number] <put parameter description here>

Default: 100.0

Outputs

Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:resampling’, input, keep_type, target, scale_up_method, scale_down_method, output_extent, user_size, user_grid)

See also

Sort grid

Description

<put algortithm description here>

Parameters

Input Grid [raster] <put parameter description here>

Down sort [boolean] <put parameter description here>

Default: True

Outputs

Sorted Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:sortgrid’, grid, down, output)

See also

Split RGB bands

Description

<put algortithm description here>

Parameters

Input layer [raster] <put parameter description here>

Outputs

Output R band layer [raster] <put output description here>

Output G band layer [raster] <put output description here>

Output B band layer [raster] <put output description here>
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Console usage

processing.runalg(’saga:splitrgbbands’, input, r, g, b)

See also

Threshold buffer

Description

<put algortithm description here>

Parameters

Features Grid [raster] <put parameter description here>

Value Grid [raster] <put parameter description here>

Threshold Grid [raster] Optional.

<put parameter description here>

Threshold [number] <put parameter description here>

Default: 0.0

Threshold Type [selection] <put parameter description here>

Options:

• 0 — [0] Absolute

• 1 — [1] Relative from cell value

Default: 0

Outputs

Buffer Grid [raster] <put output description here>

Console usage

processing.runalg(’saga:thresholdbuffer’, features, value, thresholdgrid, threshold, thresholdtype, buffer)

See also

.

18.7.8 Grid visualization

Histogram surface

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] rows

• 1 — [1] columns

• 2 — [2] circle

Default: 0

Outputs

Histogram [raster] <put output description here>

Console usage

processing.runalg(’saga:histogramsurface’, grid, method, hist)

See also

Rgb composite

Description

<put algortithm description here>

Parameters

R [raster] <put parameter description here>

G [raster] <put parameter description here>

B [raster] <put parameter description here>

Method for R value [selection] <put parameter description here>

Options:

• 0 — 0 - 255

• 1 — Rescale to 0 - 255

• 2 — User defined rescale

• 3 — Percentiles

• 4 — Percentage of standard deviation

Default: 0

Method for G value [selection] <put parameter description here>

Options:

• 0 — 0 - 255

• 1 — Rescale to 0 - 255
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• 2 — User defined rescale

• 3 — Percentiles

• 4 — Percentage of standard deviation

Default: 0

Method for B value [selection] <put parameter description here>

Options:

• 0 — 0 - 255

• 1 — Rescale to 0 - 255

• 2 — User defined rescale

• 3 — Percentiles

• 4 — Percentage of standard deviation

Default: 0

Rescale Range for RED min [number] <put parameter description here>

Default: 0

Rescale Range for RED max [number] <put parameter description here>

Default: 255

Percentiles Range for RED max [number] <put parameter description here>

Default: 1

Percentiles Range for RED max [number] <put parameter description here>

Default: 99

Percentage of standard deviation for RED [number] <put parameter description here>

Default: 150.0

Rescale Range for GREEN min [number] <put parameter description here>

Default: 0

Rescale Range for GREEN max [number] <put parameter description here>

Default: 255

Percentiles Range for GREEN max [number] <put parameter description here>

Default: 1

Percentiles Range for GREEN max [number] <put parameter description here>

Default: 99

Percentage of standard deviation for GREEN [number] <put parameter description here>

Default: 150.0

Rescale Range for BLUE min [number] <put parameter description here>

Default: 0

Rescale Range for BLUE max [number] <put parameter description here>

Default: 255

Percentiles Range for BLUE max [number] <put parameter description here>

Default: 1
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Percentiles Range for BLUE max [number] <put parameter description here>

Default: 99

Percentage of standard deviation for BLUE [number] <put parameter description here>

Default: 150.0

Outputs

Output RGB [raster] <put output description here>

Console usage

processing.runalg(’saga:rgbcomposite’, grid_r, grid_g, grid_b, r_method, g_method, b_method, r_range_min, r_range_max, r_perctl_min, r_perctl_max, r_percent, g_range_min, g_range_max, g_perctl_min, g_perctl_max, g_percent, b_range_min, b_range_max, b_perctl_min, b_perctl_max, b_percent, grid_rgb)

See also

.

18.7.9 Imagery classification

Change detection

Description

<put algortithm description here>

Parameters

Initial State [raster] <put parameter description here>

Look-up Table [table] Optional.

<put parameter description here>

Value [tablefield: any] <put parameter description here>

Value (Maximum) [tablefield: any] <put parameter description here>

Name [tablefield: any] <put parameter description here>

Final State [raster] <put parameter description here>

Look-up Table [table] Optional.

<put parameter description here>

Value [tablefield: any] <put parameter description here>

Value (Maximum) [tablefield: any] <put parameter description here>

Name [tablefield: any] <put parameter description here>

Report Unchanged Classes [boolean] <put parameter description here>

Default: True

Output as... [selection] <put parameter description here>

Options:
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• 0 — [0] cells

• 1 — [1] percent

• 2 — [2] area

Default: 0

Outputs

Changes [raster] <put output description here>

Changes [table] <put output description here>

Console usage

processing.runalg(’saga:changedetection’, initial, ini_lut, ini_lut_min, ini_lut_max, ini_lut_nam, final, fin_lut, fin_lut_min, fin_lut_max, fin_lut_nam, nochange, output, change, changes)

See also

Cluster analysis for grids

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Iterative Minimum Distance (Forgy 1965)

• 1 — [1] Hill-Climbing (Rubin 1967)

• 2 — [2] Combined Minimum Distance / Hillclimbing

Default: 0

Clusters [number] <put parameter description here>

Default: 5

Normalise [boolean] <put parameter description here>

Default: True

Old Version [boolean] <put parameter description here>

Default: True

Outputs

Clusters [raster] <put output description here>

Statistics [table] <put output description here>
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Console usage

processing.runalg(’saga:clusteranalysisforgrids’, grids, method, ncluster, normalise, oldversion, cluster, statistics)

See also

Supervised classification

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Training Areas [vector: polygon] <put parameter description here>

Class Identifier [tablefield: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Binary Encoding

• 1 — [1] Parallelepiped

• 2 — [2] Minimum Distance

• 3 — [3] Mahalanobis Distance

• 4 — [4] Maximum Likelihood

• 5 — [5] Spectral Angle Mapping

• 6 — [6] Winner Takes All

Default: 0

Normalise [boolean] <put parameter description here>

Default: True

Distance Threshold [number] <put parameter description here>

Default: 0.0

Probability Threshold (Percent) [number] <put parameter description here>

Default: 0.0

Probability Reference [selection] <put parameter description here>

Options:

• 0 — [0] absolute

• 1 — [1] relative

Default: 0

Spectral Angle Threshold (Degree) [number] <put parameter description here>

Default: 0.0
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Outputs

Class Information [table] <put output description here>

Classification [raster] <put output description here>

Quality [raster] <put output description here>

Console usage

processing.runalg(’saga:supervisedclassification’, grids, roi, roi_id, method, normalise, threshold_dist, threshold_prob, relative_prob, threshold_angle, class_info, classes, quality)

See also

.

18.7.10 Imagery RGA

Fast region growing algorithm

Description

<put algortithm description here>

Parameters

Input Grids [multipleinput: rasters] <put parameter description here>

Seeds Grid [raster] <put parameter description here>

Smooth Rep [raster] Optional.

<put parameter description here>

Outputs

Segmente [raster] <put output description here>

Mean [raster] <put output description here>

Console usage

processing.runalg(’saga:fastregiongrowingalgorithm’, input, start, rep, result, mean)

See also

.
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18.7.11 Imagery segmentation

Grid skeletonization

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Standard

• 1 — [1] Hilditch’s Algorithm

• 2 — [2] Channel Skeleton

Default: 0

Initialisation [selection] <put parameter description here>

Options:

• 0 — [0] Less than

• 1 — [1] Greater than

Default: 0

Threshold (Init.) [number] <put parameter description here>

Default: 0.0

Convergence [number] <put parameter description here>

Default: 3.0

Outputs

Skeleton [raster] <put output description here>

Skeleton [vector] <put output description here>

Console usage

processing.runalg(’saga:gridskeletonization’, input, method, init_method, init_threshold, convergence, result, vector)

See also

Seed generation

Description

<put algortithm description here>
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Parameters

Features [multipleinput: rasters] <put parameter description here>

Bandwidth (Cells) [number] <put parameter description here>

Default: 2

Type of Surface [selection] <put parameter description here>

Options:

• 0 — [0] smoothed surface

• 1 — [1] variance (a)

• 2 — [2] variance (b)

Default: 0

Extraction of... [selection] <put parameter description here>

Options:

• 0 — [0] minima

• 1 — [1] maxima

• 2 — [2] minima and maxima

Default: 0

Feature Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] additive

• 1 — [1] multiplicative

Default: 0

Normalized [boolean] <put parameter description here>

Default: True

Outputs

Surface [raster] <put output description here>

Seeds Grid [raster] <put output description here>

Seeds [vector] <put output description here>

Console usage

processing.runalg(’saga:seedgeneration’, grids, factor, type_surface, type_seeds, type_merge, normalize, surface, seeds_grid, seeds)

See also

Simple region growing

Description

<put algortithm description here>

510 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

Parameters

Seeds [raster] <put parameter description here>

Features [multipleinput: rasters] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] feature space and position

• 1 — [1] feature space

Default: 0

Neighbourhood [selection] <put parameter description here>

Options:

• 0 — [0] 4 (von Neumann)

• 1 — [1] 8 (Moore)

Default: 0

Variance in Feature Space [number] <put parameter description here>

Default: 1.0

Variance in Position Space [number] <put parameter description here>

Default: 1.0

Threshold - Similarity [number] <put parameter description here>

Default: 0.0

Refresh [boolean] <put parameter description here>

Default: True

Leaf Size (for Speed Optimisation) [number] <put parameter description here>

Default: 256

Outputs

Segments [raster] <put output description here>

Similarity [raster] <put output description here>

Seeds [table] <put output description here>

Console usage

processing.runalg(’saga:simpleregiongrowing’, seeds, features, method, neighbour, sig_1, sig_2, threshold, refresh, leafsize, segments, similarity, table)

See also

Watershed segmentation

Description

<put algortithm description here>
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Parameters

Grid [raster] <put parameter description here>

Output [selection] <put parameter description here>

Options:

• 0 — [0] Seed Value

• 1 — [1] Segment ID

Default: 0

Method [selection] <put parameter description here>

Options:

• 0 — [0] Minima

• 1 — [1] Maxima

Default: 0

Join Segments based on Threshold Value [selection] <put parameter description here>

Options:

• 0 — [0] do not join

• 1 — [1] seed to saddle difference

• 2 — [2] seeds difference

Default: 0

Threshold [number] <put parameter description here>

Default: 0

Allow Edge Pixels to be Seeds [boolean] <put parameter description here>

Default: True

Borders [boolean] <put parameter description here>

Default: True

Outputs

Segments [raster] <put output description here>

Seed Points [vector] <put output description here>

Borders [raster] <put output description here>

Console usage

processing.runalg(’saga:watershedsegmentation’, grid, output, down, join, threshold, edge, bborders, segments, seeds, borders)

See also

.
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18.7.12 Imagery tools

Vegetation index[distance based]

Description

<put algortithm description here>

Parameters

Near Infrared Band [raster] <put parameter description here>

Red Band [raster] <put parameter description here>

Slope of the soil line [number] <put parameter description here>

Default: 0.0

Intercept of the soil line [number] <put parameter description here>

Default: 0.0

Outputs

PVI (Richardson and Wiegand) [raster] <put output description here>

PVI (Perry & Lautenschlager) [raster] <put output description here>

PVI (Walther & Shabaani) [raster] <put output description here>

PVI (Qi, et al) [raster] <put output description here>

Console usage

processing.runalg(’saga:vegetationindexdistancebased’, nir, red, slope, intercept, pvi, pvi1, pvi2, pvi3)

See also

Vegetation index[slope based]

Description

<put algortithm description here>

Parameters

Near Infrared Band [raster] <put parameter description here>

Red Band [raster] <put parameter description here>
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Outputs

Normalized Difference Vegetation Index [raster] <put output description here>

Ratio Vegetation Index [raster] <put output description here>

Transformed Vegetation Index [raster] <put output description here>

Corrected Transformed Vegetation Index [raster] <put output description here>

Thiam’s Transformed Vegetation Index [raster] <put output description here>

Normalized Ratio Vegetation Index [raster] <put output description here>

Console usage

processing.runalg(’saga:vegetationindexslopebased’, nir, red, ndvi, ratio, tvi, ctvi, ttvi, nratio)

See also

.

18.7.13 Kriging

Ordinary kriging (global)

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Create Variance Grid [boolean] <put parameter description here>

Default: True

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Variogram Model [selection] <put parameter description here>

Options:

• 0 — [0] Spherical Model

• 1 — [1] Exponential Model

• 2 — [2] Gaussian Model

• 3 — [3] Linear Regression

• 4 — [4] Exponential Regression

• 5 — [5] Power Function Regression
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Default: 0

Block Kriging [boolean] <put parameter description here>

Default: True

Block Size [number] <put parameter description here>

Default: 100

Logarithmic Transformation [boolean] <put parameter description here>

Default: True

Nugget [number] <put parameter description here>

Default: 0.0

Sill [number] <put parameter description here>

Default: 0.0

Range [number] <put parameter description here>

Default: 0.0

Linear Regression [number] <put parameter description here>

Default: 1.0

Exponential Regression [number] <put parameter description here>

Default: 0.1

Power Function - A [number] <put parameter description here>

Default: 1.0

Power Function - B [number] <put parameter description here>

Default: 0.5

Grid Size [number] <put parameter description here>

Default: 1.0

Fit Extent [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Outputs

Grid [raster] <put output description here>

Variance [raster] <put output description here>

Console usage

processing.runalg(’saga:ordinarykrigingglobal’, shapes, field, bvariance, target, model, block, dblock, blog, nugget, sill, range, lin_b, exp_b, pow_a, pow_b, user_cell_size, user_fit_extent, output_extent, grid, variance)
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See also

Ordinary kriging

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Create Variance Grid [boolean] <put parameter description here>

Default: True

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Variogram Model [selection] <put parameter description here>

Options:

• 0 — [0] Spherical Model

• 1 — [1] Exponential Model

• 2 — [2] Gaussian Model

• 3 — [3] Linear Regression

• 4 — [4] Exponential Regression

• 5 — [5] Power Function Regression

Default: 0

Block Kriging [boolean] <put parameter description here>

Default: True

Block Size [number] <put parameter description here>

Default: 100

Logarithmic Transformation [boolean] <put parameter description here>

Default: True

Nugget [number] <put parameter description here>

Default: 0.0

Sill [number] <put parameter description here>

Default: 10.0

Range [number] <put parameter description here>

Default: 100.0

Linear Regression [number] <put parameter description here>

Default: 1.0
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Exponential Regression [number] <put parameter description here>

Default: 0.1

Power Function - A [number] <put parameter description here>

Default: 1

Power Function - B [number] <put parameter description here>

Default: 0.5

Maximum Search Radius (map units) [number] <put parameter description here>

Default: 1000.0

Min.Number of m_Points [number] <put parameter description here>

Default: 4

Max. Number of m_Points [number] <put parameter description here>

Default: 20

Grid Size [number] <put parameter description here>

Default: 1.0

Fit Extent [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Outputs

Grid [raster] <put output description here>

Variance [raster] <put output description here>

Console usage

processing.runalg(’saga:ordinarykriging’, shapes, field, bvariance, target, model, block, dblock, blog, nugget, sill, range, lin_b, exp_b, pow_a, pow_b, maxradius, npoints_min, npoints_max, user_cell_size, user_fit_extent, output_extent, grid, variance)

See also

Universal kriging (global)

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Create Variance Grid [boolean] <put parameter description here>

Default: True
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Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Variogram Model [selection] <put parameter description here>

Options:

• 0 — [0] Spherical Model

• 1 — [1] Exponential Model

• 2 — [2] Gaussian Model

• 3 — [3] Linear Regression

• 4 — [4] Exponential Regression

• 5 — [5] Power Function Regression

Default: 0

Block Kriging [boolean] <put parameter description here>

Default: True

Block Size [number] <put parameter description here>

Default: 100

Logarithmic Transformation [boolean] <put parameter description here>

Default: True

Nugget [number] <put parameter description here>

Default: 0.0

Sill [number] <put parameter description here>

Default: 0.0

Range [number] <put parameter description here>

Default: 0.0

Linear Regression [number] <put parameter description here>

Default: 1

Exponential Regression [number] <put parameter description here>

Default: 0.5

Power Function - A [number] <put parameter description here>

Default: 1.0

Power Function - B [number] <put parameter description here>

Default: 0.1

Grids [multipleinput: rasters] <put parameter description here>

Grid Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation
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• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Grid Size [number] <put parameter description here>

Default: 1.0

Fit Extent [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Outputs

Grid [raster] <put output description here>

Variance [raster] <put output description here>

Console usage

processing.runalg(’saga:universalkrigingglobal’, shapes, field, bvariance, target, model, block, dblock, blog, nugget, sill, range, lin_b, exp_b, pow_a, pow_b, grids, interpol, user_cell_size, user_fit_extent, output_extent, grid, variance)

See also

Universal kriging

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Create Variance Grid [boolean] <put parameter description here>

Default: True

Target Grid [selection] <put parameter description here>

Options:

• 0 — [0] user defined

Default: 0

Variogram Model [selection] <put parameter description here>

Options:

• 0 — [0] Spherical Model

• 1 — [1] Exponential Model

• 2 — [2] Gaussian Model

• 3 — [3] Linear Regression
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• 4 — [4] Exponential Regression

• 5 — [5] Power Function Regression

Default: 0

Block Kriging [boolean] <put parameter description here>

Default: True

Block Size [number] <put parameter description here>

Default: 100

Logarithmic Transformation [boolean] <put parameter description here>

Default: True

Nugget [number] <put parameter description here>

Default: 0.0

Sill [number] <put parameter description here>

Default: 0.0

Range [number] <put parameter description here>

Default: 0.0

Linear Regression [number] <put parameter description here>

Default: 1.0

Exponential Regression [number] <put parameter description here>

Default: 0.1

Power Function - A [number] <put parameter description here>

Default: 1

Power Function - B [number] <put parameter description here>

Default: 0.5

Grids [multipleinput: rasters] <put parameter description here>

Grid Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Min.Number of m_Points [number] <put parameter description here>

Default: 4

Max. Number of m_Points [number] <put parameter description here>

Default: 20

Maximum Search Radius (map units) [number] <put parameter description here>

Default: 1000.0
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Grid Size [number] <put parameter description here>

Default: 1.0

Fit Extent [boolean] <put parameter description here>

Default: True

Output extent [extent] <put parameter description here>

Default: 0,1,0,1

Outputs

Grid [raster] <put output description here>

Variance [raster] <put output description here>

Console usage

processing.runalg(’saga:universalkriging’, shapes, field, bvariance, target, model, block, dblock, blog, nugget, sill, range, lin_b, exp_b, pow_a, pow_b, grids, interpol, npoints_min, npoints_max, maxradius, user_cell_size, user_fit_extent, output_extent, grid, variance)

See also

.

18.7.14 Shapes grid

Add grid values to points

Description

Creates a new vector layer as a result of the union of a points layer with the interpolated value of one or more
base background grid layer(s). This way, the new layer created will have a new column in the attribute table that
reflects the interpolated value of the background grid.

Parameters

Points [vector: point] Input layer.

Grids [multipleinput: rasters] Background grid layer(s)

Interpolation [selection] interpolation method to use.

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0
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Outputs

Result [vector] The resulting layer.

Console usage

processing.runalg(’saga:addgridvaluestopoints’, shapes, grids, interpol, result)

See also

Add grid values to shapes

Description

<put algortithm description here>

Parameters

Shapes [vector: any] <put parameter description here>

Grids [multipleinput: rasters] <put parameter description here>

Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbor

• 1 — [1] Bilinear Interpolation

• 2 — [2] Inverse Distance Interpolation

• 3 — [3] Bicubic Spline Interpolation

• 4 — [4] B-Spline Interpolation

Default: 0

Outputs

Result [vector] <put output description here>

Console usage

processing.runalg(’saga:addgridvaluestoshapes’, shapes, grids, interpol, result)

See also

Clip grid with polygon

Description

<put algortithm description here>
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Parameters

Input [raster] <put parameter description here>

Polygons [vector: polygon] <put parameter description here>

Outputs

Output [raster] <put output description here>

Console usage

processing.runalg(’saga:clipgridwithpolygon’, input, polygons, output)

See also

Contour lines from grid

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Minimum Contour Value [number] <put parameter description here>

Default: 0.0

Maximum Contour Value [number] <put parameter description here>

Default: 10000.0

Equidistance [number] <put parameter description here>

Default: 100.0

Outputs

Contour Lines [vector] <put output description here>

Console usage

processing.runalg(’saga:contourlinesfromgrid’, input, zmin, zmax, zstep, contour)

See also

Gradient vectors from directional components

Description

<put algortithm description here>
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Parameters

X Component [raster] <put parameter description here>

Y Component [raster] <put parameter description here>

Step [number] <put parameter description here>

Default: 1

Size Range Min [number] <put parameter description here>

Default: 25.0

Size Range Max [number] <put parameter description here>

Default: 100.0

Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] nearest neighbour

• 1 — [1] mean value

Default: 0

Style [selection] <put parameter description here>

Options:

• 0 — [0] simple line

• 1 — [1] arrow

• 2 — [2] arrow (centered to cell)

Default: 0

Outputs

Gradient Vectors [vector] <put output description here>

Console usage

processing.runalg(’saga:gradientvectorsfromdirectionalcomponents’, x, y, step, size_min, size_max, aggr, style, vectors)

See also

Gradient vectors from direction and length

Description

<put algortithm description here>

Parameters

Direction [raster] <put parameter description here>

Length [raster] <put parameter description here>

524 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

Step [number] <put parameter description here>

Default: 1

Size Range Min [number] <put parameter description here>

Default: 25.0

Size Range Max [number] <put parameter description here>

Default: 100.0

Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] nearest neighbour

• 1 — [1] mean value

Default: 0

Style [selection] <put parameter description here>

Options:

• 0 — [0] simple line

• 1 — [1] arrow

• 2 — [2] arrow (centered to cell)

Default: 0

Outputs

Gradient Vectors [vector] <put output description here>

Console usage

processing.runalg(’saga:gradientvectorsfromdirectionandlength’, dir, len, step, size_min, size_max, aggr, style, vectors)

See also

Gradient vectors from surface

Description

<put algortithm description here>

Parameters

Surface [raster] <put parameter description here>

Step [number] <put parameter description here>

Default: 1

Size Range Min [number] <put parameter description here>

Default: 25.0

Size Range Max [number] <put parameter description here>

Default: 100.0
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Aggregation [selection] <put parameter description here>

Options:

• 0 — [0] nearest neighbour

• 1 — [1] mean value

Default: 0

Style [selection] <put parameter description here>

Options:

• 0 — [0] simple line

• 1 — [1] arrow

• 2 — [2] arrow (centered to cell)

Default: 0

Outputs

Gradient Vectors [vector] <put output description here>

Console usage

processing.runalg(’saga:gradientvectorsfromsurface’, surface, step, size_min, size_max, aggr, style, vectors)

See also

Grid statistics for polygons

Description

<put algortithm description here>

Parameters

Grids [multipleinput: rasters] <put parameter description here>

Polygons [vector: polygon] <put parameter description here>

Number of Cells [boolean] <put parameter description here>

Default: True

Minimum [boolean] <put parameter description here>

Default: True

Maximum [boolean] <put parameter description here>

Default: True

Range [boolean] <put parameter description here>

Default: True

Sum [boolean] <put parameter description here>

Default: True
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Mean [boolean] <put parameter description here>

Default: True

Variance [boolean] <put parameter description here>

Default: True

Standard Deviation [boolean] <put parameter description here>

Default: True

Quantiles [number] <put parameter description here>

Default: 0

Outputs

Statistics [vector] <put output description here>

Console usage

processing.runalg(’saga:gridstatisticsforpolygons’, grids, polygons, count, min, max, range, sum, mean, var, stddev, quantile, result)

See also

Grid values to points (randomly)

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Frequency [number] <put parameter description here>

Default: 100

Outputs

Points [vector] <put output description here>

Console usage

processing.runalg(’saga:gridvaluestopointsrandomly’, grid, freq, points)

See also

Grid values to points

Description

<put algortithm description here>
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Parameters

Grids [multipleinput: rasters] <put parameter description here>

Polygons [vector: any] Optional.

<put parameter description here>

Exclude NoData Cells [boolean] <put parameter description here>

Default: True

Type [selection] <put parameter description here>

Options:

• 0 — [0] nodes

• 1 — [1] cells

Default: 0

Outputs

Shapes [vector] <put output description here>

Console usage

processing.runalg(’saga:gridvaluestopoints’, grids, polygons, nodata, type, shapes)

See also

Local minima and maxima

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Outputs

Minima [vector] <put output description here>

Maxima [vector] <put output description here>

Console usage

processing.runalg(’saga:localminimaandmaxima’, grid, minima, maxima)
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See also

Vectorising grid classes

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Class Selection [selection] <put parameter description here>

Options:

• 0 — [0] one single class specified by class identifier

• 1 — [1] all classes

Default: 0

Class Identifier [number] <put parameter description here>

Default: 0

Vectorised class as... [selection] <put parameter description here>

Options:

• 0 — [0] one single (multi-)polygon object

• 1 — [1] each island as separated polygon

Default: 0

Outputs

Polygons [vector] <put output description here>

Console usage

processing.runalg(’saga:vectorisinggridclasses’, grid, class_all, class_id, split, polygons)

See also

.

18.7.15 Shapes lines

Convert points to line(s)

Description

Converts points to lines.
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Parameters

Points [vector: point] Points to convert.

Order by... [tablefield: any] Lines will be ordered following this field.

Separate by... [tablefield: any] Lines will be grouped according to this field.

Outputs

Lines [vector] The resulting layer.

Console usage

processing.runalg(’saga:convertpointstolines’, points, order, separate, lines)

See also

Convert polygons to lines

Description

Creates lines from polygons.

Parameters

Polygons [vector: polygon] Layer to process.

Outputs

Lines [vector] The resulting layer.

Console usage

processing.runalg(’saga:convertpolygonstolines’, polygons, lines)

See also

Line dissolve

Description

<put algortithm description here>

Parameters

Lines [vector: any] <put parameter description here>

1. Attribute [tablefield: any] <put parameter description here>

2. Attribute [tablefield: any] <put parameter description here>
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3. Attribute [tablefield: any] <put parameter description here>

Dissolve... [selection] <put parameter description here>

Options:

• 0 — [0] lines with same attribute value(s)

• 1 — [1] all lines

Default: 0

Outputs

Dissolved Lines [vector] <put output description here>

Console usage

processing.runalg(’saga:linedissolve’, lines, field_1, field_2, field_3, all, dissolved)

See also

Line-polygon intersection

Description

<put algortithm description here>

Parameters

Lines [vector: line] <put parameter description here>

Polygons [vector: polygon] <put parameter description here>

Output [selection] <put parameter description here>

Options:

• 0 — [0] one multi-line per polygon

• 1 — [1] keep original line attributes

Default: 0

Outputs

Intersection [vector] <put output description here>

Console usage

processing.runalg(’saga:linepolygonintersection’, lines, polygons, method, intersect)
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See also

Line properties

Description

Calculates some information on each line of the layer.

Parameters

Lines [vector: line] Layer to analyze.

Number of Parts [boolean] Determites whether to calculate number of segments in line.

Default: True

Number of Vertices [boolean] Determites whether to calculate number of vertices in line.

Default: True

Length [boolean] Determites whether to calculate total line lenght.

Default: True

Outputs

Lines with Property Attributes [vector] The resulting layer.

Console usage

processing.runalg(’saga:lineproperties’, lines, bparts, bpoints, blength, output)

See also

Line simplification

Description

Simplyfies the geometry of a lines layer.

Parameters

Lines [vector: line] Layer to process.

Tolerance [number] Simplification tolerance.

Default: 1.0

Outputs

Simplified Lines [vector] The resulting layer.
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Console usage

processing.runalg(’saga:linesimplification’, lines, tolerance, output)

See also

.

18.7.16 Shapes points

Add coordinates to points

Description

Adds the X and Y coordinates of feature in the attribute table of input layer.

Parameters

Points [vector: point] Input layer.

Outputs

Output [vector] Resulting layer with the updated attribute table.

Console usage

processing.runalg(’saga:addcoordinatestopoints’, input, output)

See also

Add polygon attributes to points

Description

Adds the specified field of the polygons layer to the attribute table of the points layer. The new attributes added
for each point depend on the value of the background polygon layer.

Parameters

Points [vector: point] Points layer.

Polygons [vector: polygon] Background polygons layer.

Attribute [tablefield: any] Attribute of the polygons layer that will be added to the points layer.

Outputs

Result [vector] The resulting layer.
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Console usage

processing.runalg(’saga:addpolygonattributestopoints’, input, polygons, field, output)

See also

Aggregate point observations

Description

<put algortithm description here>

Parameters

Reference Points [vector: any] <put parameter description here>

ID [tablefield: any] <put parameter description here>

Observations [table] <put parameter description here>

X [tablefield: any] <put parameter description here>

Y [tablefield: any] <put parameter description here>

Track [tablefield: any] <put parameter description here>

Date [tablefield: any] <put parameter description here>

Time [tablefield: any] <put parameter description here>

Parameter [tablefield: any] <put parameter description here>

Maximum Time Span (Seconds) [number] <put parameter description here>

Default: 60.0

Maximum Distance [number] <put parameter description here>

Default: 0.002

Outputs

Aggregated [table] <put output description here>

Console usage

processing.runalg(’saga:aggregatepointobservations’, reference, reference_id, observations, x, y, track, date, time, parameter, eps_time, eps_space, aggregated)

See also

Clip points with polygons

Description

<put algortithm description here>
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Parameters

Points [vector: point] <put parameter description here>

Polygons [vector: polygon] <put parameter description here>

Add Attribute to Clipped Points [tablefield: any] <put parameter description here>

Clipping Options [selection] <put parameter description here>

Options:

• 0 — [0] one layer for all points

• 1 — [1] separate layer for each polygon

Default: 0

Outputs

Clipped Points [vector] <put output description here>

Console usage

processing.runalg(’saga:clippointswithpolygons’, points, polygons, field, method, clips)

See also

Convert lines to points

Description

Converts lines layer into a points.

Parameters

Lines [vector: line] Lines layer to convert.

Insert Additional Points [boolean] Determines whether to add additional nodes or not.

Default: True

Insert Distance [number] Distance between the additional points.

Default: 1.0

Outputs

Points [vector] The resulting layer.

Console usage

processing.runalg(’saga:convertlinestopoints’, lines, add, dist, points)
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See also

Convert multipoints to points

Description

<put algortithm description here>

Parameters

Multipoints [vector: point] <put parameter description here>

Outputs

Points [vector] <put output description here>

Console usage

processing.runalg(’saga:convertmultipointstopoints’, multipoints, points)

See also

Convex hull

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Hull Construction [selection] <put parameter description here>

Options:

• 0 — [0] one hull for all shapes

• 1 — [1] one hull per shape

• 2 — [2] one hull per shape part

Default: 0

Outputs

Convex Hull [vector] <put output description here>

Minimum Bounding Box [vector] <put output description here>

Console usage
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processing.runalg(’saga:convexhull’, shapes, polypoints, hulls, boxes)

See also

Distance matrix

Description

Generates a distance matrix between each point of the input layer. A unique ID will be created in the first row of
the resulting matrix (symmetric matrix), while every other cell reflects the distance between the points.

Parameters

Points [vector: point] Input layer.

Outputs

Distance Matrix Table [table] The resulting table.

Console usage

processing.runalg(’saga:distancematrix’, points, table)

See also

Fit n points to shape

Description

<put algortithm description here>

Parameters

Shapes [vector: polygon] <put parameter description here>

Number of points [number] <put parameter description here>

Default: 10

Outputs

Points [vector] <put output description here>

Console usage

processing.runalg(’saga:fitnpointstoshape’, shapes, numpoints, points)
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See also

Points filter

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Radius [number] <put parameter description here>

Default: 1

Minimum Number of Points [number] <put parameter description here>

Default: 0

Maximum Number of Points [number] <put parameter description here>

Default: 0

Quadrants [boolean] <put parameter description here>

Default: True

Filter Criterion [selection] <put parameter description here>

Options:

• 0 — [0] keep maxima (with tolerance)

• 1 — [1] keep minima (with tolerance)

• 2 — [2] remove maxima (with tolerance)

• 3 — [3] remove minima (with tolerance)

• 4 — [4] remove below percentile

• 5 — [5] remove above percentile

Default: 0

Tolerance [number] <put parameter description here>

Default: 0.0

Percentile [number] <put parameter description here>

Default: 50

Outputs

Filtered Points [vector] <put output description here>

Console usage

processing.runalg(’saga:pointsfilter’, points, field, radius, minnum, maxnum, quadrants, method, tolerance, percent, filter)
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See also

Points thinning

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Resolution [number] <put parameter description here>

Default: 1.0

Outputs

Thinned Points [vector] <put output description here>

Console usage

processing.runalg(’saga:pointsthinning’, points, field, resolution, thinned)

See also

Remove duplicate points

Description

<put algortithm description here>

Parameters

Points [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Point to Keep [selection] <put parameter description here>

Options:

• 0 — [0] first point

• 1 — [1] last point

• 2 — [2] point with minimum attribute value

• 3 — [3] point with maximum attribute value

Default: 0

Numeric Attribute Values [selection] <put parameter description here>

Options:

• 0 — [0] take value from the point to be kept

18.7. SAGA algorithm provider 539



QGIS User Guide, Wydanie 2.6

• 1 — [1] minimum value of all duplicates

• 2 — [2] maximum value of all duplicates

• 3 — [3] mean value of all duplicates

Default: 0

Outputs

Result [vector] <put output description here>

Console usage

processing.runalg(’saga:removeduplicatepoints’, points, field, method, numeric, result)

See also

Separate points by direction

Description

<put algortithm description here>

Parameters

Points [vector: point] <put parameter description here>

Number of Directions [number] <put parameter description here>

Default: 4

Tolerance (Degree) [number] <put parameter description here>

Default: 5

Outputs

Ouput [vector] <put output description here>

Console usage

processing.runalg(’saga:separatepointsbydirection’, points, directions, tolerance, output)

See also

.
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18.7.17 Shapes polygons

Convert lines to polygons

Description

Converts lines to polygons.

Parameters

Lines [vector: line] Lines to convert.

Outputs

Polygons [vector] The resulting layer.

Console usage

processing.runalg(’saga:convertlinestopolygons’, lines, polygons)

See also

Convert polygon/line vertices to points

Description

Converts the line or polygon vertices into points.

Parameters

Shapes [vector: any] Layer to process.

Outputs

Points [vector] The resulting layer.

Console usage

processing.runalg(’saga:convertpolygonlineverticestopoints’, shapes, points)

See also

Polygon centroids

Description

Calculates the centroids of polygons.
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Parameters

Polygons [vector: polygon] Input layer.

Centroids for each part [boolean] Determites whether centroids should be calculated for each part of
multipart polygon or not.

Default: True

Outputs

Centroids [vector] The resulting layer.

Console usage

processing.runalg(’saga:polygoncentroids’, polygons, method, centroids)

See also

Polygon dissolve

Description

<put algortithm description here>

Parameters

Polygons [vector: polygon] <put parameter description here>

1. Attribute [tablefield: any] Optional.

<put parameter description here>

2. Attribute [tablefield: any] Optional.

<put parameter description here>

3. Attribute [tablefield: any] Optional.

<put parameter description here>

Dissolve... [selection] <put parameter description here>

Options:

• 0 — [0] polygons with same attribute value

• 1 — [1] all polygons

• 2 — [2] polygons with same attribute value (keep inner boundaries)

• 3 — [3] all polygons (keep inner boundaries)

Default: 0

Outputs

Dissolved Polygons [vector] <put output description here>
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Console usage

processing.runalg(’saga:polygondissolve’, polygons, field_1, field_2, field_3, dissolve, dissolved)

See also

Polygon-line intersection

Description

<put algortithm description here>

Parameters

Polygons [vector: polygon] <put parameter description here>

Lines [vector: line] <put parameter description here>

Outputs

Intersection [vector] <put output description here>

Console usage

processing.runalg(’saga:polygonlineintersection’, polygons, lines, intersect)

See also

Polygon parts to separate polygons

Description

<put algortithm description here>

Parameters

Polygons [vector: polygon] <put parameter description here>

Ignore Lakes [boolean] <put parameter description here>

Default: True

Outputs

Polygon Parts [vector] <put output description here>

Console usage

processing.runalg(’saga:polygonpartstoseparatepolygons’, polygons, lakes, parts)
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See also

Polygon properties

Description

<put algortithm description here>

Parameters

Polygons [vector: polygon] <put parameter description here>

Number of Parts [boolean] <put parameter description here>

Default: True

Number of Vertices [boolean] <put parameter description here>

Default: True

Perimeter [boolean] <put parameter description here>

Default: True

Area [boolean] <put parameter description here>

Default: True

Outputs

Polygons with Property Attributes [vector] <put output description here>

Console usage

processing.runalg(’saga:polygonproperties’, polygons, bparts, bpoints, blength, barea, output)

See also

Polygon shape indices

Description

Calculates spatial statistics for polygons. This includes:

• area

• perimeter

• perimeter / area

• perimeter / square root of the area

• maximum distance

• maximum distance / area

• maximum distance / square root of the area

• shape index
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Parameters

Shapes [vector: polygon] Layer to analyze.

Outputs

Shape Index [vector] The resulting layer.

Console usage

processing.runalg(’saga:polygonshapeindices’, shapes, index)

See also

Polygons to edges and nodes

Description

Extracts boundaries and nodes of polygons in separate files.

Parameters

Polygons [vector: polygon] Input layer.

Outputs

Edges [vector] Resulting line layer with polygons boundaries.

Nodes [vector] Resulting line layer with polygons nodes.

Console usage

processing.runalg(’saga:polygonstoedgesandnodes’, polygons, edges, nodes)

See also

.

18.7.18 Shapes tools

Create graticule

Description

Creates a grid.
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Parameters

Extent [vector: any] Optional.

Grid will be created according to the selected layer.

Output extent [extent] Extent of the grid.

Default: 0,1,0,1

Division Width [number] X-axes spacing between the lines.

Default: 1.0

Division Height [number] Y-axes spacing between the lines.

Default: 1.0

Type [selection] Geometry type of the resulting grid.

Options:

• 0 — [0] Lines

• 1 — [1] Rectangles

Default: 0

Outputs

Graticule [vector] The resulting layer.

Console usage

processing.runalg(’saga:creategraticule’, extent, output_extent, distx, disty, type, graticule)

See also

Cut shapes layer

Description

<put algortithm description here>

Parameters

Vector layer to cut [vector: any] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] completely contained

• 1 — [1] intersects

• 2 — [2] center

Default: 0

Cutting polygons [vector: any] <put parameter description here>
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Outputs

Result [vector] <put output description here>

Extent [vector] <put output description here>

Console usage

processing.runalg(’saga:cutshapeslayer’, shapes, method, polygons_polygons, cut, extent)

See also

Get shapes extents

Description

Creates polygons according to the extent of the input layer features.

Parameters

Shapes [vector: any] Input layer.

Parts [boolean] Determines whether create polygon for each feature (True) or just create single polygon for
whole layer (False).

Default: True

Outputs

Extents [vector] The resulting layer.

Console usage

processing.runalg(’saga:getshapesextents’, shapes, parts, extents)

See also

Merge shapes layers

Description

Merges two or more input layer into a unique resulting layer. You can merge together only layer of the same type
(polygons with polygons, lines with lines, points with points).

The attribute table of the resulting layer will include only the attributes of the first input layer. Two additional
columns will be added: one corresponding to the ID of every merged layer and the other one corresponding to the
original name of the merged layer.
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Parameters

Main Layer [vector: any] Initial layer.

Additional Layers [multipleinput: any vectors] Optional.

Layer(s) to merge with.

Outputs

Merged Layer [vector] The resulting layer.

Console usage

processing.runalg(’saga:mergeshapeslayers’, main, layers, out)

See also

Polar to cartesian coordinates

Description

<put algortithm description here>

Parameters

Polar Coordinates [vector: any] <put parameter description here>

Exaggeration [tablefield: any] <put parameter description here>

Exaggeration Factor [number] <put parameter description here>

Default: 1

Radius [number] <put parameter description here>

Default: 6371000.0

Degree [boolean] <put parameter description here>

Default: True

Outputs

Cartesian Coordinates [vector] <put output description here>

Console usage

processing.runalg(’saga:polartocartesiancoordinates’, polar, f_exagg, d_exagg, radius, degree, cartes)
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See also

Quadtree structure to shapes

Description

<put algortithm description here>

Parameters

Shapes [vector: any] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Outputs

Polygons [vector] <put output description here>

Lines [vector] <put output description here>

Duplicated Points [vector] <put output description here>

Console usage

processing.runalg(’saga:quadtreestructuretoshapes’, shapes, attribute, polygons, lines, points)

See also

Shapes buffer

Description

Creates buffer around features based on fixed distance or distance field.

Parameters

Shapes [vector: any] Input layer.

Buffer Distance [selection] Buffering method.

Options:

• 0 — [0] fixed value

• 1 — [1] attribute field

Default: 0

Buffer Distance (Fixed) [number] Buffer distance for “fixed value” method.

Default: 100.0

Buffer Distance (Attribute) [tablefield: any] Name of the distance field for “attribute field” method.

Scaling Factor for Attribute Value [number] <put parameter description here>

Default: 1.0
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Number of Buffer Zones [number] Number of buffer(s) to generate.

Default: 1.0

Circle Point Distance [Degree] [number] Smoothness of the buffer borders: great numbers means
rough borders.

Default: 5.0

Dissolve Buffers [boolean] Determines whether to dissolve results or not.

Default: True

Outputs

Buffer [vector] The resulting layer.

Console usage

processing.runalg(’saga:shapesbuffer’, shapes, buf_type, buf_dist, buf_field, buf_scale, buf_zones, dcircle, dissolve, buffer)

See also

Split shapes layer randomly

Description

Splits the input layer randomly in two parts.

Parameters

Shapes [vector: any] Layer to split.

Split ratio (%) [number] Split ratio between the resulting layers.

Default: 50

Outputs

Group A [vector] First resulting layer.

Group B [vector] Second resulting layer.

Console usage

processing.runalg(’saga:splitshapeslayerrandomly’, shapes, percent, a, b)

See also

Transform shapes

Description

<put algortithm description here>
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Parameters

Shapes [vector: any] <put parameter description here>

dX [number] <put parameter description here>

Default: 0.0

dY [number] <put parameter description here>

Default: 0.0

Angle [number] <put parameter description here>

Default: 0.0

Scale Factor X [number] <put parameter description here>

Default: 1.0

Scale Factor Y [number] <put parameter description here>

Default: 1.0

X [number] <put parameter description here>

Default: 0.0

Y [number] <put parameter description here>

Default: 0.0

Outputs

Output [vector] <put output description here>

Console usage

processing.runalg(’saga:transformshapes’, in, dx, dy, angle, scalex, scaley, anchorx, anchory, out)

See also

.

18.7.19 Shapes transect

Transect through polygon shapefile

Description

<put algortithm description here>

Parameters

Line Transect(s) [vector: line] <put parameter description here>

Theme [vector: any] <put parameter description here>

Theme Field [tablefield: any] <put parameter description here>
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Outputs

Result table [table] <put output description here>

Console usage

processing.runalg(’saga:transectthroughpolygonshapefile’, transect, theme, theme_field, transect_result)

See also

.

18.7.20 Simulation fire

Fire risk analysis

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Fuel Model [raster] <put parameter description here>

Wind Speed [raster] <put parameter description here>

Wind Direction [raster] <put parameter description here>

Dead Fuel Moisture 1H [raster] <put parameter description here>

Dead Fuel Moisture 10H [raster] <put parameter description here>

Dead Fuel Moisture 100H [raster] <put parameter description here>

Herbaceous Fuel Moisture [raster] <put parameter description here>

Wood Fuel Moisture [raster] <put parameter description here>

Value [raster] Optional.

<put parameter description here>

Base Probability [raster] Optional.

<put parameter description here>

Number of Events [number] <put parameter description here>

Default: 1000

Fire Length [number] <put parameter description here>

Default: 100
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Outputs

Danger [raster] <put output description here>

Compound Probability [raster] <put output description here>

Priority Index [raster] <put output description here>

Console usage

processing.runalg(’saga:fireriskanalysis’, dem, fuel, windspd, winddir, m1h, m10h, m100h, mherb, mwood, value, baseprob, montecarlo, interval, danger, compprob, priority)

See also

Simulation

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Fuel Model [raster] <put parameter description here>

Wind Speed [raster] <put parameter description here>

Wind Direction [raster] <put parameter description here>

Dead Fuel Moisture 1H [raster] <put parameter description here>

Dead Fuel Moisture 10H [raster] <put parameter description here>

Dead Fuel Moisture 100H [raster] <put parameter description here>

Herbaceous Fuel Moisture [raster] <put parameter description here>

Wood Fuel Moisture [raster] <put parameter description here>

Ignition Points [raster] <put parameter description here>

Update View [boolean] <put parameter description here>

Default: True

Outputs

Time [raster] <put output description here>

Flame Length [raster] <put output description here>

Intensity [raster] <put output description here>

Console usage

processing.runalg(’saga:simulation’, dem, fuel, windspd, winddir, m1h, m10h, m100h, mherb, mwood, ignition, updateview, time, flame, intensity)
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See also

.

18.7.21 Simulation hydrology

Overland flow - kinematic wave d8

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Gauges [vector: any] Optional.

<put parameter description here>

Simulation Time [h] [number] <put parameter description here>

Default: 24

Simulation Time Step [h] [number] <put parameter description here>

Default: 0.1

Manning’s Roughness [number] <put parameter description here>

Default: 0.03

Max. Iterations [number] <put parameter description here>

Default: 100

Epsilon [number] <put parameter description here>

Default: 0.0001

Precipitation [selection] <put parameter description here>

Options:

• 0 — [0] Homogenous

• 1 — [1] Above Elevation

• 2 — [2] Left Half

Default: 0

Threshold Elevation [number] <put parameter description here>

Default: 0.0

Outputs

Runoff [raster] <put output description here>

Flow at Gauges [table] <put output description here>
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Console usage

processing.runalg(’saga:overlandflowkinematicwaved8’, dem, gauges, time_span, time_step, roughness, newton_maxiter, newton_epsilon, precip, threshold, flow, gauges_flow)

See also

Water retention capacity

Description

<put algortithm description here>

Parameters

Plot Holes [vector: any] <put parameter description here>

DEM [raster] <put parameter description here>

Outputs

Final Parameters [vector] <put output description here>

Water Retention Capacity [raster] <put output description here>

Console usage

processing.runalg(’saga:waterretentioncapacity’, shapes, dem, output, retention)

See also

.

18.7.22 Table calculus

Fill gaps in records

Description

<put algortithm description here>

Parameters

Table [table] <put parameter description here>

Order [tablefield: any] <put parameter description here>

Interpolation [selection] <put parameter description here>

Options:

• 0 — [0] Nearest Neighbour

• 1 — [1] Linear
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• 2 — [2] Spline

Default: 0

Outputs

Table without Gaps [table] <put output description here>

Console usage

processing.runalg(’saga:fillgapsinrecords’, table, order, method, nogaps)

See also

Principle components analysis

Description

<put algortithm description here>

Parameters

Table [table] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] correlation matrix

• 1 — [1] variance-covariance matrix

• 2 — [2] sums-of-squares-and-cross-products matrix

Default: 0

Number of Components [number] <put parameter description here>

Default: 3

Outputs

Principle Components [table] <put output description here>

Console usage

processing.runalg(’saga:principlecomponentsanalysis’, table, method, nfirst, pca)

See also

Running average

Description

<put algortithm description here>
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Parameters

Input [table] <put parameter description here>

Attribute [tablefield: any] <put parameter description here>

Number of Records [number] <put parameter description here>

Default: 10

Outputs

Output [table] <put output description here>

Console usage

processing.runalg(’saga:runningaverage’, input, field, count, output)

See also

.

18.7.23 Table tools

Change date format

Description

Converts the date format of the input layer.

Parameters

Table [table] Input table.

Date Field [tablefield: any] Attribute the date.

Input Format [selection] Input date format.

Options:

• 0 — [0] dd.mm.yy

• 1 — [1] yy.mm.dd

• 2 — [2] dd:mm:yy

• 3 — [3] yy:mm:dd

• 4 — [4] ddmmyyyy, fix size

• 5 — [5] yyyymmdd, fix size

• 6 — [6] ddmmyy, fix size

• 7 — [7] yymmdd, fix size

• 8 — [8] Julian Day

Default: 0
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Output Format [selection] Output date format.

Options:

• 0 — [0] dd.mm.yy

• 1 — [1] yy.mm.dd

• 2 — [2] dd:mm:yy

• 3 — [3] yy:mm:dd

• 4 — [4] ddmmyyyy, fix size

• 5 — [5] yyyymmdd, fix size

• 6 — [6] ddmmyy, fix size

• 7 — [7] yymmdd, fix size

• 8 — [8] Julian Day

Default: 0

Outputs

Output [table] The resulting table.

Console usage

processing.runalg(’saga:changedateformat’, table, field, fmt_in, fmt_out, output)

See also

Change time format

Description

Converts the time format of the input layer.

Parameters

Table [table] Input table.

Time Field [tablefield: any] Attribute with time.

Input Format [selection] Input time format.

Options:

• 0 — [0] hh.mm.ss

• 1 — [1] hh:mm:ss

• 2 — [2] hhmmss, fix size

• 3 — [3] hours

• 4 — [4] minutes

• 5 — [5] seconds

Default: 0

558 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

Output Format [selection] Output time format.

Options:

• 0 — [0] hh.mm.ss

• 1 — [1] hh:mm:ss

• 2 — [2] hhmmss, fix size

• 3 — [3] hours

• 4 — [4] minutes

• 5 — [5] seconds

Default: 0

Outputs

Output [table] The resulting table.

Console usage

processing.runalg(’saga:changetimeformat’, table, field, fmt_in, fmt_out, output)

See also

.

18.7.24 Terrain channels

Channel network and drainage basins

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Threshold [number] <put parameter description here>

Default: 5.0

Outputs

Flow Direction [raster] <put output description here>

Flow Connectivity [raster] <put output description here>

Strahler Order [raster] <put output description here>

Drainage Basins [raster] <put output description here>

Channels [vector] <put output description here>

Drainage Basins [vector] <put output description here>

18.7. SAGA algorithm provider 559



QGIS User Guide, Wydanie 2.6

Junctions [vector] <put output description here>

Console usage

processing.runalg(’saga:channelnetworkanddrainagebasins’, dem, threshold, direction, connection, order, basin, segments, basins, nodes)

See also

Channel network

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Flow Direction [raster] Optional.

<put parameter description here>

Initiation Grid [raster] <put parameter description here>

Initiation Type [selection] <put parameter description here>

Options:

• 0 — [0] Less than

• 1 — [1] Equals

• 2 — [2] Greater than

Default: 0

Initiation Threshold [number] <put parameter description here>

Default: 0.0

Divergence [raster] Optional.

<put parameter description here>

Tracing: Max. Divergence [number] <put parameter description here>

Default: 10

Tracing: Weight [raster] Optional.

<put parameter description here>

Min. Segment Length [number] <put parameter description here>

Default: 10

Outputs

Channel Network [raster] <put output description here>

Channel Direction [raster] <put output description here>

Channel Network [vector] <put output description here>
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Console usage

processing.runalg(’saga:channelnetwork’, elevation, sinkroute, init_grid, init_method, init_value, div_grid, div_cells, trace_weight, minlen, chnlntwrk, chnlroute, shapes)

See also

Overland flow distance to channel network

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Channel Network [raster] <put parameter description here>

Flow Algorithm [selection] <put parameter description here>

Options:

• 0 — [0] D8

• 1 — [1] MFD

Default: 0

Outputs

Overland Flow Distance [raster] <put output description here>

Vertical Overland Flow Distance [raster] <put output description here>

Horizontal Overland Flow Distance [raster] <put output description here>

Console usage

processing.runalg(’saga:overlandflowdistancetochannelnetwork’, elevation, channels, method, distance, distvert, disthorz)

See also

Strahler order

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>
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Outputs

Strahler Order [raster] <put output description here>

Console usage

processing.runalg(’saga:strahlerorder’, dem, strahler)

See also

Vertical distance to channel network

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Channel Network [raster] <put parameter description here>

Tension Threshold [Percentage of Cell Size] [number] <put parameter description here>

Default: 1

Keep Base Level below Surface [boolean] <put parameter description here>

Default: True

Outputs

Vertical Distance to Channel Network [raster] <put output description here>

Channel Network Base Level [raster] <put output description here>

Console usage

processing.runalg(’saga:verticaldistancetochannelnetwork’, elevation, channels, threshold, nounderground, distance, baselevel)

See also

Watershed basins

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Channel Network [raster] <put parameter description here>

Sink Route [raster] Optional.

<put parameter description here>

Min. Size [number] <put parameter description here>

Default: 0

Outputs

Watershed Basins [raster] <put output description here>

Console usage

processing.runalg(’saga:watershedbasins’, elevation, channels, sinkroute, minsize, basins)

See also

.

18.7.25 Terrain hydrology

Burn stream network into dem

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Streams [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] simply decrease cell’s value by epsilon

• 1 — [1] lower cell’s value to neighbours minimum value minus epsilon

Default: 0

Epsilon [number] <put parameter description here>

Default: 1.0

Outputs

Processed DEM [raster] <put output description here>
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Console usage

processing.runalg(’saga:burnstreamnetworkintodem’, dem, stream, method, epsilon, burn)

See also

Catchment area (flow tracing)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Sink Routes [raster] Optional.

<put parameter description here>

Weight [raster] Optional.

<put parameter description here>

Material [raster] Optional.

<put parameter description here>

Target [raster] Optional.

<put parameter description here>

Step [number] <put parameter description here>

Default: 1

Method [selection] <put parameter description here>

Options:

• 0 — [0] Rho 8

• 1 — [1] Kinematic Routing Algorithm

• 2 — [2] DEMON

Default: 0

DEMON - Min. DQV [number] <put parameter description here>

Default: 0.0

Flow Correction [boolean] <put parameter description here>

Default: True

Outputs

Catchment Area [raster] <put output description here>

Catchment Height [raster] <put output description here>

Catchment Slope [raster] <put output description here>

Total accumulated Material [raster] <put output description here>
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Accumulated Material from _left_ side [raster] <put output description here>

Accumulated Material from _right_ side [raster] <put output description here>

Console usage

processing.runalg(’saga:catchmentareaflowtracing’, elevation, sinkroute, weight, material, target, step, method, mindqv, correct, carea, cheight, cslope, accu_tot, accu_left, accu_right)

See also

Catchment area (recursive)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Sink Routes [raster] Optional.

<put parameter description here>

Weight [raster] Optional.

<put parameter description here>

Material [raster] Optional.

<put parameter description here>

Target [raster] Optional.

<put parameter description here>

Step [number] <put parameter description here>

Default: 1

Target Areas [raster] Optional.

<put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8

• 1 — [1] Rho 8

• 2 — [2] Deterministic Infinity

• 3 — [3] Multiple Flow Direction

Default: 0

Convergence [number] <put parameter description here>

Default: 1.1
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Outputs

Catchment Area [raster] <put output description here>

Catchment Height [raster] <put output description here>

Catchment Slope [raster] <put output description here>

Total accumulated Material [raster] <put output description here>

Accumulated Material from _left_ side [raster] <put output description here>

Accumulated Material from _right_ side [raster] <put output description here>

Flow Path Length [raster] <put output description here>

Console usage

processing.runalg(’saga:catchmentarearecursive’, elevation, sinkroute, weight, material, target, step, targets, method, convergence, carea, cheight, cslope, accu_tot, accu_left, accu_right, flowlen)

See also

Catchment Area

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8

• 1 — [1] Rho 8

• 2 — [2] Braunschweiger Reliefmodell

• 3 — [3] Deterministic Infinity

• 4 — [4] Multiple Flow Direction

• 5 — [5] Multiple Triangular Flow Directon

Default: 0

Outputs

Catchment Area [raster] <put output description here>

Console usage

processing.runalg(’saga:catchmentarea’, elevation, method, carea)
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See also

Cell balance

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Parameter [raster] Optional.

<put parameter description here>

Default Weight [number] <put parameter description here>

Default: 1.0

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8

• 1 — [1] Multiple Flow Direction

Default: 0

Outputs

Cell Balance [raster] <put output description here>

Console usage

processing.runalg(’saga:cellbalance’, dem, weights, weight, method, balance)

See also

Edge contamination

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Outputs

Edge Contamination [raster] <put output description here>

18.7. SAGA algorithm provider 567



QGIS User Guide, Wydanie 2.6

Console usage

processing.runalg(’saga:edgecontamination’, dem, contamination)

See also

Fill Sinks

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Minimum Slope [Degree] [number] <put parameter description here>

Default: 0.01

Outputs

Filled DEM [raster] <put output description here>

Console usage

processing.runalg(’saga:fillsinks’, dem, minslope, result)

See also

Fill sinks (wang & liu)

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Minimum Slope [Degree] [number] <put parameter description here>

Default: 0.01

Outputs

Filled DEM [raster] <put output description here>

Flow Directions [raster] <put output description here>

Watershed Basins [raster] <put output description here>
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Console usage

processing.runalg(’saga:fillsinkswangliu’, elev, minslope, filled, fdir, wshed)

See also

Fill sinks xxl (wang & liu)

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Minimum Slope [Degree] [number] <put parameter description here>

Default: 0.01

Outputs

Filled DEM [raster] <put output description here>

Console usage

processing.runalg(’saga:fillsinksxxlwangliu’, elev, minslope, filled)

See also

Flat detection

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Flat Area Values [selection] <put parameter description here>

Options:

• 0 — [0] elevation

• 1 — [1] enumeration

Default: 0
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Outputs

No Flats [raster] <put output description here>

Flat Areas [raster] <put output description here>

Console usage

processing.runalg(’saga:flatdetection’, dem, flat_output, noflats, flats)

See also

Flow path length

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Seeds [raster] Optional.

<put parameter description here>

Seeds Only [boolean] <put parameter description here>

Default: True

Flow Routing Algorithm [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8 (D8)

• 1 — [1] Multiple Flow Direction (FD8)

Default: 0

Convergence (FD8) [number] <put parameter description here>

Default: 1.1

Outputs

Flow Path Length [raster] <put output description here>

Console usage

processing.runalg(’saga:flowpathlength’, elevation, seed, seeds_only, method, convergence, length)
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See also

Flow width and specific catchment area

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Total Catchment Area (TCA) [raster] Optional.

<put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8

• 1 — [1] Multiple Flow Direction (Quinn et al. 1991)

• 2 — [2] Aspect

Default: 0

Outputs

Flow Width [raster] <put output description here>

Specific Catchment Area (SCA) [raster] <put output description here>

Console usage

processing.runalg(’saga:flowwidthandspecificcatchmentarea’, dem, tca, method, width, sca)

See also

Lake flood

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Seeds [raster] <put parameter description here>

Absolute Water Levels [boolean] <put parameter description here>

Default: True
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Outputs

Lake [raster] <put output description here>

Surface [raster] <put output description here>

Console usage

processing.runalg(’saga:lakeflood’, elev, seeds, level, outdepth, outlevel)

See also

Ls factor

Description

<put algortithm description here>

Parameters

Slope [raster] <put parameter description here>

Catchment Area [raster] <put parameter description here>

Area to Length Conversion [selection] <put parameter description here>

Options:

• 0 — [0] no conversion (areas already given as specific catchment area)

• 1 — [1] 1 / cell size (specific catchment area)

• 2 — [2] square root (catchment length)

Default: 0

Method (LS) [selection] <put parameter description here>

Options:

• 0 — [0] Moore et al. 1991

• 1 — [1] Desmet & Govers 1996

• 2 — [2] Boehner & Selige 2006

Default: 0

Rill/Interrill Erosivity [number] <put parameter description here>

Default: 0.0

Stability [selection] <put parameter description here>

Options:

• 0 — [0] stable

• 1 — [1] instable (thawing)

Default: 0
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Outputs

LS Factor [raster] <put output description here>

Console usage

processing.runalg(’saga:lsfactor’, slope, area, conv, method, erosivity, stability, ls)

See also

Saga wetness index

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

t [number] <put parameter description here>

Default: 10

Outputs

Catchment area [raster] <put output description here>

Catchment slope [raster] <put output description here>

Modified catchment area [raster] <put output description here>

Wetness index [raster] <put output description here>

Console usage

processing.runalg(’saga:sagawetnessindex’, dem, t, c, gn, cs, sb)

See also

Sink drainage route detection

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Threshold [boolean] <put parameter description here>

Default: True
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Threshold Height [number] <put parameter description here>

Default: 100.0

Outputs

Sink Route [raster] <put output description here>

Console usage

processing.runalg(’saga:sinkdrainageroutedetection’, elevation, threshold, thrsheight, sinkroute)

See also

Sink removal

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Sink Route [raster] Optional.

<put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deepen Drainage Routes

• 1 — [1] Fill Sinks

Default: 0

Threshold [boolean] <put parameter description here>

Default: True

Threshold Height [number] <put parameter description here>

Default: 100.0

Outputs

Preprocessed DEM [raster] <put output description here>

Console usage

processing.runalg(’saga:sinkremoval’, dem, sinkroute, method, threshold, thrsheight, dem_preproc)

574 Rozdział 18. Processing providers and algorithms



QGIS User Guide, Wydanie 2.6

See also

Slope length

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Outputs

Slope Length [raster] <put output description here>

Console usage

processing.runalg(’saga:slopelength’, dem, length)

See also

Stream power index

Description

<put algortithm description here>

Parameters

Slope [raster] <put parameter description here>

Catchment Area [raster] <put parameter description here>

Area Conversion [selection] <put parameter description here>

Options:

• 0 — [0] no conversion (areas already given as specific catchment area)

• 1 — [1] 1 / cell size (pseudo specific catchment area)

Default: 0

Outputs

Stream Power Index [raster] <put output description here>

Console usage

processing.runalg(’saga:streampowerindex’, slope, area, conv, spi)
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See also

Topographic wetness index (twi)

Description

<put algortithm description here>

Parameters

Slope [raster] <put parameter description here>

Catchment Area [raster] <put parameter description here>

Transmissivity [raster] Optional.

<put parameter description here>

Area Conversion [selection] <put parameter description here>

Options:

• 0 — [0] no conversion (areas already given as specific catchment area)

• 1 — [1] 1 / cell size (pseudo specific catchment area)

Default: 0

Method (TWI) [selection] <put parameter description here>

Options:

• 0 — [0] Standard

• 1 — [1] TOPMODEL

Default: 0

Outputs

Topographic Wetness Index [raster] <put output description here>

Console usage

processing.runalg(’saga:topographicwetnessindextwi’, slope, area, trans, conv, method, twi)

See also

Upslope Area

Description

<put algortithm description here>
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Parameters

Target Area [raster] Optional.

<put parameter description here>

Target X coordinate [number] <put parameter description here>

Default: 0.0

Target Y coordinate [number] <put parameter description here>

Default: 0.0

Elevation [raster] <put parameter description here>

Sink Routes [raster] Optional.

<put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Deterministic 8

• 1 — [1] Deterministic Infinity

• 2 — [2] Multiple Flow Direction

Default: 0

Convergence [number] <put parameter description here>

Default: 1.1

Outputs

Upslope Area [raster] <put output description here>

Console usage

processing.runalg(’saga:upslopearea’, target, target_pt_x, target_pt_y, elevation, sinkroute, method, converge, area)

See also

.

18.7.26 Terrain lighting

Analytical hillshading

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Shading Method [selection] <put parameter description here>

Options:

• 0 — [0] Standard

• 1 — [1] Standard (max. 90Degree)

• 2 — [2] Combined Shading

• 3 — [3] Ray Tracing

Default: 0

Azimuth [Degree] [number] <put parameter description here>

Default: 315.0

Declination [Degree] [number] <put parameter description here>

Default: 45.0

Exaggeration [number] <put parameter description here>

Default: 4.0

Outputs

Analytical Hillshading [raster] <put output description here>

Console usage

processing.runalg(’saga:analyticalhillshading’, elevation, method, azimuth, declination, exaggeration, shade)

See also

Sky view factor

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Maximum Search Radius [number] <put parameter description here>

Default: 10000

Method [selection] <put parameter description here>

Options:

• 0 — [0] multi scale

• 1 — [1] sectors

Default: 0
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Multi Scale Factor [number] <put parameter description here>

Default: 3

Number of Sectors [number] <put parameter description here>

Default: 8

Outputs

Visible Sky [raster] <put output description here>

Sky View Factor [raster] <put output description here>

Sky View Factor (Simplified) [raster] <put output description here>

Terrain View Factor [raster] <put output description here>

Console usage

processing.runalg(’saga:skyviewfactor’, dem, maxradius, method, level_inc, ndirs, visible, svf, simple, terrain)

See also

Topographic correction

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Original Image [raster] <put parameter description here>

Azimuth [number] <put parameter description here>

Default: 180.0

Height [number] <put parameter description here>

Default: 45.0

Method [selection] <put parameter description here>

Options:

• 0 — [0] Cosine Correction (Teillet et al. 1982)

• 1 — [1] Cosine Correction (Civco 1989)

• 2 — [2] Minnaert Correction

• 3 — [3] Minnaert Correction with Slope (Riano et al. 2003)

• 4 — [4] Minnaert Correction with Slope (Law & Nichol 2004)

• 5 — [5] C Correction

• 6 — [6] Normalization (after Civco, modified by Law & Nichol)

Default: 0
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Minnaert Correction [number] <put parameter description here>

Default: 0.5

Maximum Cells (C Correction Analysis) [number] <put parameter description here>

Default: 1000

Value Range [selection] <put parameter description here>

Options:

• 0 — [0] 1 byte (0-255)

• 1 — [1] 2 byte (0-65535)

Default: 0

Outputs

Corrected Image [raster] <put output description here>

Console usage

processing.runalg(’saga:topographiccorrection’, dem, original, azi, hgt, method, minnaert, maxcells, maxvalue, corrected)

See also

.

18.7.27 Terrain morphometry

Convergence index

Description

Calculates an index of convergence/divergence regarding to overland flow. By its meaning it is similar to plan or
horizontal curvature, but gives much smoother results. The calculation uses the aspects of surrounding cells, i.e. it
looks to which degree surrounding cells point to the center cell. The result is given as percentages, negative values
correspond to convergent, positive to divergent flow conditions. Minus 100 would be like a peak of a cone, plus
100 a pit, and 0 an even slope.

Parameters

Elevation [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Aspect

• 1 — [1] Gradient

Default: 0

Gradient Calculation [selection] <put parameter description here>

Options:

• 0 — [0] 2 x 2
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• 1 — [1] 3 x 3

Default: 0

Outputs

Convergence Index [raster] <put output description here>

Console usage

processing.runalg(’saga:convergenceindex’, elevation, method, neighbours, result)

See also

• Koethe, R. / Lehmeier, F. (1996): ‘SARA, System zur Automatischen Relief-Analyse’, Benutzerhandbuch,
2. Auflage [Geogr. Inst. Univ. Goettingen, unpublished]

Convergence index (search radius)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Radius [Cells] [number] <put parameter description here>

Default: 10

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1

Gradient [boolean] <put parameter description here>

Default: True
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Difference [selection] <put parameter description here>

Options:

• 0 — [0] direction to the center cell

• 1 — [1] center cell’s aspect direction

Default: 0

Outputs

Convergence Index [raster] <put output description here>

Console usage

processing.runalg(’saga:convergenceindexsearchradius’, elevation, radius, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, slope, difference, convergence)

See also

Curvature classification

Description

<put algortithm description here>

Parameters

Plan Curvature [raster] <put parameter description here>

Profile Curvature [raster] <put parameter description here>

Threshold for plane [number] <put parameter description here>

Default: 0.001

Outputs

Curvature Classification [raster] <put output description here>

Console usage

processing.runalg(’saga:curvatureclassification’, cplan, cprof, threshold, class)

See also

Diurnal anisotropic heating

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Alpha Max (Degree) [number] <put parameter description here>

Default: 202.5

Outputs

Diurnal Anisotropic Heating [raster] <put output description here>

Console usage

processing.runalg(’saga:diurnalanisotropicheating’, dem, alpha_max, dah)

See also

Downslope distance gradient

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Vertical Distance [number] <put parameter description here>

Default: 10

Output [selection] <put parameter description here>

Options:

• 0 — [0] distance

• 1 — [1] gradient (tangens)

• 2 — [2] gradient (degree)

Default: 0

Outputs

Gradient [raster] <put output description here>

Gradient Difference [raster] <put output description here>

Console usage

processing.runalg(’saga:downslopedistancegradient’, dem, distance, output, gradient, difference)
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See also

Effective air flow heights

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Wind Direction [raster] Optional.

<put parameter description here>

Wind Speed [raster] Optional.

<put parameter description here>

Constant Wind Direction [Degree] [number] <put parameter description here>

Default: 135

Old Version [boolean] <put parameter description here>

Default: True

Search Distance [km] [number] <put parameter description here>

Default: 300

Acceleration [number] <put parameter description here>

Default: 1.5

Use Pyramids with New Version [boolean] <put parameter description here>

Default: True

Lee Factor [number] <put parameter description here>

Default: 0.5

Luv Factor [number] <put parameter description here>

Default: 1.0

Wind Direction Units [selection] <put parameter description here>

Options:

• 0 — [0] radians

• 1 — [1] degree

Default: 0

Wind Speed Scale Factor [number] <put parameter description here>

Default: 1.0

Outputs

Effective Air Flow Heights [raster] <put output description here>
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Console usage

processing.runalg(’saga:effectiveairflowheights’, dem, dir, len, dir_const, oldver, maxdist, accel, pyramids, leefact, luvfact, dir_units, len_scale, afh)

See also

Hypsometry

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Number of Classes [number] <put parameter description here>

Default: 100.0

Sort [selection] <put parameter description here>

Options:

• 0 — [0] up

• 1 — [1] down

Default: 0

Classification Constant [selection] <put parameter description here>

Options:

• 0 — [0] height

• 1 — [1] area

Default: 0

Use Z-Range [boolean] <put parameter description here>

Default: True

Z-Range Min [number] <put parameter description here>

Default: 0.0

Z-Range Max [number] <put parameter description here>

Default: 1000.0

Outputs

Hypsometry [table] <put output description here>

Console usage

processing.runalg(’saga:hypsometry’, elevation, count, sorting, method, bzrange, zrange_min, zrange_max, table)
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See also

Land surface temperature

Description

<put algortithm description here>

Parameters

Elevation [m] [raster] <put parameter description here>

Short Wave Radiation [kW/m2] [raster] <put parameter description here>

Leaf Area Index [raster] <put parameter description here>

Elevation at Reference Station [m] [number] <put parameter description here>

Default: 0.0

Temperature at Reference Station [Deg.Celsius] [number] <put parameter description
here>

Default: 0.0

Temperature Gradient [Deg.Celsius/km] [number] <put parameter description here>

Default: 6.5

C Factor [number] <put parameter description here>

Default: 1.0

Outputs

Land Surface Temperature [Deg.Celsius] [raster] <put output description here>

Console usage

processing.runalg(’saga:landsurfacetemperature’, dem, swr, lai, z_reference, t_reference, t_gradient, c_factor, lst)

See also

Mass balance index

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Vertical Distance to Channel Network [raster] Optional.

<put parameter description here>
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T Slope [number] <put parameter description here>

Default: 15.0

T Curvature [number] <put parameter description here>

Default: 0.01

T Vertical Distance to Channel Network [number] <put parameter description here>

Default: 15.0

Outputs

Mass Balance Index [raster] <put output description here>

Console usage

processing.runalg(’saga:massbalanceindex’, dem, hrel, tslope, tcurve, threl, mbi)

See also

Morphometric protection index

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Radius [number] <put parameter description here>

Default: 2000.0

Outputs

Protection Index [raster] <put output description here>

Console usage

processing.runalg(’saga:morphometricprotectionindex’, dem, radius, protection)

See also

Multiresolution index of valley bottom flatness (mrvbf)

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Initial Threshold for Slope [number] <put parameter description here>

Default: 16

Threshold for Elevation Percentile (Lowness) [number] <put parameter description here>

Default: 0.4

Threshold for Elevation Percentile (Upness) [number] <put parameter description here>

Default: 0.35

Shape Parameter for Slope [number] <put parameter description here>

Default: 4.0

Shape Parameter for Elevation Percentile [number] <put parameter description here>

Default: 3.0

Update Views [boolean] <put parameter description here>

Default: True

Classify [boolean] <put parameter description here>

Default: True

Maximum Resolution (Percentage) [number] <put parameter description here>

Default: 100

Outputs

MRVBF [raster] <put output description here>

MRRTF [raster] <put output description here>

Console usage

processing.runalg(’saga:multiresolutionindexofvalleybottomflatnessmrvbf’, dem, t_slope, t_pctl_v, t_pctl_r, p_slope, p_pctl, update, classify, max_res, mrvbf, mrrtf)

See also

Real area calculation

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Outputs

Real Area Grid [raster] <put output description here>
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Console usage

processing.runalg(’saga:realareacalculation’, dem, area)

See also

Relative heights and slope positions

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

w [number] <put parameter description here>

Default: 0.5

t [number] <put parameter description here>

Default: 10.0

e [number] <put parameter description here>

Default: 2.0

Outputs

Slope Height [raster] <put output description here>

Valley Depth [raster] <put output description here>

Normalized Height [raster] <put output description here>

Standardized Height [raster] <put output description here>

Mid-Slope Positon [raster] <put output description here>

Console usage

processing.runalg(’saga:relativeheightsandslopepositions’, dem, w, t, e, ho, hu, nh, sh, ms)

See also

Slope, aspect, curvature

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Maximum Slope (Travis et al. 1975)

• 1 — [1] Maximum Triangle Slope (Tarboton 1997)

• 2 — [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)

• 3 — [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)

• 4 — [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)

• 5 — [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)

• 6 — [6] Fit 3.Degree Polynom (Haralick 1983)

Default: 5

Outputs

Slope [raster] <put output description here>

Aspect [raster] <put output description here>

Curvature [raster] <put output description here>

Plan Curvature [raster] <put output description here>

Profile Curvature [raster] <put output description here>

Console usage

processing.runalg(’saga:slopeaspectcurvature’, elevation, method, slope, aspect, curv, hcurv, vcurv)

See also

Surface specific points

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Method [selection] <put parameter description here>

Options:

• 0 — [0] Mark Highest Neighbour

• 1 — [1] Opposite Neighbours

• 2 — [2] Flow Direction

• 3 — [3] Flow Direction (up and down)
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• 4 — [4] Peucker & Douglas

Default: 0

Threshold [number] <put parameter description here>

Default: 2.0

Outputs

Result [raster] <put output description here>

Console usage

processing.runalg(’saga:surfacespecificpoints’, elevation, method, threshold, result)

See also

Terrain ruggedness index (tri)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Radius (Cells) [number] <put parameter description here>

Default: 1

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1.0

Outputs

Terrain Ruggedness Index (TRI) [raster] <put output description here>
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Console usage

processing.runalg(’saga:terrainruggednessindextri’, dem, radius, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, tri)

See also

Topographic position index (tpi)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Standardize [boolean] <put parameter description here>

Default: True

Min Radius [number] <put parameter description here>

Default: 0.0

Max Radius [number] <put parameter description here>

Default: 100.0

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 75.0

Outputs

Topographic Position Index [raster] <put output description here>

Console usage

processing.runalg(’saga:topographicpositionindextpi’, dem, standard, radius_min, radius_max, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, tpi)
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See also

Tpi based landform classification

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Min Radius A [number] <put parameter description here>

Default: 0

Max Radius A [number] <put parameter description here>

Default: 100

Min Radius B [number] <put parameter description here>

Default: 0

Max Radius B [number] <put parameter description here>

Default: 1000

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 75.0

Outputs

Landforms [raster] <put output description here>

Console usage

processing.runalg(’saga:tpibasedlandformclassification’, dem, radius_a_min, radius_a_max, radius_b_min, radius_b_max, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, landforms)
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See also

Vector ruggedness measure (vrm)

Description

<put algortithm description here>

Parameters

Elevation [raster] <put parameter description here>

Radius (Cells) [number] <put parameter description here>

Default: 1

Distance Weighting [selection] <put parameter description here>

Options:

• 0 — [0] no distance weighting

• 1 — [1] inverse distance to a power

• 2 — [2] exponential

• 3 — [3] gaussian weighting

Default: 0

Inverse Distance Weighting Power [number] <put parameter description here>

Default: 1

Inverse Distance Offset [boolean] <put parameter description here>

Default: True

Gaussian and Exponential Weighting Bandwidth [number] <put parameter description here>

Default: 1

Outputs

Vector Terrain Ruggedness (VRM) [raster] <put output description here>

Console usage

processing.runalg(’saga:vectorruggednessmeasurevrm’, dem, radius, distance_weighting_weighting, distance_weighting_idw_power, distance_weighting_idw_offset, distance_weighting_bandwidth, vrm)

See also

Wind effect

Description

<put algortithm description here>
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Parameters

Elevation [raster] <put parameter description here>

Wind Direction [raster] Optional.

<put parameter description here>

Wind Speed [raster] Optional.

<put parameter description here>

Constant Wind Direction [Degree] [number] <put parameter description here>

Default: 135

Old Version [boolean] <put parameter description here>

Default: True

Search Distance [km] [number] <put parameter description here>

Default: 300.0

Acceleration [number] <put parameter description here>

Default: 1.5

Use Pyramids [boolean] <put parameter description here>

Default: True

Wind Direction Units [selection] <put parameter description here>

Options:

• 0 — [0] radians

• 1 — [1] degree

Default: 0

Wind Speed Scale Factor [number] <put parameter description here>

Default: 1.0

Outputs

Wind Effect [raster] <put output description here>

Windward Effect [raster] <put output description here>

Leeward Effect [raster] <put output description here>

Console usage

processing.runalg(’saga:windeffect’, dem, dir, len, dir_const, oldver, maxdist, accel, pyramids, dir_units, len_scale, effect, luv, lee)

See also

.
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18.7.28 Terrain profiles

Cross profiles

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Lines [vector: line] <put parameter description here>

Profile Distance [number] <put parameter description here>

Default: 10.0

Profile Length [number] <put parameter description here>

Default: 10.0

Profile Samples [number] <put parameter description here>

Default: 10.0

Outputs

Cross Profiles [vector] <put output description here>

Console usage

processing.runalg(’saga:crossprofiles’, dem, lines, dist_line, dist_profile, num_profile, profiles)

See also

Profile from points table

Description

<put algortithm description here>

Parameters

Grid [raster] <put parameter description here>

Input [table] <put parameter description here>

X [tablefield: any] <put parameter description here>

Y [tablefield: any] <put parameter description here>

Outputs

Result [table] <put output description here>
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Console usage

processing.runalg(’saga:profilefrompointstable’, grid, table, x, y, result)

See also

Profiles from lines

Description

<put algortithm description here>

Parameters

DEM [raster] <put parameter description here>

Values [multipleinput: rasters] Optional.

<put parameter description here>

Lines [vector: line] <put parameter description here>

Name [tablefield: any] <put parameter description here>

Each Line as new Profile [boolean] <put parameter description here>

Default: True

Outputs

Profiles [vector] <put output description here>

Profiles [vector] <put output description here>

Console usage

processing.runalg(’saga:profilesfromlines’, dem, values, lines, name, split, profile, profiles)

See also

.

18.8 TauDEM algorithm provider

TauDEM (Terrain Analysis Using Digital Elevation Models) is a set of Digital Elevation Model (DEM) tools
for the extraction and analysis of hydrologic information from topography as represented by a DEM. This is
software developed at Utah State University (USU) for hydrologic digital elevation model analysis and watershed
delineation.

TauDEM is distributed as a set of standalone command line executable programs for a Windows and source code
for compiling and use on other systems.

Informacja: Please remember that Processing contains only the interface description, so you need to install
TauDEM 5.0.6 by yourself and configure Processing properly.
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Documentation for TauDEM algorithms derived from official TauDEM documentation

.

18.8.1 Basic Grid Analysis

D8 Contributing Area

Description

Calculates a grid of contributing areas using the single direction D8 flow model. The contribution of each grid cell
is taken as one (or when the optional weight grid is used, the value from the weight grid). The contributing area
for each grid cell is taken as its own contribution plus the contribution from upslope neighbors that drain in to it
according to the D8 flow model.

If the optional outlet point shapefile is used, only the outlet cells and the cells upslope (by the D8 flow model) of
them are in the domain to be evaluated.

By default, the tool checks for edge contamination. This is defined as the possibility that a contributing area value
may be underestimated due to grid cells outside of the domain not being counted. This occurs when drainage
is inwards from the boundaries or areas with “no data” values for elevation. The algorithm recognizes this and
reports “no data” for the contributing area. It is common to see streaks of “no data” values extending inwards
from boundaries along flow paths that enter the domain at a boundary. This is the desired effect and indicates that
contributing area for these grid cells is unknown due to it being dependent on terrain outside of the domain of data
available. Edge contamination checking may be turned off in cases where you know this is not an issue or want to
ignore these problems, if for example, the DEM has been clipped along a watershed outline.

Parameters

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.

Outlets Shapefile [vector: point] Optional.

A point shapefile defining the outlets of interest. If this input file is used, only the cells upslope of these
outlet cells are considered to be within the domain being evaluated.

Weight Grid [raster] Optional.

A grid giving contribution to flow for each cell. These contributions (also sometimes referred to as weights
or loadings) are used in the contributing area accumulation. If this input file is not used, the contribution to
flow will assumed to be one for each grid cell.

Check for edge contamination [boolean] A flag that indicates whether the tool should check for edge
contamination. Edge contamination is defined as the possibility that a contributing area value may be
underestimated due to the fact that grid cells outside of the domain have not been evaluated. This occurs
when drainage is inwards from the boundaries or areas with NODATA values for elevation. The algorithm
recognizes this and reports NODATA for the impated cells. It is common to see streaks of NODATA values
extending inwards from boundaries along flow paths that enter the domain at a boundary. This is the desired
effect and indicates that contributing area for these grid cells is unknown due to it being dependent on terrain
outside of the domain of available data. Edge contamination checking may be turned off in cases where you
know this is not an issue, or want to ignore these problems, if for example, the DEM has been clipped along
a watershed outline.

Default: True
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Outputs

D8 Contributing Area Grid [raster] A grid of contributing area values calculated as the cells own con-
tribution plus the contribution from upslope neighbors that drain in to it according to the D8 flow model.

Console usage

processing.runalg(’taudem:d8contributingarea’, -p, -o, -wg, -nc, -ad8)

See also

D8 Flow Directions

Description

Creates 2 grids. The first contains the flow direction from each grid cell to one of its adjacent or diagonal neighbors,
calculated using the direction of steepest descent. The second contain the slope, as evaluated in the direction of
steepest descent, and is reported as drop/distance, i.e. tan of the angle. Flow direction is reported as NODATA for
any grid cell adjacent to the edge of the DEM domain, or adjacent to a NODATA value in the DEM. In flat areas,
flow directions are assigned away from higher ground and towards lower ground using the method of Garbrecht
and Martz (1997). The D8 flow direction algorithm may be applied to a DEM that has not had its pits filled, but it
will then result in NODATA values for flow direction and slope at the lowest point of each pit.

D8 Flow Direction Coding:

• 1 — East

• 2 — Northeast

• 3 — North

• 4 — Northwest

• 5 — West

• 6 — Southwest

• 7 — South

• 8 — Southeast

The flow direction routing across flat areas is performed according to the method described by Garbrecht, J. and L.
W. Martz, (1997), “The Assignment of Drainage Direction Over Flat Surfaces in Raster Digital Elevation Models”,
Journal of Hydrology, 193: 204-213.

Parameters

Pit Filled Elevation Grid [raster] A grid of elevation values. This is usually the output of the “Pit
Remove” tool, in which case it is elevations with pits removed. Pits are low elevation areas in digital
elevation models (DEMs) that are completely surrounded by higher terrain. They are generally taken to
be artifacts of the digitation process that interfere with the processing of flow across DEMs. So they are
removed by raising their elevation to the point where they just drain off the domain. This step is not essential
if you have reason to believe that the pits in your DEM are real. If a few pits actually exist and so should not
be removed, while at the same time others are believed to be artifacts that need to be removed, the actual
pits should have NODATA elevation values inserted at their lowest point. NODATA values serve to define
edges of the domain in the flow field, and elevations are only raised to where flow is off an edge, so an
internal NODATA value will stop a pit from being removed, if necessary.
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Outputs

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope.

D8 Slope Grid [raster] A grid giving slope in the D8 flow direction. This is measured as drop/distance.

Console usage

processing.runalg(’taudem:d8flowdirections’, -fel, -p, -sd8)

See also

D-Infinity Contributing Area

Description

Calculates a grid of specific catchment area which is the contributing area per unit contour length using the
multiple flow direction D-infinity approach. D-infinity flow direction is defined as steepest downward slope on
planar triangular facets on a block centered grid. The contribution at each grid cell is taken as the grid cell length
(or when the optional weight grid input is used, from the weight grid). The contributing area of each grid cell is
then taken as its own contribution plus the contribution from upslope neighbors that have some fraction draining
to it according to the D-infinity flow model. The flow from each cell either all drains to one neighbor, if the angle
falls along a cardinal (0, 𝜋/2, 𝜋, 3𝜋/2) or ordinal (𝜋/4, 3𝜋/4, 5𝜋/4, 7𝜋/4) direction, or is on an angle falling between
the direct angle to two adjacent neighbors. In the latter case the flow is proportioned between these two neighbor
cells according to how close the flow direction angle is to the direct angle to those cells. The contour length used
here is the grid cell size. The resulting units of the specific catchment area are length units the same as those of
the grid cell size.

When the optional weight grid is not used, the result is reported in terms of specific catchment area, the upslope
area per unit contour length, taken here as the number of cells times grid cell length (cell area divided by cell
length). This assumes that grid cell length is the effective contour length, in the definition of specific catchment
area and does not distinguish any difference in contour length dependent upon the flow direction. When the
optional weight grid is used, the result is reported directly as a summation of weights, without any scaling.

If the optional outlet point shapefile is used, only the outlet cells and the cells upslope (by the D-infinity flow
model) of them are in the domain to be evaluated.

By default, the tool checks for edge contamination. This is defined as the possibility that a contributing area value
may be underestimated due to grid cells outside of the domain not being counted. This occurs when drainage
is inwards from the boundaries or areas with “no data” values for elevation. The algorithm recognizes this and
reports “no data” for the contributing area. It is common to see streaks of “no data” values extending inwards
from boundaries along flow paths that enter the domain at a boundary. This is the desired effect and indicates that
contributing area for these grid cells is unknown due to it being dependent on terrain outside of the domain of data
available. Edge contamination checking may be turned off in cases where you know it is not an issue or want to
ignore these problems, if for example, the DEM has been clipped along a watershed outline.

Parameters

D-Infinity Flow Direction Grid [raster] A grid of flow directions based on the D-infinity flow
method using the steepest slope of a triangular facet. Flow direction is determined as the direction of
the steepest downward slope on the 8 triangular facets of a 3x3 block centered grid. Flow direction is en-
coded as an angle in radians, counter-clockwise from east as a continuous (floating point) quantity between
0 and 2𝜋. The resulting flow in a grid is then usually interpreted as being proportioned between the two
neighboring cells that define the triangular facet with the steepest downward slope.
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Outlets Shapefile [vector: point] Optional.

A point shapefile defining the outlets of interest. If this input file is used, only the cells upslope of these
outlet cells are considered to be within the domain being evaluated.

Weight Grid [raster] Optional.

A grid giving contribution to flow for each cell. These contributions (also sometimes referred to as weights
or loadings) are used in the contributing area accumulation. If this input file is not used, the result is reported
in terms of specific catchment area (the upslope area per unit contour length) taken as the number of cells
times grid cell length (cell area divided by cell length).

Check for edge contamination [boolean] A flag that indicates whether the tool should check for edge
contamination. Edge contamination is defined as the possibility that a contributing area value may be
underestimated due to the fact that grid cells outside of the domain have not been evaluated. This occurs
when drainage is inwards from the boundaries or areas with NODATA values for elevation. The algorithm
recognizes this and reports NODATA for the impated cells. It is common to see streaks of NODATA values
extending inwards from boundaries along flow paths that enter the domain at a boundary. This is the desired
effect and indicates that contributing area for these grid cells is unknown due to it being dependent on terrain
outside of the domain of available data. Edge contamination checking may be turned off in cases where you
know this is not an issue, or want to ignore these problems, if for example, the DEM has been clipped along
a watershed outline.

Default: True

Outputs

D-Infinity Specific Catchment Area Grid [raster] A grid of specific catchment area which is the
contributing area per unit contour length using the multiple flow direction D-infinity approach. The con-
tributing area of each grid cell is then taken as its own contribution plus the contribution from upslope
neighbors that have some fraction draining to it according to the D-infinity flow model.

Console usage

processing.runalg(’taudem:dinfinitycontributingarea’, -ang, -o, -wg, -nc, -sca)

See also

D-Infinity Flow Directions

Description

Assigns a flow direction based on the D-infinity flow method using the steepest slope of a triangular facet (Tar-
boton, 1997, “A New Method for the Determination of Flow Directions and Contributing Areas in Grid Digital
Elevation Models”, Water Resources Research, 33(2): 309-319). Flow direction is defined as steepest down-
ward slope on planar triangular facets on a block centered grid. Flow direction is encoded as an angle in radians
counter-clockwise from east as a continuous (floating point) quantity between 0 and 2𝜋. The flow direction angle
is determined as the direction of the steepest downward slope on the eight triangular facets formed in a 3 x 3 grid
cell window centered on the grid cell of interest. The resulting flow in a grid is then usually interpreted as being
proportioned between the two neighboring cells that define the triangular facet with the steepest downward slope.

A block-centered representation is used with each elevation value taken to represent the elevation of the center
of the corresponding grid cell. Eight planar triangular facets are formed between each grid cell and its eight
neighbors. Each of these has a downslope vector which when drawn outwards from the center may be at an angle
that lies within or outside the 45 degree (𝜋/4 radian) angle range of the facet at the center point. If the slope vector
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angle is within the facet angle, it represents the steepest flow direction on that facet. If the slope vector angle is
outside a facet, the steepest flow direction associated with that facet is taken along the steepest edge. The slope
and flow direction associated with the grid cell is taken as the magnitude and direction of the steepest downslope
vector from all eight facets. Slope is measured as drop/distance, i.e. tan of the slope angle.

In the case where no slope vectors are positive (downslope), the flow direction is set using the method of Garbrecht
and Martz (1997) for the determination of flow across flat areas. This makes flat areas drain away from high ground
and towards low ground. The flow path grid to enforce drainage along existing streams is an optional input, and if
used, takes precedence over elevations for the setting of flow directions.

The D-infinity flow direction algorithm may be applied to a DEM that has not had its pits filled, but it will then
result in “no data” values for the D-infinity flow direction and slope associated with the lowest point of the pit.

Parameters

Pit Filled Elevation Grid [raster] A grid of elevation values. This is usually the output of the “Pit
Remove” tool, in which case it is elevations with pits removed.

Outputs

D-Infinity Flow Directions Grid [raster] A grid of flow directions based on the D-infinity flow
method using the steepest slope of a triangular facet. Flow direction is determined as the direction of
the steepest downward slope on the 8 triangular facets of a 3x3 block centered grid. Flow direction is en-
coded as an angle in radians, counter-clockwise from east as a continuous (floating point) quantity between
0 and 2𝜋. The resulting flow in a grid is then usually interpreted as being proportioned between the two
neighboring cells that define the triangular facet with the steepest downward slope.

D-Infinity Slope Grid [raster] A grid of slope evaluated using the D-infinity method described in Tar-
boton, D. G., (1997), “A New Method for the Determination of Flow Directions and Contributing Areas in
Grid Digital Elevation Models”, Water Resources Research, 33(2): 309-319. This is the steepest outwards
slope on one of eight triangular facets centered at each grid cell, measured as drop/distance, i.e. tan of the
slope angle.

Console usage

processing.runalg(’taudem:dinfinityflowdirections’, -fel, -ang, -slp)

See also

Grid Network

Description

Creates 3 grids that contain for each grid cell: 1) the longest path, 2) the total path, and 3) the Strahler order
number. These values are derived from the network defined by the D8 flow model.

The longest upslope length is the length of the flow path from the furthest cell that drains to each cell. The total
upslope path length is the length of the entire grid network upslope of each grid cell. Lengths are measured
between cell centers taking into account cell size and whether the direction is adjacent or diagonal.

Strahler order is defined as follows: A network of flow paths is defined by the D8 Flow Direction grid. Source
flow paths have a Strahler order number of one. When two flow paths of different order join the order of the
downstream flow path is the order of the highest incoming flow path. When two flow paths of equal order join
the downstream flow path order is increased by 1. When more than two flow paths join the downstream flow path
order is calculated as the maximum of the highest incoming flow path order or the second highest incoming flow
path order + 1. This generalizes the common definition to cases where more than two flow paths join at a point.
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Where the optional mask grid and threshold value are input, the function is evaluated only considering grid cells
that lie in the domain with mask grid value greater than or equal to the threshold value. Source (first order) grid
cells are taken as those that do not have any other grid cells from inside the domain draining in to them, and
only when two of these flow paths join is order propagated according to the ordering rules. Lengths are also only
evaluated counting paths within the domain greater than or equal to the threshold.

If the optional outlet point shapefile is used, only the outlet cells and the cells upslope (by the D8 flow model) of
them are in the domain to be evaluated.

Parameters

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.

Outlets Shapefile [vector: point] Optional.

A point shapefile defining the outlets of interest. If this input file is used, only the cells upslope of these
outlet cells are considered to be within the domain being evaluated.

Mask Grid [raster] Optional.

A grid that is used to determine the domain do be analyzed. If the mask grid value >= mask threshold (see
below), then the cell will be included in the domain. While this tool does not have an edge contamination
flag, if edge contamination analysis is needed, then a mask grid from a function like “D8 Contributing
Area” that does support edge contamination can be used to achieve the same result.

Mask Threshold [number] This input parameter is used in the calculation mask grid value >= mask threshold
to determine if the grid cell is in the domain to be analyzed.

Default: 100

Outputs

Longest Upslope Length Grid [raster] A grid that gives the length of the longest upslope D8 flow path
terminating at each grid cell. Lengths are measured between cell centers taking into account cell size and
whether the direction is adjacent or diagonal.

Total Upslope Length Grid [raster] The total upslope path length is the length of the entire D8 flow
grid network upslope of each grid cell. Lengths are measured between cell centers taking into account cell
size and whether the direction is adjacent or diagonal.

Strahler Network Order Grid [raster] A grid giving the Strahler order number for each cell. A net-
work of flow paths is defined by the D8 Flow Direction grid. Source flow paths have a Strahler order number
of one. When two flow paths of different order join the order of the downstream flow path is the order of
the highest incoming flow path. When two flow paths of equal order join the downstream flow path order
is increased by 1. When more than two flow paths join the downstream flow path order is calculated as the
maximum of the highest incoming flow path order or the second highest incoming flow path order + 1. This
generalizes the common definition to cases where more than two flow paths join at a point.

Console usage

processing.runalg(’taudem:gridnetwork’, d8_flow_dir_grid, outlets_shape, mask_grid, threshold, longest_len_grid, total_len_grid, strahler_grid)
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See also

Pit Remove

Description

Identifies all pits in the DEM and raises their elevation to the level of the lowest pour point around their edge. Pits
are low elevation areas in digital elevation models (DEMs) that are completely surrounded by higher terrain. They
are generally taken to be artifacts that interfere with the routing of flow across DEMs, so are removed by raising
their elevation to the point where they drain off the edge of the domain. The pour point is the lowest point on the
boundary of the “watershed” draining to the pit. This step is not essential if you have reason to believe that the
pits in your DEM are real. If a few pits actually exist and so should not be removed, while at the same time others
are believed to be artifacts that need to be removed, the actual pits should have NODATA elevation values inserted
at their lowest point. NODATA values serve to define edges in the domain, and elevations are only raised to where
flow is off an edge, so an internal NODATA value will stop a pit from being removed, if necessary.

Parameters

Elevation Grid [raster] A digital elevation model (DEM) grid to serve as the base input for the terrain
analysis and stream delineation.

Outputs

Pit Removed Elevation Grid [raster] A grid of elevation values with pits removed so that flow is routed
off of the domain.

Console usage

processing.runalg(’taudem:pitremove’, -z, -fel)

See also

.

18.8.2 Specialized Grid Analysis

D8 Distance To Streams

Description

Computes the horizontal distance to stream for each grid cell, moving downslope according to the D8 flow model,
until a stream grid cell is encountered.

Parameters

D8 Flow Direction Grid [raster] This input is a grid of flow directions that are encoded using the D8
method where all flow from a cells goes to a single neighboring cell in the direction of steepest descent.
This grid can be obtained as the output of the “D8 Flow Directions” tool.
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Stream Raster Grid [raster] A grid indicating streams. Such a grid can be created by several of the tools
in the “Stream Network Analysis” toolset. However, the tools in the “Stream Network Analysis” toolset
only create grids with a value of 0 for no stream, or 1 for stream cells. This tool can also accept grids
with values greater than 1, which can be used in conjunction with the Threshold parameter to determine
the location of streams. This allows Contributing Area grids to be used to define streams as well as the
normal Stream Raster grids. This grid expects integer (long integer) values and any non-integer values will
be truncated to an integer before being evaluated.

Threshold [number] This value acts as threshold on the Stream Raster Grid to determine the location
of streams. Cells with a Stream Raster Grid value greater than or equal to the Threshold value
are interpreted as streams.

Default: 50

Outputs

Output Distance to Streams [raster] A grid giving the horizontal distance along the flow path as de-
fined by the D8 Flow Directions Grid to the streams in the Stream Raster Grid.

Console usage

processing.runalg(’taudem:d8distancetostreams’, -p, -src, -thresh, -dist)

See also

D-Infinity Avalanche Runout

Description

Identifies an avalanche’s affected area and the flow path length to each cell in that affacted area. All cells downs-
lope from each source area cell, up to the point where the slope from the source to the affected area is less than
a threshold angle called the Alpha Angle can be in the affected area. This tool uses the D-infinity multiple flow
direction method for determining flow direction. This will likely cause very small amounts of flow to be dispersed
to some downslope cells that might overstate the affected area, so a threshold proportion can be set to avoid this
excess dispersion. The flow path length is the distance from the cell in question to the source cell that has the
highest angle.

All points downslope from the source area are potentially in the affected area, but not beyond a point where the
slope from the source to the affected area is less than a threshold angle called the Alpha Angle.

Slope is to be measured using the straight line distance from source point to evaluation point.

It makes more physical sense to me for the angle to be measured along the flow path. Nevertheless it is equally easy
to code straight line angles as angles along the flow path, so an option that allows switching will be provided. The
most practical way to evaluate avalanche runout is to keep track of the source point with the greatest angle to each
point. Then the recursive upslope flow algebra approach will look at a grid cell and all its upslope neighbors that
flow to it. Information from the upslope neighbors will be used to calculate the angle to the grid cell in question
and retain it in the runout zone if the angle exceeds the alpha angle. This procedure makes the assumption that the
maximum angle at a grid cell will be from the set of cells that have maximum angles to the inflowing neighbors.
This will always be true of angle is calculated along a flow path, but I can conceive of cases where flow paths bend
back on themselves where this would not be the case for straight line angles.

The D-infinity multiple flow direction field assigns flow from each grid cell to multiple downslope neighbors using
proportions (Pik) that vary between 0 and 1 and sum to 1 for all flows out of a grid cell. It may be desirable to
specify a threshold T that this proportion has to exceed before a grid cell is counted as flowing to a downslope
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grid cell, e.g. Pik > T (=0.2 say) to avoid dispersion to grid cells that get very little flow. T will be specified as
a user input. If all upslope grid cells are to be used T may be input as 0.

Avalanche source sites are to be input as a short integer grid (name suffix *ass, e.g. demass) comprised of
positive values where avalanches may be triggered and 0 values elsewhere.

The following grids are output:

• rz — A runout zone indicator with value 0 to indicate that this grid cell is not in the runout zone and value
> 0 to indicate that this grid cell is in the runout zone. Since there may be information in the angle to the
associated source site, this variable will be assigned the angle to the source site (in degrees)

• dm — Along flow distance from the source site that has the highest angle to the point in question

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.

Pit Filled Elevation Grid [raster] This input is a grid of elevation values. As a general rule, it is
recommended that you use a grid of elevation values that have had the pits removed for this input. Pits are
generally taken to be artifacts that interfere with the analysis of flow across them. This grid can be obtained
as the output of the “Pit Remove” tool, in which case it contains elevation values where the pits have been
filled to the point where they just drain.

Avalanche Source Site Grid [raster] This is a grid of source areas for snow avalanches that are com-
monly identified manually using a mix of experience and visual interpretation of maps. Avalanche source
sites are to be input as a short integer grid (name suffix *ass, e.g. demass) comprised of positive values
where avalanches may be triggered and 0 values elsewhere.

Proportion Threshold [number] This value is a threshold proportion that is used to limit the disperson
of flow caused by using the D-infinity multiple flow direction method for determining flow direction. The
D-infinity multiple flow direction method often causes very small amounts of flow to be dispersed to some
downslope cells that might overstate the affected area, so a threshold proportion can be set to avoid this
excess dispersion.

Default: 0.2

Alpha Angle Threshold [number] This value is the threshold angle, called the Alpha Angle, that is used
to determine which of the cells downslope from the source cells are in the affected area. Only the cells
downslope from each source area cell, up to the point where the slope from the source to the affected area
is less than a threshold angle are in the affected area.

Default: 18

Measure distance along flow path [boolean] This option selects the method used to measure the
distance used to calculate the slope angle. If option is True then measure it along the flow path, where
the False option causes the slope to be measure along the straight line distance from the source cell to the
evaluation cell.

Default: True

Outputs

Runout Zone Grid [raster] This grid Identifies the avalanche’s runout zone (affected area) using a runout
zone indicator with value 0 to indicate that this grid cell is not in the runout zone and value > 0 to indicate
that this grid cell is in the runout zone. Since there may be information in the angle to the associated source
site, this variable will be assigned the angle to the source site (in degrees).

Path Distance Grid [raster] This is a grid of the flow distance from the source site that has the highest
angle to each cell.
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Console usage

processing.runalg(’taudem:dinfinityavalancherunout’, -ang, -fel, -ass, -thresh, -alpha, -direct, -rz, -dfs)

See also

D-Infinity Concentration Limited Accumulation

Description

This function applies to the situation where an unlimited supply of a substance is loaded into flow at a concentra-
tion or solubility threshold Csol over a region indicated by an indicator grid (dg). It a grid of the concentration of
a substance at each location in the domain, where the supply of substance from a supply area is loaded into the
flow at a concentration or solubility threshold. The flow is first calculated as a D-infinity weighted contributing
area of an input Effective Runoff Weight Grid (notionally excess precipitation). The concentation of substance
over the supply area (indicator grid) is at the concentration threshold. As the substance moves downslope with the
D-infinity flow field, it is subject to first order decay in moving from cell to cell as well as dilution due to changes
in flow. The decay multiplier grid gives the fractional (first order) reduction in quantity in moving from grid cell
x to the next downslope cell. If the outlets shapefile is used, the tool only evaluates the part of the domain that
contributes flow to the locations given by the shapefile. This is useful for a tracking a contaminant or compound
from an area with unlimited supply of that compound that is loaded into a flow at a concentration or solubility
threshold over a zone and flow from the zone may be subject to decay or attenuation.

The indicator grid (dg) is used to delineate the area of the substance supply using the (0, 1) indicator function
i(x). A[] denotes the weighted accumulation operator evaluated using the D-Infinity Contributing Area func-
tion. The Effective Runoff Weight Grid gives the supply to the flow (e.g. the excess rainfall if this is overland
flow) denoted as w(x). The specific discharge is then given by:

Q(x)=A[w(x)]

This weighted accumulation Q(x) is output as the Overland Flow Specific Discharge Grid. Over the substance
supply area concentration is at the threshold (the threshold is a saturation or solubility limit). If i(x) = 1, then

C(x) = Csol, and L(x) = Csol Q(x),

where L(x) denotes the load being carried by the flow. At remaining locations, the load is determined by load
accumulation and the concentration by dilution:

Here d(x) = d(i, j) is a decay multiplier giving the fractional (first order) reduction in mass in moving
from grid cell x to the next downslope cell. If travel (or residence) times t(x) associated with flow between
cells are available d(x) may be evaluated as exp(-k t(x)) where k is a first order decay parameter. The
Concentration grid output is C(x). If the outlets shapefile is used, the tool only evaluates the part of the domain
that contributes flow to the locations given by the shapefile.

Useful for a tracking a contaminant released or partitioned to flow at a fixed threshold concentration.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This grid can be created by the function
“D-Infinity Flow Directions”.

Disturbance Indicator Grid [raster] A grid that indicates the source zone of the area of substance
supply and must be 1 inside the zone and 0 or NODATA over the rest of the domain.
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Decay Multiplier Grid [raster] A grid giving the factor by which flow leaving each grid cell is multiplied
before accumulation on downslope grid cells. This may be used to simulate the movement of an attenuating
or decaying substance. If travel (or residence) times t(x) associated with flow between cells are available
d(x) may be evaluated as exp(-k t(x)) where k is a first order decay parameter.

Effective Runoff Weight Grid [raster] A grid giving the input quantity (notionally effective runoff or
excess precipitation) to be used in the D-infinity weighted contributing area evaluation of Overland Flow
Specific Discharge.

Outlets shapefile [vector: point] Optional.

This optional input is a point shapefile defining outlets of interest. If this file is used, the tool will only
evaluate the area upslope of these outlets.

Concentration Threshold [number] The concentration or solubility threshold. Over the substance sup-
ply area, concentration is at this threshold.

Default: 1.0

Check for edge contamination [boolean] This option determines whether the tool should check for
edge contamination. Edge contamination is defined as the possibility that a value may be underestimated
due to grid cells outside of the domain not being considered when determining contributing area.

Default: True

Outputs

Concentration Grid [raster] A grid giving the resulting concentration of the compound of interest in the
flow.

Console usage

processing.runalg(’taudem:dinfinityconcentrationlimitedaccumulation’, -ang, -dg, -dm, -q, -o, -csol, -nc, -ctpt)

See also

D-Infinity Decaying Accumulation

Description

The D-Infinity Decaying Accumulation tool creates a grid of the accumulated quantity at each location in the
domain where the quantity accumulates with the D-infinity flow field, but is subject to first order decay in moving
from cell to cell. By default, the quantity contribution of each grid cell is the cell length to give a per unit width
accumulation, but can optionally be expressed with a weight grid. The decay multiplier grid gives the fractional
(first order) reduction in quantity in accumulating from grid cell x to the next downslope cell.

A decayed accumulation operator DA[.] takes as input a mass loading field m(x) expressed at each grid location
as m(i, j) that is assumed to move with the flow field but is subject to first order decay in moving from cell to
cell. The output is the accumulated mass at each location DA(x). The accumulation of m at each grid cell can be
numerically evaluated.

Here d(x) = d(i ,j) is a decay multiplier giving the fractional (first order) reduction in mass in moving from
grid cell x to the next downslope cell. If travel (or residence) times t(x) associated with flow between cells are
available d(x) may be evaluated as exp(-k t(x)) where k is a first order decay parameter. The weight grid
is used to represent the mass loading m(x). If not specified this is taken as 1. If the outlets shapefile is used the
function is only evaluated on that part of the domain that contributes flow to the locations given by the shapefile.
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Useful for a tracking contaminant or compound subject to decay or attenuation.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This grid can be created by the function
“D-Infinity Flow Directions”.

Decay Multiplier Grid [raster] A grid giving the factor by which flow leaving each grid cell is multiplied
before accumulation on downslope grid cells. This may be used to simulate the movement of an attenuating
substance.

Weight Grid [raster] Optional.

A grid giving weights (loadings) to be used in the accumulation. If this optional grid is not specified, weights
are taken as the linear grid cell size to give a per unit width accumulation.

Outlets Shapefile [vector: point] Optional.

This optional input is a point shapefile defining outlets of interest. If this file is used, the tool will only
evaluate ther area upslope of these outlets.

Check for edge contamination [boolean] This option determines whether the tool should check for
edge contamination. Edge contamination is defined as the possibility that a value may be underestimated
due to grid cells outside of the domain not being considered when determining contributing area.

Default: True

Outputs

Decayed Specific Catchment Area Grid [raster] The D-Infinity Decaying Accumulation tool cre-
ates a grid of the accumulated mass at each location in the domain where mass moves with the D-infinity
flow field, but is subject to first order decay in moving from cell to cell.

Console usage

processing.runalg(’taudem:dinfinitydecayingaccumulation’, -ang, -dm, -wg, -o, -nc, -dsca)

See also

D-Infinity Distance Down

Description

Calculates the distance downslope to a stream using the D-infinity flow model. The D-infinity flow model is a
multiple flow direction model, because the outflow from each grid cell is proportioned between up to 2 downslope
grid cells. As such, the distance from any grid cell to a stream is not uniquely defined. Flow that originates at
a particular grid cell may enter the stream at a number of different cells. The statistical method may be selected
as the longest, shortest or weighted average of the flow path distance to the stream. Also one of several ways
of measuring distance may be selected: the total straight line path (Pythagoras), the horizontal component of the
straight line path, the vertical component of the straight line path, or the total surface flow path.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.
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Pit Filled Elevation Grid [raster] This input is a grid of elevation values. As a general rule, it is
recommended that you use a grid of elevation values that have had the pits removed for this input. Pits are
generally taken to be artifacts that interfere with the analysis of flow across them. This grid can be obtained
as the output of the “Pit Remove” tool, in which case it contains elevation values where the pits have been
filled to the point where they just drain.

Stream Raster Grid [raster] A grid indicating streams, by using a grid cell value of 1 on streams and 0 off
streams. This is usually the output of one of the tools in the “Stream Network Analysis” toolset.

Weight Path Grid [raster] Optional.

A grid giving weights (loadings) to be used in the distance calculation. This might be used for example
where only flow distance through a buffer is to be calculated. The weight is then 1 in the buffer and
0 outside it. Alternatively the weight may reflect some sort of cost function for travel over the surface,
perhaps representing travel time or attenuation of a process. If this input file is not used, the loadings will
assumed to be one for each grid cell.

Statistical Method [selection] Statistical method used to calculate the distance down to the stream. In the
D-Infinity flow model, the outflow from each grid cell is proportioned between two downslope grid cells.
Therefore, the distance from any grid cell to a stream is not uniquely defined. Flow that originates at a
particular grid cell may enter the stream at a number of cells. The distance to the stream may be defined as
the longest (maximum), shortest (minimum) or weighted average of the distance down to the stream.

Options:

• 0 — Minimum

• 1 — Maximum

• 2 — Average

Default: 2

Distance Method [selection] Distance method used to calculate the distance down to the stream. One of
several ways of measuring distance may be selected: the total straight line path (Pythagoras), the horizontal
component of the straight line path (horizontal), the vertical component of the straight line path (vertical),
or the total surface flow path (surface).

Options:

• 0 — Pythagoras

• 1 — Horizontal

• 2 — Vertical

• 3 — Surface

Default: 1

Check for edge contamination [boolean] A flag that determines whether the tool should check for
edge contamination. This is defined as the possibility that a value may be underestimated due to grid cells
outside of the domain not being counted. In the context of Distance Down this occurs when part of a flow
path traced downslope from a grid cell leaves the domain without reaching a stream grid cell. With edge
contamination checking selected, the algorithm recognizes this and reports no data for the result. This is the
desired effect and indicates that values for these grid cells is unknown due to it being dependent on terrain
outside of the domain of data available. Edge contamination checking may be overridden in cases where
you know this is not an issue or want to evaluate the distance using only the fraction of flow paths that
terminate at a stream.

Default: True

Outputs

D-Infinity Drop to Stream Grid [raster] Grid containing the distance to stream calculated using the
D-infinity flow model and the statistical and path methods chosen.
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Console usage

processing.runalg(’taudem:dinfinitydistancedown’, dinf_flow_dir_grid, pit_filled_grid, stream_grid, weight_path_grid, stat_method, dist_method, edge_contam, dist_down_grid)

See also

D-Infinity Distance Up

Description

This tool calculates the distance from each grid cell up to the ridge cells along the reverse D-infinity flow directions.
Ridge cells are defined to be grid cells that have no contribution from grid cells further upslope. Given the
convergence of multiple flow paths at any grid cell, any given grid cell can have multiple upslope ridge cells.
There are three statictical methods that this tool can use: maximum distance, minimum distance and waited flow
average over these flow paths. A variant on the above is to consider only grid cells that contribute flow with a
proportion greater than a user specified threshold (t) to be considered as upslope of any given grid cell. Setting
t=0.5 would result in only one flow path from any grid cell and would give the result equivalent to a D8 flow model,
rather than D-infinity flow model, where flow is proportioned between two downslope grid cells. Finally there are
several different optional paths that can be measured: the total straight line path (Pythagoras), the horizontal
component of the straight line path, the vertical component of the straight line path, or the total surface flow path.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.

Pit Filled Elevation Grid [raster] This input is a grid of elevation values. As a general rule, it is
recommended that you use a grid of elevation values that have had the pits removed for this input. Pits are
generally taken to be artifacts that interfere with the analysis of flow across them. This grid can be obtained
as the output of the “Pit Remove” tool, in which case it contains elevation values where the pits have been
filled to the point where they just drain.

Slope Grid [raster] This input is a grid of slope values. This is measured as drop/distance and it is most often
obtained as the output of the “D-Infinity Flow Directions” tool.

Statistical Method [selection] Statistical method used to calculate the distance down to the stream. In the
D-Infinity flow model, the outflow from each grid cell is proportioned between two downslope grid cells.
Therefore, the distance from any grid cell to a stream is not uniquely defined. Flow that originates at a
particular grid cell may enter the stream at a number of cells. The distance to the stream may be defined as
the longest (maximum), shortest (minimum) or weighted average of the distance down to the stream.

Options:

• 0 — Minimum

• 1 — Maximum

• 2 — Average

Default: 2

Distance Method [selection] Distance method used to calculate the distance down to the stream. One of
several ways of measuring distance may be selected: the total straight line path (Pythagoras), the horizontal
component of the straight line path (horizontal), the vertical component of the straight line path (vertical),
or the total surface flow path (surface).

Options:

• 0 — Pythagoras
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• 1 — Horizontal

• 2 — Vertical

• 3 — Surface

Default: 1

Proportion Threshold [number] The proportion threshold parameter where only grid cells that contribute
flow with a proportion greater than this user specified threshold (t) is considered to be upslope of any given
grid cell. Setting t=0.5 would result in only one flow path from any grid cell and would give the result
equivalent to a D8 flow model, rather than D-Infinity flow model, where flow is proportioned between two
downslope grid cells.

Default: 0.5

Check for edge contamination [boolean] A flag that determines whether the tool should check for
edge contamination. This is defined as the possibility that a value may be underestimated due to grid cells
outside of the domain not being counted.

Default: True

Outputs

D-Infinity Distance Up [raster] Grid containing the distances up to the ridge calculated using the D-
Infinity flow model and the statistical and path methods chosen.

Console usage

processing.runalg(’taudem:dinfinitydistanceup’, dinf_flow_dir_grid, pit_filled_grid, slope_grid, stat_method, dist_method, threshold, edge_contam, dist_up_grid)

See also

D-Infinity Reverse Accumulation

Description

This works in a similar way to evaluation of weighted Contributing area, except that the accumulation is by
propagating the weight loadings upslope along the reverse of the flow directions to accumulate the quantity of
weight loading downslope from each grid cell. The function also reports the maximum value of the weight
loading downslope from each grid cell in the Maximum Downslope grid.

This function is designed to evaluate and map the hazard due to activities that may have an effect downslope. The
example is land management activities that increase runoff. Runoff is sometimes a trigger for landslides or debris
flows, so the weight grid here could be taken as a terrain stability map. Then the reverse accumulation provides a
measure of the amount of unstable terrain downslope from each grid cell, as an indicator of the danger of activities
that may increase runoff, even though there may be no potential for any local impact.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.

Weight Grid [raster] A grid giving weights (loadings) to be used in the accumulation.
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Outputs

Reverse Accumulation Grid [raster] The grid giving the result of the “Reverse Accumulation” func-
tion. This works in a similar way to evaluation of weighted Contributing area, except that the accumulation
is by propagating the weight loadings upslope along the reverse of the flow directions to accumulate the
quantity of loading downslope from each grid cell.

Maximum Downslope Grid [raster] The grid giving the maximum of the weight loading grid downslope
from each grid cell.

Console usage

processing.runalg(’taudem:dinfinityreverseaccumulation’, -ang, -wg, -racc, -dmax)

See also

D-Infinity Transport Limited Accumulation - 2

Description

This function is designed to calculate the transport and deposition of a substance (e.g. sediment) that may be
limited by both supply and the capacity of the flow field to transport it. This function accumulates substance flux
(e.g. sediment transport) subject to the rule that transport out of any grid cell is the minimum between supply and
transport capacity, Tcap. The total supply at a grid cell is calculated as the sum of the transport in from upslope
grid cells, Tin, plus the local supply contribution, E (e.g. erosion). This function also outputs deposition, D,
calculated as total supply minus actual transport.

Here E is the supply. Tout at each grid cell becomes Tin for downslope grid cells and is reported as Transport
limited accumulation (tla). D is deposition (tdep). The function provides the option to evaluate concentration
of a compound (contaminant) adhered to the transported substance. This is evaluated as follows:

Where Lin is the total incoming compound loading and Cin and Tin refer to the Concentration and Transport
entering from each upslope grid cell.

If

else

where Cs is the concentration supplied locally and the difference in the second term on the right represents the
additional supply from the local grid cell. Then,

Cout at each grid cell comprises is the concentration grid output from this function.

If the outlets shapefile is used the tool only evaluates that part of the domain that contributes flow to the locations
given by the shapefile.

Transport limited accumulation is useful for modeling erosion and sediment delivery, including the spatial depen-
dence of sediment delivery ratio and contaminant that adheres to sediment.
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Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.

Supply Grid [raster] A grid giving the supply (loading) of material to a transport limited accumulation func-
tion. In the application to erosion, this grid would give the erosion detachment, or sediment supplied at each
grid cell.

Transport Capacity Grid [raster] A grid giving the transport capacity at each grid cell for the transport
limited accumulation function. In the application to erosion this grid would give the transport capacity of
the carrying flow.

Input Concentration Grid [raster] A grid giving the concentration of a compound of interest in the
supply to the transport limited accumulation function. In the application to erosion, this grid would give the
concentration of say phosphorous adhered to the eroded sediment.

Outlets Shapefile [vector: point] Optional.

This optional input is a point shapefile defining outlets of interest. If this file is used, the tool will only
evaluate the area upslope of these outlets.

Check for edge contamination [boolean] This option determines whether the tool should check for
edge contamination. Edge contamination is defined as the possibility that a value may be underestimated
due to grid cells outside of the domain not being considered when determining the result.

Default: True

Outputs

Transport Limited Accumulation Grid [raster] This grid is the weighted accumulation of supply
accumulated respecting the limitations in transport capacity and reports the transport rate calculated by
accumulating the substance flux subject to the rule that the transport out of any grid cell is the minimum of
the total supply (local supply plus transport in) to that grid cell and the transport capacity.

Deposition Grid [raster] A grid giving the deposition resulting from the transport limited accumulation.
This is the residual from the transport in to each grid cell minus the transport capacity out of the grid cell.
The deposition grid is calculated as the transport in + the local supply - the tranport out.

Output Concentration Grid [raster] If an input concentation in supply grid is given, then this grid is
also output and gives the concentration of a compound (contaminant) adhered or bound to the transported
substance (e.g. sediment) is calculated.

Console usage

processing.runalg(’taudem:dinfinitytransportlimitedaccumulation2’, dinf_flow_dir_grid, supply_grid, capacity_grid, in_concentr_grid, outlets_shape, edge_contam, transp_lim_accum_grid, deposition_grid, out_concentr_grid)
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See also

D-Infinity Transport Limited Accumulation

Description

This function is designed to calculate the transport and deposition of a substance (e.g. sediment) that may be
limited by both supply and the capacity of the flow field to transport it. This function accumulates substance flux
(e.g. sediment transport) subject to the rule that transport out of any grid cell is the minimum between supply and
transport capacity, Tcap. The total supply at a grid cell is calculated as the sum of the transport in from upslope
grid cells, Tin, plus the local supply contribution, E (e.g. erosion). This function also outputs deposition, D,
calculated as total supply minus actual transport.

Here E is the supply. Tout at each grid cell becomes Tin for downslope grid cells and is reported as Transport
limited accumulation (tla). D is deposition (tdep). The function provides the option to evaluate concentration
of a compound (contaminant) adhered to the transported substance. This is evaluated as follows:

Where Lin is the total incoming compound loading and Cin and Tin refer to the Concentration and Transport
entering from each upslope grid cell.

If

else

where Cs is the concentration supplied locally and the difference in the second term on the right represents the
additional supply from the local grid cell. Then,

Cout at each grid cell comprises is the concentration grid output from this function.

If the outlets shapefile is used the tool only evaluates that part of the domain that contributes flow to the locations
given by the shapefile.

Transport limited accumulation is useful for modeling erosion and sediment delivery, including the spatial depen-
dence of sediment delivery ratio and contaminant that adheres to sediment.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-infinity method.
Flow direction is measured in radians, counter clockwise from east. This can be created by the tool “D-
Infinity Flow Directions”.

Supply Grid [raster] A grid giving the supply (loading) of material to a transport limited accumulation func-
tion. In the application to erosion, this grid would give the erosion detachment, or sediment supplied at each
grid cell.

Transport Capacity Grid [raster] A grid giving the transport capacity at each grid cell for the transport
limited accumulation function. In the application to erosion this grid woul give the transport capacity of the
carrying flow.

Outlets Shapefile [vector: point] Optional.

This optional input is a point shapefile defining outlets of interest. If this file is used, the tool will only
evaluate the area upslope of these outlets.

Check for edge contamination [boolean] This option determines whether the tool should check for
edge contamination. Edge contamination is defined as the possibility that a value may be underestimated
due to grid cells outside of the domain not being considered when determining the result.
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Default: True

Outputs

Transport Limited Accumulation Grid [raster] This grid is the weighted accumulation of supply
accumulated respecting the limitations in transport capacity and reports the transport rate calculated by
accumulating the substance flux subject to the rule that the transport out of any grid cell is the minimum of
the total supply (local supply plus transport in) to that grid cell and the transport capacity.

Deposition Grid [raster] A grid giving the deposition resulting from the transport limited accumulation.
This is the residual from the transport in to each grid cell minus the transport capacity out of the grid cell.
The deposition grid is calculated as the transport in + the local supply - the tranport out.

Console usage

processing.runalg(’taudem:dinfinitytransportlimitedaccumulation’, dinf_flow_dir_grid, supply_grid, capacity_grid, outlets_shape, edge_contam, transp_lim_accum_grid, deposition_grid)

See also

D-Infinity Upslope Dependence

Description

The D-Infinity Upslope Dependence tool quantifies the amount each grid cell in the domain contributes to a
destination set of grid cells. D-Infinity flow directions proportion flow from each grid cell between multiple
downslope grid cells. Following this flow field downslope the amount of flow originating at each grid cell that
reaches the destination zone is defined. Upslope influence is evaluated using a downslope recursion, examining
grid cells downslope from each grid cell, so that the map produced identifies the area upslope where flow through
the destination zone originates, or the area it depends on, for its flow.

The figures below illustrate the amount each source point in the domain x (blue) contributes to the destination point
or zone y (red). If the indicator weighted contributing area function is denoted I(y; x) giving the weighted
contribution using a unit value (1) from specific grid cells y to grid cells x, then the upslope dependence is: D(x;
y) = I(y; x).

This is useful for example to track where flow or a flow related substance or contaminant that enters a destination
area may come from.

Parameters

D-Infinity Flow Direction Grid [raster] A grid giving flow direction by the D-Infinity method
where the flow direction angle is determined as the direction of the steepest downward slope on the eight
triangular facets formed in a 3x3 grid cell window centered on the grid cell of interest. This grid can be
produced using the “D-Infinity Flow Direction” tool.

Destination Grid [raster] A grid that encodes the destination zone that may receive flow from upslope.
This grid must be 1 inside the zone y and 0 over the rest of the domain.
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Outputs

Output Upslope Dependence Grid [raster] A grid quantifing the amount each source point in the do-
main contributes to the zone defined by the destination grid.

Console usage

processing.runalg(’taudem:dinfinityupslopedependence’, -ang, -dg, -dep)

See also

Slope Average Down

Description

This tool computes slope in a D8 downslope direction averaged over a user selected distance. Distance should be
specified in horizontal map units.

Parameters

D8 Flow Direction Grid [raster] This input is a grid of flow directions that are encoded using the D8
method where all flow from a cells goes to a single neighboring cell in the direction of steepest descent.This
grid can be obtained as the output of the “D8 Flow Directions” tool.

Pit Filled Elevation Grid [raster] This input is a grid of elevation values. As a general rule, it is
recommended that you use a grid of elevation values that have had the pits removed for this input. Pits are
generally taken to be artifacts that interfere with the analysis of flow across them. This grid can be obtained
as the output of the “Pit Remove” tool, in which case it contains elevation values where the pits have been
filled to the point where they just drain.

Downslope Distance [number] Input parameter of downslope distance over which to calculate the slope
(in horizontal map units).

Default: 50

Outputs

Slope Average Down Grid [raster] This output is a grid of slopes calculated in the D8 downslope direc-
tion, averaged over the selected distance.

Console usage

processing.runalg(’taudem:slopeaveragedown’, -p, -fel, -dn, -slpd)
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See also

Slope Over Area Ratio

Description

Calculates the ratio of the slope to the specific catchment area (contributing area). This is algebraically related to
the more common ln(a/tan beta) wetness index, but contributing area is in the denominator to avoid divide by 0
errors when slope is 0.

Parameters

Slope Grid [raster] A grid of slope. This grid can be generated using ether the “D8 Flow Directions” tool
or the “D-Infinity Flow Directions” tool.

Specific Catchment Area Grid [raster] A grid giving the contributing area value for each cell taken
as its own contribution plus the contribution from upslope neighbors that drain in to it. Contributing area is
counted in terms of the number of grid cells (or summation of weights). This grid can be generated using
either the “D8 Contributing Area” tool or the “D-Infinity Contributing Area” tool.

Outputs

Slope Divided By Area Ratio Grid [raster] A grid of the ratio of slope to specific catchment area
(contributing area). This is algebraically related to the more common ln(a/tan beta) wetness index,
but contributing area is in the denominator to avoid divide by 0 errors when slope is 0.

Console usage

processing.runalg(’taudem:slopeoverarearatio’, -slp, -sca, -sar)

See also

.

18.8.3 Stream Network Analysis

D8 Extreme Upslope Value

Description

Evaluates the extreme (either maximum or minimum) upslope value from an input grid based on the D8 flow
model. This is intended initially for use in stream raster generation to identify a threshold of the slope times area
product that results in an optimum (according to drop analysis) stream network.

If the optional outlet point shapefile is used, only the outlet cells and the cells upslope (by the D8 flow model) of
them are in the domain to be evaluated.

By default, the tool checks for edge contamination. This is defined as the possibility that a result may be underes-
timated due to grid cells outside of the domain not being counted. This occurs when drainage is inwards from the
boundaries or areas with “no data” values for elevation. The algorithm recognizes this and reports “no data” for
the result for these grid cells. It is common to see streaks of “no data” values extending inwards from boundaries
along flow paths that enter the domain at a boundary. This is the desired effect and indicates that the result for
these grid cells is unknown due to it being dependent on terrain outside of the domain of data available. Edge
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contamination checking may be turned off in cases where you know this is not an issue or want to ignore these
problems, if for example, the DEM has been clipped along a watershed outline.

Parameters

D8 Flow Directions Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.

Upslope Values Grid [raster] This is the grid of values of which the maximum or minimum upslope value
is selected. The values most commonly used are the slope times area product needed when generating stream
rasters according to drop analysis.

Outlets Shapefile [vector: point] Optional.

A point shape file defining outlets of interest. If this input file is used, only the area upslope of these outlets
will be evaluated by the tool.

Check for edge contamination [boolean] A flag that indicates whether the tool should check for edge
contamination.

Default: True

Use max upslope value [boolean] A flag to indicate whether the maximum or minimum upslope value is
to be calculated.

Default: True

Outputs

Extereme Upslope Values Grid [raster] A grid of the maximum/minimum upslope values.

Console usage

processing.runalg(’taudem:d8extremeupslopevalue’, -p, -sa, -o, -nc, -min, -ssa)

See also

Length Area Stream Source

Description

Creates an indicator grid (1, 0) that evaluates A >= (M)(Ly) based on upslope path length, D8 contributing
area grid inputs, and parameters M and y. This grid indicates likely stream source grid cells. This is an exper-
imental method with theoretical basis in Hack’s law which states that for streams L ~ A 0.6. However for
hillslopes with parallel flow L ~ A. So a transition from hillslopes to streams may be represented by L ~ A
0.8 suggesting identifying grid cells as stream cells if A > M (L (1/0.8)).

Parameters

Length Grid [raster] A grid of the maximum upslope length for each cell. This is calculated as the length of
the flow path from the furthest cell that drains to each cell. Length is measured between cell centers taking
into account cell size and whether the direction is adjacent or diagonal. It is this length (L) that is used in
the formula, A >(M)(Ly), to determine which cells are considered stream cells. This grid can be obtained
as an output from the “Grid Network” tool.
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Contributing Area Grid [raster] A grid of contributing area values for each cell that were calculated us-
ing the D8 algorithm. The contributing area for a cell is the sum of its own contribution plus the contribution
from all upslope neighbors that drain to it, measured as a number of cells. This grid is typically obtained as
the output of the “D8 Contributing Area” tool. In this tool, it is the contributing area (A) that is compared
in the formula A > (M)(Ly) to determine the transition to a stream.

Threshold [number] The multiplier threshold (M) parameter which is used in the formula: A > (M)(Ly),
to identify the beginning of streams.

Default: 0.03

Exponent [number] The exponent (y) parameter which is used in the formula: A > (M)(Ly), to identify
the beginning of streams. In branching systems, Hack’s law uggests that L = 1/M A(1/y) with 1/y =
0.6 (or 0.56) (y about 1.7). In parallel flow systems L is proportional to A (y about 1). This method tries
to identify the transition between these two paradigms by using an exponent y somewhere in between (y
about 1.3).

Default: 1.3

Outputs

Stream Source Grid [raster] An indicator grid (1,0) that evaluates A >= (M)(L^y), based on the maximum
upslope path length, the D8 contributing area grid inputs, and parameters M and y. This grid indicates likely
stream source grid cells.

Console usage

processing.runalg(’taudem:lengthareastreamsource’, length_grid, contrib_area_grid, threshold, exponent, stream_source_grid)

See also

Move Outlets To Streams

Description

Moves outlet points that are not aligned with a stream cell from a stream raster grid, downslope along the D8 flow
direction until a stream raster cell is encountered, the “max_dist” number of grid cells are examined, or the flow
path exits the domain (i.e. a “no data” value is encountered for the D8 flow direction). The output file is a new
outlets shapefile where each point has been moved to coincide with the stream raster grid, if possible. A field
“dist_moved” is added to the new outlets shapefile to indicate the changes made to each point. Points that are
already on a stream cell are not moved and their “dist_moved” field is assigned a value 0. Points that are initially
not on a stream cell are moved by sliding them downslope along the D8 flow direction until one of the following
occurs: a) A stream raster grid cell is encountered before traversing the “max_dist” number of grid cells. In which
case, the point is moved and the “dist_moved” field is assigned a value indicating how many grid cells the point
was moved. b) More than the “max_number” of grid cells are traversed, or c) the traversal ends up going out of
the domain (i.e., a “no data” D8 flow direction value is encountered). In which case, the point is not moved and
the “dist_moved” field is assigned a value of -1.

Parameters

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.
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Stream Raster Grid [raster] This output is an indicator grid (1, 0) that indicates the location of streams,
with a value of 1 for each of the stream cells and 0 for the remainder of the cells. This file is produced by
several different tools in the “Stream Network Analysis” toolset.

Outlets Shapefile [vector: point] A point shape file defining points of interest or outlets that should ide-
ally be located on a stream, but may not be exactly on the stream due to the fact that the shapefile point
locations may not have been accurately registered with respect to the stream raster grid.

Maximum Number of Grid Cells to traverse [number] This input paramater is the maximum
number of grid cells that the points in the input outlet shapefile will be moved before they are saved to
the output outlet shapefile.

Default: 50

Outputs

Output Outlet Shapefile [vector] A point shape file defining points of interest or outlets. This file has
one point in it for each point in the input outlet shapefile. If the original point was located on a stream,
then the point was not moved. If the origianl point was not on a stream, the point was moved downslope
according to the D8 flow direction until it reached a stream or the maximum distance had been reached.
This file has an additional field “dist_moved” added to it which is the number of cells that the point was
moved. This field is 0 if the cell was originally on a stream, -1 if it was not moved becuase there was not a
stream within the maximum distance, or some positive value if it was moved.

Console usage

processing.runalg(’taudem:moveoutletstostreams’, -p, -src, -o, -md, -om)

See also

Peuker Douglas

Description

Creates an indicator grid (1, 0) of upward curved grid cells according to the Peuker and Douglas algorithm.

With this tool, the DEM is first smoothed by a kernel with weights at the center, sides, and diagonals. The
Peuker and Douglas (1975) method (also explained in Band, 1986), is then used to identify upwardly curving
grid cells. This technique flags the entire grid, then examines in a single pass each quadrant of 4 grid cells, and
unflags the highest. The remaining flagged cells are deemed “upwardly curved”, and when viewed, resemble a
channel network. This proto-channel network generally lacks connectivity and requires thinning, issues that were
discussed in detail by Band (1986).

Parameters

Elevation Grid [raster] A grid of elevation values. This is usually the output of the “Pit Remove” tool, in
which case it is elevations with pits removed.

Center Smoothing Weight [number] The center weight parameter used by a kernel to smooth the DEM
before the tool identifies upwardly curved grid cells.

Default: 0.4

Side Smoothing Weight [number] The side weight parameter used by a kernel to smooth the DEM before
the tool identifies upwardly curved grid cells.

Default: 0.1
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Diagonal Smoothing Weight [number] The diagonal weight parameter used by a kernel to smooth the
DEM before the tool identifies upwardly curved grid cells.

Default: 0.05

Outputs

Stream Source Grid [raster] An indicator grid (1, 0) of upward curved grid cells according to the Peuker
and Douglas algorithm, and if viewed, resembles a channel network. This proto-channel network generally
lacks connectivity and requires thinning, issues that were discussed in detail by Band (1986).

Console usage

processing.runalg(’taudem:peukerdouglas’, elevation_grid, center_weight, side_weight, diagonal_weight, stream_source_grid)

See also

• Band, L. E., (1986), “Topographic partition of watersheds with digital elevation models”, Water Resources
Research, 22(1): 15-24.

• Peuker, T. K. and D. H. Douglas, (1975), “Detection of surface-specific points by local parallel processing
of discrete terrain elevation data”, Comput. Graphics Image Process., 4: 375-387.

Slope Area Combination

Description

Creates a grid of slope-area values = (Sm) (An) based on slope and specific catchment area grid inputs, and
parameters m and n. This tool is intended for use as part of the slope-area stream raster delineation method.

Parameters

Slope Grid [raster] This input is a grid of slope values. This grid can be obtained from the “D-Infinity Flow
Directions” tool.

Contributing Area Grid [raster] A grid giving the specific catchment area for each cell taken as its own
contribution (grid cell length or summation of weights) plus the proportional contribution from upslope
neighbors that drain in to it. This grid is typically obtained from the “D-Infinity Contributing Area” tool.

Slope Exponent [number] The slope exponent (m) parameter which will be used in the formula:
(Sm)(An), that is used to create the slope-area grid.

Default: 2

Area Exponent [number] The area exponent (n) parameter which will be used in the formula: (Sm)(An),
that is used to create the slope-area grid.

Default: 1

Outputs

Slope Area Grid [raster] A grid of slope-area values = (Sm)(An) calculated from the slope grid, specific
catchment area grid, m slope exponent parameter, and n area exponent parameter.
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Console usage

processing.runalg(’taudem:slopeareacombination’, slope_grid, area_grid, slope_exponent, area_exponent, slope_area_grid)

See also

Stream Definition By Threshold

Description

Operates on any grid and outputs an indicator (1, 0) grid identifing cells with input values >= the threshold value.
The standard use is to use an accumulated source area grid to as the input grid to generate a stream raster grid
as the output. If you use the optional input mask grid, it limits the domain being evaluated to cells with mask
values >= 0. When you use a D-infinity contributing area grid (*sca) as the mask grid, it functions as an edge
contamination mask. The threshold logic is:

src = ((ssa >= thresh) & (mask >= s0)) ? 1:0

Parameters

Accumulated Stream Source Grid [raster] This grid nominally accumulates some characteristic or
combination of characteristics of the watershed. The exact characteristic(s) varies depending on the stream
network raster algorithm being used. This grid needs to have the property that grid cell values are monoton-
ically increasing downslope along D8 flow directions, so that the resulting stream network is continuous.
While this grid is often from an accumulation, other sources such as a maximum upslope function will also
produce a suitable grid.

Threshold [number] This parameter is compared to the value in the Accumulated Stream Source grid (*ssa)
to determine if the cell should be considered a stream cell. Streams are identified as grid cells for which ssa
value is >= this threshold.

Default: 100

Mask Grid [raster] Optional.

This optional input is a grid that is used to mask the domain of interest and output is only provided where
this grid is >= 0. A common use of this input is to use a D-Infinity contributing area grid as the mask so
that the delineated stream network is constrained to areas where D-infinity contributing area is available,
replicating the functionality of an edge contamination mask.

Outputs

Stream Raster Grid [raster] This is an indicator grid (1, 0) that indicates the location of streams, with a
value of 1 for each of the stream cells and 0 for the remainder of the cells.

Console usage

processing.runalg(’taudem:streamdefinitionbythreshold’, -ssa, -thresh, -mask, -src)
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See also

Stream Drop Analysis

Description

Applies a series of thresholds (determined from the input parameters) to the input accumulated stream source
grid (*ssa) grid and outputs the results in the *drp.txt file the stream drop statistics table. This function is
designed to aid in the determination of a geomorphologically objective threshold to be used to delineate streams.
Drop Analysis attempts to select the right threshold automatically by evaluating a stream network for a range
of thresholds and examining the constant drop property of the resulting Strahler streams. Basically it asks the
question: Is the mean stream drop for first order streams statistically different from the mean stream drop for
higher order streams, using a T-test. Stream drop is the difference in elevation from the beginning to the end of
a stream defined as the sequence of links of the same stream order. If the T-test shows a significant difference
then the stream network does not obey this “law” so a larger threshold needs to be chosen. The smallest threshold
for which the T-test does not show a significant difference gives the highest resolution stream network that obeys
the constant stream drop “law” from geomorphology, and is the threshold chosen for the “objective” or automatic
mapping of streams from the DEM. This function can be used in the development of stream network rasters, where
the exact watershed characteristic(s) that were accumulated in the accumulated stream source grid vary based on
the method being used to determine the stream network raster.

The constant stream drop “law” was identified by Broscoe (1959). For the science behind using this to determine
a stream delineation threshold, see Tarboton et al. (1991, 1992), Tarboton and Ames (2001).

Parameters

D8 Contributing Area Grid [raster] A grid of contributing area values for each cell that were calcu-
lated using the D8 algorithm. The contributing area for a cell is the sum of its own contribution plus the
contribution from all upslope neighbors that drain to it, measured as a number of cells or the sum of weight
loadings. This grid can be obtained as the output of the “D8 Contributing Area” tool. This grid is used in
the evaluation of drainage density reported in the stream drop table.

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.

Pit Filled Elevation Grid [raster] A grid of elevation values. This is usually the output of the “Pit
Remove” tool, in which case it is elevations with pits removed.

Accumulated Stream Source Grid [raster] This grid must be monotonically increasing along the
downslope D8 flow directions. It it compared to a series of thresholds to determine the beginning of the
streams. It is often generated by accumulating some characteristic or combination of characteristics of the
watershed with the “D8 Contributing Area” tool, or using the maximum option of the “D8 Flow Path
Extreme” tool. The exact method varies depending on the algorithm being used.

Outlets Shapefile [vector: point] A point shapefile defining the outlets upstream of which drop analysis
is performed.
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Minimum Threshold [number] This parameter is the lowest end of the range searched for possible threshold
values using drop analysis. This technique looks for the smallest threshold in the range where the absolute
value of the t-statistic is less than 2. For the science behind the drop analysis see Tarboton et al. (1991,
1992), Tarboton and Ames (2001).

Default: 5

Maximum Threshold [number] This parameter is the highest end of the range searched for possible threshold
values using drop analysis. This technique looks for the smallest threshold in the range where the absolute
value of the t-statistic is less than 2. For the science behind the drop analysis see Tarboton et al. (1991,
1992), Tarboton and Ames (2001).

Default: 500

Number of Threshold Values [number] The parameter is the number of steps to divide the search range
into when looking for possible threshold values using drop analysis. This technique looks for the smallest
threshold in the range where the absolute value of the t-statistic is less than 2. For the science behind the
drop analysis see Tarboton et al. (1991, 1992), Tarboton and Ames (2001).

Default: 10

Spacing for Threshold Values [selection] This parameter indicates whether logarithmic or linear
spacing should be used when looking for possible threshold values using drop ananlysis.

Options:

• 0 — Logarithmic

• 1 — Linear

Default: 0

Outputs

D-Infinity Drop to Stream Grid [file] This is a comma delimited text file with the following header
line:

:: Threshold,DrainDen,NoFirstOrd,NoHighOrd,MeanDFirstOrd,MeanDHighOrd,StdDevFirstOrd,StdDevHighOrd,T

The file then contains one line of data for each threshold value examined, and then a summary line that
indicates the optimum threshold value. This technique looks for the smallest threshold in the range where
the absolute value of the t-statistic is less than 2. For the science behind the drop analysis, see Tarboton et
al. (1991, 1992), Tarboton and Ames (2001).

Console usage

processing.runalg(’taudem:streamdropanalysis’, d8_contrib_area_grid, d8_flow_dir_grid, pit_filled_grid, accum_stream_source_grid, outlets_shape, min_treshold, max_threshold, treshold_num, step_type, drop_analysis_file)

See also

• Broscoe, A. J., (1959), “Quantitative analysis of longitudinal stream profiles of small watersheds”, Office
of Naval Research, Project NR 389-042, Technical Report No. 18, Department of Geology, Columbia
University, New York.

• Tarboton, D. G., R. L. Bras and I. Rodriguez-Iturbe, (1991), “On the Extraction of Channel Networks from
Digital Elevation Data”, Hydrologic Processes, 5(1): 81-100.

• Tarboton, D. G., R. L. Bras and I. Rodriguez-Iturbe, (1992), “A Physical Basis for Drainage Density”,
Geomorphology, 5(1/2): 59-76.

• Tarboton, D. G. and D. P. Ames, (2001), “Advances in the mapping of flow networks from digital ele-
vation data”, World Water and Environmental Resources Congress, Orlando, Florida, May 20-24, ASCE,
http://www.engineering.usu.edu/dtarb/asce2001.pdf.
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Stream Reach and Watershed

Description

This tool produces a vector network and shapefile from the stream raster grid. The flow direction grid is used
to connect flow paths along the stream raster. The Strahler order of each stream segment is computed. The
subwatershed draining to each stream segment (reach) is also delineated and labeled with the value identifier that
corresponds to the WSNO (watershed number) attribute in the Stream Reach Shapefile.

This tool orders the stream network according to the Strahler ordering system. Streams that don’t have any
other streams draining in to them are order 1. When two stream reaches of different order join the order of
the downstream reach is the order of the highest incoming reach. When two reaches of equal order join the
downstream reach order is increased by 1. When more than two reaches join the downstream reach order is
calculated as the maximum of the highest incoming reach order or the second highest incoming reach order +
1. This generalizes the common definition to cases where more than two reaches join at a point. The network
topological connectivity is stored in the Stream Network Tree file, and coordinates and attributes from each grid
cell along the network are stored in the Network Coordinates file.

The stream raster grid is used as the source for the stream network, and the flow direction grid is used to trace
connections within the stream network. Elevations and contributing area are used to determine the elevation and
contributing area attributes in the network coordinate file. Points in the outlets shapefile are used to logically split
stream reaches to facilitate representing watersheds upstream and downstream of monitoring points. The program
uses the attribute field “id” in the outlets shapefile as identifiers in the Network Tree file. This tool then translates
the text file vector network representation in the Network Tree and Coordinates files into a shapefile. Further
attributes are also evaluated. The program has an option to delineate a single watershed by representing the entire
area draining to the Stream Network as a single value in the output watershed grid.

Parameters

Pit Filled Elevation Grid [raster] A grid of elevation values. This is usually the output of the “Pit
Remove” tool, in which case it is elevations with pits removed.

D8 Flow Direction Grid [raster] A grid of D8 flow directions which are defined, for each cell, as the
direction of the one of its eight adjacent or diagonal neighbors with the steepest downward slope. This grid
can be obtained as the output of the “D8 Flow Directions” tool.

D8 Drainage Area [raster] A grid giving the contributing area value in terms of the number of grid cells (or
the summation of weights) for each cell taken as its own contribution plus the contribution from upslope
neighbors that drain in to it using the D8 algorithm. This is usually the output of the “D8 Contributing
Area” tool and is used to determine the contributing area attribute in the Network Coordinate file.

Stream Raster Grid [raster] An indicator grid indicating streams, by using a grid cell value of 1 on
streams and 0 off streams. Several of the “Stream Network Analysis” tools produce this type of grid.
The Stream Raster Grid is used as the source for the stream network.

Outlets Shapefile as Network Nodes [vector: point] Optional.

A point shape file defining points of interest. If this file is used, the tool will only deliiniate the stream
network upstream of these outlets. Additionally, points in the Outlets Shapefile are used to logically split
stream reaches to facilitate representing watersheds upstream and downstream of monitoring points. This
tool REQUIRES THAT THERE BE an integer attribute field “id” in the Outlets Shapefile, because the “id”
values are used as identifiers in the Network Tree file.

Delineate Single Watershed [boolean] This option causes the tool to delineate a single watershed by
representing the entire area draining to the Stream Network as a single value in the output watershed grid.
Otherwise a seperate watershed is delineated for each stream reach. Default is False (seperate watershed).

Default: False
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Outputs

Stream Order Grid [raster] The Stream Order Grid has cells values of streams ordered according to the
Strahler order system. The Strahler ordering system defines order 1 streams as stream reaches that don’t
have any other reaches draining in to them. When two stream reaches of different order join the order of
the downstream reach is the order of the highest incoming reach. When two reaches of equal order join the
downstream reach order is increased by 1. When more than two reaches join the downstream reach order
is calculated as the maximum of the highest incoming reach order or the second highest incoming reach
order + 1. This generalizes the common definition to cases where more than two flow paths reaches join at
a point.

Watershed Grid [raster] This output grid identified each reach watershed with a unique ID number, or in
the case where the delineate single watershed option was checked, the entire area draining to the stream
network is identified with a single ID.

Stream Reach Shapefile [vector] This output is a polyline shapefile giving the links in a stream network.
The columns in the attribute table are:

• LINKNO — Link Number. A unique number associated with each link (segment of channel between
junctions). This is arbitrary and will vary depending on number of processes used

• DSLINKNO — Link Number of the downstream link. -1 indicates that this does not exist

• USLINKNO1 — Link Number of first upstream link. (-1 indicates no link upstream, i.e. for a source
link)

• USLINKNO2 — Link Number of second upstream link. (-1 indicates no second link upstream, i.e.
for a source link or an internal monitoring point where the reach is logically split but the network does
not bifurcate)

• DSNODEID — Node identifier for node at downstream end of stream reach. This identifier corre-
sponds to the “id” attribute from the Outlets shapefile used to designate nodes

• Order — Strahler Stream Order

• Length — Length of the link. The units are the horizontal map units of the underlying DEM grid

• Magnitude — Shreve Magnitude of the link. This is the total number of sources upstream

• DS_Cont_Ar — Drainage area at the downstream end of the link. Generally this is one grid cell
upstream of the downstream end because the drainage area at the downstream end grid cell includes
the area of the stream being joined

• Drop — Drop in elevation from the start to the end of the link

• Slope — Average slope of the link (computed as drop/length)

• Straight_L — Straight line distance from the start to the end of the link

• US_Cont_Ar — Drainage area at the upstream end of the link

• WSNO — Watershed number. Cross reference to the *w.shp and *w grid files giving the identifica-
tion number of the watershed draining directly to the link

• DOUT_END — Distance to the eventual outlet (i.e. the most downstream point in the stream network)
from the downstream end of the link

• DOUT_START — Distance to the eventual outlet from the upstream end of the link

• DOUT_MID — Distance to the eventual outlet from the midpoint of the link

Network Connectivity Tree [file] This output is a text file that details the network topological connec-
tivity is stored in the Stream Network Tree file. Columns are as follows:

• Link Number (Arbitrary — will vary depending on number of processes used)

• Start Point Number in Network coordinates (*coord.dat) file (Indexed from 0)

• End Point Number in Network coordinates (*coord.dat) file (Indexed from 0)
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• Next (Downstream) Link Number. Points to Link Number. -1 indicates no links downstream, i.e. a
terminal link

• First Previous (Upstream) Link Number. Points to Link Number. -1 indicates no upstream links

• Second Previous (Upstream) Link Numbers. Points to Link Number. -1 indicates no upstream links.
Where only one previous link is -1, it indicates an internal monitoring point where the reach is logically
split, but the network does not bifurcate

• Strahler Order of Link

• Monitoring point identifier at downstream end of link. -1 indicates downstream end is not a monitoring
point

• Network magnitude of the link, calculated as the number of upstream sources (following Shreve)

Network Coordinates [file] This output is a text file that contains the coordinates and attributes of points
along the stream network. Columns are as follows:

• X coordinate

• Y Coordinate

• Distance along channels to the downstream end of a terminal link

• Elevation

• Contributing area

Console usage

processing.runalg(’taudem:streamreachandwatershed’, -fel, -p, -ad8, -src, -o, -sw, -ord, -w, -net, -tree, -coord)

See also

.
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Print Composer

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an
image or an SVG-file. This is a powerfull way to share geographical information produced with QGIS that can be
included in reports or published.

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align and position each element and adjust the properties to create your layout. The
layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working
properly with some recent Qt4 versions; you should try and check individually on your system). You can save the
layout as a template and load it again in another session. Finally, generating several maps based on a template can
be done through the atlas generator. See a list of tools in table_composer_1:

629



QGIS User Guide, Wydanie 2.6

Icon Purpose Icon Purpose

Save Project New Composer

Duplicate Composer Composer Manager

Load from template Save as template

Print or export as PostScript Export to an image format

Export print composition to SVG Export as PDF

Revert last change Restore last change

Zoom to full extent Zoom to 100%

Zoom in Zoom out

Refresh View

Pan Zoom to specific region

Select/Move item in print composition Move content within an item

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add scale bar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Add an HTML frame

Group items of print composition Ungroup items of print composition

Lock Selected Items Unlock All items

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composer 1: Print Composer Tools

All Print Composer tools are available in menus and as icons in a toolbar. The toolbar can be switched off and on
using the right mouse button over the toolbar.

19.1 First steps

19.1.1 Open a new Print Composer Template

Before you start to work with the Print Composer, you need to load some raster and vector layers in the QGIS
map canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized

to your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will
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be prompted to choose a title for the new Composer.

19.1.2 Overview of the Print Composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items; the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Rysunek 19.1: Print Composer

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.

• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.
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• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

• Finally, you can save your print composition with the Save Project button.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number and a combo box to set the zoom level.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

Navigation tools

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom in

• Zoom out

• Zoom to full extent

• Zoom to 100%

• Refresh the view (if you find the view in an inconsistent state)

• Pan composer

• Marquee zoom mode (zoom to a specific region of the Composer)

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need to switch
to pan mode while working in the Composer area, you can hold the Spacebar or the the mouse wheel. With
Ctrl+Spacebar, you can temporarily switch to marquee zoom mode, and with Ctrl+Shift+Spacebar,
to zoom out mode.

19.1.3 Sample Session

To demonstrate how to create a map please follow the next instructions.

1. On the left site, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and place the map item with the left mouse button on the Print
Composer canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and draw it to a new
location to change it’s size.
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6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change it the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Finally, you can save your print composition with the Save Project button.

19.1.4 Print Composer Options

From Settings → Composer Options you can set some options that will be used as default during your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color.

• Grid defaults defines spacing, offset and tolerance of the grid. There are three types of grid: Dots, Solid
lines and Crosses.

• Guide defaults defines the tolerance for the guides.

19.1.5 Composition tab — General composition setup

In the Composition tab, you can define the global settings of your composition.

• You can choose one of the Presets for your paper sheet, or enter your custom width and height.

• Composition can now be divided into several pages. For instance, a first page can show a map canvas, and
a second page can show the attribute table associated with a layer, while a third one shows an HTML frame
linking to your organization website. Set the Number of pages to the desired value. You can choose the

page Orientation and its Exported resolution. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

• Grid lets you customize grid settings like spacings, offsets and tolerance to your need.

• In Snap to alignments, you can change the Tolerance, which is the maximum distance below which an item
is snapped to smart guides.

Snap to grid and/or to smart guides can be enabled from the View menu. In this menu, you can also hide or show
the grid and smart guides.

19.1.6 Composer items common options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

• The Position and size dialog lets you define size and position of the frame that contains the item. You can
also choose which Reference point will be set at the X and Y coordinates previously defined.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the label. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• The Background enables or disables a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can also be adjusted
throught the alpha field.

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
any potential web client. You can set an ID on an item (e.g., a map and a label), and then the web client can
send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will list
what items and which IDs are available in a layout.

• Rendering mode can be selected in the option field. See Rendering_Mode.
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Rysunek 19.2: Common Item properties Dialogs

Informacja:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map item
or use expressions. These are particularly helpful with atlas generation (See atlas_data_defined_overrides).

19.2 Rendering mode

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Rysunek 19.3: Rendering mode

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the the menu beside the slider.

• Exclude item from exports: You can decide to make an item not visible in all exports. After activating
this checkbox, the item will not be included in PDF’s, prints etc..

• Blending mode: You can achieve special rendering effects with these tools that you previously only may
know from graphics programs. The pixels of your overlaying and underlaying items are mixed through the
settings described below.
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– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it; the colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with pixel values of the other. In case
of values above 1 (as in the case of RGB), white is displayed. This mode is suitable for highlighting
features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the numbers for the
corresponding pixel of the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This mode is supposed to emulate shining a soft light onto an image.

– Hard light: Hard light is very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer with pixel values of the other. In
case of negative values, black is displayed.

19.3 Composer Items

19.3.1 The Map item

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties tab:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.
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You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button. After you have found the right place for an item,

you can lock the item position within the Print Composer canvas. Select the map item and use the toolbar
Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected using the Items tab. Once

selected you can use the Items tab to unlock individual items. The Unlock All Items icon will unlock all locked
composer items.

Main properties

The Main properties dialog of the map Item Properties tab provides the following functionalities (see fig-
ure_composer_map_1):

Rysunek 19.4: Map Item properties Tab

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• The field Scale sets a manual scale.

• The field Rotation allows you to rotate the map element content clockwise in degrees. Note that a
coordinate frame can only be added with the default value 0.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
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hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on

the button you will see the list of all the preset views: just select the preset you want to display. The

map canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you

want to unselect the preset, just uncheck the and press on the button. See Legenda mapy to find out
how to create presets views.

Extents

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Rysunek 19.5: Map Extents Dialog

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grids

The Grids dialog of the map Item Properties tab provides the the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

Rysunek 19.6: Map Grids Dialog
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After you have added a grid, you can active the checkbox Show grid to overlay a grid onto the map element.
Expand this option to provides a lot of configuration options, see Figure_composer_map_4.

Rysunek 19.7: Draw Grid Dialog

As grid type, you can specify to use a solid line or cross. Symbology of the grid can be chosen. See section
Rendering_Mode. Furthermore, you can define an interval in the X and Y directions, an X and Y offset, and the
width used for the cross or line grid type.

Rysunek 19.8: Grid Frame Dialog

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• Advanced rendering mode is also available for grids (see section Rendering_mode).

• The Draw coordinates checkbox allows you to add coordinates to the map frame. The annotation can
be drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical,
horizontal and vertical, or boundary direction, for each border individually. Units can be in meters or in
degrees. Finally, you can define the grid color, the annotation font, the annotation distance from the map
frame and the precision of the drawn coordinates.

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:
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Rysunek 19.9: Grid Draw Coordinates dialog

Rysunek 19.10: Map Overviews Dialog

19.3. Composer Items 639



QGIS User Guide, Wydanie 2.6

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map. Next you create the map
you want to use as the overview map, just like a normal map.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

Open Overviews and press the green plus icon-button to add an overview. Initially this overview is named
‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the overview
item in the list named ‘Overview 1’ and change it to another name.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes. See Rendering_Mode.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

19.3.2 The Label item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Rysunek 19.11: Label Item properties Tab
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Main properties

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

Alignment and Display

• You can define the horizontal and vertical alignment in the Alignment zone.

• In the Display tag, you can define a margin in mm. This is the margin from the edge of the composer item.

19.3.3 The Image item

To add an image, click the Add image icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the image Item Properties tab.

The image Item Properties tab provides the following functionalities (see figure_composer_image_1):

Rysunek 19.12: Image Item properties Tab
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You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading preview.. to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.

• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes
the rotation of a picture in the QGIS map canvas (i.e., a rotated north arrow) with the appropriate Print Composer
image.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Informacja: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for
languages that do not use an ‘N’ for North, so they can use another letter.

19.3.4 The Legend item

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Main properties

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

In Main properties you can:
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Rysunek 19.13: North arrows available for selection in provided SVG library

Rysunek 19.14: Legend Item properties Tab

Rysunek 19.15: Legend Main properties Dialog

19.3. Composer Items 643



QGIS User Guide, Wydanie 2.6

• Change the title of the legend.

• Set the title alignment to Left, Center or Right.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.

Legend items

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

Rysunek 19.16: Legend Legend Items Dialog

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer-, groupname or title, first you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button the filter the legend by map content, only the legend items visible in the map
will be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update] to adapt the changes
in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• You can change the font of the legend title, group, subgroup and item (layer) in the legend item. Click on a
category button to open a Select font dialog.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legen..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.
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Rysunek 19.17: Legend Fonts, Columns, Symbol and Spacing Dialogs

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can change the width and height of the legend symbol in this dialog.

WMS legendGraphic and Spacing

The WMS legendGraphic and Spacing dialogs of the legend Item Properties tab provide the following functional-
ities (see figure_composer_legend_5):

Rysunek 19.18: WMS legendGraphic Dialogs

When you have added a WMS layer and you insert a legend composer item, a request will be send to the WMS
server to provide a WMS legend, This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.
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WMS legendGraphic is used to be able to adjust the Legend width and the legend hight of the WMS legend raster
image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

19.3.5 The Scale Bar item

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see fig-
ure_composer_scalebar_1):

Rysunek 19.19: Scale Bar Item properties Tab

Main properties

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_scalebar_2):

Rysunek 19.20: Scale Bar Main properties Dialog

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).
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Units and Segments

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

Rysunek 19.21: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the map units used. There are four possible choices: Map Units is the automated unit selection;
Meters, Feet or Nautical Miles force unit conversions.

• The Label field defines the text used to describe the units of the scale bar.

• The Map units per bar unit allows you to fix the ratio between a map unit and its representation in the scale
bar.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar, and how
long each segment will be (Size field). Height can also be defined.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

Rysunek 19.22: Scale Bar Display

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing

• Line width : line widht of the scale bar drawing

19.3. Composer Items 647



QGIS User Guide, Wydanie 2.6

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Rysunek 19.23: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font

• Font color: set the font color

• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bare

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

19.3.6 The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon or the Add Arrow icon, place
the element holding down the left mouse. Customize the appearance in the Item Properties tab.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Informacja: Unlike other items, you can not style the frame or the background color of the frame.
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Rysunek 19.24: Shape Item properties Tab

19.3.7 The Arrow item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties tab.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see the_image_item).

Rysunek 19.25: Arrow Item properties Tab

Item Properties

The Arrow item properties tab allows you to configure an arrow item.

The [Line style ...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.
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• Default : To draw a regular arrow, gives you options to style the arrow head

• None : To draw a line without arrow head

• SVG Marker : To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Arrow outline color : Set the outline color of the arrow head

• Arrow fill color : Set the fill color of the arrow head

• Arrow outline width : Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker : Choose an SVG image to draw at the beginning of the line

• End marker : Choose an SVG image to draw at the end of the line

• Arrow head width: Sets the size of Start and/or headmarker

SVG images are automatically rotated with the line. The color of the SVG image can not be changed.

19.3.8 The Attribute Table item

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, place the element with the left mouse button on the Print Composer canvas, and position and customize the
appearance in the Item Properties tab.

The Item properties of an attribute table item tab provides the following functionalities (see fig-
ure_composer_table_1):

Rysunek 19.26: Attribute table Item properties Tab

Main properties

The Main properties dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_2):

• For Source you can normally select only ‘Layer features’.
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Rysunek 19.27: Attribute table Main properties Dialog

• With Layer you can choose from the vector layers loaded in the project.

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table.

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in a row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a
new attribute using a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cel in the Headings column to change the Heading, just type a new name.

– Select a cel in the Alignment column and you can choose between Left, Center or Right alignment.

– Select a cel in the Width column and you can change it from Automatic to a width in mm, just type a
number. When you want to change it back to Automatic, use the cross.

– The [Reset] button can allways be used to restore it to the original attribute settings.

In the Sorting section you can:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.

– use the minus button to remove an attribute from the sort order list.

Feature filtering

The Feature filtering dialogs of the attribute table Item Properties tab provide the following functionalities (see
figure_composer_table_4):

You can:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.
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Rysunek 19.28: Attribute table Select attributes Dialog

Rysunek 19.29: Attribute table Feature filtering Dialog
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• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expressing use
the given expression button. A few examples of filtering statements you can use when you have loaded the
airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the arpoirts that have a letter ‘i’ in the attribute field ‘USE’.

Appearance

The Appearance dialogs of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_5):

Rysunek 19.30: Attribute table appearance Dialog

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have choosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Draw empty cells, will fill the attribute table with empty cells, this option can also be used to provide
additional empty cells when you have a result to show!

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table.

Show grid

The Show grid dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_6):
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Rysunek 19.31: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Stroke width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table Item Properties tab provide the following functionalities
(see figure_composer_table_7):

Rysunek 19.32: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment and choose from Follow column align-
ment, Left, Center or Right. The column alignment is set using the Select Attributes dialog (see Fig-
ure_composer_table_3 ).

Frames

The Frames dialog of the attribute table Item Properties tab provide the following functionalities (see fig-
ure_composer_table_8):

Rysunek 19.33: Attribute table Frames Dialog
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• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

19.3.9 The HTML frame item

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties tab (see
figure_composer_html_1).

Rysunek 19.34: HTML frame, the item properties Tab

HTML Source

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_html_2):
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Rysunek 19.35: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Source you can enter text in the textbox with some HTML tags or provide a full HTML page.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activate Evaluate QGIS expressions in HTML code to see the result of the expression you have included,
otherwise you will see the expression instead.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Frames

The Frames dialog of the HTML frame Item Properties tab provides the following functionalities (see fig-
ure_composer_html_3):

Rysunek 19.36: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extent to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.
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• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Rysunek 19.37: HTML frame, Use smart page breaks and User stylesheet properties

• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

19.4 Manage items

19.4.1 Size and position

Each item inside the Composer can be moved/resized to create a perfect layout. For both operations the first step is

to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while holding
the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the Shift
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while moving the mouse. If you need a better precision, you can move a selected item using the Arrow keys
on the keyboard; if the movement is too slow, you can speed up it by holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. Guides are set by clicking
and dragging in the rulers. Guide are moved by clicking in the ruler, level with the guide and dragging to a new
place. To delete a guide move it off the canvas. If you need to disable the snap on the fly just hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group just like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

19.4.2 Alignment

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1). This order is shown in the Items tab. You can also raise
or lower objects in the Items tab by clicking and dragging an object’s label in this list.

There are several alignment functionalities available within the Align selected items pull-down menu (see ta-
ble_composer_1). To use an alignment functionality, you first select some elements and then click on the matching
alignment icon. All selected elements will then be aligned within to their common bounding box. When moving
items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

19.4.3 Copy/Cut and Paste items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position.

Informacja: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the
Item Properties tab.

19.5 Revert and Restore tools

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last changes

• Restore last changes
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Rysunek 19.38: Alignment helper lines in the Print Composer
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This can also be done by mouse click within the Command history tab (see figure_composer_29).

Rysunek 19.39: Command history in the Print Composer

19.6 Atlas generation

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_atlas):

Rysunek 19.40: Atlas generation tab

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the geometries
on which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.
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• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• An input box Margin around feature that allows you to select the amount of space added around each
geometry within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

19.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. For example, for
a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’ format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ is ‘ format_number($area/1000000,2) %] is an
expression used inside the label. That would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

19.6.2 Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly usefull with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composite tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than it’s width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. press the button of field Orientation,
select Edit ... so the Expression string builder dialog opens. Give following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically for each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) - 20

Use the button of field Heigth to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 210 ELSE 297 END) - 20
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When you want to give a title above map in the center of the page, insert a label item above the map. First use the
item properties of the label item to set the horizontal alignment to Center. Next activate from Reference point
the upper middle checkbox. You can provide following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry) THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when page
is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in english and portugese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use Data Defined Overrides.

19.6.3 Preview

Once the atlas settings have been configured and map items selected, you can create a preview of all the pages by
clicking on Atlas → Preview Atlas and using the arrows, in the same menu, to navigate through all the features.

19.6.4 Generation

The atlas generation can be done in different ways. For example, with Atlas → Print Atlas, you can directly print
it. You can also create a PDF using Atlas → Export Atlas as PDF: The user will be asked for a directory for saving

all the generated PDF files (except if the Single file export when possible has been selected). If you need to
print just a page of the atlas, simply start the preview function, select the page you need and click on Composer
→ Print (or create a PDF).

19.7 Creating Output

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the sections above.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• Export as PDF saves the defined Print Composer canvas directly as a PDF.

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will also create a world file.

Informacja:
• Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying Qt

library. This will hopefully be sorted out in future versions.

• Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is also a problem
with the underlying Qt management of rasters.
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Rysunek 19.41: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame
added

19.8 Manage the Composer

With the Save as template and Add items from template icons, you can save the current state of a Print Composer
session as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in Composer → Composer Manager allows you to add a
new Composer template, create a new composition based on a previously saved template or to manage already
existing templates.

By default, the Composer manager searches for user templates in ~/.qgis2/composer_template.

The New Composer and Duplicate Composer buttons in the QGIS toolbar and in Composer → New Composer
and Composer → Duplicate Composer allow you to open a new Composer dialog, or to duplicate an existing
composition from a previously created one.

Finally, you can save your print composition with the Save Project button. This is the same feature as in the QGIS
main window. All changes will be saved in a QGIS project file.

.
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Rysunek 19.42: The Print Composer Manager
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Plugins

.

20.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

You can manage your plugins in the plugin dialog which can be opened with Plugins > Manage and install
pluginsi ....

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface
could display a blue link in the status bar to tell you that there are some plugins updating waiting to be applied.

20.1.1 The Plugins Dialog

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin have some metadatas displayed in the right panel:

• information if the plugin is experimental

• description

• rating vote(s) (you can vote for your prefered plugin!)

• tags

• some useful links as the home page, tracker and code repository

• author(s)

• version available

You can use the filter to find a specific plugin.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin], if a plugin is listed but not installed,
and [Uninstall plugin] as well as [Reinstall plugin], if a plugin is installed. If a plugin is installed, it can be
de/activated using the checkbox.

Installed

In this menu, you can find only the installed plugins. The external plugins can be uninstalled and reinstalled using
the [Uninstall plugin] and [Reinstall plugin] buttons. You can [Upgrade all] here as well.

Not installed
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Rysunek 20.1: The All menu

Rysunek 20.2: The Installed menu
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This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Rysunek 20.3: The Not installed menu

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for
more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons.

Settings

In this menu, you can use the following options:

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Show also deprecated plugins. These plugins are deprecated and generally unsuitable for production
use.

To add external author repositories, click [Add...] in the Plugin repositories section. If you do not want one or
more of the added repositories, they can be disabled via the [Edit...] button, or completely removed with the
[Delete] button.

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.

Wskazówka: Core and external plugins
QGIS plugins are implemented either as Core Plugins or External Plugins. Core Plugins are maintained by
the QGIS Development Team and are automatically part of every QGIS distribution. They are written in one of
two languages: C++ or Python. External Plugins are currently all written in Python. They are stored in external
repositories and are maintained by the individual authors.

20.1. QGIS Plugins 667



QGIS User Guide, Wydanie 2.6

Rysunek 20.4: The Upgradeable menu

Rysunek 20.5: The Settings menu
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Detailed documentation about the usage, minimum QGIS version, home page, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, documentation might be available with the external plugins themselves. In general, it is not included
in this manual.

.

20.2 Using QGIS Core Plugins

Icon Plugin Description Manual Reference

Coordinate Capture Capture mouse coordinate in different CRS Coordinate Capture Plugin

DB Manager Manage your databases within QGIS DB Manager Plugin

DXF2Shape Converter Converts from DXF to SHP file format Dxf2Shp Converter Plugin

eVis Event Visualization Tool eVis Plugin

fTools A suite of vector tools fTools Plugin

GPS Tools Tools for loading and importing GPS data GPS Plugin

GRASS GRASS functionality GRASS GIS Integration

GDAL Tools GDAL raster functionality GDAL Tools Plugin

Georeferencer GDAL Georeference rasters with GDAL Georeferencer Plugin

Heatmap Create heatmap rasters from input vector points Heatmap Plugin

Interpolation plugin Interpolation on base of vertices of a vector layer Interpolation Plugin

Offline Editing Offline editing and synchronizing with database Offline Editing Plugin

Oracle Spatial Georaster Access Oracle Spatial GeoRasters Oracle Spatial GeoRaster Plugin

Plugin Manager Manage core and external plugins The Plugins Dialog

Raster Terrain Analysis Compute geomorphological features from DEMs Raster Terrain Analysis Plugin

Road Graph plugin Shortest path analysis Road Graph Plugin

SQL Anywhere plugin Access SQL anywhere DB SQL Anywhere Plugin

Spatial Query Spatial queries on vectors Spatial Query Plugin

SPIT Shapefile to PostgreSQL/PostGIS Import Tool SPIT Plugin

Zonal Statistics Calculate raster statistics for vector polygons Zonal Statistics Plugin

MetaSearch Interact with metadata catalogue services (CSW) MetaSearch Catalogue Client
.

20.3 Coordinate Capture Plugin

The coordinate capture plugin is easy to use and provides the ability to display coordinates on the map canvas for
two selected coordinate reference systems (CRS).

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.
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Rysunek 20.6: Coordinate Capture Plugin

2. Click on the Enable on the fly projection checkbox and select a projected coordinate system of your
choice (see also Praca z układami współrzędnych).

3. Activate the coordinate capture plugin in the Plugin Manager (see The Plugins Dialog) and ensure that the

dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled. The
coordinate capture dialog appears as shown in Figure figure_coordinate_capture_1. Alternatively, you can

also go to Vector → Coordinate Capture and see if Coordinate Capture is enabled.

4. Click on the Click to the select the CRS to use for coordinate display icon and select a different CRS from the one you
selected above.

5. To start capturing coordinates, click on [Start capture]. You can now click anywhere on the map canvas
and the plugin will show the coordinates for both of your selected CRS.

6. To enable mouse coordinate tracking, click the mouse tracking icon.

7. You can also copy selected coordinates to the clipboard.

.

20.4 DB Manager Plugin

The DB Manager Plugin is officially part of the QGIS core and is intended to replace the SPIT Plugin and,

additionally, to integrate all other database formats supported by QGIS in one user interface. The DB Manager

Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and it will
import your layer into your spatial database. You can drag and drop tables between spatial databases and they will
get imported. You can also use the DB Manager to execute SQL queries against your spatial database and then
view the spatial output for queries by adding the results to QGIS as a query layer.

The Database menu allows you to connect to an existing database, to start the SQL window and to exit the DB
Manager Plugin. Once you are connected to an existing database, the menus Schema and Table additionally
appear.

The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g., PostGIS
2), to start a TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
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Rysunek 20.7: DB Manager dialog

to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

.

20.5 Dxf2Shp Converter Plugin

The dxf2shape converter plugin can be used to convert vector data from DXF to shapefile format. It requires the
following parameters to be specified before running:

Rysunek 20.8: Dxf2Shape Converter Plugin

• Input DXF file: Enter the path to the DXF file to be converted.

• Output Shp file: Enter desired name of the shapefile to be created.

• Output file type: Specify the geometry type of the output shapefile. Currently supported types are polyline,
polygon, and point.
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• Export text labels: When this checkbox is enabled, an additional shapefile point layer will be created, and
the associated DBF table will contain information about the “TEXT” fields found in the DXF file, and the
text strings themselves.

20.5.1 Using the Plugin

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see The Plugins Dialog) and click on the
Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog appears,

as shown in Figure_dxf2shape_1.

2. Enter the input DXF file, a name for the output shapefile and the shapefile type.

3. Enable the Export text labels checkbox if you want to create an extra point layer with labels.

4. Click [OK].

.

20.6 eVis Plugin

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see The Plugins Dialog).

The eVis plugin is made up of three modules: the ‘Database Connection tool’, ‘Event ID tool’, and the ‘Event
Browser’. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

20.6.1 Event Browser

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Launch the Event Browser module

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.
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Understanding the Display window

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

Rysunek 20.9: The eVis display window

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab, then when you double-click
on the value of the field containing the path to the file, the application to open the file will be launched to
view or hear the contents of the file. If the file extension is recognized, the attribute data will be displayed
in green.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.

Understanding the Options window

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must
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Rysunek 20.10: The eVis Options window
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be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Specifying the location
and name of a photograph below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_2 (A) will be
appended.

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.

6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked, the path rules
will only apply to photographs, and other documents will ignore the base path parameter.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Reset values: Resets the values on this line to the default setting.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the [Reset] buttons.

10. Save: This will save the settings without closing the Options pane.

Understanding the Configure External Applications window

Rysunek 20.11: The eVis External Applications window

1. File reference table: A table containing file types that can be opened using eVis. Each file type needs a
file extension and the path to an application that can open that type of file. This provides the capability of
opening a broad range of files such as movies, sound recordings, and text documents instead of only images.

2. Add new file type: Add a new file type with a unique extension and the path for the application that can
open the file.

3. Delete current row: Delete the file type highlighted in the table and defined by a file extension and a path
to an associated application.
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20.6.2 Specifying the location and name of a photograph

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

20.6.3 Specifying the location and name of other supporting documents

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

20.6.4 Using the Event Browser

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

To close the Event Browser window, click on the [Close] button from the Display window.

20.6.5 Event ID Tool

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.
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Launch the Event ID module

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

20.6.6 Database connection

The ‘Database Connection’ module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.

eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Launch the Database Connection module

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Connect to a database

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected ‘MS Access’ as
the database type. If the database resides on your desktop, you should enter “localhost”.

Enter the name of the database in the Database Name textbox. If you selected ‘ODBC’ as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Database Type: A drop-down list to specify the type of database that will be used.

2. Database Host: The name of the database host.

3. Port: The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name: The name of the database.

5. Connect: A button to connect to the database using the parameters defined above.

6. Output Console: The console window where messages related to processing are displayed.

7. Username: Username for use when a database is password protected.

8. Password: Password for use when a database is password protected.

9. Predefined Queries: Tab to open the “Predefined Queries” window.

10. Database Connection: Tab to open the “Database Connection” window.
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Rysunek 20.12: The eVis Database connection window

11. SQL Query: Tab to open the “SQL Query” window.

12. Help: Displays the online help.

13. OK: Closes the main “Database Connection” window.

Running SQL queries

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. SQL Query Text Window: A screen to type SQL queries.

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Console Window: The console window where messages related to processing are displayed.

4. Help: Displays the online help.

5. OK: Closes the main Database Connection window.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
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Rysunek 20.13: The eVis SQL query tab

created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Wskazówka: Creating a vector layer from a Microsoft Excel Worksheet
When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Running predefined queries

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.
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Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

Rysunek 20.14: The eVis Predefined Queries tab

1. Open File: Launches the “Open File” file browser to search for the XML file holding the predefined queries.

2. Predefined Queries: A drop-down list with all of the queries defined by the predefined queries XML file.

3. Query description: A short description of the query. This description is from the predefined queries XML
file.

4. Console Window: The console window where messages related to processing are displayed.

5. Help: Displays the online help.

6. OK: Closes the main “Database Connection” window.

XML format for eVis predefined queries

The XML tags read by eVis
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Tag Description
query Defines the beginning and end of a query statement.
shortde-
scription

A short description of the query that appears in the eVis drop-down menu.

descrip-
tion

A more detailed description of the query displayed in the Predefined Query text window.

database-
type

The database type, defined in the Database Type drop-down menu in the Database Connection
tab.

database-
port

The port as defined in the Port text box in the Database Connection tab.

database-
name

The database name as defined in the Database Name text box in the Database Connection tab.

databaseuser-
name

The database username as defined in the Username text box in the Database Connection tab.

databasep-
assword

The database password as defined in the Password text box in the Database Connection tab.

sqlstate-
ment

The SQL command.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
the database without running the database connection routine in the Database Connection tab.

A complete sample XML file with three queries is displayed below:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
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<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

.

20.7 fTools Plugin

The goal of the fTools Python plugin is to provide a one-stop resource for many common vector-based GIS tasks,
without the need for additional software, libraries, or complex work-arounds. It provides a growing suite of spatial
data management and analysis functions that are both fast and functional.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see The Plugins Dialog). When enabled, the fTools plugin
adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry and
Geoprocessing Tools, as well as several useful Data Management Tools.

20.7.1 Analysis tools

Icon Tool Purpose

Distance
matrix

Measure distances between two point layers, and output results as a) Square distance
matrix, b) Linear distance matrix, or c) Summary of distances. Can limit distances to
the k nearest features.

Sum line
length

Calculate the total sum of line lengths for each polygon of a polygon vector layer.

Points in
polygon

Count the number of points that occur in each polygon of an input polygon vector layer.

List unique
values

List all unique values in an input vector layer field.

Basic
statistics

Compute basic statistics (mean, std dev, N, sum, CV) on an input field.

Nearest
neighbor
analysis

Compute nearest neighbor statistics to assess the level of clustering in a point vector
layer.

Mean
coordinate(s)

Compute either the normal or weighted mean center of an entire vector layer, or
multiple features based on a unique ID field.

Line
intersections

Locate intersections between lines, and output results as a point shapefile. Useful for
locating road or stream intersections, ignores line intersections with length > 0.

Table Ftools 1: fTools Analysis tools
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20.7.2 Research tools

Icon Tool Purpose

Random selection Randomly select n number of features, or n percentage of features.

Random selection
within subsets

Randomly select features within subsets based on a unique ID field.

Random points Generate pseudo-random points over a given input layer.

Regular points Generate a regular grid of points over a specified region and export them as a
point shapefile.

Vector grid Generate a line or polygon grid based on user-specified grid spacing.

Select by location Select features based on their location relative to another layer to form a new
selection, or add or subtract from the current selection.

Polygon from layer
extent

Create a single rectangular polygon layer from the extent of an input raster or
vector layer.

Table Ftools 2: fTools Research tools

20.7.3 Geoprocessing tools

Icon Tool Purpose

Convex hull(s) Create minimum convex hull(s) for an input layer, or based on an ID field.

Buffer(s) Create buffer(s) around features based on distance, or distance field.

Intersect Overlay layers such that output contains areas where both layers intersect.

Union Overlay layers such that output contains intersecting and non-intersecting areas.

Symmetrical
difference

Overlay layers such that output contains those areas of the input and difference
layers that do not intersect.

Clip Overlay layers such that output contains areas that intersect the clip layer.

Difference Overlay layers such that output contains areas not intersecting the clip layer.

Dissolve Merge features based on input field. All features with identical input values are
combined to form one single feature.

Eliminate sliver
polygons

Merges selected features with the neighbouring polygon with the largest area or
largest common boundary.

Table Ftools 3: fTools Geoprocessing tools
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20.7.4 Geometry tools

Icon Tool Purpose

Check geometry
validity

Check polygons for intersections, closed holes, and fix node ordering.

Export/Add
geometry columns

Add vector layer geometry info to point (XCOORD, YCOORD), line
(LENGTH), or polygon (AREA, PERIMETER) layer.

Polygon centroids Calculate the true centroids for each polygon in an input polygon layer.

Delaunay
triangulation

Calculate and output (as polygons) the Delaunay triangulation of an input point
vector layer.

Voronoi polygons Calculate Voronoi polygons of an input point vector layer.

Simplify geometry Generalize lines or polygons with a modified Douglas-Peucker algorithm.
Densify geometry Densify lines or polygons by adding vertices.

Multipart to
singleparts

Convert multipart features to multiple singlepart features. Creates simple
polygons and lines.

Singleparts to
multipart

Merge multiple features to a single multipart feature based on a unique ID field.

Polygons to lines Convert polygons to lines, multipart polygons to multiple singlepart lines.

Lines to polygons Convert lines to polygons, multipart lines to multiple singlepart polygons.

Extract nodes Extract nodes from line and polygon layers and output them as points.

Table Ftools 4: fTools Geometry tools

Informacja: The Simplify geometry tool can be used to remove duplicate nodes in line and polygon geometries.
Just set the Simplify tolerance parameter to 0 and this will do the trick.

20.7.5 Data management tools

Icon Tool Purpose

Define
current
projection

Specify the CRS for shapefiles whose CRS has not been defined.

Join
attributes by
location

Join additional attributes to vector layer based on spatial relationship. Attributes from
one vector layer are appended to the attribute table of another layer and exported as a
shapefile.

Split vector
layer

Split input layer into multiple separate layers based on input field.

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer type
(point, line, area).

Create
spatial index

Create a spatial index for OGR- supported formats.

Table Ftools 5: fTools Data management tools

.
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20.8 GDAL Tools Plugin

20.8.1 What is GDAL Tools?

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a VRT (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

The GDAL Library

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDALTools plugin offers an easy interface to the tools, exposing only the most popular options.

20.8.2 List of GDAL tools

Rysunek 20.15: The GDALTools menu list

Projections

Warp
(Reproject)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information, you can read on the GDAL
website http://www.gdal.org/gdalwarp.html.

Assign
projection

This tool allows you to assign projection to rasters that are already georeferenced but miss
projection information. Also with its help, it is possible to alter existing projection definitions.
Both single file and batch mode are supported. For more information, please visit the utility
page at the GDAL site, http://www.gdal.org/gdalwarp.html.

Extract
projection

This utility helps you to extract projection information from an input file. If you want to
extract projection information from a whole directory, you can use the batch mode. It creates
both .prj and .wld files.
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Conversion

Rasterize
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR-supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided. For
more information see http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

This utility creates vector polygons for all connected regions of pixels in the raster sharing a
common pixel value. Each polygon is created with an attribute indicating the pixel value of that
polygon. The utility will create the output vector datasource if it does not already exist,
defaulting to ESRI shapefile format. See also http://www.gdal.org/gdal_polygonize.html.

Translate
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsetting, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html.

RGB
to PCT

This utility will compute an optimal pseudocolor table for a given RGB image using a median
cut algorithm on a downsampled RGB histogram. Then it converts the image into a
pseudocolored image using the color table. This conversion utilizes Floyd-Steinberg dithering
(error diffusion) to maximize output image visual quality. The utility is also described at
http://www.gdal.org/rgb2pct.html.

PCT
to RGB

This utility will convert a pseudocolor band on the input file into an output RGB file of the
desired format. For more information, see http://www.gdal.org/pct2rgb.html.

Extraction

Con-
tour

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html, you can find more information.

Clip-
per

This utility allows you to clip (extract subset) rasters using selected extent or based on mask layer
bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analysis

Sieve This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be written
back to the existing raster band, or copied into a new file. For more information, see
http://www.gdal.org/gdal_sieve.html.

Near
Black

This utility will scan an image and try to set all pixels that are nearly black (or nearly white)
around the edge to exactly black (or white). This is often used to “fix up” lossy compressed
aerial photos so that color pixels can be treated as transparent when mosaicing. See also
http://www.gdal.org/nearblack.html.

Fill
nodata

This utility fills selected raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the areas. On http://www.gdal.org/gdal_fillnodata.html, you can
find more information.

Proximity This utility generates a raster proximity map indicating the distance from the center of each
pixel to the center of the nearest pixel identified as a target pixel. Target pixels are those in
the source raster for which the raster pixel value is in the set of target pixel values. For more
information see http://www.gdal.org/gdal_proximity.html.

Grid (In-
terpolation)

This utility creates a regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, and you can choose
from various interpolation methods. The utility is also described on the GDAL website,
http://www.gdal.org/gdal_grid.html.

DEM
(Terrain
models)

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a
color relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness
map from any GDAL-supported elevation raster. For more information, see
http://www.gdal.org/gdaldem.html.

Miscellaneous

Build Virtual
Raster (Catalog)

This program builds a VRT (Virtual Dataset) that is a mosaic of the list of input GDAL
datasets. See also http://www.gdal.org/gdalbuildvrt.html.

Merge This utility will automatically mosaic a set of images. All the images must be in the
same coordinate system and have a matching number of bands, but they may be
overlapping, and at different resolutions. In areas of overlap, the last image will be
copied over earlier ones. The utility is also described at
http://www.gdal.org/gdal_merge.html.

Information This utility lists various information about a GDAL-supported raster dataset. On
http://www.gdal.org/gdalinfo.html, you can find more information.

Build
Overviews

The gdaladdo utility can be used to build or rebuild overview images for most supported
file formats with one of several downsampling algorithms. For more information, see
http://www.gdal.org/gdaladdo.html.

Tile Index This utility builds a shapefile with a record for each input raster file, an attribute
containing the filename, and a polygon geometry outlining the raster. See also
http://www.gdal.org/gdaltindex.html.
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GDAL Tools Settings

Use this dialog to embed your GDAL variables.

.

20.9 Georeferencer Plugin

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine coordinates.

Features
Icon Purpose Icon Purpose

Open raster Start georeferencing

Generate GDAL Script Load GCP Points

Save GCP Points As Transformation settings

Add Point Delete Point

Move GCP Point Pan

Zoom In Zoom Out

Zoom To Layer Zoom Last

Zoom Next Link Georeferencer to QGIS

Link QGIS to Georeferencer Full histogram stretch

Local histogram stretch

Table Georeferencer 1: Georeferencer Tools

20.9.1 Usual procedure

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm)), which corre-
spond with the selected point on the image, two alternative procedures can be used:

• The raster itself sometimes provides crosses with coordinates “written” on the image. In this case, you can
enter the coordinates manually.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

The usual procedure for georeferencing an image involves selecting multiple points on the raster, specifying their
coordinates, and choosing a relevant transformation type. Based on the input parameters and data, the plugin will
compute the world file parameters. The more coordinates you provide, the better the result will be.

The first step is to start QGIS, load the Georeferencer Plugin (see The Plugins Dialog) and click on Raster →
Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.
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Rysunek 20.16: Georeferencer Plugin Dialog

Entering ground control points (GCPs)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Click on a point in the raster image and enter the X and Y coordinates manually.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continue entering points. You should have at least four points, and the more coordinates you can provide,
the better the result will be. There are additional tools on the plugin dialog to zoom and pan the working
area in order to locate a relevant set of GCP points.

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.

Defining the transformation settings

After you have added your GCPs to the raster image, you need to define the transformation settings for the
georeferencing process.
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Rysunek 20.17: Add points to the raster image

Rysunek 20.18: Defining the georeferencer transformation settings
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Available Transformation algorithms

Depending on how many ground control points you have captured, you may want to use different transformation
algorithms. Choice of transformation algorithm is also dependent on the type and quality of input data and the
amount of geometric distortion that you are willing to introduce to the final result.

Currently, the following Transformation types are available:

• The Linear algorithm is used to create a world file and is different from the other algorithms, as it does
not actually transform the raster. This algorithm likely won’t be sufficient if you are dealing with scanned
material.

• The Helmert transformation performs simple scaling and rotation transformations.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves colliniarity and allows scaling, translation and rotation only.

• The Thin Plate Spline (TPS) algorithm is a more modern georeferencing method, which is able to intro-
duce local deformations in the data. This algorithm is useful when very low quality originals are being
georeferenced.

• The Projective transformation is a linear rotation and translation of coordinates.

Define the Resampling method

The type of resampling you choose will likely depending on your input data and the ultimate objective of the
exercise. If you don’t want to change statistics of the image, you might want to choose ‘Nearest neighbour’,
whereas a ‘Cubic resampling’ will likely provide a more smoothed result.

It is possible to choose between five different resampling methods:

1. Nearest neighbour

2. Linear

3. Cubic

4. Cubic Spline

5. Lanczos

Define the transformation settings

There are several options that need to be defined for the georeferenced output raster.

• The Create world file checkbox is only available if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the Output raster field
is not activated, because only a new world file will be created.

• For all other transformation types, you have to define an Output raster. As default, a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.

• As a next step, you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see Praca z układami współrzędnych).

• If you like, you can generate a pdf map and also a pdf report. The report includes information about the
used transformation parameters, an image of the residuals and a list with all GCPs and their RMS errors.

• Furthermore, you can activate the Set Target Resolution checkbox and define the pixel resolution of the
output raster. Default horizontal and vertical resolution is 1.

• The Use 0 for transparency when needed can be activated, if pixels with the value 0 shall be visualized
transparent. In our example toposheet, all white areas would be transparent.
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• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Show and adapt raster properties

Clicking on the Raster properties dialog in the Settings menu opens the raster properties of the layer that you want
to georeference.

Configure the georeferencer

• You can define whether you want to show GCP coordiniates and/or IDs.

• As residual units, pixels and map units can be chosen.

• For the PDF report, a left and right margin can be defined and you can also set the paper size for the PDF
map.

• Finally, you can activate to Show Georeferencer window docked.

Running the transformation

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

.

20.10 Interpolation Plugin

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.

• Interpolation attribute: Select the attribute column to be used for interpolation or enable the Use
Z-Coordinate checkbox to use the layer’s stored Z values.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’.

• Number of columns/rows: Specify the number of rows and columns for the output raster file.

• Output file: Specify a name for the output raster file.

• Add result to project to load the result into the map canvas.

20.10.1 Using the plugin

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see The Plugins Dialog) and click on the Raster →

Interpolation → Interpolation , which appears in the QGIS menu bar. The Interpolation plugin dialog
appears as shown in Figure_interpolation_1.
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Rysunek 20.19: Interpolation Plugin

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Select an interpolation method (e.g., ‘Triangulated Irregular Network (TIN)’), and specify a cell size of
5000 as well as the raster output filename (e.g., elevation_tin).

5. Click [OK].

.

20.11 Offline Editing Plugin

For data collection, it is a common situation to work with a laptop or a cell phone offline in the field. Upon return-
ing to the network, the changes need to be synchronized with the master datasource (e.g., a PostGIS database). If
several persons are working simultaneously on the same datasets, it is difficult to merge the edits by hand, even if
people don’t change the same features.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

20.11.1 Using the plugin

• Open some vector layers (e.g., from a PostGIS or WFS-T datasource).

• Save it as a project.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Edit the layers offline.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.

.
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Rysunek 20.20: Create an offline project from PostGIS or WFS layers

20.12 Oracle Spatial GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

This will load the raster into the default GDAL_IMPORT table, as a column named RASTER.

20.12.1 Managing connections

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see The Plugins Dialog). The
first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains the

data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection.

• Database instance: Enter the name of the database that you will connect to.

• Username: Specify your own username that you will use to access the database.

• Password: Provide the password associated with your username that is required to access the database.
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Rysunek 20.21: Create Oracle connection dialog

Now, back on the main Oracle Spatial GeoRaster dialog window (see Figure_oracle_raster_2), use the drop-down
list to choose one connection, and use the [Connect] button to establish a connection. You may also [Edit] the
connection by opening the previous dialog and making changes to the connection information, or use the [Delete]
button to remove the connection from the drop-down list.

20.12.2 Selecting a GeoRaster

Once a connection has been established, the subdatasets window will show the names of all the tables that contain
GeoRaster columns in that database in the format of a GDAL subdataset name.

Click on one of the listed subdatasets and then click on [Select] to choose the table name. Now another list of
subdatasets will show with the names of GeoRaster columns on that table. This is usually a short list, since most
users will not have more than one or two GeoRaster columns on the same table.

Click on one of the listed subdatasets and then click on [Select] to choose one of the table/column combinations.
The dialog will now show all the rows that contain GeoRaster objects. Note that the subdataset list will now show
the Raster Data Table and Raster Id pairs.

At any time, the selection entry can be edited in order to go directly to a known GeoRaster or to go back to the
beginning and select another table name.

Rysunek 20.22: Select Oracle GeoRaster dialog
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The selection data entry can also be used to enter a WHERE clause at the end of the iden-
tification string (e.g., geor:scott/tiger@orcl,gdal_import,raster,geoid=). See
http://www.gdal.org/frmt_georaster.html for more information.

20.12.3 Displaying GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and the next time it opens, it will keep the same
connection and will show the same previous list of subdatasets, making it very easy to open up another image
from the same context.

Informacja: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated
outside of QGIS using Oracle PL/SQL or gdaladdo.

The following is an example using gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

This is an example using PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

.

20.13 Raster Terrain Analysis Plugin

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Description of the analysis:

• Slope: Calculates the slope angle for each cell in degrees (based on first- order derivative estimation).

• Aspect: Exposition (starting with 0 for north direction, in degrees counterclockwise).

• Hillshade: Creates a shaded map using light and shadow to provide a more three-dimensional appearance
for a shaded relief map.

• Ruggedness Index: A quantitative measurement of terrain heterogeneity as described by Riley et al. (1999).
It is calculated for every location by summarizing the change in elevation within the 3x3 pixel grid.

• Relief: Creates a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors by analysing the frequency distribution.

20.13.1 Using the plugin

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.
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Rysunek 20.23: Raster Terrain Modelling Plugin (slope calculation)

2. Load the Raster Terrain Analysis plugin in the Plugin Manager (see The Plugins Dialog).

3. Select an analysis method from the menu (e.g., Raster → Terrain Analysis → Slope). The Slope dialog
appears as shown in Figure_raster_terrain_1.

4. Specify an output file path, and an output file type.

5. Click [OK].

.

20.14 Heatmap Plugin

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.

20.14.1 Activate the Heatmap plugin

First this core plugin needs to be activated using the Plugin Manager (see The Plugins Dialog). After activation,

the heatmap icon can be found in the Raster Toolbar, and under the Raster → Heatmap menu.

Select the menu View → Toolbars → Raster to show the Raster Toolbar if it is not visible.

20.14.2 Using the Heatmap plugin

Clicking the Heatmap tool button opens the Heatmap plugin dialog (see figure_heatmap_2).

The dialog has the following options:

• Input point layer: Lists all the vector point layers in the current project and is used to select the layer to be
analysed.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be choosen, in
most cases GeoTIFF is the best format to choose.

• Radius: Is used to specify the heatmap search radius (or kernel bandwidth) in meters or map units. The
radius specifies the distance around a point at which the influence of the point will be felt. Larger values
result in greater smoothing, but smaller values may show finer details and variation in point density.

When the Advanced checkbox is checked, additional options will be available:
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• Rows and Columns: Used to change the dimensions of the output raster. These values are also linked to
the Cell size X and Cell size Y values. Increasing the number of rows or columns will decrease the cell size
and increase the file size of the output file. The values in Rows and Columns are also linked, so doubling
the number of rows will automatically double the number of columns and the cell sizes will also be halved.
The geographical area of the output raster will remain the same!

• Cell size X and Cell size Y: Control the geographic size of each pixel in the output raster. Changing these
values will also change the number of Rows and Columns in the output raster.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Decay ratio: Can be used with Triangular kernels to further control how heat from a feature decreases with
distance from the feature.

– A value of 0 (=minimum) indicates that the heat will be concentrated in the centre of the given radius
and completely extinguished at the edge.

– A value of 0.5 indicates that pixels at the edge of the radius will be given half the heat as pixels at the
centre of the search radius.

– A value of 1 means the heat is spread evenly over the whole search radius circle. (This is equivalent
to the ‘Uniform’ kernel.)

– A value greater than 1 indicates that the heat is higher towards the edge of the search radius than at the
centre.

The input point layer may also have attribute fields which can affect how they influence the heatmap:

• Use radius from field: Sets the search radius for each feature from an attribute field in the input layer.

• Use weight from field: Allows input features to be weighted by an attribute field. This can be used to
increase the influence certain features have on the resultant heatmap.

When an output raster file name is specified, the [OK] button can be used to create the heatmap.

20.14.3 Tutorial: Creating a Heatmap

For the following example, we will use the airports vector point layer from the QGIS sample
dataset (see Przykładowe dane). Another exellent QGIS tutorial on making heatmaps can be found at
http://qgis.spatialthoughts.com.

In Figure_Heatmap_1, the airports of Alaska are shown.

1. Select the Heatmap tool button to open the Heatmap dialog (see Figure_Heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Leave the Output format as the default format, GeoTIFF.

5. Change the Radius to 1000000 meters.

6. Click on [OK] to create and load the airports heatmap (see Figure_Heatmap_3).

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.
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Rysunek 20.24: Airports of Alaska

Rysunek 20.25: The Heatmap Dialog
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Rysunek 20.26: The heatmap after loading looks like a grey surface

1. Open the properties dialog of the heatmap_airports layer (select the layer heatmap_airports,
open the context menu with the right mouse button and select Properties).

2. Select the Style tab.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.

5. Click the [Load] button to fetch the minimum and maximum values from the raster, then click the [Classify]
button.

6. Press [OK] to update the layer.

The final result is shown in Figure_Heatmap_4.

.
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Rysunek 20.27: Styled heatmap of airports of Alaska

20.15 MetaSearch Catalogue Client

20.15.1 Introduction

MetaSearch is a QGIS plugin to interact with metadata catalogue services, supporting the OGC Catalogue Service
for the Web (CSW) standard.

MetaSearch provides an easy and intuitive approach and user-friendly interface to searching metadata catalogues
within QGIS.

20.15.2 Installation

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.
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Install MetaSearch from the QGIS plugin manager, or manually from http://plugins.qgis.org/plugins/MetaSearch.

20.15.3 Working with Metadata Catalogues in QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse, and query metadata about data, services, and other potential resources.

Startup

To start MetaSearch, click the MetaSearch icon or select Web / MetaSearch / MetaSearch via the QGIS main
menu. The MetaSearch dialog will appear. The main GUI consists of two tabs: ‘Services’ and ‘Search’.

Managing Catalogue Services

The ‘Services’ tab allows the user to manage all available catalogue services. MetaSearch provides a default list
of Catalogue Services, which can be added by pressing ‘Add default services’ button.

To all listed Catalogue Service entries, click the dropdown select box.

To add a Catalogue Service entry, click the ‘New’ button, and enter a Name for the service, as well as the
URL/endpoint. Note that only the base URL is required (not a full GetCapabilities URL). Clicking ok will add
the service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the ‘Edit’ button, and
modify the Name or URL values, then click ok.

To delete a Catalogue Service entry, select the entry you would like to delete and click the ‘Delete’ button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
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<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the ‘Load’ button. A new window will appear; click the ‘Browse’ button and
navigate to the XML file of entries you wish to load and click ‘Open’. The list of entries will be displayed. Select
the entries you wish to add from the list and click ‘Load’.

The ‘Service info’ button displays information about the selected Catalogue Service such as service identification,
service provider and contact information. If you would like to view the raw XML response, click the ‘GetCapa-
bilities response’ button. A separate window will open displaying Capabilities XML.

Searching Catalogue Services

The ‘Search’ tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

The following search parameters are available:

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on. The default bounding box is the map view / canvas.
Click ‘Set global’ to do a global search, or enter custom values as desired

• Records: the number of records to return when searching. Default is 10 records

Clicking the ‘Search’ button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the ‘View search results as XML’ button opens a window with the service
response in raw XML format.

Clicking a result will show the record’s abstract in the ‘Abstract’ window and provides the following options:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser
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• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate ‘Add to
WMS/WMTS|WFS|WCS’ buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear

Settings

You can fine tune MetaSearch with the following settings:

• Results paging: when searching metadata catalogues, the number of results to show per page

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

.

20.16 Road Graph Plugin

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Main features:

• Calculates path, as well as length and travel time.

• Optimizes by length or by travel time.

• Exports path to a vector layer.

• Highlights roads directions (this is slow and used mainly for debug purposes and for the settings testing).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

In the layer attribute table, the following fields can be used:

• Speed on road section (numeric field).

• Direction (any type that can be cast to string). Forward and reverse directions correspond to a one-way road,
both directions indicate a two-way road.
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Rysunek 20.28: Road Graph Plugin

If some fields don’t have any value or do not exist, default values are used. You can change defaults and some
plugin settings in the plugin settings dialog.

20.16.1 Using the plugin

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

After setting the Time unit, Distance unit and Topology tolerance, you can choose the vector layer in the Trans-
portation layer tab. Here you can also choose the Direction field and Speed field. In the Default settings tab, you
can set the Direction for the calculation.

Finally, in the Shortest Path panel, select a Start and a Stop point in the road network layer and click on [Calcu-
late].

.

20.17 Spatial Query Plugin

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Possible operators are:

• Contains

• Equals

• Overlap
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Rysunek 20.29: Road graph plugin settings

• Crosses

• Intersects

• Is disjoint

• Touches

• Within

20.17.1 Using the plugin

As an example, we want to find regions in the Alaska dataset that contain airports. The following steps are
necessary:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see The Plugins Dialog) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Select the layer regions as the source layer and airports as the reference feature layer.

4. Select ‘Contains’ as the operator and click [Apply].

Now you get a list of feature IDs from the query and you have several options, as shown in figure_spatial_query_1.

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• Additionally, you can Zoom to item or display Log messages.

.
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Rysunek 20.30: Spatial Query analysis - regions contain airports

20.18 SPIT Plugin

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins

menu, in the Installed menu check the box next to the SPIT and click [OK].

To import a shapefile, use Database → Spit → Import Shapefiles to PostgreSQL from the menu bar to open the
SPIT - Shapefile to PostGIS Import Tool dialog. Select the PostGIS database you want to connect to and click on
[Connect]. If you want, you can define or change some import options. Now you can add one or more files to the
queue by clicking on the [Add] button. To process the files, click on the [OK] button. The progress of the import
as well as any errors/warnings will be displayed as each shapefile is processed. .

20.19 SQL Anywhere Plugin

SQL Anywhere is a proprietary relational database management system (RDBMS) from Sybase. SQL Anywhere
provides spatial support, including OGC, shapefiles and built-in functions to export to KML, GML and SVG
formats.

SQL Anywhere allows you to connect to spatially enabled SQL Anywhere databases. The Add SQL Anywhere
layer dialog is similar in functionality to the dialogs for PostGIS and SpatiaLite.

.
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Rysunek 20.31: Using SPIT Plugin to import Shape files to PostGIS

Rysunek 20.32: SQL Anywhere dialog (KDE)
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Rysunek 20.33: The Topology Checker Plugin

20.19. SQL Anywhere Plugin 709



QGIS User Guide, Wydanie 2.6

20.20 Topology Checker Plugin

Topology describes the relationships between points, lines and polygons that represent the features of a geographic
region. With the Topology Checker plugin, you can look over your vector files and check the topology with several
topology rules. These rules check with spatial relations whether your features ‘Equal’, ‘Contain’, ‘Cover’, are
‘CoveredBy’, ‘Cross’, are ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’ or are ‘Within’ each other. It depends on
your individual questions which topology rules you apply to your vector data (e.g., normally you won’t accept
overshoots in line layers, but if they depict dead-end streets you won’t remove them from your vector layer).

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

It is very simple to create topology rules with the Topology Checker plugin.

On point layers the following rules are available:

• Must be covered by: Here you can choose a vector layer from your project. Points that aren’t covered by
the given vector layer occur in the ‘Error’ field.

• Must be covered by endpoints of: Here you can choose a line layer from your project.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• Must not have duplicates: Whenever a point is represented twice or more, it will occur in the ‘Error’ field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part-geometries: All multi-part points are written into the ‘Error’ field.

On line layers, the following rules are available:

• End points must be covered by: Here you can select a point layer from your project.

• Must not have dangles: This will show the overshoots in the line layer.

• Must not have duplicates: Whenever a line feature is represented twice or more, it will occur in the ‘Error’
field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. All multi-part lines are written into the
‘Error’ field.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
psuedo node.

On polygon layers, the following rules are available:

• Must contain: Polygon layer must contain at least one point geometry from the second layer.

• Must not have duplicates: Polygons from the same layer must not have identical geometries. Whenever a
polygon feature is represented twice or more it will occur in the ‘Error’ field.

• Must not have gaps: Adjacent polygons should not form gaps between them. Administrative boundaries
could be mentioned as an example (US state polygons do not have any gaps between them...).

• Must not have invalid geometries: Checks whether the geometries are valid. Some of the rules that define
a valid geometry are:

– Polygon rings must close.

– Rings that define holes should be inside rings that define exterior boundaries.

– Rings may not self-intersect (they may neither touch nor cross one another).

– Rings may not touch other rings, except at a point.
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• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. For example, a country consisting of
multiple islands can be represented as a multi-polygon.

• Must not overlap: Adjacent polygons should not share common area.

• Must not overlap with: Adjacent polygons from one layer should not share common area with polygons
from another layer.

.

20.21 Zonal Statistics Plugin

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). You can calculate the sum, the mean value and the total count of the pixels that are within a
polygon. The plugin generates output columns in the vector layer with a user-defined prefix.

Rysunek 20.34: Zonal statistics dialog (KDE)

.
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Pomoc i wsparcie

21.1 Lista mailingowa

QGIS jest ciągle rozwijany i może w związku z tym nie zawsze zachowywać się tak, jakbyś tego oczekiwał.
Najlepszym sposobem uzyskania pomocy jest skorzystanie z listy qgis-users. W ten sposób twoje pytanie zobaczy
większa ilość osób, a z odpowiedzi będą mogli skorzystać również inni.

21.1.1 qgis-users

Ta lista służy do ogólnych dyskusji o QGIS oraz do bardziej szczegółowych kwestii dotyczących jego instalacji i
używania. Do listy qgis-users możesz zapisać się pod adrsem: http://lists.osgeo.org/mailman/listinfo/qgis-user

21.1.2 fossgis-talk-liste

Dla użytkowników niemieckojęzycznych FOSSGIS e.V. prowadzi listę fossgis-talk-liste. Lista ta służy do rozmów
o oprogramowaniu GIS o otwartym źródle, włączając w to QGIS. Możesz się zapisać do listy fossgis-talk-liste
pod adresem: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

21.1.3 qgis-developer

Jeśli jesteś programistą i napotkałeś na problemy natury technicznej, dołącz do listy mailingowej qgis-developer
pod adresem : http://lists.osgeo.org/mailman/listinfo/qgis-developer

21.1.4 qgis-commit

Za każdym razem, gdy ktoś dodaje coś do repozytorium kodu źródłowego QGIS, na tę listę wysyłany jest
email. Jeśli chcesz być na bieżąco z kodem źródłowym, możesz zapisać się na tę listę pod adresem:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

21.1.5 qgis-trac

Na tę listę wysyłane są mailowe powiadomienia związane z zarządzaniem projektem, w tym zawierające
zgłoszenia błędów, zadania i zapotrzebowanie na danego typu narzędzia. Możesz zapisać się do tej listy pod
adresem: http://lists.osgeo.org/mailman/listinfo/qgis-trac
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21.1.6 qgis-community-team

Ta lista obejmuje temtykę dokumentacji, pomocy kontekstowej, podręcznika, i materiałów online, takich
jak strony projektu, blog, listy mailingowe, forum i tłumaczenia. Gdybyś chciał popracować nad po-
dręcznikiem, ta lista jest dobrym miejscem do zadawania pytań. Możesz do niej dołączyć pod adresem:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

21.1.7 qgis-release-team

Ta lista dotyczy tematów związanych z tworzeniem kolejnych wersji programu, tworzeniem paczek binarnych
dla różnych systemów operacyjnych i ogłaszania nowych wersji. możesz do niej dołączyć pod adresem:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

21.1.8 qgis-tr

Ta lista dotyczy tłamaczeń. Jeśli chciałbyć przetłumaczyć podręcznik lub graficzny interfejs użytkown-
ika (GUI), to jest właściwe miejsce do zadawania pytań. Możesz się do niej zapisać pod adresem:
http://lists.osgeo.org/mailman/listinfo/qgis-tr

21.1.9 qgis-edu

Lista ta dotyczy działań edukacyjnych związanych z QGIS. Gdybyś chciał opracować jakieś materiały edukacyjne,
to jest to właściwe miejsce do zadawania związanych z tym pytań. Możesz się zapisać na tę listę pod adresem:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

21.1.10 qgis-psc

Lista ta używana jest to dyskusji nad sprawami Komitetu Sterującego, dotyczącymi ogólnego zarządzania i
kierunku rozwoju QGIS. Można się do niej zapisać pod adrsem: http://lists.osgeo.org/mailman/listinfo/qgis-psc

Zapraszamy do zapisania się do dowolnych list. Prosimy o wnoszenie własnego wkładu poprzez udzielanie
odpowiedzi na pytania i dzielenie się własnym doświadczeniem. Prosimy zwrócić uwagę na to, że qgis-commit
i qgis-trac utworzone zostały wyłącznie w celu powiadamiania użytkowników, a nie przyjmowania postów
użytkowników.

21.2 IRC

Jesteśmy równiez obecnie na IRC - możesz się z nami spotkać na kanale #qgis na irc.freenode.net. Prosimy o danie
nam chwili na odpowiedź na wasze pytania, bo użytkownicy kanału mogą być czymś zajęci i zajmuje to zwykle
jakiś czas, zanim zobaczą nowe pytanie. Jeśli ominęła cię jakaś dyskusja na IRC, nie ma problemu! Wszystkie
dyskusje są zapisywane, więc możesz do nich łatwo powrócić. Po prostu odwiedź stronę http://qgis.org/irclogs.

Możliwe jest również uzyskanie komercyjnego wsparcia dla QGIS. Więcej informacji znajdziesz na stronie
http://qgis.org/en/commercial-support.html .

21.3 BugTracker

Lista qgis-users świetnie nadaje się do zadawania pytań ‘jak w QGIS zrobić ABC’, ale możesz przecież chcieć
powiadomić nas o jakimś błędzie QGISa. Do przesłania raportu o błędzie QGIS możesz wykorzystać tzw. bug
tracker pod adrsem http://hub.qgis.org/projects/quantum-gis/issues. Gdy przesyłasz zgłoszenie o błędzie, prosimy
o podanie adresu email, abyśmy mogli zapytać Cię o szczegóły.
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Prosimy zwrócić uwagę na to, że zgłoszenia błędów mogą nie mieć tak wysokiego priorytetu, na jaki liczysz
(zależy to od tego, jak poważne są to błędy). Naprawa niektórych błędów wymaga sporego nakładu pracy, a nie
zawsze dysponujemy wolnymi zasobami.

Za pomocą systemu zgłaszania błędów można również zgłaszać zapotrzebowania na funkcjonalności. Nie zapom-
nij o zaznaczeniu typu zgłoszenia jako Feature.

Jeśli znalazłeś jakiś błąd i samodzielnie go naprawiłeś, możesz przesłać nam swoją łatkę. Tu-
taj również możesz wykorzystać nasz kochany system ticketów redmine, znajdujący się pod adresem
http://hub.qgis.org/wiki/quantum-gis/issues. Zaznacz opcję Patch supplied i załącz swoją łatkę przed
wysłaniem raportu o błędzie. Któryś z deweloperów przejrzy ją i włączy do QGIS. Prosimy się nie niepokoić,
jeśli twoja łatka od razu nie zostanie zastosowana — deweloperzy mogą być zajęci innymi zgłoszeniami.

21.4 Blog

Społeczność QGIS prowadzi również bloga pod adresem http://planet.qgis.org/planet/ . Znajdziesz tam intere-
sujące teksty członków społeczności zarówno dla użytkowników, jak i deweloperów. Zapraszamy do tworzenia
własnego bloga!

21.5 Wtyczki

Na stronie http://plugins.qgis.org znajduje się oficjalny portal wtyczek QGIS. Możesz tu znaleźć listę wszystkich
wtyczek, stabilnych i eksperymentalnych, dostępnych w ‘oficjalnym repozytorium wtyczek QGIS‘.

21.6 Wiki

I na koniec mamy jeszcze stronę WIKI, znajdującą się pod adresem http://hub.qgis.org/projects/quantum-gis/wiki,
gdzie można znaleźć różne przydatne informacje dotyczące rozwoju QGISa, planów kolejnych wydań, linków do
stron pobierania, wskazówek tłumaczeniowych itd. Sprawdź ją, bo jest tam sporo dobra!

.
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Appendix

22.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

22.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.

.
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